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1. アグロフォレストリーパイロット活動からの教訓 

 

1.1. アグロフォレストリープロットの造成及び維持管理に関する教訓 

 現地の状況確認を踏まえたサイト決定 

アグロフォレストリーを実施するサイトを決定する際には、地図上で協議して決めるのではなく、実際

に現地の状況を確認してから決定することが重要である。ファラケのアグロフォレストリープロット１は、道

路際に設定されたが、道路がやや高い位置にあるため、プロットの道路沿いの一部が滞水することが後

から判明した。滞水のため、道路際に植栽したアボカド及びサンダルウッドは全滅し、その後植え替えた

ユーカリも 1本しか生存していない。一方、アグロフォレストリープロット 2は、一部に岩石があり、植栽の

支障となることがやはり後から判明した。植栽に邪魔な岩石を打ち砕くために多くの労力を費やした。こ

のような自然条件による造成・維持管理上の障害を避けるため、アグロフォレストリーのサイトを決定する

際には、地図上だけで決めることなく、現地の状況を確認してから決定することが重要である。（ファラケ

では上記の経験からアグロフォレストリープロット 3 の設定に当たっては、地図上でいくつか候補を選定

したのち、現場の状況を確認してからサイトを決定することにした。） 

 

 コミュニティ自身によるアグロフォレストリーレイアウトの作成 

コミュニティによって必要とする樹種・作物は異なり、また、地域により自然条件（地形、土壌、害虫の

有無等）及び社会条件（農作物・木材需要、市場へのアクセス等）は異なることから、アグロフォレストリ

ーに植栽すべき樹種・作物は異なる。したがって、政府機関や援助機関が樹種や作物の組み合わせを

決定し、植栽間隔を定めた「アグロフォレストリーモデル（レイアウト）」を開発し、それを全国のコミュニテ

ィに普及（奨励）するのではなく、コミュニティ自らが地域の自然・社会条件を踏まえて、樹種及び作物を

選定し、植栽する場所や面積等レイアウトを策定することが適切である。さらに、植栽後も、樹木・作物の

生存・生育状況に応じて、適宜、レイアウトをコミュニティ自身が修正していくことが適当である。 

 

 植栽材料調達及び市場性に留意した樹種選定 

アグロフォレストリーレイアウト作成時に樹種を選定する際には、特に苗木や種子など植栽材料の調

達の可否（容易さ）、及び木材市場に留意する必要がある。コムニボリでは、苗木調達（種子入手）の容

易さからチーク及びマホガニーを選定する傾向にある（Plot 1 では pencil cedar も植栽されたが、Plot 2

はチーク及びマホガニーのみ）。プロジェクトが 2019 年に実施した『市場及びバリューチェーン分析最

終報告書（Market and Value Chain Analysis Final Report Part II）』によると、これら外来樹種に関心を示

す木材販売業者は極めて限られており1、植栽しても伐採時に販売が困難となる可能性がある。将来、

樹木が成長してから販売困難という問題に直面することがないよう、アグロフォレストリーレイアウト作成

時に将来の用途を明確にして樹種を選定することが重要である。 

在来樹種の植栽材料の調達については、MOFR からの種子や苗木の支援は期待できないことから、

出し苗の活用が奨励される。コムニボリ及びファラケコミュニティでは優良な母樹を特定しており、前者は

                                                       
1 木材販売業者 13社（ホニアラの 10社及びアウキの 3社）へのインタビュ―結果によると、1社のみチークとマホガニーの在庫を有して

いたが、チークやマホガニーなどの外来樹種の売買に関心を示した業者はなかった。また、1社（South Pacific Group）のみ最近になって

チークの買い付けを通知するようになった。 
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pencil cedar を、後者は Akwa (Pometia pinnata)、Baula (Calophyllum sp.)、Rosewood（Pterocarpus 

indicus）を山出し苗を活用してアグロフォレストリープロットに植栽しており、いずれも成長良好である。 

チークやマホガニーといった外来樹種については、MOFR から種子を支援してもらえるのでコミュニ

ティで苗木を生産することができる。アグロフォレストリーに植える本数は少ないことから、必ずしもコミュ

ニティ苗畑を造成する必要はなく、コミュニティメンバーが個人の敷地内で小規模に苗木を生産する方

が効率的かつ現実的である。 

 

 生態系及び人体への影響を考慮した病虫害対策 

アグロフォレストリープロットでは農地と同様に様々な病虫害が発生する。病虫害対策を講じる場合は、

生態系や人体に及ぼす影響を事前に十分に考慮する必要がある。コムニボリではアフリカマイマイ

（Giant African Snail）によるピーナッツ等農作物や果樹幼木への被害がひどく、これを抑制するため農

業家畜省から天敵（ニューギニアヤリガタリクウズムシ）の導入が提案され、コミュニティはこれに同意した。

しかし、この方法は他国の事例から将来的に生態系に取り返しのつかない悪影響を及ぼすリスクがあっ

たことからプロジェクトでは導入しないよう要請し、結論としては殺虫剤を使用すること、及びアフリカマイ

マイの被害を受けにくい作物に転換する対策を講じることになった。 

コムニボリのアフリカマイマイ以外は、大規模かつ深刻な病虫害被害は生じていないが、バナナやグ

ワバの葉などに病虫害が散見される。必要に応じてソロモンで一般的に流通している殺虫剤・薬剤を利

用しているが、環境及び人体への安全性が十分に確認されているものを使用するようにすることが望ま

れる。また、できるだけ環境及び人体へのリスクを回避するため、害虫忌避の効果がある植物を一緒に

植える2など化学薬品に頼らない対策を講じることが重要である。 

 

1.2. アグロフォレストリー活動の運営に関する教訓 

 収支記録の作成・公開による透明性の確保 

コミュニティが共同でアグロフォレストリーを実施する場合は、透明性及び公平性の確保が不可欠で

ある。 プロジェクトでは、各パイロットサイトでアグロフォレストリーサブコミッティに収支記録の作成を指

導し、収支記録の分析を支援し、その結果をコミュニティ内で共有した。これにより、コミュニティメンバー

は、アグロフォレストリー活動の実施に関して、何にどれだけお金がかかったか、また、何をどれだけ販

売していくらの収入が得られたかを認識し、このようにして透明性・説明責任を図ることができるということ

を初めて理解した。 

透明性の確保に関連して、収支記録の作成・公開は、公平な便益分配を実施する上でも重要である。

コムニボリではアグロフォレストリー活動への参加日数に応じて、収益を各世帯に分配したが、収支記録

を提示すれば、仮に便益分配が少ないと不満に思うコミュニティメンバーがいても、なぜ、そのような額

になるのかを説明し、納得させられる。 

 

  

                                                       
2 ファラケでは個人でアグロフォレストリーを開始した住民が、タロの害虫忌避効果がある花卉をアグロフォレストリープロットに植栽している。 
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 記録作成の強化及び簡略化並びデジタル化の検討 

プロジェクトでは、収支記録の他にも活動実施状況、活動への参加状況、植物の生育状況、収穫量

についても記録を作成するよう指導してきた。これらの記録は、透明性や公平性の確保だけではなく、

アグロフォレストリー活動を改善していく上でも有効である。収支記録からコスト及び便益を分析すること

により、何にコストがかかっているのか、あるいは、どの作物の売上が最も収入創出に貢献しているか、と

いうようなことがわかる。この結果を踏まえて、例えば市場への交通費が突出していたらそれを節減する

方法を検討したり、あるいは、タロが一番売上に貢献していれば、来期はタロの作付けを増やすなど、

次の計画・アクションにつなげて改善していくことが重要である。 

しかし、コミュニティは「記録を作成する」ということに不慣れであり、記録作成には改善の余地が大き

い。プロジェクトでは記録様式を開発し、コミュニティの意見を取り入れながら改定してきたが、再度、記

録すべき項目や方法、並びに記録様式を見直し、できるだけ記録作成を簡素化することが必要である。

併せて、今後もコミュニティに対してきめ細かい指導を行う必要がある。 

記録作成はモニタリングを行う上でも重要である。本プロジェクトでは、モニタリングもコミュニティ主体

で実施するよう心掛けてきた。効率的にモニタリングを実施するため、タブレット端末を活用したモニタリ

ングの実施も検討したが、コミュニティで協議しながらモニタリングを行う際には紙ベースの方が適当と考

えられたため、最終的には紙ベースでモニタリングを実施した。しかし、実際に紙ベースでモニタリングを

実施したところ、紙ベースで作成された記録の取りまとめには多大な時間を要することが判明した。また、

紙ベースの記録作成では、書き写し時のミスによると思われる記載内容の整合性の欠如が散見された。

これらのことから、今後、改めてタブレット端末でのモニタリングの実施を検討することが提案される。 

 

 モニタリングツールについて 

タブレット端末でのモニタリングの実施に向けた改善点を教訓として整理する。タブレット端末等での

情報入力は主に 2 つの場面が考えられる。ひとつは、位置情報が必要となるフィールドでの現状の記

録、もう一つは、それが必要のない収支記録等の記録である。前者は、植栽計画の図面に対して、現状

は何が植栽されており、またそれがどのような状態であるかを記録することが主になる。しかし、タブレッ

ト等に付属する GPS 端末の位置精度（3-10ｍ）では、作物の植栽位置を正確に記録することが難しく、

場所と属性の正確な記録が技術的な課題であった。本プロジェクトでは、ドローンで詳細な空中写真を

撮影したが、技術的な改善として、このような写真を基図として用いることが提案できる。例えば、植栽開

始時等の空中写真を位置情報の基準として、その後は GPS の位置情報を参考に、目視で場所を判断

して、空中写真上に、種類、植栽範囲、写真を含む状況の記録を簡単に行える仕組みが考えられる。

その際、できるだけ手書きも併用できることで紙と近い感覚で使用できると考える。 

後者については、会計システムの簡易版と考えることができる。キーボードが使用できないため、でき

るだけ選択式の入力が求められる等、そのための、入力項目とその簡便化について本プロジェクトの紙

での記録の経験を基に検討できる。 

ツールの使用は、透明性の確保等記録の重要性の認識の上で有効であるため、この部分と連携して

進めると効果的と考える。タブレットやドローンの空中写真等の入手及び運用は、課題である。この点に

ついて森林研究省のサポートが重要になる。 
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 コミュニティメンバーの合意に基づく運営 

コミュニティの共同作業としてアグロフォレストリーを実施する場合は、アグロフォレストリーサブコミッテ

ィやコミュニティのリーダー層など一部のコミュニティメンバーだけの活動にならないように留意する必要

がある。コムニボリではアグロフォレストリーサブコミッティのイニシアティブにより、アグロフォレストリー活

動が順調に実施されてきたが、反面、アグロフォレストリー活動が同サブコミッティのみの活動、すなわち、

アグロフォレストリーサブコミッティの私物化になっていないかという懸念があった。短期専門家が 2年ぶ

りに現地を訪問して参加記録を確認し、アグロフォレストリーサブコミッティ以外のコミュニティメンバーに

聞き取りを行ったところ、杞憂であることが判明したが、コミュニティの共同作業を長く続けていくために

は、一部のコミュニティメンバーだけの活動にならないように留意する必要がある。ただし、メンバーによ

り活動への関心の度合いや参加しうるキャパシティは異なるので3、「参加の強要」にならないように留意

する必要がある。肝心なことは、コミュニティメンバーがアグロフォレストリー活動の運営方法に合意して

いることであり、この点を随時確認しながら活動を実施することが重要である。 

 

1.3. 今後のアグロフォレストリー促進に関する教訓 

 知見・教訓の蓄積及び共有 

今後、ソロモンでアグロフォレストリーを効果的・効率的に普及していくために、各コミュニティにおい

てアグロフォレストリーの実施を通じて得られる知見・教訓を MOFR が集積し、関係者（アグロフォレスト

リーを実施する・実施しようとするコミュニティ、地方森林事務所、MOFR本部、MOAL等）に共有する仕

組み（システム）を構築することが提言される。ここでいう知見・教訓とは、例えば、在来樹種の結実時期

や関する情報や病虫害の効果的な対策、あるいは現地を確認した上でのサイト選定等である。このよう

な情報が蓄積・共有されれば、他のコミュニティは同様の試行錯誤や失敗を繰り返すことなく、効率的・

効果的にアグロフォレストリーを実施できる。 

本プロジェクトでは、知見・教訓の抽出・蓄積に加えて、当初、インプット及びアウトプットに係るデータ

の蓄積も試みた。ソロモンでは、これまでも政府関係機関やドナー機関の支援アグロフォレストリーが実

施されてきたが、何をどのように植えたら、どのような結果が得られたかという記録がほとんど残されてお

らず、それが同国におけるアグロフォレストリーの最大の課題と思われたからである。この問題に対処す

るため、プロジェクトではインプットとアウトプット（何をどれだけ植えたら、どれくらいの収穫が得られたか。

どの程度の労力・コストを投入したら、どのくらいの収入が得られたか）を明確にするため、コミュニティに

記録をとることを指導した。しかし、上述したとおり、コミュニティは記録作成に不慣れであり、多岐にわた

る詳細な記録作成は困難であることが判明した。 

仮に、今後MOFRが、コミュニティがアグロフォレストリーのレイアウトを策定する際の参考になるような

データ収集を望むのであれば、それはコミュニティに記録作成を依頼するのではなく、MOFR 主体で試

験プロットを造成し、MOFR職員が責任をもって植栽及び収穫に係るデータの計測・記録を行うことが適

当である。 

 

                                                       
3 例えば、コムニボリの場合、全 25世帯中、4世帯は 33～55日、別の 4世帯は 20～28日、8世帯は 11～14日、別の 8世帯は 2～6日

とアグロフォレストリー活動への参加日数（AF開始当初から 2021年 12月 21日までの参加日数）は世帯により異なる（1世帯は場所が離

れていることもあり AFに参加していない。） 
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 長期的な管理方法の構築 

本プロジェクトでは、両パイロットサイトでアグロフォレストリーを実践した期間は約 2 年半であり、樹木

が成長した後の管理方法については十分に試行できなかった。成長が早いチークやマホガニーは樹

高 5～6 メートルに成長し、成長した樹木が落とす影が作物に与える影響が懸念され始めている。コムニ

ボリでチークの枝打ちを行ったが、必要に応じて対策を講じる必要がある。木材用樹種の枝打ちは、節

の少ない高品質の材を生産する観点からも重要であり、植林木の管理方法としても計画的に実施する

ことが必要である。 

今後、さらに樹木が成長して、樹冠が閉鎖した場合や伐期を迎えた際にどのように維持管理を行え

ばよいかについては本プロジェクトでは対応できず、既存の知識・情報も不足している。これらのことから

MOFR は、引き続き、コミュニティ主体で実施されるアグロフォレストリーをモニタリングし、そこからの知

見・教訓を抽出して長期的なアグロフォレストリーの維持管理方法を確立していくことが望まれる。 

 

 食料安全保障上の位置づけの明確化 

本プロジェクトではアグロフォレストリーは持続的森林資源管理に資する生計向上の一つとして位置

づけられていた。持続的森林資源管理という点については、天然林への圧力を軽減しうる焼畑に替わる

土地利用方法と認識されつつあり、また、在来の有用木材樹種を含む森林資源の再生という面からも

直接的に貢献しうることが示唆された。コンセッション収益の代替生計手段という点については、額とし

ては大きくないが収益を挙げており、目的を達成している。 

他方、プロジェクトの実施を通じて、コミュニティは、アグロフォレストリーは食料安全保障の観点からも

重要であると認識していることが明らかになった4。また、MOFR の事務次官も当初からソロモンにおける

アグロフォレストリーの最大の意義は、生産物の多様化であると考えていた。したがって、今後ソロモン

でアグロフォレストリーを普及・推進していくに当たっては、食料安全保障という点にも留意していくこと

が適当である。具体的には、例えば、換金作物だけを植栽するのではなく、非常時に主食を確保できる

ようにイモ類を植栽したり、通年、何らかの作物が収穫できるようにしたり、多様な栄養がとれるように多

種類の果樹・作物を植栽することを奨励していくことが提言される。 

 

 

  

                                                       
4 長期専門家主導で実施したコミュニティに対するアンケート調査結果、及びコミュニティによるアグロフォレストリーの評価結果による。 
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2. その他生計向上活動からの教訓 

 

2.1. アプローチに関する教訓 

 自助努力及びオーナーシップの精神の醸成 

活動の成否を左右し、また持続性を確保するために最も重要な要素は、活動の主体である参加住民、

或いは活動グループ（Interest group：IG）メンバーの活動に対する自助努力及びオーナーシップの精神

をいかに高めるかという点である。このため、本プロジェクトの生計向上活動では、例えば、活動開始に

必要な資材の供与を検討する際、プロジェクトからの供与は必要最低限の品目及び量に抑える一方、

IG メンバーには最大限の自助努力（貢献）を求めた。また実際の資材の見積の取付け及び調達に当た

っては、IG メンバーが率先して行動し、プロジェクトと責任を分担するよう働きかけを行った。モニタリン

グやレビューも全て参加型で実施し、常にオーナーシップが発揮されるような仕組みを導入した。更に

は、経営計画を含む管理規約の策定に際しては、プロジェクトのためではなく IG メンバーのための計

画・規約であることを再三念押ししつつ、自分達が将来にわたって活動を運営していく際に、仮に問題

が生じても自分たちで問題を解決できる方策をイメージして検討するように助言を行った。 

住民参加型の活動に限らず、全ての生計向上活動においては、不測の事態を含めた問題等が起きる

ことが一般的であり、それが契機となり活動が頓挫することは世界中どこでもみられることである。大事な

ことは、問題等が起こることを想定して万全の準備を整えておくこと、また問題等を乗り越えることが可能

なレベルの組織能力を備えておくこと、そのためには繰り返しになるが、IG メンバー、或いはコミュニティ

の構成員が高いレベルの自助努力及びオーナーシップの精神を持ち合わせていることが求められる。 

 

 適切な支援活動数の設定 

持続的森林資源管理に係る支援を行う際には、コミュニティ、或いは IGの能力を考慮し、活動の数、

或いは量を設定することが重要である。養豚のレビューの結果からは、IG メンバーから、「その他の活動

時間（家庭、学校関連行事、信教、その他プロジェクト活動等）との重複が重荷になった」とのコメントが

挙げられた。本プロジェクト期間中は、コロナ禍のため活動への支援が中断した時期もあり、再開後に

森林管理、アグロフォレストリー、その他生計向上活動（養豚、養鶏）が同時並行的に実施されたという

事情も背景にあったものの、プロジェクト活動に係る時間のやり繰りが IG メンバーにとって頭の痛い問

題であったことは事実である。 

幸いなことに、元々本プロジェクトの 2つのパイロットサイトのコミュニティの能力は他地域と比較しても

高く、かつ活動を通じて更なる能力の向上が図られたこともあり、多数の活動を何とか管理することがで

きたが、通常のコミュニティであれば、管理が容易ではないことが懸念される。したがって、新規で持続

的森林資源管理を開始するコミュニティでは、小さく始め大きく育てることを念頭に、当初は活動の数、

或いは量を制限することを検討すべきである。また、そのためには、支援する側は活動実施期間を十分

に確保することが必須である。 
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2.2. 活動の管理に関する教訓 

 共同管理方式による活動実施 

コミュニティ全体、或いは IGによる活動の運営・管理が、手法・アプローチ次第では機能することが明

らかとなった。プロジェクト専門家の経験則及び関係者等からの助言を受け、プロジェクトとしては当初、

養豚については個人或いは世帯レベルでの活動を想定していたが、パイロットサイトのコミュニティから

全世帯による共同での活動の実施を求める強い要望が挙げられたことを考慮し、共同管理方式を採用

することとした。 

実際の活動は、各 IG メンバー／世帯が日替わりで日々の管理を担当する方式となった。決められた

担当メンバー／世帯の不参加などの日々の飼育に係る問題のみならず、販売時の掛け売りといった経

営に係る問題も発生したものの、プロジェクトから問題解決に向けた IG メンバー間での協議を側面支援

するなどの支援を行ったことにより、何とか現在まで共同での管理が継続されてきている状況である。 

共同管理のメリットは、労力や資機材等の投入を効率的に配分できること、知見や技術を効率的に習

得できることなどが挙げられる。プロジェクト終了後、このようなメリットを継続して享受し、同時に問題等

が発生した場合に、活動の頓挫に至る致命的な状況を回避し、共同管理方式を持続的に継続していく

ためにも、IGメンバーが外部からの支援なしに、独自で問題解決を図るための方策が必要である。後述

する管理規約（Management rules and regulations）は、この目的のためにも非常に重要なツールとなると

考えられる。 

 

 活動管理規約の策定による活動の持続性の担保 

前項で述べた共同管理方式による活動の実施に関連して、活動管理規約の策定が特に共同管理方

式での持続的な活動の展開に大きく寄与すると察せされる。本プロジェクトにおいては、養豚の同管理

規約は両パイロットサイトにおいてほぼ策定が完了し、養鶏については、現在 IG により、養豚の事例を

参考に策定が進められている状況である。 

同管理規約（案）の内容は、IG コミッティの構成、新規会員の IG 入会の条件・プロセス、日々の養豚

管理業務、経営計画、販売、回転基金、モニタリング及び IG定期会合（報告）、管理規約の改定、養豚

の中止（IG の解消）等の条項から構成されている。同管理規約（案）の策定に際しては、プロジェクト側

としては、IG メンバーの自主性、また上述のオーナーシップを重視する観点を徹底し、時間をかけて協

議を行い、IG メンバー全員が十分に納得でき、また実効性のある内容となるようにファシリテーションを

行った。 

同管理規約は必要に応じて改定されることとなっているため、今後、IG コミッティ役員の交替、経営計

画の変更、回転基金の開始といった事態に対応すべく、実態に合わせる形で柔軟に改定を行い、活動

の持続性が担保されることが望まれる。 
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2.3. 組織能力向上に関する教訓 

 コミュニティの能力向上に資する活動の選定 

活動項目の選定に当たっては、特に第一番目となる活動は、養豚のようにコミュニティの組織能力向

上に資する活動が選定されることが推奨される。パイロット活動の中のその他生計向上活動において、

養豚を選定した際の基準／理由としては、以下が挙げられる。①両コミュニティにおいて優先順位が高

かったこと、②多くの裨益者が見込まれること（全世帯が参加希望）、③比較的低コストで活動を開始で

きること、④短期間（6～9 ヶ月）で収益が期待できること（よってモチベーションを高める、或いは維持す

ることに寄与する）、⑤ほとんどの世帯が養豚の経験があることから、技術的な制約が低いこと（ただし改

善すべき事項も多い）、⑥豚肉の市場（販売先）について問題がないこと（コミュニティでの消費も可）、

⑦活動を通じて多くの事項についての経験の蓄積及び組織能力の強化が期待できること（外部機関と

の連携、研修実施、活動グループの組織化、資機材調達、技術的フォローアップ／農民間技術普及、

回転ファンド設立・運営、マーケティング、モニタリング・レビュー／評価等）。 

中でも⑦の組織能力の強化については、養豚を通じて、多様な組織能力の向上が図られたことが示

唆されている。具体的な事例としては、活動の共同管理のノウハウの習得、協働の習慣・環境の醸成、

女性のコミュニティ活動への参加機会の提供、コミュニティのメンバー間の結束力強化であり、これらに

ついては、IG メンバーと共に実施したレビューにおいても、IG メンバーが実感していることが確認されて

いる。 

活動項目を選定する際には、コミュニティの組織能力向上への貢献度を選定基準に加えることにより、

生計向上活動を通じてコミュニティの組織能力向上を図るという相乗効果が期待できる。 

 

 コミュニティ全体の組織体制の構築支援によるインパクト 

コミュニティ全体の組織体制が整備されることにより、各グループの活動が活性化され、その結果プロ

ジェクト活動への正のインパクトが認められた。プロジェクトの支援により、コミュニティでの活動の全てを

統括するコミュニティ・コミュニティ（委員会）に加え、①社会サービス、②文化・法執行、③信仰、④経済

開発、⑤女性開発、⑥青年開発の 6 つのサブコミッティ（sector）が正式に設立された。プロジェクトから

はプロジェクト活動に係る経済開発サブコミッティに対してのみ支援を行い、その他のセクターには直接

的な支援を行ってこなかったが、独自の活動を展開するサブコミッティが確認された。ファラケの女性開

発サブコミッティが好例で、苗畑造成（野菜、花卉用）、野菜栽培、ワークショップ造成（縫製、手工芸用）

といった活動を開始している。また、他サブコミッティである青年開発セクターと連携し、これらの活動を

より効果的・効率的に展開する一方、養鶏を共同実施することを企画し、本プロジェクトに支援を打診す

ることにつながった。 

これら一連の動きは、コミュニティ全体の組織体制が整備されることなしには恐らく起こらなかったと推

察され、プロジェクトの組織能力向上に対する支援のインパクトに該当すると思料される。コミュニティ全

体の組織体制の構築につながる活動を一部支援することで、コミュニティ全体のエンパワーメントがなさ

れ、その結果、生計向上活動（プロジェクトが直接支援しない活動を含む）が更に促進されるという好循

環が生まれつつある。 
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1. Simple Procedures on how to use SolGeo-FIMS as a GIS tool 

• Purpose: To Share Forest data and information within MoFR HQ. 

• Overview  

 You can access forest GIS data and documents stored in the SolGeo-FIMS 

through a Web based platform without GIS software or can be integrate with GIS software 

(QGIS) 

 No access to the map through Internet from outside. (Access from only inside MoFR HQ) 

 

Main view 

How to access: 

 Enter URL address: http://solgeofims.mofr.gov.sb/ to access the SolGeo-FIMS home page as 

shown below. 

 You need to sign in to access the SolGeo-FIMS page with a User name***** and 

password*****. 

 You have to register if you do not have a User name***** and password*****. 

 

 

 

 

 

Sign in button 

Username 

Password 
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2. Data and Maps links view 

How to access data, map and creating maps: 

 Click Data button to open panel to access layers and documents as shown below 

 Click Map button to open panel to explore map or create map. 

 You can also search for data, documents and map using the search link. 

 To upload Layer, create Layer or upload Document, go to the Data upload link. 

 To create Map, go to the Create Map link. 

 
 

 

 

 

 

Data and Maps links view 
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3. Explore maps 

To explore map: 

 Click on the Map button to select list of layer comes up, select layer to view map 

 To view map of interest click on the view map tab as indicated below. 

 

 

Explore maps 

 

 

Map list comes up 

Click the item to view 

map
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Explore maps (Guadalcanal Map) 

 

 

Explore Maps (Western Map) 
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4. Explore Layers 

To explore Layers: 

 Click on the data button to select list of layer comes up, select layer to view layer. 

 

 
 

 

Explore Layers 

 

Layer list comes up 

Click the item to view 

map 

Input criteria 
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Explore Layers 

 

 

Forest Type Map 

 

 

 

 

Click to View the Map 
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Forest Management Unit 

 

 

High Conservation Value Map 
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5. Download layers 

How to download layer: 

 To download any layer, click on the Data button 

 And click the Layer button 

 

 The Explore Layer page will open 

 Click the Layer you want to download (e.g.: Western_Road_polyline_2021) 

 

 Click the Download Layer button to finally download the Layer you want. 
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6. Explore Documents 

To explore document: 

 Click document from the data button to view the list of documents, then select item to view 

document.  

 

 

 

Explore Documents 

 

Document 

Document list comes up 

Select item to view Document 
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7. Download Documents 

To download document 

 To download document, click the download document button as indicated below. 

 

 

 

  

Click to download 
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8. Base Map View 

To add layer to base map: 

 Select base map from explore map list, to view base map. 

 You can use different menu button to view, add layer and create map from the base map 

(Layer setting button, function button, base map button and map control button) as indicated 

below. 

 

 

 

Base Map View 
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Layer Settings 

 

Layer Settings 

 

Layer Settings 
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Layer Settings 
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9. Upload Layers 

To upload Layers: 

 Go to upload Layers in the data button menu, select file by clicking the upload files button to 

navigate to your computer. Or drag and drop file from your computer. 

 Upload by select file by clicking the upload button as indicated below. 

 

Upload Documents 

 Go to upload Documents in the data button menu, select file by clicking the upload files 

button to navigate to your computer. Or drag and drop file from your computer. 

 Upload by select file by clicking the upload button as indicated below. 

 

Choose Files  

or Drag and Drop 

Click to upload selected files 

Select users or groups 

 for data access 

Choose Files 

Click to upload selected files 

Select users or groups 

 for data access 
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10. How to Connect QGIS to SolGeo-FIMS 

   

WMS: Web Mapping 

Services 

You can load the maps 

and layers on the server 

with the prefix color as an 

image. 

WFS: Web Feature 

Services 

You can load the vector 

layers on the server as GIS 

data 

WCS: Web Coverage 

Service 

You can load the raster 

layers on the server as GIS 

data 

Geonode 

to access WMS, WFC on 

GeoNode 

 

 

 

SolGeo-FIMS Data View on QGIS 

 

Right click to New Connection 

 

GeoNode Connection 

http://solgeofims.mofr.gov.sb/ 

 

WMS/WMTS, WFS, WCS Connection 

http://solgeofims.mofr.gov.sb/geoserver/ows?version=1.3.0 

 

 
 

Type URL 
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SolGeo-FIMS Layers 

Add Layer to QGIS 
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11. User and Group 

 

 

User and Group 
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1. Start/Stop Geonode 

1. Start Geonode 

Geonode is currently set up in the Virtual machine(A virtual computer in a computer). To start 

Geonode, you need to start up a virtual machine. To do so, Doble clicks to start Oracle VM 

Virtual box(VM) which is the software to manage virtual machines in your desktop. 

  
You can see the list of virtual machines at the left window of the VM. Select a virtual machine 

 then click Start > the virtual machine will start (when you see the 

message window, please click Switch) 

  

 
Sign in the machine( Select user, the password is user) > The Ubuntu machine will be started > 

Then Geonode will be automatically started at the same time  

  
Sigh in window                           Ubuntu machine 
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2. Stop Geonode 

When you click  then you can close the virtual machine > please select Power off the 

machine > OK 

 >  

 

2. Login the Geonode as administrator 

1. Open a web browser(e.g. google chrome, firefox, Edge. Internet Explorer can not be used) then 

access to Geonode URL; 172.17.61.90 

2. Sign in from ; Username admin Password admin 

 You can access to Admin, GeoServer, and Monitoring & Analytics  menu  

2. Use the Admin menu 

1. Enter Admin menu: Click on the above   

2. Leave Admin menu 

Click VIEW SITE from Admin menu 

 

3. User management 

1. Available function for User management 

E-mail management of users 
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Group profile management. Users can be added to a group(such as REDD+) 

Group permission management. 

 
 

 

Avatar management of users. Users can upload their pictures as their avatars. 

 
User management. You can Activate users. 

 

2. Activate users by the administrator  

After signing up by a user, you can activate the user. Without activating the user, the user can 

not sing in Geonode. 

People > Users > You can see the list of users. You will find the user who doesn’t be activated. 

Click on the user > Check on Active > Save  

      

The user list(You can see ACTIVE at the right side of the list) 

 

 
 

The checkbox of activation( Check Active) 

 

After activation, you can see the green check. 
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So far, don’t use the below options. 

 

3. Create users by the administrator 

After signing up by a user, you can activate the user. Without activating the user, the user can 

not sing in Geonode. 

People > Users > Add > 

 

Enter the Username and password. Not necessary to input Contact ROLES. 
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4. Delete a user 

People > Users > Click on the username to delete  > (it located at the end of window) 

5. Managing groups 

 Add groups  

Click add to add a new group.  

 
 

Type Name as group name then select permissions. So far, not necessary to select, please 

leave it blank. 

 
 

 Delete a group 

Groups > Group profiles > Click on a group name to delete >   (it located at the 

end of window) 

 Change group permissions. 

Click Change to change group information.  
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> you can see the list of groups > Click a group name to change permission or name. 

 

 Change Group profiles 

GROUPS > Click Group profiles or Change > You can see the list of groups. 

 
> Click on the name of the group to change its profile > Change the profiles > Save 

  

  Join a user to a group(from Users) 

People > Users > You can see the list of users. > Click on the username to join a group. 
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> Select the groups of the left window then click . 

Optional> To remove a group, select the groups of the right window then click   

> Save  

 

 Join users to a group 

GROUPS > Click Group profiles or Change > You can see the list of groups. 
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> Click on the name of the group to change its profile > Add users to the group > Save 

>   

4. The other contents will be updated. 
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1. Objectives 

To learn the basic & intermediate geonode administration. 

2. Software and dataset 

2-1. Installation 
2-2 QGIS3.14.15 is used in this tutorial. QGIS3.10.x can be used. 
2-3 pgAdmin4.26 Management tool to manage postgreSQL database. 
2-4 winSCP 5.17 window secure FTP Client application.will uses to access Ubuntu 
2-5 putty 0.74 Secure shell (ssh) and telnet client application for Windows. 
2-6 Geonode GeospatialContent Management System (main application will train on today) 
2-7 Anaconda Alternative to presents Geonode customization presentation. 
 
2-8. Dataset 
Please copy 004_training_data to your desktop.This is avoid the Read and Write permission of the 
shared drive if you don’t have permission. 004_training_data contained sample data that will be used 
for this training. 
 
The mofr_trainingDoc folder contains the files below. 
Document:Contains Documentation for django,geonode and linux cheetsheet for basic linux 
administration.All these Documents can also download from the internet if you don’t have one. 
Presentation.ppt: Overview presentation of all workdone related to geonode customization and 
Migration. 

Tutorial 1: Geonode Administration step-by-step guide .docx 

 

3. Acessing the admin panel: 

GeoNode has an administration panel based on the Django admin which can be used 

to do some database operations.Although most of the operations can and should be 

done through the normal GeoNode interface, the admin panel provides a quick 

overview and management tool over the database. 
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It should be highlighted that the sections not covered in this guide are meant to be 

managed through GeoNode. Only the staff users (including the superusers) can 

access the admin interface. 

 Note- User's staff membership can be set by the admin panel itself. 

The link to access the admin interface can be found by clicking in the upper right 

corner on the user name. 

                              

 

 

 

4. Reset or Change the admin Password:{useCase, admin password need to change} 

From the Admin Interface you can access the CHANGE PASSWORD link on the right 

side of the navigation bar. 

 
 

      

 
 
 
 

 
We will focus on following only. 
Refer to the Geonode Admin Manual 
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5. Add new User to Geonode: {useCase where new user to add to the system} 

In GeoNode, administrators can manage other users. For example, they can Add New 

Users through the following form. From Admin Interface go to People and click add 

 
 

Fill up the form with the require username and Password.e.g 123456.you need to choose 

your own username & Password. 
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Then you specify the resources user need to access with approperiote role or permission 

level. 

 

 
 
 
 
 
Now user “JohnDoe” is added successfully to the system. 

 
 
so,we need to fill up the personel information for the user.This information must be authentic info 
about the user.e.g real name & email address. 
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Next step, setup the permission for the user to have when login to the system.There are 3 permission 

level, Active (do not access adminn interface), Staff Status and Superuser status does. 

 
 

Then Click save button: 

Now check that user you add to the system is listed in user list page. 

 

 

6. Activate/Disable a User: {useCase where user want to deactivate & Activate} 

Active users can interact with other users and groups, can manage resources and, more 

in general, can take actions on the GeoNode platform.Untick the Active checkbox to 

disable the user. It will be not considered as user by the GeoNode system. 

Revisit Username you created,then go to permission option and uncheck the tickbox to 
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disable the User and Activation is vice-versa (check the box). 

 
 

7. Change a User Password: (usecase where user request to change password) 

GeoNode administrators can also change/reset the password for those users who forget 

it. As shown in the picture below,go to user you create previously and  

click on this form link from the User Details Page to access the Change Password Form. 

 
 
 
 
 
 

Next, Enter new intended password and Click change Password 
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8. Promoting a User to Staff member or superuser: {useCase where new admin need} 

Active users have not access to admin tools. GeoNode makes available those tools only 

to Staff Members who have the needed permissions. Superusers are staff members with 

full access to admin tools (all permissions are assigned to them).Administrators can 

promote a user to Staff Member by ticking the Staff status checkbox in the User Details 

Page. To make some user a Superuser, the Superuser status checkbox should be ticked. 

See the picture below. 

 

 

                            Staff and Superuser permissions 
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9. Creating a Group: {useCase where new group needed to add} 

The creation of a Group can be done both on the GeoNode UI and on the Admin Panel. 

In GeoNode is possible to create new groups with set of permissions which will be 

inherited by all the group members.we will explore the creation of group using Geonode 

UI in this case: 

 

 

 

 

First login as admin and go to the about menu and create group. 

 

 

 

 
 

Fill out all the required fields and click create . The Group Details 

Page will open. 
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10. Managing a Group: {useCase where admin need to make change to existing Group} 

Through the Groups link of About menu in the navigation bar, administrators can reach 

the Groups List Page. 

  
 
 

 

 

 

11. Managing a Group Members: {useCase where admin need to add new Group 

member} 

The Manage Group Members link opens the Group Members Page which shows Group 

Members and Group Managers. Managers can edit group details, can delete the group, 

can see the group activities and can manage memberships. Other Members can only see 

the group activities. 

Add the Group Member to the newly create Group.Click on Manage Group Members. 
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Option 2: 

Groups can also be created from the Django-based Admin Interface of GeoNode.The 

Groups link of the AUTHENTICATION AND AUTHORIZATION section allows to 

manage basic Django groups which only care about permissions. 

 
 
 
 

 

johnDoe now a Group Member. 
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To create a GeoNode group using admin Interface Click on Group profiles. 

 
 

List of all groups in geonode will appeared.see Training also listed. 

 

 

To create A Group Click on ADD GROUP PROFILE 

 

Next, fill all the group information and choose the group members and  their Roles.Then Click 

SAVE 
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12. Uploading Documents: {useCase where admin need to publish Documents} 

GeoNode allows to publish tabular and text data, manage metadata and associated documents. By 
clicking the Documents link you will be brought to the Documents menu where you can upload your 
documents. 

 

Support document extension format. 
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Fill the DocumentTitle,browse your disk to where the document is store and Click upload. 

Filling the Document Metadata.Start with Basic Metadata.and Click Next 

 
Now fill the location and License Information,then Click Next.Note:You can leave it blank but it is 
best practice you provide the required infor 



15 
 

 
 
 
Next,fill the optional metadata,otherwise leave it blank and click update. 
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The Document Information page makes available useful tools for document editing. Click on 

the Edit Document button to see what you can do to make changes. The picture below shows 

you the Editing Panel that will appear on the screen. 
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13. Uploading a layers: {useCase where admin need to publish Layers} 

The most important resource type in GeoNode is the Layer. A layer represents spatial 

information so it can be displayed inside a map. To better understand what we are 

talking about lets upload your first layer.  

 

The Layer Uploading page can be reached from the Upload Layer link of the Data menu 

in the navigation bar. 

 

Next, Click on Choose file or drag n drop the upload file here.Note: upload all related files. 

 

Not only the .shp extension file. 

Before uploading the layers, make sure you Rename the title with correct title.  

 

 

 

 

Layer successfully uploaded. 
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Next,upload the sld layer. 

 

 

Note:The steps to edit the metadata are similar to editing Document metadata except one 

more option is added {Dataset Attributes.} 

 

14.Uploading Maps{useCase where admin need to publish Maps} 

{ We will skip uploading maps, since process to upload Maps are similar to Layers & 

Documents.} 
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15.Uploading Style {useCase where admin need to apply style to Layers} 

In GeoNode it is also possible to upload an existing style from file. 

Currently only styles in SLD (Style Layer Descriptor 1.0, 1.1) format can be uploaded in 

GeoNode.From the Layer Page click on Editing Tools to open the Editing Tools panel and 

follow the steps below: 

 

Click the Upload button of the Styles section. 

 

 Click on Choose Files and select your style from your disk.We will use SLD file from Qgis to 

style the uploaded layer. 
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16.Downloading Layers {useCase where GIS officer need to make map in Qgis} 

 

At the top of the Layer Page there is the Download Layer button (see Layer 

Information). It provides access to the ability to extract geospatial data from within 

GeoNode. 
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You will see a list of options of the supported export formats. You can choose the Images 

formats PNG, PDF, JPEG if you want to save a “screenshot-like” image of the layer.or 

The Original datasets 

 

 

 

 

 

 

 

17.Accessing Layers in Qgis {useCase where GIS officer work with layers directly in Qgis} 

Note:Only Admin & GIS officer are allow to access database directly.Others want to 

access directly with PostGIS database will use WMS protocal. 

Step: 1 Launch Qgis and connect to POSTGIS database server. 
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Step 2: Login using your credential pass. 

 
 

 

 

Step 3- Successfull connection will populated all layers presented in PostGIS Schema. 

Conection details: 
Name:Anything 
Host:192.168.5.50 
Port:5432 
Database:geonode_data 
Password:Will be given 
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Step 4- Add the layer to Qgis workspace and SAVE copy to your local hard drive.e.g  
 
Western_Forest_Type_Map0 
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18. How to access Geonode via WMS Protocal using Qgis. 

Accessing the layers directly in Qgis is also possible but with minimal permission.using this 

protocal(WMS) user can fetch data directly from geonode in to Qgis. 

 

Step 1: Launch Qgis,and go Layer >>Add Layer >>Add WMS/WMTS Layer 

 

Step 2: Provide any Name you Prefer but specify the given URL exactly as it is below: 

 

 

 

 

 

Copy and Paste this URL: 

http://solgeofims.mofr.gov.sb/geoserver/ows?service=wms&version=1.3.0&request=GetCapabilities 
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Step 4: Successful WMS connection will populate all data as shown below: 

 

 

 

Step 5: Select layer you want to work with, then click Add.The added layer will display 

directly in Qgis workspace.e.g Komuniboli boundary. 

Step3: Click Ok 



26 
 

 

 

Step 6- SAVE copy to your local hard drive.e.g copy of Komuniboli boundary. 

 

 

 

19. Uploading spatial data directly to Geonode using Qgis. 

To push data directly in to Geonode PostreSQL & PostGIS, sometimes is an option for 

the GIS & IT administrator.this option is handy since you do not need to copy your files 

around but just to upload your data directly to geonode schema. 

 

1.Launch Qgis and go to Database >>DB Manager>> 

Layer Name: 
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DB Manager will open as below. 

 

 

2.Click on PostGIS.then click on database Name.Enter your credential pass,successful 

connection will allow you to access the public schema of PostGIS & postgreSQL, see 

below. 
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3.To upload layer, click on import Layer & File and Browser the layer to upload from 

your local hard disk. 
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4.Click OK to upload the layer directly from Qgis to Geonode database. 

 

20.How to access Geonode postgreSQL & postGIS using, pgAdmin4 and putty. 

Accessing Geonode using pgAdmin4 has a advantage in terms of administration of the 

database.pgAdmin4 has a lot of rich features to manage and monitor the progress of the 

database.We will use pgAdmin4 track the features such a  of the geonode database session, 

server sessions,transaction per seconds,Turples in, Turbles out and most important Block 

I/O. 

1.Launch putty application 
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2. Click on Session and for the Host Name, Enter this IP Address: 192.168.5.50. 

 

 

3. Go to Connection, expand SSH option,then selection the tunnel option. 
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4. Configure the tunnel connection and click Add 
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5. You should see this login Screen. 

 

 

 

6. Launch pgAdmin4 and Create Server Connection 

 

 

 

 

 

Please login: 
With the credential provided. 
 

 
Successful login 
 

 

 



33 
 

 

 

7. Click Tab General and give Name for the server connection.e.g mofr_geonode_db. 

  

8. You should see Dasboard Overview as below with schemas for Geonode Application.We use 

geonode_data as a schema for geonode. 

 

Expansion of table.. 

Next,Click on connection and Enter Localhost 

 

Expand Geonode_data 
Schema and go to table 
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21. Review the log directories for application and system logs. 

The purpose of a log is to act as a red flag when something bad is happening.  

Reviewing logs regularly could help identify problems on your system and the application. 

Given the large of amount of log data generated by systems,we can monitor how the system is 

behaved. 

 

There are many kinds of logs in GeoNode, most of them are located in 

directory:`/var/log/ngnix/` and will be explained below in order of relevance: 

 

View Geonode Logs {geonode.log} 
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Step 1: Launch putty and setup session connection to geonode application 

  

 

Step 2: Change directory to /var/log/ uwsgi/app and view geonode.log 

 

 

 

Step 3: enter ls to view contains of app directory,where geonode log stored. 

 

 

Step 3: enter cat command to view contain of geonode.log 

Please login: 
With the credential provided. 
 

 
Successful login 
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Step 4: enter tail command to view first 10 lines of file geonode.log  e.g enter tail geonode.log 

10 0r 15. 

 

 

View Geoserver Logs{geoserver.log}- * **GeoServer log**: It contains most of the information 

related to problems with data, rendering and styling errors. 

 

Now repeat the steps above with the Geoserver logs. 

Hint.change directory to /opt/data/geoserver_log. Apply cat & tail command as above. 

 

View PostgreSQL Logs{.log}-  PostgreSQL is accessed by GeoServer and Django, therefore 

information about errors which are very hard to debug may be found by looking at 

PostgreSQL's logs. 
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Now repeat the steps above with the postgresql-11-main.logs. 

Hint.change directory to /var/log/postgresql. Apply cat & tail command. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

22. launch Glances System Monitor Tool {easy overview for all system parameter} 

1.login as superuser and then launch the glances tool to look at overview of the system 

performance.type glances and hit Enter.You should see command line dashboard as below: 
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1 Land Cover Map Attribute Specification 
 

No Field Name Type Length Precision 

1 fid Real 10 0 

2 Province Code String 10 0 

3 Province Name String 30 0 

4 Class code Integer 10 0 

5 Land cover  String 30 0 

 

 

 

2 Classification Code Definition 
 

cd td Descriptions Colors Remarks 

11 Primary Dense Forest #00a506 ref. segmentation stats 

12 Disturbed Disturbed Forest #00cc41 ref. segmentation stats 

13 Mangrove Mangrove #009900   

14 Swamp Freshwater swamp #00cc8c   

20 Water Water body #0000ff   

30 Settlement Settlements #ff0000 Building, Road(paved) 

40 Otherland Bare Soil #ff8000 Field, Road 

50 Grassland Young Vegetation #ccff34 inc. Shrub / Woodland 

61 Subsistence Gardening #ffffcc Subsistence agriculture 

62 Palm Oil Palm plantation #ffff8a   

63 Coconut Coconut plantation #cccc5c   

 

3 Detailed Classification Code Definition 
Code LU Land Cover Map Disturbance  

111 Lp Lowland Forest Primary Forest on level or nearly level 

land below 200 m.a.s.l. 
112 Ld Degraded 

121 Hp Hill Forest Primary Forest between 200-600 

m.a.s.l. 
122 Hd Degraded 

131 Up Montane Forest  Primary Forest on at higher altitude 

ridge tops, generally above 

600 m.a.s.l. 
132 Ud Degraded 

140 M Mangrove Forest  - Forest on land subjected to 

tidal influences such as 

estuaries and foreshores 

150 S Freshwater Swamp 

and Riverine Forest 

- Forest on land with little relief 

and impeded drainage 
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160 P Forest Plantation -  

200 W Water -  

300 S Settlement -  

400 O Otherland -  

500 G Grassland -  

610 Cs Cropland Subsistence  

620 Cp Palm  

630 Cc Coconut  

 

4 Workflow 
 

 
 

 

5 Setting information 
 

Optical Mosaic 

Items Settings  Remarks 

AOI EE asset, 0 km buffer Interesting province code 

DAT 5 years before 31 Dec 2019 
 

SRC L8 and L8 T2   

SCN Use all scenes   

CMP Corrections 

   SR, BRDF 

Pixel filters 

   All zero 

Cloud masking 

   Moderate 

Cloud buffering 

   None 

Snow masking 

   On 

Composing method 

  Medoid 

  

 



December 2021 

3 

 

 

Classification 

Items Settings  Remarks 

IMG EE asset ID For preview image, we can also set 

recipe (but loading takes time) 

LEG Import CSV file 
 

TRN Import CSV file   

AUX Terrain, Water Terrain: SRTM 

Water: JRC Water 

CLS Random forest 25 trees 
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6 Create mosaic image 
 

Create Landsat 8 mosaic image with sepal 

Go to ‘PROCESS’ and click ‘+’ buttom 

 

 
 

Select ‘Create a mosaic using Landsat or Sentinel 2’ 
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6.1 Area of Interest (AOI) 

 

Select EE TABLE to identify the AOI (Area of Interest) 

And select parameter like below with your purpose, and go next 

 

 
 

6.2 Dates (DAT) 

Select ‘more’ to set the details 
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Set parameters as below, and go next 

To make 2020 mosaic, use 5 years imagery ending 31 Dec 2019 

 

 
 

6.3 Sources (SRC) 

Use Landsat 8 and Landsat 8 T2 

  
 

6.4 Scenes (SCN) 

Set ‘SCENE’ as below 

 
 

 

6.5 Composite (CMP) 

 



December 2021 

7 

 

Set composite as below 

 
 

6.6 SAVE in Google Earth Engine Asset 

Open the ‘Retrieve mosaic’ 
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Select bands to retrieve ‘BLUE, GREEN, RED, NIR, SWIR1, SWIR2, 

and Retrieve to ‘Google Earth Engine Asset’ 
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7 Classification 
 

Click “+” buttom to create new recipe 

And select “Classification” 

 
 

 

 

 

 

7.1 Image to classify (IMG) 

 

Input asset ID of mosaic image to classify which you saved in Google Earth Engine Asset. Image 

bands to be used is ‘blue’ ‘green’ ‘red’ ‘nir’ ‘swir1’ ‘swir2’ 
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7.2 Legend (LEG) 

 

Click ‘import’ the existing prepared ‘legend’ csv file, 

 

 
 

 

And select parameter as the following image 
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7.3 Training data collected outside of Sepal (TRN) 

 

From “TRN”, Click “Add” button to import existing training data and go to next 

 
 

 

Location Type is X/Y, Select the coordinate columns as below, and go “next” 
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7.4 Select “cd” for the class, and go “next” 
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7.5 Auxiliary Sources (AUX) 

Set ‘TERRAIN’ and ‘WATER’ 

TERRAIN uses SRTM dataset, WATER uses JRC Water, these datasets tend to improve output 

 

 

 
 

7.6 Classifier Configuration (CLS) 

Use ‘RANDOM FOREST’ 
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7.7 Retrieve 

Select ‘class’ and save in sepal workspace 
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8 Evaluation and Modification 

 
cd td color 

11 Primary #00a506 

12 Disturbed #00cc41 

13 Mangrove #009900 

14 Swamp #00cc8c 

20 Water #0000ff 

30 Settlement #ff0000 

40 Otherland #ff8000 

50 Grassland #ccff34 

61 Subsistance #ffffcc 

62 Palm #ffff8a 

63 Coconut #cccc5c 

 

 

It is most important to identify the forest area (11: Primary and 12: Disturbed). So the forest 

areas has first priority in this classification. 

 

Once you got the classification image, compare with the other satellite image and evaluate its 

boundary and land cover class on Sepal or QGIS . 

If it is necessary to amend, try to improve the training data. 

 

 

 

8.1 Duplicate the recipe to modify and name 

eg) 2_Guadalcanal_classification_L8_2020 

 
 

 

8.2 Evaluation 

Compare the class (classification) and Planet image (December 2019) And change training point 

which is not adequate 
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 In this image case, Water body and Settlement are not classified well, so check and move the 

training point to get more good quality. 
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8.3 Modification (Delete and add the training points) 

Once you find an inadequate point, change the point one by one. 

Click the point and click “Remove” 

  
 
And put a training point instead of deleted data or just only add, and click close 

 
 

1 

3 

2 

4 close 
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9 Stratification with External Information 
 

Forest area (Primary and Disturbed) is divided into the following three classes based on the FRL 

report, although Plantation Forest is defined in the other chapter. 

Land Cover Map Class FRL type Description 

Lowland Forest Primary Forest on level or nearly level land below 200 m.a.s.l. with 

no clearly visible indications of human activities and 

ecological disturbance. 

Degraded Forest on level or nearly level land below 200 m.a.s.l. with 

visible indications of human disturbance. 

Hill Forest Primary Forest between 200-600 m.a.s.l. on well-drained soils with 

no clearly visible indications of human activities and 

ecological disturbance. 

Degraded Forest between 200-600 m.a.s.l. on well-drained soils with 

visible indications of human disturbance. 

Montane Forest  

(Upland Rainforest) 

Primary Forest on at higher altitude ridge tops, generally above 

600 m.a.s.l. with no clearly visible indications of human 

activities and ecological disturbance. 

Degraded Forest on at higher altitude ridge tops, generally above 

600 m.a.s.l. with visible indications of human disturbance. 

 

 

1.1 Work flow of the stratification 

 
 

 

 

1.2 Convert Altitude information 
Open SRTM30 with QGIS, and Calculate with Raster Calculator, and Save as “SRTM30_recls” 

Less than200 m to “10” 

200-600 m to “100” 

600m and more to “1000”  

 

Set expression like the image below. 

("SRTM30_SI@1" < 200) * 10 + ("SRTM30_SI@1" >= 200 AND "SRTM30_SI@1"  <  600) * 100+ 

("SRTM30_SI@1" >= 600) * 1000 

 

cd td cd Altitude cd td note cd td note
11 Primary X 10 200 = 110 Lowland Forest Primary = 111 Primary
12 Disturbed 100 200-600 120 Disturbed 112 Disturbed
13 Mangrove 1000 600 1100 Hill Forest Primary 121 Primary
14 Swamp 1200 Disturbed 122 Disturbed
20 Water 11000 Montane Forest Primary 131 Primary
30 Settlement 12000 Disturbed 132 Disturbed
40 Otherland 13 Mangrove 140 Mangrove Forest
50 Grassland 14 Swamp 150 Swamp Forest
61 Subsistance 20 Water 200 Water
62 Palm 30 Settlement 300 Settlement
63 Coconut 40 Otherland 400 Otherland

50 Grassland 500 Grassland
61 Subsistance 610 Subsistance
62 Palm 620 Palm
63 Coconut 630 Coconut

Lowland Forest

Hill Forest

Montane Forest
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1.3 Raster Calculatation 
Open “SRTM30_recls” and “Western_classification_L8_2020” with QGIS and calculate with 

“Raster Calculator”, then Save as “Western” 

Expression 

( "Western_classification_L8_2020@1" < 13 )  * " Western_classification_L8_2020@1" * 

"Srtm30_recls@1" +  ( " Western_classification_L8_2020@1" > 12 )  * " 

Western_classification_L8_2020@1" 
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1.4 Reclass 
Open “Western” and Reclass with “Raster calculator” as the following. 

 

("Western@1" = 110) * 111 + ("Western@1" = 120) * 112+("Western@1" = 1100) * 

121+("Western@1" = 1200) * 122+("Western@1" = 11000) * 131+("Western@1" = 12000) * 

132+("Western@1" = 13) * 140+("Western@1" = 14) * 150+("Western@1" = 20) * 

200+("Western@1" = 30) * 300+("Western@1" = 40) * 400+("Western@1" = 50) * 

500+("Western@1" = 61) * 610+("Western@1" = 62) * 620+("Western@1" = 63) * 630 

 
 

This stratification is finalized with this. 
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10 Vectorize and add attribute 
Polygonise the stratified LU map with “Polygonize” and Disolve by “DN” (Code). 
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Union the Forest Type Level2 and Level 3 information with “Union”. 

Use “Forest_type_level2.shp”and “Forest_type_level2.shp”file respectively. 

These dataset shall be prepared beforehand. It is better to clip out them with Provical boundary to 

reduce the processing time. 
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11 External Information （Forest Plantation, Oil Palm Plantation） 
 

The following image is the attribute which is cleaned up after “Union” 

 
 

Union Land Cover shp file and Plantation shp file. 

The following image is the attribute 
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Where Oil Palm plantation locates, DN (Land Use Type) shall be changed to be “620”,  

Where Forest plantation locates, DN shall be changed to be “160”, with “field calculator” as “DN2” 

 

 
 

Palm Oil Plantation 

 

CASE 

WHEN "common_nam" = 'Oil Palm' THEN '620' 

ELSE "DN" 

END 

 

Forest Plantation 

CASE 

WHEN "Company" = 'KFPL' THEN '160' 

WHEN "Company" = 'EAGON' THEN '160' 

WHEN "Company" ='SANTA CRUZ' THEN '160' 

ELSE "DN"  

END 
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After clean up, the attribute shall be the following image. 
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12 Fill the no data attribute 
 

Fill the attribute where land cover type hasn’t been aquired (Code: ‘0’)because of lack of satellite 

image or other reason. Name with land cover type by the relation of surrounding parts. 

Refer classification tif or landsat image which were used for this classification to make decision. 

Most of no data point is out of classification on outer boundary or lack of satellite image.  

 
 

1.Use Geometry tools > Multipart to single part (in case that there is multipart polygon) 
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Use Geoprocessing tools > Eliminate selected polygon 

Select Land cover type (gridcode in the image) is ‘0’,  

 
Then eliminate selected polygons 

 
 

Use “Largest Common Boundary” to eliminate, they will be merged as it is like. 

 
 

Confirm attribute as the processing has done successfully comparing with tif data. 

Clean up the attribute. 
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1. FMU Attribute Table Specification 
 

 Components  

No Field Name Type Length Precision Source 

1 fid Integer 10 0 Original 

2 Province Code String 10 0 Census 

3 Province Name String 10 0 Census 

4 Ward Code String 10 0 Census 

5 Ward Name String 30 0 Census 

6 Catchment Code String 10 0 Original 

7 FMU Code String 10 0 #2+#6 

8 Area (ha) Real 

(double) 

10 2 Original 

9 LC_Type String 10 0 Original 

Land Cover Map 

Majority 

10 LC Code String 10 0 Original 

Land Cover Map 

Majority 

11 Forest Type String 10 0 FTM 

Majority 

12 F_TYPE2 String 10 0 ForestType 

Level1 

13 F_TYPE3 String 10 0 ForestType 

Level2 

14 F_TYPE4 String 10 0 ForestType 

Level3 

15 Treecover(ha) Real 

(double) 

10 2 Hansen Treecover 

16 Loss area (ha) Real 

(double) 

10 2 Hansen Lossyear 

17 Loss rate (ha) Real 

(double) 

10 2 Hansen Lossyear 
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18 Gain area (ha) Real 

(double) 

10 2 Hansen Gain 

19 Water area (ha) Real 

(double) 

10 2 Hansen Datamask 

20 Elevation Real 

(double) 

10 2 SRTM30 

21 Elevation>400 ratio Real 

(double) 

10 3 SRTM30 

22 Slope Real 

(double) 

10 2 SRTM30 

23 Aspect (8 directions) Integer 10 0 SRTM30 

24 Distance(Major road) Real 

(double) 

10 2 Base Map 

25 Distance(River) Real 

(double) 

10 2 Base Map 

26 Volume_sum (m3) Real 

(double) 

10 2 Original 

Tree Volume 

27 Volume_ha (m3) Real 

(double) 

10 2 Original 

Tree Volume 

28 Carbon_sum (C-ton) Real 

(double) 

10 2 Original 

AGC 

29 Carbon_ha Real 

(double) 

10 2 Original 

AGC 
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 Province Code and Ward Code 

Province 

Code 

Ward 

Code 

Ward name 

 
01 Choisuel  

 101 Wagina 

 102 Katupika 

 103 Vasipuki 

 104 Viviru 

 105 Babatana 

 106 Tepazaka 

 107 Batava 

 108 Tavua 

 109 Polo 

 110 Bangera 

 111 Susuka 

 112 Senga 

 113 Kerepangara 

 114 Kirugela 

   

02 West  

 201 Outer Shortlands 

 202 Inner Shortlands 

 203 Simbo 

 204 North Ranongga 

 205 Central Ranongga 

 206 South Ranongga 

 207 Vonunu 

 208 Mbilua 

 209 Ndovele 

 210 Irringgilla 

 211 Gizo 

 212 South Kolombangara 
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 213 Vonavona 

 214 Kusaghe 

 215 Munda 

 216 Nusa Roviana 

 217 Roviana Lagoon 

 218 South Rendova 

 219 North Rendova 

 220 Kolombaghea 

 221 Mbuini Tusu 

 222 Nono 

 223 Nggatokae 

 224 North Vangunu 

 225 Noro 

 226 North Kolombangara 

   

03 Isabel  

 301 Kia 

 302 Baolo 

 303 Kokota 

 304 Hovikoilo 

 305 Buala 

 306 Tirotongana 

 307 Koviloko 

 308 Kmaga 

 309 Kaloka 

 310 Tatamba 

 311 Sigana 

 312 Japuana 

 313 Kolomola 

 314 Kolotubi 

 315 Susubona 

 316 Samasodu 

   

04 Central  
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 401 Sandfly/Buenavista 

 402 West Gela 

 403 East Gela 

 404 Tulagi 

 405 South West Gela 

 406 South East Gela 

 407 North East Gela 

 408 North West Gela 

 409 Banika 

 410 Pavuvu 

 411 Lovukol 

 412 North Savo 

 413 South Savo 

   

05 Rennell-Bellona  

 501 East Tenggano 

 502 West Tenggano 

 503 Lughu 

 504 Kanava 

 505 Te Tau Gangoto 

 506 Mugi Henua 

 507 Matangi 

 508 East Gaongau 

 509 West Gaongau 

 510 Sa'aiho 

   

06 Guadalcanal  

 601 Tandai 

 602 Saghalu 

 603 Savulei 

 604 Tangarare 

 605 Wanderer Bay 

 606 Duidui 

 607 Vatukulau 



June 2022 

 
 

 608 Talise 

 609 Avuavu 

 610 Moli 

 611 Tetekanji 

 612 Birao 

 613 Valasi 

 614 Kolokarako 

 615 Longu 

 616 Aola 

 617 Paripao 

 618 East Tasimboko 

 619 Vulolo 

 620 Malango 

 621 West Ghaobata 

 622 East Ghaobata 

   

07 Malaita  

 701 Auki 

 702 Aimela 

 703 Buma 

 704 Fauabu 

 705 West Baegu/Fataleka 

 706 Mandalua/Folotana 

 707 Fo'ondo/Gwaiau 

 708 Malu'u 

 709 Matakwalao 

 710 Takwa 

 711 East Baegu 

 712 Fouenda 

 713 Sulufou/Kwarande 

 714 Sububenu/Burianiasi 

 715 Nafinua 

 716 Faumamanu/Kwai 

 717 Gulalofou 
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 718 Waneagu/Taelanasina 

 719 Aiaisi 

 720 Areare 

 721 Raroisu'u 

 722 Aba/Asimeuri 

 723 Asimae 

 724 Mareho 

 725 Tai 

 726 Kwarekwareo 

 727 Siesie 

 728 Waneagu/Silana Sina 

 729 Keaimela/Radefasu 

 730 Langalanga 

 731 Luaniua 

 732 Pelau 

 733 Sikaiana 

   

08 Makira/Ulawa  

 801 North Ulawa 

 802 South Ulawa 

 803 West Ulawa 

 804 Ugi and Pio 

 805 Arosi South 

 806 Arosi West 

 807 Arosi North 

 808 Arosi East 

 809 Bauro West 

 810 Bauro Central 

 811 Bauro East 

 812 Wainoni West 

 813 Wainoni East 

 814 Star Harbour North 

 815 Santa Ana 

 816 Santa Catalina 
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 817 Star Harbour South 

 818 Rawo 

 819 Weather Coast 

 820 Haununu 

   

09 Temotu  

 901 Fenualoa 

 902 Polynesia Outer Islands 

 903 Nipua/Nopoli 

 904 Lipe/Temua 

 905 Manuopo 

 906 Nenumpo 

 907 Nevenema 

 908 Luva Station 

 909 Graciosa Bay 

 910 Nea/Noole 

 911 North East Santa Cruz 

 912 Nanggu/Lord  Howe 

 913 Duff Islands 

 914 Utupua 

 915 Vanikoro 

 916 Tikopia 

 917 Neo 

   

10 Honiara   

 1001 Nggossi 

 1002 Mbumburu 

 1003 Rove/Lenggakiki 

 1004 Cruz 

 1005 Vavaea 

 1006 Vuhokesa 

 1007 Mataniko 

 1008 Kola'a 

 1009 Kukum 
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 1010 Naha 

 1011 Vura 

 1012 Panatina 
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 Land Cover Type Code 
 

Code LU Land Cover Map Disturbance  

111 Lp Lowland Forest Primary Forest on level or nearly level 

land below 200 m.a.s.l. 
112 Ld Degraded 

121 Hp Hill Forest Primary Forest between 200-600 

m.a.s.l. 
122 Hd Degraded 

131 Up Montane Forest  Primary Forest on at higher altitude 

ridge tops, generally above 

600 m.a.s.l. 
132 Ud Degraded 

140 M Mangrove Forest  - Forest on land subjected to 

tidal influences such as 

estuaries and foreshores 

150 S Freshwater Swamp 

and Riverine Forest 

- Forest on land with little relief 

and impeded drainage 

160 P Forest Plantation -  

200 W Water -  

300 S Settlement -  

400 O Otherland -  

500 G Grassland -  

610 Cs Cropland Subsistence  

620 Cp Palm  

630 Cc Coconut  
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 FOREST TYPE CLASSIFICATION 

 

Forest typing from API(air photo interpretation) will result in forest 

types which are composites of stratification levels one, two and three , 

as shown in the following example 

 
Level1   ECOLOGICAL CLASS  eg: HM 
   

Level2   CANOPY CONDITION CLASS  eg: 3 
   

Level3   CROWN SIZE CLASS  eg:S 
   

*first two characters designating...ecological class 

*second character designating...canopy condition 

class 

*third character designating…crown size class 

=coding for the above example is shown thus: 

"HM3S" 

 
Level 1Ecological Classes 

UPLAND FOREST ON HILLS 

  UM upland forest on hills,mixed spp composition 

      

OTHER AREAS 

  NH Herbaceous swamps, mixed spp composition 

  NR River courses: braided streams 

  NW Open water(inland) 

  NP Plantation areas for timber production 

  NC Cloud obscured areas 

SALINE SWAMP FOREST 

  SM Saline swamp forest, mixed spp (magroves) 

  SN Degraded forest (anthropogenic, gardens etc) 

FRESHWATER SWAMP FOREST 

  FM 
Fresh water swamp forest, mixed spp 

composition 

  FC Casuarina swamp forest 

  FP Pandan swamp forest 

  FS Sago swamp forest 

  FT Terminalia swamp forest 

  FL Logged forest 

  FN Degraded forest (anthropogenic, gardens etc) 

LOWLAND RAINFOREST ON NEAR LEVEL LANDS 
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  LM Lowland rainforest, mixed spp composition 

  LC Casuarina dominated lowland rainforest 

  LL logged forest 

  LN Degraded forest (anthropogenic, gardens etc) 

HILL FOREST 

  HM Rainforest on hills, mixed spp composition 

  HC Casuarina dominated hill forest 

  HN Degraded rainforest on hills 

  HL Logged forest 
   

   

   

Level2 Canopy Density Classes 

Class Density Description 

1 10-20% 

Degraded forest areas 

Cleared to sparse remnant forest 

Primary canopy: very open to isolated trees 

2 10-50% 

Severe to moderately disturbed forest 

areasSparse to mid-dense forestPrimary 

canopy: clearly separated 

3 
40-

100% 

Moderate to relatively undisturbed forest areas 

Mid dense to dense forest 

Primary canopy: separated to overlapping 

   

   

Level3 Crown Size Classes 

Class Crown size 

S small-medium 

M medium-large 

V various 

 

 

 Direction code 

3 2 1 

4 
 8 

5 6 7 

 Direction number *0 = no data  
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2. Preparation: Catchment (5ha watershed) 
 

Make up FMU boundary with 5ha level watershed 

1. Union watershed_5ha and Provincial boundary (costal 

line) with”SAGA Polygon Union”   *this process can take 

time, check geometry correctness using “fix geometry” 

 

 

1. Area 

1. Put field “Area” with “Field Calculator”. *it is better to 

fix geometry before executing this 

2. Set “real”and field length as 10 and 2, and calculate as 

“ha” 

3. Select small polygons < 5ha with “Select Features by 

Value” 

4. Eliminate small polygons with “Eliminate selected 

polygons” using “Largest Common Boundary” 

5. See attribute table to confirm elimination, but note that 

some of small island cannot be eliminated.  

6. Recalculate the AREA 

 

 

 
 

 

 

 

 

 

 

 

 



June 2022 

 
 

3. fid  
*It is needed to “fid” column in case that they already have “fid” field. 

 

1. Put serial number as fid with “Add Autoincremaental Field” 

  Field name: fid, Start values: 1 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Refactor 

1. Change field order with 

“Refactor field” 
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4. Province and Ward 
 

1. Open Attribute of “Admin Boundary 

Wards”. 

2. Open Field Calculator. 

3. Convert “Wardcode” into the expression like 

“0000” with “Field Calculator” Numbers 

shall have ‘0’s as 4 digits’ text. 

4. Make up “Provincial code” with “Field 

Calculator” like image. 

   Expression: left ( "code" ,'2' ) 

 

 

 

5. Add “Province Name” with “Field Calculator” like image 

Expression: If ( ‘Province_c’  = '10', 'Honiara', ‘Guadalcanal’ ). 
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6. Add “Province Code and Name”, “Ward Code and Ward name” field with “Join Attributes by 

Location” using “intersects” 

7. Parameters are the following image 

8. They are added on Attribute Table 

9. Add “Province Name” 

with Field Calculator.  



June 2022 

 
 

5. Catchment Code 
 

 

1. Open Attribute Table of FMU 

2. Open Field Calculator 

3. Create a new field as text with 

expression like image 

    lpad ("fid" ,5,'0')  

 

Means fid→Catchment Code 

 

4. Numbers shall have ‘0’s as text 
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6. FMU Code 
 

5. Open Attribute Table of FMU 

6. Open Field Calculator 

7. Create a new field as text with expression like image 

    lpad( "prov_code" + "catch_code" , 7, 0)  

 
means “Province Code” + “Catchment Code” = “”FMU Code” 
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7. Land Cover Type and Code 
1.  Open Zonal Statistics 

2. Set parameters like image and save as different file 

         *Use majority as Statistics to calculate 

 

 
 

3. Set into defined style with field calculator and Remove tentative attribute 
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4 Open Field calculator 

5 Calculate like the following 

 

CASE 

WHEN "LC Code" = '111' THEN 'Lp' 

WHEN "LC Code" = '112' THEN 'Ld' 

WHEN "LC Code" = '121' THEN 'Hp' 

WHEN "LC Code" = '122' THEN 'Hd' 

WHEN "LC Code" = '131' THEN 'Up' 

WHEN "LC Code" = '132' THEN 'Ud' 

WHEN "LC Code" = '140' THEN 'M' 

WHEN "LC Code" = '150' THEN 'S' 

WHEN "LC Code" = '160' THEN 'P' 

WHEN "LC Code" = '200' THEN 'W' 

WHEN "LC Code" = '300' THEN 'S' 

WHEN "LC Code" = '400' THEN 'O' 

WHEN "LC Code" = '500' THEN 'G' 

WHEN "LC Code" = '610' THEN 'Cs' 

WHEN "LC Code" = '620' THEN 'Cp' 

WHEN "LC Code" = '630' THEN 'Cc' 

END 
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8. Forest Type 
 

1. Join the field from Forest Type Map 

*Use the original 

2. Add the field with “Join Attributes by 

Location” 

3. Parameters are the following image 

 *Use join type“Take attributes of the 

feature with largest overlap only (one to 

one)” 

 

 

 

 

 

 

 

 

 
 

 

 

 

Organize Attribute Table 

1. Open  “Refactor fields” 

2. Select field row and click 

“arrow” buttons to change 

the order 

3. The “Field name” or “Length” 

can be changed  
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9. Treecover Area 
 
1. Open treecover2000 

*Use 2019 version 

2. Merge and reclass this 

3. Set parameters like image 

  0 thru 50 = 0 

  50 thru 100 = 1 

 

*means counting 

 forest >=50% 

 

 

 

 

 

 

 

 

Zonal Statistics 

1. Open reclassed treecover2000 and FMU file. 

2. Open “Zonal Statistics” 

3. Set parameters like images 

4. The results come up in the attribute 

table 
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5. Open Attribute Table.  

And Make it to Area with “Field Calculator” 

    Expression: “_sum” * 729m2 /10,000 

 

Then, eliminate tc_sum column.  
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10. Loss year 
 

Reclass Loss year data * use 2019 version 

1. Open Hansen loss year 

2. Reclass like image to calculate “Loss 

area” 

    0 = 0 

    1 thru 19 = 1 

 

 

 

 

 

 

 

 

 

Zonal Raster Statistics 

1. Open reclassed loss year and FMU 

file. 

1. Open “Zonal Raster Statistics” 

2. Set parameters like images 

3. The results come up into Attribute 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. Open “Field Calculator” 

5. Set parameters like image to calculate Area 

(one cell to 729m2) 
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11. Loss rate 
 
6. Consequently, Set parameters like image to 

calculate loss rate 

7. Remove “loss_sum” and “loss_count ” column   
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12. Gain area 
 

1. Merge “Hansen gain” 

2. Open “FMU” 

3. Open “Zonal Statistic” 

4. Set parameters like image 

5. Convert to Area with “Field 

Calculator” as well 

6. Remove “gain_sum” column 
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13. Water area 
 

1. Open Hansen datamask 

2. Merge and Reclass this 

3. Set parameters like the following 

     0 thru 1 = 0 

     2 = 1 

4. Clip data with administrative 

boundary 

5. Open “Zonal Statistic” 

6. Set parameters like image 

7. Convert to Area(ha) with “Field 

Calculator” 

8. Remove “mask_count” column 
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14. Elevation, 400 > rate, Slope, Aspect 
 
1. Convert from SRTM30 

2. Open SRTM30 which is converted to filled and 

UTM projection 

3. Open “Slope” to create slope map 

4. Set parameters like image 

 

 

 

 

5. Open “r.watershed> Drainage direction” to 

create aspect 

6. Set parameters like image 

 

 

6. Reclass SRTM30 to (0, 1) with the following  

  expression: 

   0 thru 400 = 0 

   400 thru 5000 = 1 
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6. Open “Zonal Statictis” 

7. Set parameters like image (Dem30_utm and FMU shp) 

    Use “Mean” 

8. Convert ele_mean to Ele_mean by field calculator like the following 

9. Remove “ele_mean” column 

 

 

 

 

 

10. Open Zonal Statics 

11. Set parameters like image (dem30_400 and FMU shp) 

    Use “Count and Sum” 

12. Open field calculator and calculate the rate as following expression 
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8. For “Slope”, use Zonal statics 

     Use “Mean” 

9. Open field calculator and make this to defined style like image 

 

10. Remove slope_mean as usual. 

 

 

11. For Aspect: Open Zonal Statistics 

12. Set parameters like image 

         *Use majority 

13. Set into defined style with field calculator 

 

3 2 1 

4 
 8 

5 6 7 

Direction #0 = no data  



June 2022 

 
 

15. Distance from Main Road and Main River 
 

1. Calculate distance from 

the centroid of  “FMU” to 

existing “road data” from 

Base map 

2. Create centroids from 

“FMU” with “Centroids” 

3. Set parameters like 

image 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. Open “v. distance” 

5. Set parameter like image and 

create output as temporary file. 

Automatically name as “Distance” 

*Use UTM and gpkg data 

6. Select “Area” as column name 

   



June 2022 

 
 

7. Output shall be like image 

8. Calculate distance with “Field 

Calculator>$length” 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

9. Open FMU and go to Layer Properties 

10. Select Join and click + button 

11. Set parameters like image 

12. Save this as a new file 

 

 

 

 

 

 

 

 

 

 

13. Calculate distance from watercourse similarly 

*Polygons are needed to convert to line 
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16. Volume_sum 
Open “Zonal Statistics”using GEDI2019_Vol.tif and Select input data as the image. 

Only “sum” is to be used as Statistics to calculate. 

 

 
 

Set into defined style with field calculator and Remove tentative attribute 

 

And Calculate volume per ha with field calculator as below. 
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17. Carbon_sum 
Open “Zonal Statistics”using GEDI2019_TC.tif and Select input data as the image. 

Only “sum” is to be used as Statistics to calculate. 

 
 

Set into defined style with field calculator and Remove tentative attribute 

And Calculate carbon per ha with field calculator as below. 
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18. Clean up the boundary 
 

Finally the output need to clip put with the province boundary. 
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19. Managing the data related to logging on 

Solgeofims 
 

1. Objective 

2. Georeferencing using Solgeofims data 

Open the QGIS project on your desktop 

 

3. Tracing function on QGIS 

(1) Add SNAP toolbar to QGIS 

> View > Toolbars >  

>> You can see  

(2) Settings of Snap toolbar 

> Push  to use snapping tool > Then change the setting. 

Target layer setting > select  all layer (if necessary, change the settings)  

 
Target point setting > select Vertex and Segment >  

 
Snap range setting > change the snapping distance setting. 

(When the mouse cursor withing the value below, it snaps to 

the vertex or segment. 

 
 

Snapping option > push the tracing button  

 

(3) Setting for CRS: Super important Use UTM57S 

Click EPSG (the below) > Type 32757 in the filter box > select WGS84 / UTM 

zone 57S > Click OK 
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(4) Add new polygon for concession boundary 

> Click  to add new shapefile > 

change settings like below > OK 

 

> highlight the above new polygon 

in the layers panel > click  and 

 to edit > draw polygon > when 

you move your mouse near existing 

line or polygon, the cursor will be 

attached. Then you can trace the 

line or polygon. 

 

You don’t need snap function to 

draw the paper map. Please click 

 to stop. 
 

4. Estimating volume of concession 

area 
Select manually 

(1) Comparing the elevation, slope, river, etc., select  
> Open the basemap project > Add A concession polygon > Check the inside of 
concession area (The below is the example with slope layer) 
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> Select FMUs inside the concession by selecting tools. 
>Highlight the FMU layer > With pushing the shift key, ctrl key of your keyboard, you can 
select multiple polygons   

 
(2) Calculate SUM of selected polygon  

> Vector > Analysis Tools > > Change the settings like below > 
Click Run > You can see the link in your QGIS to show the result > check SUM 
 
 

Don’t forget to check  
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Select by Polygon 
(1) Select by Location 

> Vector > Research Tools > > change the settings like below > RUN 
> You can see the selected polygons > Go to above (2) Calculate SUM of selected polygon 
to calculate a total volume of selected polygon 

 
 

 
 
Calculate total thinking about area proportion in a concession 

(1) Clipping the FMU polygon by a concession layer 

Vector > Geoprocessing Tools > > change the settings like below. Input 

layer is the FMU while Overlay layer is a concession layer > RUN (If you want to 
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save the result, please, save using the Clipped part.) 

 

 
The result (Clipped) 

 

(2) Recalculate the total volume of each FMU considering their area 

> Open the attribute table (right click on Clipped FMU) > Click  > Change 

the setting like below (Please name Area2_ha)> OK > You can see the new 

field including the result 
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Again! > Open the attribute table (right click on Clipped FMU) > Click  > 

Change the setting like below (Please name EstVol)( Fomula: "volume_sum" *  

"area2_ha"/ "area_ha" ) > OK > You can see the new field including the result 

> You can see the volume considering the area. 
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After that you can go to above Select manually, Select by Polygon to calculate the total 
volume of the concession area. 
 
 

Click  to stop editing 

 
 
 
 
 
 

5. Subtract the harvested volume (for the practice we use the result of 4.) 

Preparing a harvested volume from Marketing section!!  

 

E.g. here we use 10000m2 for a harvested volume 

 

Using the select by polygon function etc. to subtract, then  

For the first time > Open the attribute table (right click on FMU) > Click  > 

Change the setting like below (Please name SubVol)( Fomula: 10000 *  

"area_ha" / sum( "area_ha" ) ) > OK > You can see the new field including the 
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result  

   
 

After that update the SubVol > Open the attribute table (right click on FMU) 

> Click  > Change the setting like below (Please update SubVol) 
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6. Update the yearly growth 

For example, here we suppose yearly growth: 9.20 m3/ha 

Open the attribute table (right click on FMU) > Click  > Change the setting 

like below (Please name Volume2023)( Fomula: "volume_sum"  -  "subVol"  + 

(9.2* "area_ha")) > OK > You can see the new field including the result 
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7. Share the concession area by Solgeofims 

>Access to Solgeofims (http://solgeofims.mofr.gov.sb/) and sign in > 

>Upload Concession layer to Solgeofims >  >  > Select a 

set of shape file > Change the permissions to share > Upload files 

 

go to  >Open the below map (currently only Guadalcanal) 

 
 

>Scroll down and find the Copy this map > click Create a New Map >  
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> Click  > add layer > search and add a concession layer > 

  
 
> Go to SAVE As… > Name by Concession ID > Save As  

  

> Back to the  > you can see the saved map >Open the map > Scroll down to 

permissions > click Change Permissions of this Map > Apply change > click  > 
Share it by e-mail to Commissioner etc.  
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HCV 1-3 probability maps: Methodology in Solomon Island 

 

1.1 Overview 

This report provides indicators and the methodology for developing HCV 1, 

HCV 2, HCV 3 probability maps. Proposed places where these HCVs may exist 

are separately identified by using each indicators mentioned later. A proposed 

methodology is also provided for how the HCV 1-3 maps can be overlaid to 

produce an HCV 1–3 probability map. These draft indicators are based on the 

existing RSPO document: HCV 1-3 probability maps: methodology and 

consultation (HCV_SH_7_mapping_methods.pdf).  

 

The basic steps for developing the maps are as follows: 

1. Define indicators for HCV 1-3 

2. Collect data 

3. Develop draft probability maps for HCV 1-3, and conduct accuracy 

testing 

4. Refine probability maps for HCV 1-3 

5. Combine HCV 1, 2 and 3 maps into draft combined HCV 1-3 probability 

map 

6. Final revision of all maps. Final outputs will be a methods document and 

shapefile/raster maps of: HCV 1-3 probability 
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1.2 Indicators 

 

Firstly, indicators are set up and converted to each Indicator Map, then these 

maps are merged into the Probability Maps for each HCV. 

 

Probability of HCV 1 presence 

1. The presence of a recognized biodiversity priority area 

2. A designation by national authorities, or by reputable conservation organizations 

3. The presence of natural habitat in good condition 

Probability of HCV 2 presence 

1. Existing landscape-level designations (e.g. Ramsar sites, National parks, 

Sanctuaries, etc.) 

2. Areas with low levels of overall disturbance and high connectivity 

3. Large, undisturbed landscape-level (Intact Forest Landscapes) forests comes from 

the World Resources Institute 

4. Other forests matching criteria (with an area of at least 5000 km2 etc.) 

Probability of HCV 3 presence 

1. In regions where many natural ecosystems or habitats have been eliminated, and 

others have been heavily impacted by development, remaining natural ecosystems 

of reasonable quality are likely to be HCV 3. 

2. Where ecosystem proxies indicate the presence of RTE ecosystems, even if these 

are inaccessible or have not been confirmed on the ground. 
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1.2.1 Dataset 

High probability of HCV 1-3 presence 

Natural Forest Patched >=1,000ha (plus an additional 50m buffer) Hansen Treecover 

Hansen Lossyear 

Create treecover2018 from above 

data 

Protected Areas (plus a 50m buffer) World Database on Protected 

Areas(WDPA) 

 

Intact Forest Landscape (IFL) (plus a 50m buffer) Intact Forest Landscape 

 

Medium probability of HCV 1-3 presence 

50m to 500m buffer around natural forest patches >1,000ha Treecover2018 

Swamp ecosystems TROP-

SUBTROP_WetlandV2_2016_CIFOR 

50m to 1km buffer around PAs World Database on Protected 

Areas(WDPA) 

50m to 1km buffer around IFLs Intact Forest Landscape 

Natural forest patches of 50-1,000ha Treecover2018 

 

Low probability of HCV 1-3 presence 

All remaining areas, consisting of existing agriculture, 

scrubland/degraded natural areas and natural forest patches <50ha 

Remaining areas 
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1.2.2 Methodology 

a. High probability of HCV1-3 presence 

Treecover2018 creation 

1. Open Hansen Treecover map and merge these. 

 
 

Parameter are like below 

 

 When you fail merge, use temporal file and save. 

 

Merge Lossyear as well 
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2. Clip out Treecove2000 with Lossyear 

 Reclass Lossyear to (0,1) 

  *Make sure to open with QGIS with GRASS 

 

 

 

 

 

 

 

 

 

Reclass rules text 

0 = 1 

1 thru 18 = 0 

 

 

Make this as a temporary file 
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3. Calculate treecover2018 

Open Raster calculator 

 

 

 

Parameters are like a right image 

treecover2000*lossyear 

  =treecover2018 (the end of 2018) 
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Reclass treecover2018 to (0,1) 

Percentage indicates crown cover rate. 

Classify this like below 

0-89% =0 

90-100=1 

 

Save this as: 

Treecover2018_reclass 

 

 

 

 

 

 

 *From now on, it is better to clip raster to each province to avoid processing into failure. 

 

4. Polygonize trecover2018_reclass. 

 

 

*It takes time so that it is preferable to leave processing overnight. 
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After this, Dissolve with DN(1, 0) 

1 = 90% and over, 0 = under 90% 

If geometery error occur when you process,  

Use “Fix geometries” or “generate 0m buffer”to fix 

 

 

 

 

 

Then, select DN=1 from polygonized treecover2018_reclass by filter. 
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Change the coordinate system to UTM57S 

Calculate area with field calculator 
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Then Select area >=1000ha using filter>Query Builder 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

And save this as “treecover2018_reclass_selected1000ha” 

 

5. Generate 50m buffer with “Buffer” 

 

 

Parameters are below: 
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6. Open IFL and guad_admin. Clip out IFL by Guadalcanal area 

 

 Save file with UTM57S 
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7. Change project coordination to UTM57S 

 

 

 

8. Generate 50m buffer 

9. Generate 50m buffer with PA in same way 

 

 

 

10. Merge “treecover2018_reclass_selected1000ha” and IFL and WP as High area. 
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11. Open Field Calculator and add field. Parameters are like below: 

 
 

12. Dissolve with number 1 

 

b. Medium probability of HCV1-3 presence 

 

1. Open generated“treecover2018_reclass_selected1000ha” 

2. Create 500m buffer and save this. 

3. Select “code20: mangrove area” from WetlandV2 

4. Select over 50ha to 1000ha area using original “treecover2018_reclass” 

5. Create 1km buffer with IFL and PA 

6. Merge and Dissolve these area with number 2 

 

c. Probability of HCV1-3 presence 

1. Put attribute number 3 on admin boundary (as Low) 

2. Union High and Medium and admin boundary (as Low) 

3. Clip out this map with admin boundary 

4. Color Map with number 1(High), 2(Medium), 3(Low) 
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1. Concession Attribute Table Specification 
 

1.1 Components  

No Field Name Type Length Note 

1 fid Integer -  

2 shape Geometry -  

3 Province String 40  

4 License1 String 30 Application for a new license 

5 License2 String 40 Application for renewing 
(license1) or a new license by 
the same company that holds 
license1. 

6 License Type String 2 Indicate license type 

7 Area Long - ha 

8 Quota1 Long - Permitted volume for 
harvesting  

9 Quota2 Long - Permitted volume for 
harvesting 

10 Year String 8 Indicate inception year 

11 Inception1 Sting 12 The date license1 application 
was submitted to MoFR 

12 Inception2 Date - The date license1 application 
was submitted to MoFR. 
Especially, if license1 was 
renewed or a new license was 
issued to the holder of 
license1. 

13 Inception3 Date - If the license holder repeat 
the Inception2 process, it 
comes here 

14 Expiry1 String 10 Expiry the date which 
connected to the license1 

15 Expiry2 Date - If the license holder renews 
this license or applies 
for a new one. And this 
license reached its expiry 
date, this comes here 
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16 Expiry3 Date - If the license holder repeat 
the expiry2 process, it comes 
here 

17 Status String 15 Indicate whether it is active or 
not active 

18 Company String 254  

19 Layer String 100  

 

 

1.2 License Type 
 

No Type Note 

1 A1 Felling license 

2 UD Stands for License under application 

 

 

1.3 Status 

No Status Note 

1 Current Concession area currently has operations in it  
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2. MERF Attribute Table Specification 

1.1 Merchantable Forest 
 

 
 

1.2 Status 

No Status Note 

1 C1 Commercial Forest, slope 0-15 degree 

2 C2 Commercial Forest, slope 15-30 degree 

3 S1 Semi Commercial Forest, slope 0-15 

4 S2 Semi Commercial Forest, slope 15-30 degree 

 
 

1.3 Slope 
 

No Slope Note 

1 0-15 Indicate slope range 

2 15-30 Indicate slope range 

 
 
 
 
 
 

No Field Name Type Length Note 

1 Type String 4 Only MERF 

2 Status String 2 Indicate commercial status 
and forest condition 

3 Area Integer - ha 

4 Slope String 5 Indicate slope division 
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1. Objective of the data 
 Solomon Islands depends very much on the forest.  By far forest 
becomes one of the biggest income generators for the country. Moreover, most 
people equally rely on forests for their livelihood. However, people’s 
dependence and inadequate forest governance have caused deforestation to a 
level that is not sustainable. Commercial logging operations, for instance, have 
been one of the major causes of deforestation. And as the population 
increases, it also demands more forest resources consumption as well. 
Therefore, the data of current tree volume is essential for the sustainable use of 
forest resources.  
 

2. Method to estimate 
 The tree volume data is estimated using satellite lidar data (Global 
Ecosystem Dynamics Investigation (GEDI) https://gedi.umd.edu/) and inventory 
data on the pilot sites: Komuniboli and Falake. The method to estimate the tree 
volume is described below. 
 

2.1. Preparation  
GEDI Global Forest Canopy Height data and inventory data 

GEDI Global Forest Canopy Height 
data (GEDICH) is downloaded from 
https://glad.umd.edu/dataset/gedi. The data 
was developed through the integration of the 
GEDI Lidar data and Landsat analysis-ready 
data time series. The spatial resolution is 
30m. The inventory survey was conducted on 
the pilot site: Komuniboli and Falake. There 
are 29 plots in total. (Komuniboli:17, Falake:12). Both data were acquired in 
2019. 

 

2.2. Developing tree volume estimation model based on 
GEDICH 

The models to estimate Tree Volume (Volume) from GEDICH were 
developed compared with the overstory height of plots. Lorey’s height method 
was used to estimate the height of plots. The height had a good correlation with 
GEDICH (Lorey’sH=0.984 GEDICH. R2: 0.98). We used the exponential 
function to build the models. 

The developed model is shown in Figure 1. The formula is below. The 
model does not use the forest type category because of a limited number of 
plots. 

Tree volume/ha = 1.355 * (0.984 GEDICH) ^1.524          R2:  0.40349  

GEDICH(m) and 

Falake inventory plots 
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Fig. 1 Developed Tree volume estimation model (it does not use the forest type category) 

 

2.3. Mapping tree volume based on GEDICH 

The model developed was applied to map the tree volume of Solomon Islands. 

Their spatial resolution was 30m. The volume per pixel was calculated. At last, this map 

is summarized by Forest Management Unit (FMU). The FMU-based volume data can 

be used for concession management. 

 Tree Volume (Raster) 

FMU based volume (Vector) 
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3. Specification of FMU-based tree volume 
 FMU whose minimum size is five hectares has an attribute of total tree volume, volume 

per ha, and carbon stock values in an FMU polygon.  

 

- volume_sum : Total tree volume in a FMU polygon 

- volume_ha : volume / ha in a FMU polygon 

- carbon_sum : Total carbon stock in a FMU polygon  

- carbon_ha : carbon stock / ha in a FUM polygon  

 

 

4. Update Manual 

4.1. Subtract the harvested volume 

 At first, you need to get the harvested volume of each concession. This 

information can be shared from the license/marketing division. Please contact them. 

Please prepare the data below. 

 

 Harvest log volume of each concession with the concession ID 

 A concession polygon with a concession ID 

 

(1) Open FMU data from Solgeofims and a concession polygon by QGIS 

This manual uses QGIS3.24. The basemap project is convenient to open the data. 

Open QGIS >  >  > Select Solgeo 

server and Click Connect to open  SolGeoFIMS server > Add 

FMU (e.g. for Makira )  

 

Please make the fields (hrvvol year and volsum year) to store the results of this process 

before you start. Please see 4.3. Preparing new fields.  
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If you don’t have the connection to SolGeoFIMS 

Open QGIS >  >  > Click  >type like below: 

Name: Solgeo, URL: http://solgeofims.mofr.gov.sb/geoserver/ows?version=2.0.0 > 

Click OK 

 

 

(2) Open a concession boundary 

Open QGIS >  > navigate to your folder or Solgeo server > add a concession 

boundary 

 
Fig. 2 FMU and a concession layer (Example) 
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(3) Select intersected FMU by the concession boundary. 

From your QGIS >  >  >  > Change the settings 

like below >  > you can see the selected FMUs. 

 

 

 
Fig. 3 Selected FMUs by the concession boundary 
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Tips: If you have an error of geometry, please fix geometry 

 

 

(4) Calculate harvested volume in the concession boundary 

Here, we use 5000 m3 as an example value of harvest log volume from marketing 

division. Please use true value for your case. And we use the percentage of 

Merchantable volume is 50% of tree volume. 

Right click on FMU layer > > open field calculator  > Copy and 

paste the below formula and modify the harvested log volume, percentage of 

commercial volume, and concession polygon name (the numbers and text showed as 

RED) > Change settings like below > OK > Click  to stop editing > Click Save 

5000 * 100/50 * ("area_ha"*(100-"_400_ratio")/100)/sum("area_ha"*(100-

"_400_ratio")/100,filter:=overlay_intersects(layer:='A102001_')) 

 

**Modify the red parts 

 

The formula considers an area proportion of high-altitude area (more than 400m). In 

this case, 10000 m2 (tree volume will be distributed as harvested tree volume). 

 

Check the result 

> close the attribute table > click the  button 

> select FMU and harvol field > you can see the total (only selected area) > then check 

the total harvest volume registered to FMU. In this case, it is 10000. 
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Harvested log volume is once converted to tree volume. 

Then it is subtracted from the FUMs based on the area 

proportion considering prohibit area (more than 

400m).White FMUs has high percentage of more than 

400m altitude. 

 

Go to (1) and repeat the process to 

reflect all harvest volumes. 

hrvvol2022 field will be updated.  

(Please change the year according to this year) 

 

4.2. Yearly update of the tree volume 
considering the growth rate 

 Here we use the 9.2m3/ha/year as a growth rate. 

(1) Concept 

 

  =   -  +   

(2) Calculate an initial tree volume for the next period 

Highlight FMU > Click  to clear selection  

Right click on FMU layer > > open field calculator  >  

Copy and paste the below formula > Change settings like below > OK > Click  to 

stop editing > Click Save > volsum2023 will be updated 

(For the next year volume_sum will be replaced by volsum2023, hrvvol2022 will be 

hrvvol2023) 

 

Formula: copy and paste the below. 

if ("hrvvol2022" is NULL, "volume_sum" + (9.2* "area_ha"),"volume_sum"  -

"hrvvol2022"   + (9.2* "area_ha")) 

 

 

New initial 

volume of next 

year 

Initial volume of 

current year 

Extracted volume 

of current year 

(Calculated in 4.1) 

growth volume of 

current year 
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4.3. Preparing the fields to store the result  

You cannot make new field using the WFS connection. So, you need to use the 

 connection from  button to read a FMU layer. Here, please make 

two fields: hrvvol2022, volsum2023. 2022, 2023 should be changed according to 

current year and next year. 

 

(1) Make PostgreSQL connection 

> Click  > go to  > click  > type like below. 

Name:  solgeofims 
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Host:  solgeofims.mofr.gov.sb  , Port: 5432, Database: geonode_data 

> Click Basic under the Authentication > type geonode for both Username and 

Password 

 > Click OK > click  > Open public > you will see the data list 
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(2) Make the fields: hrvvol2022, volsum2023 

Data loading may take time. Very slow. Please wait until all the data shows. 

> Add a FMU layer from the list > right click on the FMU > > 

click  to start editing > click  > make hrvvol2022 like below > OK > > click  

to stop and save editing 

 

Repeat the above process for the volsum2023 field > click OK > click  to stop and 

save editing 

 

 

(3) Update the change for Solgeofims 

> Open solgeo fims http://solgeofims.mofr.gov.sb/ > go to  >  > and 

open the FMU layer (you can search it) > scroll down > click 

 > click  > if you can see 

the fields in the list, finished. 
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Go to 4.1. and start updating the volume information! 
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１． オンライン研修のフォーマットの検討と試行  

１−１. 目的 
本プロジェクトでは、森林研究省（以下、MOFR）主要メンバを対象として、2019 年 7

〜８⽉に本邦研修を実施したのち、10 ⽉末〜11 ⽉上旬に本邦研修のフォローアップ研修を
行った。2020 年 2 ⽉には、各課の業務に即した研修として、リフォレステーション課を対
象に、GPS 情報の取得と森林情報ツールへの登録について研修を行った。このため新型コ
ロナウイルスの影響で渡航制限下であっても研修を継続することで、森林情報ツールを活
用した持続的森林管理に資すると考え、オンライン研修のフォーマットの検討と試行を行
った。 

  
１−２．オンライン研修の企画と実施 

研修がオンライン化することで、ドローン等の屋外での研修は難しくなる。また、完全に
個々人の環境においては、研修員の相互のサポートや集中力の維持は難しくなり、信頼関係
の醸成、議論やワークショップによる相互の触発の効果は、小さくなると考える。一方で、
参加人数や時間、場所等は自由になる。そこで、上記のようなメリット、デメリットを整理
しつつ、効果を挙げるためのテーマやフォーマットを検討し実施した。 

企画した研修は、表 1 に示す計 6 日分であり、これらを 2 日ずつ 3 回に分けて行った。
オンラインでは短時間で集中する方が良いと考えて、11:00〜15:00（12:00〜13;00 はランチ
休憩）の 3 時間程度とした。通常のオンライン研修は、参加者も別々の場所から参加する
が、ソロモン諸島においてはインターネット環境やハードウェアの所有状況を考えると難
しく、また、政府の水際対策による出入国制限が早期に行われ、当時は COVID-19 の感染
者が国内でていなかったことから、ソロモン側はインターネットとハードウェアの環境が
十分に整っている場所に集まって受講してもらうこととした（図 0-1）。1，2 回目は ICT 
training lab であったが、3 回目は会場が利用できなかったため MOFR で行った。全研修を
通じて現地スタッフが研修のサポートを行った。2 回目の研修以降に、ソロモン国において
も感染者が確認されたため、人を集める集会の制限やトレーニングラボが一時的に利用で
きなくなったことにより、研修開催が困難となり 3 回目の開催は年度末まで延期された。 

テーマは、プロジェクトの進捗と必要性を考慮して決定した。1 回目は、流域界をベース
とした Forest Management Unit(FMU)に基づく森林管理をテーマとし、整備した FMU と
それに基づく森林管理方法、それに基づく森林機能区分（土砂流出）について講義と実習を
行った。2 回目はインベントリーをテーマとし、GIZ/JICA 協業で試行的に実施された行わ
れたインベントリーデータからパイロットサイトの材積の推定や、インベントリーデータ
の取得に関して住⺠参加型の調査方法について講義と実習を行った。3 回目はモニタリング
をテーマとして、モニタリングの意義や考え方をパイロットサイトの活動と関連付けて説



 

明し、タブレット端末で動作する調査用アプリケーション Open Data kit（ODK）の実習を
行った。3 回目の実習では、MOFR 駐車場で、ODK を実際に使用してもらうことも含めた。 

使用ツールは、当初、データトラフィックが少なく業務ミーティングでも使用していた
Google meet を予定していたが、ソロモン国 I C T 部局が当初 Google アプリへのアクセス
に利用制限をかけていたのが関係したと思われる接続トラブルが会場で発生したことから
Zoom を使用することとなった。以降研修では有料版 Zoom を用いて録画した。研修教材お
よび録画した動画は、クラウドストレージ（Google drive）を通して共有した。 
 
 表 1 実施したオンライン研修 

日程 テーマ 会場 使用ツール 形式 
2020 年 8 ⽉ 25 日 
11:00〜15:00
（12:00〜13;00 は
ランチ休憩） 

1. Forest management tool and 
FMU based management 

SIG ICT 
Services 
training 
lab 
 

Google 

meet/Zoom 

講義 
実習 

8 ⽉ 26 日 
時間は同上 

2. Evaluating and zoning by the 
concept of forest functions - 
Sediment retention – 

講義 
実習 

10 ⽉１日 
時間は同上 

1. Utilizing Inventory survey data 講義 
実習 

10 ⽉ 2 日 
時間は同上 

2. GPS transect walk and its 
facilitation 

講義 

2021 年 3 ⽉ 30 日 
時間は同上 

1. Mapping/monitoring for Forest 
management and Agroforestry 

Planning 
division 
office 

Zoom 講義 
実習 

3 ⽉ 31 日 2. Forest information tools for 
monitoring 

講義 
実習 

研修の企画については、添付資料１を参照のこと 
 

 
 



 

 

図 0-1 研修フォーマット 
 
１−３．チュートリアル集の作成 とデータ整理 

上述のように研修は 1 日 3 時間程度であり、講義の録画や研修資料を Google drive で共
有した。実習部分の資料は、通信が途切れた時でも継続できること、事後、自分で復習がで
きることを考慮してステップバイステップのチュートリアルを加えた(表 2)。また、これら
のチュートリアルを行う上で必要となるデータについても整理した。作成したチュートリ
アルの詳細は、添付資料２を参照のこと。 
 
表 2 チュートリアル一覧 

日付 実習テーマ チュートリアル名 データセット 
8 ⽉
25 日 

Forest management tool and 
FMU based management 

Tutorial1_Workin with 
FMU 

FMU,Forest loss,slope, 
elev,settlement, etc. 

8 ⽉
26 日 

Evaluating and zoning by the 
concept of forest functions - 
Sediment retention – 

Tutorial2_Forest_func
tion 

FMU,elev, Geological 
data,Rainfall, etc. 



 

10 ⽉
1 日 

Utilizing Inventory survey 
data 

Tutorial3_inventory_s
urvey 

Plot location, drone 
photo, boundary, forest 
type,etc. 

3 ⽉
30 日 

Mapping/monitoring for 
Forest management and 
Agroforestry 

Tutorial4_monitoring
_inventory 

Landuse(current/future 
plan), FMU, etc. 

3 ⽉
31 日 

Forest information tools for 
monitoring 

Tutorial5_form_creati
on 
ODK_build_minitutor
ial 

No data. Only ODK need 
to be download. 

   
１−４．オンライン研修の要点整理  

主に 8 ⽉ 25、26 日、10 ⽉ 1、２日の研修を企画、実施する中で、オンライン研修を実施
する際の要点を整理した。詳細は、添付資料３オンライン研修振り返りメモを参照のこと。
図 0-1 に示した通り、通信手段には Zoom を用いた。Zoom での録画は講師の負担もなく
行えたが、通常の研修実施と大きく違いオンライン環境等の確認事項等多く講師が録画ま
で気を配る事が難しく録画開始を忘れてしまうことがあった。そのため、録画については研
修の運営を行う補助者が行う必要があり、少なくとも国内からは２名体制で行う必要があ
ることがわかった。また、録画された動画は大容量にならず、500〜700MB 程度であり、共
有も容易であった。GoogleDrive を利用することで、ドライブ上でビデオ再生が可能なため、
閲覧者はダウンロードをする必要がないこともメリットとしてあげられる。また、ミーティ
ングシステムと録画機能を利用する場合は、講師・主催者は通常事務用のスタンダード P C
ではなく、ややハイスペックの P C を利用すること、講師は共有画面とその他事項の確認
のため２つの P C または２つのモニターを準備するのが良いと考えられる。 

日本側の講師・参加者は別々の場所、PC で参加したため、ハウリング等音声の問題はな
かった。しかし、ソロモン側では、1 か所に集合しての参加であったため、講師の声を聴く
ためのスピーカ、質問等を行うためのマイクが非常に重要であった。個別のカメラマイクを
各 PC に設置することを試みたが、会場のセキュリティの問題で設置できなかった。最終的
に、集音マイク（１０名程度の会議用マイク）とスピーカを使用することとなった。このた
め、会議室のような大会場で実施する場合は、発言者が集音マイクに近づいて発言するなど
工夫の必要がある。 

カメラは、参加者の様子を確認するのに必要であった。トレーニングラボでは前方に、
MOFR では後方にカメラを設置した。前方からは参加者の表情が見えやすかった。一方で
後方からは会場の雰囲気が確認しやすかった。 



 

 

図 0-2 カメラからの映像（左：前方から、右：後方から） 
  

  研修の実施には、ローカルスタッフの協力が不可欠であった。研修準備、研修中のファ
イルの送受信、通信トラブル対応、研修内容のサポート等、実際に会場や参加者の横でサポ
ートができなければ、オンライン研修は難しいだろう。また、ローカルスタッフとのコミュ
ニケーションには、Zoom 等メインの通信手段以外にも、電話、メール、ショートメッセー
ジ等複数の通信手段を持っておくと通信トラブルへの対応が容易であることがわかった。 
 上記を踏まえて、オンライン研修簡易マニュアルを作成した（添付資料４）。 
 
１−5．オンライン研修実施による副次的な効果 

本プロジェクトでは、COVID19 による渡航制限が開始されてからローカルスタッフとの
コミュニケーション手段として Google meet によるオンライン会議を定期的に実施してき
た。これが、オンライン研修を実施する際に絶対的に必要なローカルスタッフの補助が比較
的スムーズに行われた要因だと思われる。また、前述のとおり当初は野外で実施するドロー
ンやタブレット端末の研修は困難が伴うものと思われたが、研修やミーティングを継続し
ていくうち、プロジェクトからの遠隔での支援を前提に C/P より自主的なドローンリフレ
ッシュ研修の提案がなされ、研修も C/P 自身によって行われたことは大いに評価できる。
また、2021 年度に入って実施された JCC や FS-TWG でのオンライン環境の設定、現在実
施中のドローンやタブレット端末を活用した森林モニタリングを取組みは、C/P・ローカル
スタッフが遠隔でのコミュニケーションを基礎としたプロジェクト推進方法を経験的に理
解し身に着けていることが何より礎になっていると考えられる。 

 

 

 
 
 

 
 図 0-3 ドローン自主研修の様子 
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Output1/Activity1.5: Forest Information Tool

1. オンライン研修の位置づけと本マニュアルにおける想定
COVID-19の世界的な拡大による渡航制限により、本プロジェクトにおいても渡航しての

直接支援が行えない状況となっている。しかし、渡航制限下であっても、カウンターパート
の技術研鑽の継続とプロジェクト推進の動機を維持が必要であり、オンライン研修は、こ
れらの達成手段として位置付けた。

本マニュアルは、ソロモン諸島において実施したカウンターパート向けのオンライン研修
を基に整理したものである。カウンターパートは１か所（ICTラボ）に集合して、講師とスタッ
フが日本から遠隔で講義や実習を行う形式のマニュアルとする。

本マニュアルで、説明する研修のイメージ

The Project on Capacity Development for Sustainable Forest Resource Management in Solomon Islands (SI-SFRM)

２. オンライン研修企画の留意点

07 May 2021 MOFR/JICA 4

オンライン研修は、教室内で行える内容に適する。例えば、ドローンやGPS等の機材を

使った屋外での研修は運営が難しい。研修の企画は、運営の困難さも考慮する必要が
ある。

オフライン研修であれば、研修員は一か所に集まって研修を受けることになる。一方で、
オンライン研修では、個人の自宅で、個人の機材を用いて受講することが可能であり、参
加人数や時間、場所等は自由になる。しかし、使用される通信環境や機器は、研修員の
経済状況やICTへの関心等に左右されることがある。実習については、オフライン研修の
ような統一された環境で機材トラブル等をコントロールすることは難しい。

また、研修員が集合しないため、相互のサポートや集中力の維持が難しくなる。講師と
研修員、研修員間の信頼や友情関係の醸成、議論やワークショップによる相互の触発の
効果は小さくなる。
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３. オンライン研修の企画と準備
（１）研修テーマの設定

オンライン研修で行う研修テーマ、内容、タ
イムスケジュール案を作成し、研修員にコン
セプトノートとして配布する。研修時間は、研
修員の集中力の維持等を考慮して、オフライ
ン研修よりは短時間の方が良い。屋外作業を
伴う研修は、現地でのサポートスタッフが必
須である。また、進捗が変化しやすいので、
内容を絞り、スケジュールはゆとりを持ってお
くと良い。

Online Trainings Concept Note 

1. Objective:  

 So far, the project conducted training in Japan from July to August last year and follow-up training 

of training in Japan from the end of October to the beginning of November. In February, The other 

training was conducted for the reforestation division on acquisition of GPS information and 

registration in the forest information tool as training tailored to the work of each section. The 

continuous training will contribute to sustainable forest management utilizing forest information 

tools even under the current travel restrictions, and the following online training will be 

conducted. 

(1). Creation and maintenance of information data with Sol-FIMS aiming to the practical use 

(2). Preparation of field survey and organization its outputs 

 

2. Expected Participants:  

          FRMTS, MOFR  

               Florence Pupuka, Florence Lenga, Arnold Augwaroa, Gideon Solo, Stanley Lesinenea,  

               Gusgrandy Mua 

          MOFR/JICA project 

               Jerry Iriahoroa,  Japhiliet Rouhanna, John Smith Daffe,  

 Hirokazu Takahashi, Nobuhiko Yoshimura 

 

3. Schedule  

 The first training: 

Date: 25th-26th in August 

Participants: Planning Division staff (MOFR) 

Venue: SIG ICT Services training lab in the new ICT building 

                             Access URL: https://meet.google.com/xnq-iwst-aac  

                                                  

Day1 Forest management tool and FMU based management 

11:00 Introduction of forest information tool. 

11:30 Forest management based on FMU. Decision making with FMU 

12:00 Lunch Break 

13:00 Understanding the current situation using the existing attributes of FMU. 

13:30 Comparing FMU with the concept of Logging code practice 

14:00 Add /update new attributes for decision making 

14:30 Summary of the training 

15:00 End 

Day2 Evaluating and zoning by the concept of forest functions - Sediment retention –  

      11:00 Introduction of forest function 

      12:00 Lunch Break 

      13:00 Wrap-up discussion 

      15:00 End 

 

 

コンセプトノートの例

The Project on Capacity Development for Sustainable Forest Resource Management in Solomon Islands (SI-SFRM)
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３. オンライン研修の企画と準備（つづき）
（２）会場の選定
個々人のPCと通信で研修を実施することが難しい場合、かつ、集会が可能な場合は、オ

フライン研修のように、一か所に集まって行うことで、集中力の維持や相互サポート等の効
果が期待できる。
会場の選定は、想定人数から、会場の大きさ、PC台数、そして通信環境を考慮し行う。付

帯設備の確認も必要であり、プロジェクター＆スクリーン、マイク＆スピーカー、ウェブカム
の有無を確認する。

今回は、個別のマイク、スピーカーがなかったため、会議用の集合マイク（１０名程度の
会議用マイク）とスピーカーを準備した。研修者各PCにマイク＆スピーカーがある場合は
ハウリングが起こらないかを確認する必要がある。

PCについては特に、研修内容に応じて下記を確認すること。
 使用するソフトウェアを考慮して、PCスペックを確認

 機器接続時のドライバーなど必要なものをインストールす
ること（セキュリティ上インストールできないことがある）

できるかぎり、使用する機材の使用やソフトウェア
のインストール等は実際に試しておくと安心

会場のイメージ（ICTラボ）
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（３）ミーティングシステムの決定

会場のセキュリティによって利用できない場合があるため、利用できるかどうかを事前に
確認して決定する。試行時は、録画等の容易さ等からZoomの有償版を利用した。

無償版では、参加人数、録画機能など制限される場合がある。特に録画機能は記録とし
て、また復習の機会を提供するためにも重要であるので、使用するミーティングシステム
で確実に使えるかどうか確認が必要である。
通信負荷も考慮する必要がある。事前に複数のシステムで接続を行い、画質、機能、通
信負荷、安定性等を確認すると良い。今回のテストでは、GoogleMeetが最も負荷が小さ
かったが、研修時の不具合からGoogle Meetが使用できず、Zoomに変更した。

（４）通信のバックアップ

ミーティングシステムが不安定になったり、通信が途切れたりするトラブルは容易に起こ
りえる。そのため、現地スタッフ等と、電話やチャット等で別途連絡が取れるようにしておく
必要がある。また、会場の通信が使用できなくなった際用に、Wifiルーター等回線のバック
も準備すると良い。
今回は、携帯電話を現地スタッフとの連絡に使用し、Wifiルーターを持参しておいた。

The Project on Capacity Development for Sustainable Forest Resource Management in Solomon Islands (SI-SFRM)
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４. チュートリアルの作成
（１）チュートリアルの作成

オンライン研修において、通信が途切れることは起こりえる。そのようなときにも各自が
研修を進めることができるようにするために、ステップバイステップのチュートリアルが必
要である。ひとつひとつのチュートリアルは、集中力を考慮し、できるだけ短時間で行え
るようにすると良い。通常の現地研修に比べ開催者の負担も大きい。研修員の集中力
以外にも、開催者の負担を考慮して、テーマ数、研修時間数・開催間隔を決定すること
が必要である。今回は、1日3時間程度の研修を３回とした。

（２）チュートリアルデータの整理と共有
ファイルサイズの大きなデータはネット
ワークの状況によっては共有が難しい。研
修用には小さなデータセットとする方が良
い。てチュートリアルとして、テキストとデー
タのセットを整備し、 Google Drive等で研修
前後、研修中に、研修者、ローカルスタッフ
に共有する。

チュートリアルの共有
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５．開催前のチェックリスト
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• 機材
 講師用PCと研修者用PCは動作するか
 講師用PCはプロジェクター、マイク、カメラと接続しており動作するか

• ミーティングシステム
 通信状況は安定しているか
 音声はお互いしっかり聞こえるか
 会場の様子は確認できるか（通信が悪い場合は音声を優先する）
 画面共有によりプレゼンテーションが行えるか
 録画を行えるか

• 通信のバックアップ
 現地スタッフと電話やチャット等、ミーティングシステム以外の連絡手段が
確保されているか。Wifiルーター等回線のバックアップはあるか（推奨）。

• ソフトウェア
 必要なアプリケーションとドライバー類はインストールされているか
 チュートリアル（テキストとデータ）は、研修者のPCにコピーされているか

• ファイル共有
 共有ドライブ等に、講師用および研修者用PCからアクセスできるか
（最低限1台はアクセスできるようにする）

• ランチ等の手配は行ったか（ソロモン諸島では必須）

The Project on Capacity Development for Sustainable Forest Resource Management in Solomon Islands (SI-SFRM)
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６. オンライン研修の実施
（１）最終確認

１時間前には、現地スタッフに会場入りしても
らい、５．の項目を最終確認する。特に、会場
のWi-Fi、モバイルWi-Fi等複数の通信手段を確
認しておく。

（２）役割の確認
講師と補助者の２名以上で進行する。

• 講師：研修を実施する講師
• 補助者：全体のファシリテーション

 画面・音声状況確認
 録画・写真（画面キャプチャ）など

• ローカルスタッフ
事前に資料等共有し、研修員のPCの
調整、研修内容の補助

（３）研修継続の確認

実習は、チュートリアルに基づいて通信が途切れた時でも継
続できることを研修員、ローカルスタッフと確認しておく

（４）コーヒー・ランチの準備も忘れずに

時差があることを忘れないように、ランチブレイク等はしっかり行う

研修フォーマット
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７. オンライン研修の整理
オンライン研修は録画を行うことができる。また、チュートリアルをしっかり整備してい
るため復習が容易である。研修員の復習や資料整理のため、講義の録画や研修資料
（チュートリアルテキストおよびデータも含む）を共有ドライブ（Google drive等）で共有す

る。容量が大きくなるため資料を共有するドライブは有償版が望ましい。

Google driveを用いた研修資料の共有
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Online Trainings Concept Note 

1. Objective:  

 So far, the project conducted training in Japan from July to August last year and follow-up training 

of training in Japan from the end of October to the beginning of November. In February, The other 

training was conducted for the reforestation division on acquisition of GPS information and 

registration in the forest information tool as training tailored to the work of each section. The 

continuous training will contribute to sustainable forest management utilizing forest information 

tools even under the current travel restrictions, and the following online training will be 

conducted. 

(1). Creation and maintenance of information data with Sol-FIMS aiming to the practical use 

(2). Preparation of field survey and organization its outputs 

 

2. Expected Participants:  

          FRMTS, MOFR  

               Florence Pupuka, Florence Lenga, Arnold Augwaroa, Gideon Solo, Stanley Lesinenea,  

               Gusgrandy Mua 

          MOFR/JICA project 

               Jerry Iriahoroa,  Japhiliet Rouhanna, John Smith Daffe,  

 Hirokazu Takahashi, Nobuhiko Yoshimura 

 

3. Schedule  

 The first training: 

Date: 25th-26th in August 

Participants: Planning Division staff (MOFR) 

Venue: SIG ICT Services training lab in the new ICT building 

                             Access URL: https://meet.google.com/xnq-iwst-aac  

                                                  

Day1 Forest management tool and FMU based management 

11:00 Introduction of forest information tool. 

11:30 Forest management based on FMU. Decision making with FMU 

12:00 Lunch Break 

13:00 Understanding the current situation using the existing attributes of FMU. 

13:30 Comparing FMU with the concept of Logging code practice 

14:00 Add /update new attributes for decision making 

14:30 Summary of the training 

15:00 End 

Day2 Evaluating and zoning by the concept of forest functions - Sediment retention –  

      11:00 Introduction of forest function 

      12:00 Lunch Break 

      13:00 Wrap-up discussion 

      15:00 End 

 

 



3-Sep-20 
The Project on Capacity Development for Sustainable Forest Resource Management in Solomon Islands 

The Second Online Trainings Concept Note 

1. Objective:  

 So far, the project conducted training in Japan from July to August last year and follow-up training 

of training in Japan from the end of October to the beginning of November. In February, The other 

training was conducted for the reforestation division on acquisition of GPS information and 

registration in the forest information tool as training tailored to the work of each section. The 

continuous training will contribute to sustainable forest management utilizing forest information 

tools even under the current travel restrictions, and the following online training will be 

conducted. 

(1). Creation and maintenance of information data with Sol-FIMS aiming to the practical use 

(2). Preparation of field survey and organization its outputs 

 

 

2. Venue 

      ICT building Training lab with Zoom 

     Access URL: https://zoom.us/j/97777208831?pwd=a3NYajFPNVpiYnBLQzRLempyTmIvZz09 

 

3. Schedule 

The Second training: 

Date: 1st -2nd in October 

Expected Participants: Reforestation division staff 

  (Planning division staff as assistants for system) 

 

Day1: Utilizing Inventory survey data 

     11:00 Introduction of forest information tool. 

12:00 Lunch Break 

13:00 Utilizing Inventory survey data 

14:30 Summary of the training 

15:00 End 

 

Day2: GPS transect walk and its facilitation 

11:00 Introduction of GPS transect walk. 

12:00 Lunch Break 

13:00 GPS transect walk and its facilitation 

14:30 Summary of the training 

15:00 End  

 

 The third training:  Two days in November 

Day1 Mapping/monitoring for agroforestry or cyclical management of Forests 

Day2 Maintenance of the data on Forest information tools. 

 



23-Mar-21 
The Project on Capacity Development for Sustainable Forest Resource Management in Solomon Islands 

The Third Online Trainings Concept Note 

1. Objective:  

 So far, the project conducted training in Japan from July to August last year and follow-up training 

of training in Japan from the end of October to the beginning of November. In February, The other 

training was conducted for the reforestation division on acquisition of GPS information and 

registration in the forest information tool as training tailored to the work of each section. The 

continuous training will contribute to sustainable forest management utilizing forest information 

tools even under the current travel restrictions, and the following online training will be 

conducted. 

(1). Creation and maintenance of information data with Sol-FIMS aiming to the practical use 

(2). Preparation of field survey and organization its outputs 

This training shall be a part of preparation for the actual forest monitoring activities in Pilot site.  

 

2. Venue 

      Planning division office 

      Access URL: https://zoom.us/j/93751360817?pwd=ZTdwODI5WkNrczIrMlpOcEhNdzVzdz09 

 

3. Schedule (tentative) 

The Third training: 

Date: 30 -31, March 

Expected Participants: TSC members 

  (Assistant: Planning division staff) 

 

Day1: Mapping/monitoring for Forest management and Agroforestry 

     11:00 Introduction of simple forest monitoring. 

12:00 Lunch Break 

13:00 Inventory and monitoring 

14:30 Plan the actual forest monitoring for pilot site 

15:00 End 

 

Day2: Forest information tools for monitoring 

11:00 Introduction of Tablet tool. 

12:00 Lunch Break 

13:00 Utilization tablet tool for monitoring 

14:30 Summary of the training 

15:00 End  
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1. Objectives 

Learning how to use the FMU to understand the target sites. And how to analyze the 
geospatial data such as tree cover loss, elevation, slope, etc. with FMU to discuss the planning. 

2. Software and dataset 

2-1. Installation 
QGIS3.14.15 is used in this tutorial. QGIS3.10.x can be used. If you do not have it on your 
computer, please download the software from 
https://qgis.org/en/site/forusers/download.html. 
 
The current PCs are usually 64 bit. So, please download the standalone installer of 64 bit.  

  
After downloading, please double click on the .exe file to install. You can follow the guidance 
of the QGIS installer. 

 
 
2-2. Check your QGIS 
You have the QGIS folder on the desktop. e.g. QGIS 3.14. Please open the folder then start 
the QGIS with GRASS. e.g. QGIS Desktop 3.14.15 with GRASS 7.8.3.   

      
 
When you have opened the QGIS. Please add the Processing Toolbox. 
In the global menu in the QGIS window > Processing > Select Toolbox. 
So, you can see the Processing Toolbox at the right side of the QGIS window.  
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Adding the Processing Toolbox in the QGIS window 

 
2-3. Dataset 
Please copy the 1_Understanding folder on your PC. You had better use one folder to store 
online training material. e.g. C:/Online_training/1_Understanding 
 
The 1_Understanding folder contains the files below. 
 
Doc: Related documents including this tutorial such as Logging code practice.  
fmu.shp: fmu layer based on watersheds 
Guad_coastline_u57.shp: coastline 
Guad_coastline_inside_buffer100_u57.shp: A 100m buffer from coastline according to the 
logging code practice. 
Guad_settlement_font_point_u57.shp: The apploximately locations of village. 
Guad_Hansen_xxx:Global Forest Change 2000–2019 Data by Hansen at al. 
https://earthenginepartners.appspot.com/science-2013-global-forest/download_v1.7.html 
 Gain: Forest gain during the period 2000–2012 
 Loss: Forest loss during the period 2000–2019(1 is the loss during the period) 

Loss year: A year of Forest loss during the period 2000–2019 
(The value 1 - 19 represents to a year. Lossyear_null has null value for no change.) 
Treecover2000: Tree cover in the year 2000, defined as canopy closure for all 
vegetation taller than 5m in height. Encoded as a percentage per output grid cell, in 
the range 0–100. 

Guad_Slope, srtm(elevation), and hillshade: the topographic data. The unit is degree, meter, 
unitless respectively. 
Result: Sample QGIS project file to check the result of this tutorial. 



4 
 

 
 

3. Understanding the target site based on FMU 

3-1. Adding FMU layer and save your project. 
Add the fmu.shp from the folder.  

Click  button > navigate to 1_understanding folder > double click on fmu.shp. 

Or you can use the Browser window. 

 
Add the FMU.shp to QGIS. The color of the layer will be set randomly. 

Please save the project before starting further analysis. 

Click on  > Navigate to 1_Understanding folder > Name “understanding” > Click Save 
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After you have saved your project, the project name will be shown. 
 
3-2. Exploring the attributes of FMU 
(1) Open the attribute table 
Right-click on fmu > Open Attribute Table. You can see the attribute table. 

 
 
Please see the pdf file to 
check the detail of the attributes. You can find the pdf file in the 1_understanding/Doc folder. 

 
(2) Show the basic statistics to the a file 
Click Sigma button on the QGIS menue > the Statistics window will be shown. 

 
Select fmu and the field to show the statistics. Please use Loss_ha at first. > You can see the 
result. 
If you want to show stats of selected features. 

Check  > select features by  or from attribute table 

 
Select the feature from map(Left), Select feature from attribute table. 
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Basic statistics(according to the Hansen data, approximately 40178 ha has been lost) 

 
(3) Check the histogram(distribution) 
We can not understand the distribution of the data using basic statistics. So, a histogram is 
one of the key techniques to grasp the distribution. 
In the Processing Toolbox > type hist in the search box > Click on Vector layer histogram. 

  
 
 
 
 
 
Select Input > Input layer: fmu, Attribute: Loss_ha, number of bins: 100 > Run > you can see 
the File path at the lower right corner of the QGIS window > Then click on the file path. 
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Histgram 

(4) Practice 
Show the basic statistics and histogram of loss rate and explain the status of loss rate based on 
the FMU.  
 
3-3. Exploring the FMU map with its attributes. 
(1) Mapping to check spatial distribution 
To grasp the spatial distribution of the attributes, we can use a map. 
We are going to show the map of the Loss rate as an example. 
Double click on fmu > Symbology > Select Graduated > Select Value: Loss_rate > Select 
Mode: Natural Breasks(Janks) > Click Classify > Change the color of the map > Click OK. 
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The spatial distribution of the loss rate. Where were the hotspots of forest loss?  

 
(2) Compare to the other layers such as elevation, slope. 
Add the elevation layer and calculate slope. 

Click  button > navigate to 1_understanding folder > double click on 

Guad_srtm30u57.tif.  
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Double click on Guad_srtm30u57 > Symbology > Select Render type: Single band pseudo-
color > Select Interpolation: Discrete > Select Classes: 4 > Change the thresholds (100, 200, 
400, inf) > OK 

 
Elevation map colored by thresholds. 

Change the order of the layers. 
Click on Guad_srtm30u57(keep clicking), then move the layer under the fmu. 

        
Uncheck the fmu then compare the relationship 
between fmu(Loss rate) and Elevation.    
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(3) Tips (Optional) 
MapSwipe Tool is especially useful to compare layers. 
Plugins > Manage and Install Plugins… > Type swipe in the search box > Install Plugin  

 

 

When you have installed the plugin, you can see the  in the toolbar. Then Click on fmu 

then swipe on the map. You can compare the maps. 

 
 
(4) Practice1 
Please interpret the map based on the relationship between the loss rate and the elevation. 
Where were the hotspots of loss rate? 
How about above 400m? (Logging code practice)  
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(5) Practice2 
Add the slope layer (Guad_slope30_u57.tif) from 1_understanding folder and interpret the 
relationship between the loss rate and the slope. 
 
Slope color should be based on the threshold (number of class: 4, threshold: 10,20,30, inf) 

 
 
Slope more than 30 degrees is restricted by the logging code practice. 
The elevation and slope are included in the attribute table of the FMU (Slope_mean, 
Ele_mean). 
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(6) Practice3 
Add the settlement point (Settlement_font_point_u57.shp) from 1_understanding folder. 
The buffer from the Village is also restricted (Depends on the village. If they do not have any 
decision, the size will be 200m according to the logging code practice. 

 
Comparing the loss rate with the location of settlement. The points is based on the map 
produced by Ministry of Land. 
 
(7) Practice4 
Add the buffer from coastline (Guad_costline_inside_buffer100_u57.shp) from 
1_understanding folder. The 100m buffer from the ocean (High tide) is also restricted 
according to the logging code practice. The data may not represent the high tide line. Just 
for a reference. 

 
 
Color settings. 
Double click on Guad_costline_inside_buffer100_u57 > Click simple fill under Fill > Click on 
the drop-down arrow > select transparent fill > OK  
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3-4. Analyzing a spatial trend of forest loss 
More than the existing attributes of FMU, you can add other attributes summarizing raster 
layers such as forest loss year. In this section, we are going to add the loss-year of forest to 
analyze a spatial trend of forest loss. 
 
(1) Preparing the necessary layers 
Add forest loss year layer (Guad_Hansen_lossyear_null.tif). 

Click  button > navigate to 1_understanding folder > double click on 

Guad_Hansen_lossyear_null.tif. 

  
 
Change the color setting 
Double click on Guad_Hansen_lossyear_null > Symbology > Select Render: Single band 
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pseudo color > Click classify > Select Mode: Quantile > Click OK. 
 

 
 
Add hillshade (Guad_hillshade30u57.tif). 

Click  button > navigate to 1_understanding folder > double click on 

Guad_hillshade30u57.tif 
 
Change the layer order. 
Click on Guad_hillshade30u57 (keep clicking), then move the layer under the fmu(at least 
under Guad_Hansen_lossyear_null). 
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You can find the spatial trend of forest loss based on the years. 
 

       
 

 
Forest loss by year (Blue color shows the latest deforestation) 

 
(2) Summarize the loss year by FMU 
Type zone in the search box > Open Zonal statistics 
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Select Input > Raster layer: Guad_Hansen_lossyear_null, Vector layer constaining zone: fmu 
> Click Selection button at the right of Statistics to calculate 

 
Select the type of calculation > Check Count, Range, Minority, Majority, Variety, Variance. 
Then Click RUN 
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Check the result 
Right click on the fmu > Open attribute table > Scroll to the right in the attribute table > You 
can see _majority, etc. Be careful! _count does not calculate properly due to the bug of QGIS. 
This error happens when we used the raster including no data in the zone layer.   

 
 
(3) Visualize the loss year 
We are going to map the majority. However, the majority does not reflect the size of loss. To 
remove small size of loss, The threshold 30 pixel(almost 2 ha) will be used. Smaller size of loss 
less than 30 pixel will be ignored. 

Double click on fmu > Symbology > Select Graduated > click  next Value  

> type “if( "_count" > 30,"_majority", null)” into expression > Click OK > 

 
 
 
Click Classify > Select Mode: Pretty Breaks > Change the color of the map (red to blue) > 
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Click OK. 
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Loss year. You can see the large forest loss around 400m altitude line 

(above loss year, below elevation). 
 
 
(4) Practice 
Please visualize the variety. The example color setting is below. 

Double click on fmu > Symbology > Select Graduated >  > type if( "_count" > 

30,"_variety", null) > Select Mode: Natural breaks (Jenks) > Change the color of the map(red 
to blue) > Click OK. 
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Please interpret the map comparing with other layers.  
Hint variety represents the frequency of loss year. 
 

 
The map of variety 

 
(5) Draw a box plot. 
Check the relation between loss year and mean_elev drawing a box plot. 
Install the Data Plotly plugin. 
Plugins > Manage and Install Plugins… > Type plot in the search box > Install Plugin  

 

 

You can see the icon  in the tool bar. 

 
 



21 
 

 
Filter the rows to remove the small size of loss. 

Click the  to select the polygons that are shown in the map > then click the upper left 

corner (keep clicking) > move the mouse to lower right corner > release the button. 

 
 

Click  > You can see the window of Data Plotly > if the window is too small. Please 

click and move then expand. 
Setting > Plot type : Box Plot > Layer: fmu, Ground field: _majority, Y field: Ele_mean > 
Click Create Plot 
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The boxplot(The loss year vs mean elevation).  
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The median value became higher from the year 2011. 
  

When you have closed the graph window, click  then deselect the polygon. 

 

4. Discussion and conclusion 

We have tried to understand the target site based on the fmu. The raster data shows the detail 
of the target site based on the pixels. Since the pixel size was small and the square boundaries 
do not have any relation to the real situation, it is difficult to reflect results based on the pixels 
directory to the forest management practice. Using fmu, we can summarize the detail. The 
fmu is based on the topography. It is the watershed. So, it is relatively easy to reflect forest 
management practice. 
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1. Objectives 

To learn the concept of forest function and evaluating the potential of the land. 

2. Software and dataset 

2-1. Installation 
QGIS3.14.15 is used in this tutorial. QGIS3.10.x can be used. If you do not have it on your 
computer, please download the software from 
https://qgis.org/en/site/forusers/download.html. 
 
The current PCs are usually 64 bit. So, please download the standalone installer of 64 bit.  

  
After downloading, please double click on the .exe file to install. You can follow the guidance 
of the QGIS installer. 

 
 
2-2. Check your QGIS 
You have the QGIS folder on the desktop. e.g. QGIS 3.14. Please open the folder then start 
the QGIS with GRASS. e.g. QGIS Desktop 3.14.15 with GRASS 7.8.3.   

      
 
When you have opened the QGIS. Please add the Processing Toolbox. 
In the global menu in the QGIS window > Processing > Select Toolbox. 
So, you can see the Processing Toolbox at the right side of the QGIS window.  
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Adding the Processing Toolbox in the QGIS window 

 
2-3. Dataset 
Please copy the 2_Forest_Function folder on your PC. You had better use one folder to store 
online training material. e.g. C:/Online_training/2_Forest_Function 
 
The 2_Forest_Function folder contains the files below. 
Doc: Related documents including this tutorial such as the review paper of USLE.  
fmu.shp: fmu layer based on watersheds 
K: the folder to calculate K factor(working folder. So far the sample result is included). 
R: monthly precipitation layers and an annual precipitation layer, R factor layer are included. 
Monthly precipitation layers can be downloaded from worldclim.org. the precipitation data 
is averaging value of the 1970-2000. The spatial resolution is 30 seconds (~1 km2). 
https://www.worldclim.org/data/worldclim21.html 
Gual_CLYPPT, SNDPPT, SLTPPT, ORCDRC .tif: They are the fraction of the Clay, SAND, 
SLIT, Organic Carbon, respectively. The unit is %. These are downloaded from the below 
site. https://www.isric.org/index.php/explore/soilgrids  
In this tutorial, 0-5 cm depth data are used. ORCDRC is converted to %(Divided by 10) after 
download. The spatial resolution is 250m. 
Guad_LS_factor.tif: the example result of this tutorial. You can calculate it from 
Guad_srtm30u57.tif. 
Guad_srtm30u57.tif(elevation): the topographic data. 
Guad_USLE.tif: This is the final result of this tutorial. 
USLE.qgz: Sample QGIS project file to check the result of this tutorial. 
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3. The concept of Forest Functions 

Forest provides a variety of ecosystem services such as timber production, sediment retention, 
carbon stock, etc.. ITTO shows the four SFM objective and their criteria(7) and 
indicators(58)(https://www.itto.int/direct/topics/topics_pdf_download/topics_id=4872&n
o=1&disp=inline). The objective3(3. Maintaining the multiple functions of forests to deliver 
products and environmental services) is to maintain the forest functions(See Table1). 
Focusing on the criteria, criterion 4(Forest production), 5(Forest biodiversity), 6(Soil and 
water protection) are shown. On the other hand, The code of logging practice in Solomon 
islands also shows the regulations and rules of logging that relate to ITTO Criteria of 
SFM(Table 2). The forest functions should be balanced with each other. The forest functions 
can be the understandable target of FMU toward SFM. According to the forest function of 
each FMU, we can think about how we manage the forest in FMUs. 
 
Table 2. The linkage between ITTO criteria and the code of logging practice in Solomon 
islands 

ITTO criteria Restriction based on 
Code of logging practice in Solomon Islands 

Criterion4 
Forest production 

 Rules for harvesting operations 

Criterion5 
Forest biodiversity 

 Mountains and high altitude areas(higher than 400m) 
 Area of ecological or scientific importance such as 

wetlands, Mangroves. 
 Protected areas and forest reserves 

Criterion6 
Soil and water protection 

 Landslip areas 
 Rivers and streams with buffer area 
 Gullies 
 Steep slope(steeper than 30 degrees) 

 
In the Japanese forest management, the forest function which is the target is recorded in the 
attribute of FMU. The category is mainly five types; Prevent disaster(Landslide, windthrown, 
etc.), Water protection, Nature conservation, Utilizing forest such as recreation, Moderating 
the heat, noise, etc. 
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Fig1. The map of FMU of Japan(above) and the attribute(below).  

The color of the map is based on the forest function. 
Source: https://nlftp.mlit.go.jp/ksj/index.html 
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Table1 The ITTO C&I as they relate to the management of tropical forests 

 
Source:https://www.itto.int/direct/topics/topics_pdf_download/topics_id=4872&no=1&dis
p=inline 
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4. Evaluating the potential soil loss to discuss the forest function 

In this tutorial, the potential soil loss will be evaluated. For example, using the evaluation, we 
can think the target of forest management in the high possible area “Soil protection”. First, 
we assume that the land without any vegetation or the same vegetation(Fig.2). Next, we 
estimate the potential soil loss using the topographic or weather factors. 

 
Fig.2 The land without any vegetation to estimate a potential soil loss. Topographic, weather 
factors are considered(Left). Example of the high potential area of soil loss(in the red 
boundaries)(Right). 
 
The method we use is the Universal Soil Loss Equation(USLE) which is common in the 
world(http://www.fao.org/land-water/land/land-governance/land-resources-planning-
toolbox/category/details/en/c/1236441/).  
 
USLE equation: Annual Soil Loss(ton/(ha⋅yr)) 
 

uslei=Ri⋅Ki⋅LSi⋅Ci⋅Pi 
 
Where 
Ri  is rainfall erosivity (units: MJ⋅mm/(ha⋅hr⋅yr))   
Ki  is soil erodibility  (units: ton⋅ha⋅hr/(MJ⋅mm⋅ha)) 
LSi is a slope length-gradient factor (unitless) 
C is a crop-management factor (unitless) This time, we use the constant value(0.99 urban or 
0.25 forest). 
Pi is a support practice factor  (unitless) This time, we use the constant value(1) 
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5. Calculate the USLE 

5-1. Calculate Slope Length-gradient factor(LS factor) 
(1) Add elevation from the 2̲Forest̲Function folder.  

Click  button > navigate to 2_Forest_Function folder > double click on 

Guad_srtm30u57.tif Or you can use the Browser window. 

Click on  > Navigate to 2_Forest_Function folder > Name “USLE” > Click Save 

       
After you have saved your project, the project name will be shown. 
(2) Calculate LS factor 
In the Processing Toolbox > type water in the search box > Click on r.watershed. 

 
Set the parameters below > RUN 
Elevation: Guad_srtm30u57 
Minimum size of exterior 
watershed basin(optional): 55 
(55 means 5 ha in this case) 
Check: Enable Single Flow 
Direction(D8) 
Leave the default settings for 
other parameters. 
 
You will see the result including 
LS factor. However they are 
tentative data in RAM of your 
PC. 
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The results of r.watershed function. You can see Slope length and steepness(LS) factor. 

 
To save the LS factor, please export it to 2_Forest_Function folder. 
Right click on Slope length and steepness(LS) factor for USLE > Export > Save As… > 
Name: Guad_LS_factor.tif 

 
 
Then remove unnesessary layers. 
Remove all layers except Guad_LS_factor and Guad_srtm30u57 
Push Ctrl key and click on the layers to remove. Then right click 
> Remove Layer…  
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(3) Check the LS factor 
Double click on Guad_LS_factor > Symbology > Set parameters like below (Render type: 
Single band pseudo color, Mode: Quantile > Click Classify > OK 

 
Color settings 

 
LS factor. High to Low: Blue to Red.  
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5-2. Calculate R factor 
(1) Add precipitation layers 

Click  button > navigate to 2_Forest_Function/R folder > double click the monthly 

precipitation layers: Guad_wc2.1_30s_prec_01.tif 〜 Guad_wc2.1_30s_prec_12.tif. 

 
List of precipitation layers 

 
Precipitation layers 
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(2) Calculate an annual precipitation 
Raster > Raster Calculator 

 
Set parameters below 
Raster Calculator Expression: 
"Guad_wc2.1_30s_prec_01@1" + "Guad_wc2.1_30s_prec_02@1" + 
"Guad_wc2.1_30s_prec_03@1" + "Guad_wc2.1_30s_prec_04@1" + 
"Guad_wc2.1_30s_prec_05@1" + "Guad_wc2.1_30s_prec_06@1" + 
"Guad_wc2.1_30s_prec_07@1" + "Guad_wc2.1_30s_prec_08@1" + 
"Guad_wc2.1_30s_prec_09@1" + "Guad_wc2.1_30s_prec_10@1" + 
"Guad_wc2.1_30s_prec_11@1" + "Guad_wc2.1_30s_prec_12@1" 
Output layer: Save into K folder under 2_Forest_Function, Name Guad_prep_year > OK 

 
The raster calculator settings 
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The annual precipitation 

 
(3) Calculate R factor 
In the Processing Toolbox > type usle in the search box > Click on r.usler. 

 
Set the parameters below 
> RUN 
Name of annual 
precipitation raster map 
[mm/year]: Guad_prep_year 
Name of USLE R equation: morgan 
USLE R raster: Save into K folder under 2_Forest_Function/R, Name R > RUN 

Remove unnecessary layers. Please leave Guad_LS_factor.tif, R, K, Guad_srtm30u57. 

Morgan model(Tested in eninsular Malaysia):  
R=(9.28×P−8838)(75/1000) 
P: mean annual precipitation (mm) 
Units: MJ⋅mm/(ha⋅hr⋅yr) 
Source A_review_of_the_Revised_Universal_Soil_Loss_Equati(R.Benavidez, et. al(2018)) 
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R factor map based on Morgan model. 

5-3. Calculate K factor 
(1) Add Soil layers(% of Silt, Clay, Sand, Soil Organic Content)  

Click  button > navigate to 2_Forest_Function folder > double click the layers below. 

Guad_CLYPPT_M_sl2_250m.tif, Guad_ORCDRC_M_sl2_250m.tif, 
Guad_SLTPPT_M_sl2_250m.tif, Guad_SNDPPT_M_sl2_250m.tif 
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The soil layers 

 
(2) The formula of K factor 
K factor can be calculated by the below formula. Usually, the 100 is used instead of 759. 759 
is to calculate the value in SI unit. 

  
(Renard et al., 1997) 

Where K = soil erodibility factor (t⋅ha⋅hr⋅(MJ⋅mm⋅ha)−1; 

M = (silt (%) + very fine sand (%))*(100-clay (%)) 

a = organic matter (%)  

b = structure code(choose the value): 1 very structured or particulate, 2 fairly structured, 3 

slightly structured and 4 solid 

c = profile permeability code(choose the value): 1 rapid, 2 moderate to rapid, 3 moderate, 4 

moderate to slow, 5 slow and 6 very slow. 

Source: https://storage.googleapis.com/releases.naturalcapitalproject.org/invest-
userguide/latest/sdr.html 
https://www.ars.usda.gov/ARSUserFiles/64080530/RUSLE/AH_703.pdf 
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(1) Calculate M in the formula of K factor 
M value can be calculated by the formula: M = (silt (%) + very fine sand (%))(100-clay (%)) 
Raster > Raster Calculator 

 
Set parameters below 
Raster Calculator Expression: 
( "Guad_SLTPPT_M_sl2_250m@1" + "Guad_SNDPPT_M_sl2_250m@1" ) * ( 100 - 
"Guad_CLYPPT_M_sl2_250m@1" ) 
Output layer: Save into K folder under 2_Forest_Function, Name m > OK 

 
The raster calculator settings 
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The result of M = (silt (%) + very fine sand (%))(100-clay (%)) 

 
(2) Calculate K 
Raster > Raster Calculator 

 
Set parameters below 
Raster Calculator Expression: 
(2.1 * ( 10 ^ -4 ) * ( 12 - "Guad_ORCDRC_M_sl2_250m@1" ) * ("m@1" ^ 1.14) + 3.25 * (2-
2) + 2.5 * (3-3)) / 759 
b = structure code: 2 fairly structured, c = profile permeability code: 3 moderate are used 
Output layer: Save into K folder under 2_Forest_Function, Name K > OK 
 
b = structure code: 1 very structured or particulate, 2 fairly structured, 3 slightly structured and 4 

solid c = profile permeability code: 1 rapid, 2 moderate to rapid, 3 moderate, 4 moderate to slow, 

5 slow and 6 very slow.
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The raster calculator settings 

 
The result of M 

 
 
5-4. Calculate USLE 
(1) Check the input layers 
Please make sure the necessary layers. R, K, Guad_LS_factor are necessary. 
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Layers to calculate USLE 

 
(2) Calculate USLE 
Raster > Raster Calculator 

 
Set parameters below 
Raster Calculator Expression: 
"R@1" * "K@1" * "Guad_LS_factor@1" * 0.25*1 * ("R@1" * "K@1" * "Guad_LS_factor@1" * 
0.25*1 >=0) 
(The constant value are used for C and P: 0.25 and 1 respectively) 
Output layer: Save into K folder under 2_Forest_Function, Name Guad_USLE > OK 
 

 
Remove unnecessary layers. Please leave Guad_USLE.tif, R.tif, K.tif, Guad_srtm30u57. 
 

* ("R@1" * "K@1" * "Guad_LS_factor@1" * 0.25*1 >=0) in the formula is to remove 
the negative value. The negative value will be changed to 0. If the M value is more than 
12, The USLE will be negative. The USLE is annual soil loss. Only positive value makes 
sense. 
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The raster calculator settings 

 
The result of USLE. The color settings are below. 
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Settings(Use the Invert Color Ramp) 
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6. Interpretation of the USLE with FUM 

(1) Change elevation to Hillshade 
Double click on Guad_srtm30u57 > Synbology > Change the Render type to Hillshade > OK 

 

 
Then you can see the Hillshade, which you can use to check the topography 

 
(2) Change the transparency of USLE 
Double click on Guad_USLE > Transparency > Change the Global Opacity: 60 % > OK 
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You can see the USLE with the topography. 

 
(3) Summarize the USLE by FMU  

Click  button > navigate to 1_Understanding folder > double click on fmu.shp. 
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Type zone in the search box > Open Zonal statistics 

 
Select Input > Raster layer: Guad_USLE, Vector layer constaining zones: fmu > Output 
column prefix: u_ > Click Selection button at the right of Statistics to calculate 

 
Select the type of calculation > Check Count, Sum, Mean, Min, Max. 
Then Click RUN 
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Visualizing by Mean value of USLE 
Change the settings referring the below fig. Parameter: Graduated, Value: u_mean, Mode: 
Natural Breaks(Jenks) with the number of class 5, Color ramp: from 

. > OK 

 
The color setting 

 
 

The FMU based USLE(Mean value) 
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(4) Comparing Mean USLE with Loss rate in FMU attribute. 
Add one more fum.shp. Change the settings. E.g. Graduated, Value: loss_rate, Mode: Natural 
Breaks(Jenks) with the number of class 5, Color ramp: Red > OK 

 
Loss rate 

 
Mean USLE 

7. Discussion and conclusion 

USLE is the annual soil loss from the land. The place where the USLE value is high, you 
should care about forest management. In other words, the forest function to prevent the soil 
loss expected in the USLE high-value area. If the operation is conducted, the operator try to 
minimize soil loss more than the USLE low-value area.  
Of course, the USLE can not estimate the soil loss perfectly. However, this spatial explicit 
evaluation can be used for forest management planning for a wide area. 
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1. Objectives 

In this tutorial, we are going to learn the concrete process of timber volume estimation using 
inventory survey data. 

2. Software and dataset 

2-1. Installation 
QGIS3.14.15 is used in this tutorial. QGIS3.10.x can be used. If you do not have it on your 
computer, please download the software from 
https://qgis.org/en/site/forusers/download.html. 
 
The current PCs are usually 64 bit. So, please download the standalone installer of 64 bit.  

  
After downloading, please double click on the .exe file to install. You can follow the guidance 
of the QGIS installer. 

 
 
2-2. Check your QGIS 
You have the QGIS folder on the desktop. e.g. QGIS 3.14. Please open the folder then start 
the QGIS with GRASS. e.g. QGIS Desktop 3.14.15 with GRASS 7.8.3.   

      
 
When you have opened the QGIS. Please add the Processing Toolbox. 
In the global menu in the QGIS window > Processing > Select Toolbox. 
So, you can see the Processing Toolbox on the right side of the QGIS window.  
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Adding the Processing Toolbox in the QGIS window 

 
2-3. Dataset 
Please copy the 3_inventory_survey folder on your PC. You had better use one folder to store 
online training material. e.g. C:/Online_training/3_inventory_survey.  
 

 

Forest_type: includes komu_forest_type map 
Sample_result: the sample result of this tutorial 
3_inventory_survey.pptx: presentation file 
Boundary.shp: the boundary file 
Inventory_survey.csv: sample 
Inventory_survey.qgz: sample QGIS project 
file. 
Inventory_survey.xlsx: the result of inventory 
survey. 
Komu_drone_1m.tif: the aerial photo taken by a 
drone. 
Komu_samplePlots.shp: inventory plot location 
Tutorial3_inventory_survey.docx: This file. 
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3. Concept and procedure of timber volume estimation using inventory survey 

Estimating timber volume is essential for sustainable forest management. There are many 
methods for that. For example, measuring all trees(DBH, Tree height, etc.) in a forest is the 
most accurate but the most costly method. The Forest area is always wide. Budget and human 
resources are always limited. We always need to consider the balance between cost and 
accuracy. 
The statistical method has been developed to solve the problem. We can estimate the true 
value of our target by analyzing the samples. An inventory survey based on the sampling plots 
can be the data to estimate the volume of the entire area. One of the common methods uses 
the forest type map with sample plot survey data. 
 
Procedure 
1. Making a forest type map from an aerial photo or satellite image 
2. Calculating area(ha) by forest type.  
3. Calculating the representative timber volume(m3/ha) such as average, median, etc. by 

forest type from field survey. 
4. Multiplying the timber volume(m3/ha) by area(ha) for each forest type 

      
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Target site                 1. Making forest type map      2. Sample plot survey 
 
 

? 
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Forest type Volume(m3/ha) Area(ha) Estimated 

volume(m3) 
Secondary forest    

Swamp forest    
Lowland forest    

Total    
 
Figure 1. Concept of the statistical method to estimate the timber volume. It is very hard to 
measure all trees in the area. So, the timber volume of sample plots is used to estimate those 
of the entire area.  
 

4. Explore the inventory survey plot layer 

(1) Add necessary layers to QGIS 
Please open the layers below. 
・ komu_drone_1m.tif : aerial photo taken by drone 
・ Boundary.shp : Komuniboli project area boundary 
・ komu_samplePlots.shp : Invent komu_samplePlots.shpry plot location 

Click  button > navigate to 3_inventry_survey folder > double click on the above layer 

one by one. 
 
(2) Change the layer order 
Drag one layer and move to up/down to change the layer order. Then modify the order like 
below. If the boundary(polygon) or komu_drone_1m(image) are above than 
komu_samplePlots(point), komu_samplePlots will be hidden. 

  
(3) Change the color of the boundary 
Double click on Boundary.shp > Symbology > Click Simple fill > Click down-arrow at the 
right most of Fill color > Select Transparent fill > Click down-arrow at the right most of 
Stroke color then select red color > Change stroke width to 1 > Click OK 

Drag one layer and move 
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Figure. To remove the fill color of a polygon layer 
 

 
Figure. The color setting of Boundary after changing the border color and width. 
 
(4) Check the attribute table of Komu̲samplePlots 
Please check the attributes of the layer: how to identify the plot (Plot ID), how many/what 
kinds of forest types in the inventory plots.    
Right-click on Komu_samplePlots > Open Attribute Table; When you click on the field name 
such as SP_ID, the field will be re-ordered. 
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Figure. Table of komu_samplePlots.shp 
 
Q1 How many plots? 
Q2 How many forest types? What kinds of forest types?  
 
(5) Change the color of Komu̲samplePlots 
Double click on Komu_samplePlots.shp > Symbology > Change single symbol to Categorized 
> Select Forest typ for Value> Click Classify > Click OK 

 
Figure. Color settings of Komu_samplePlots.shp 
 
(6) Check the result of the inventory survey. 
Please check the Result sheet which will be used for estimating timber volume. 
Open the Inventory_survey.xlsx in the 3_inventry_survey folder > Click the Result sheet.  
Check Tree Data sheet, STAT sheet too. Tree data is the raw inventory result. STAT is the 
summary of Tree Dat by Plots. The Result sheet is a copy of STAT, which is modified for 
QGIS. 
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Q1 Which field is the same as Komu_samplePlots.shp? 
 
Export the Result sheet as CSV format to import into QGIS. 
Click Result sheet > File > Save as… > change the file type to CSV(Comma 
delimited)(*.csv) > Save (Use the same name as the excel file: Inventory_survey) > Close 
excel. 

 
 

 
Figure. The result of the above. 
 
Save your project which means the working condition. 
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Click on  > Navigate to 3_inventry_survey folder > Name “inventyr_survey” > Click Save 

       
After you have saved your project, the project name will be shown. 
 

5. Drawing forest type on drone image.  

Please draw the forest type map. The category of forest type follows those of the inventory 
survey. There are 3 categories: (1) Lowland Forest, (2) Secondary Forest, (3) Swamp Forest. 
However, the settlement or road area can be seen in the drone image. So, please add one more 
category; (4) Settlement. When you draw the boundary, please check the inventory survey 
plot point colored by Forest type. 

  

Example of the border of forest 
type: Swamp Forest. 
 
Q1 Is the forest condition the 
same in Swamp Forest? 
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6. Estimating the timber volume of each forest type. 

6-1. Add the prepared forest type map; komu̲forest̲type.shp 
(1) Add komu̲forest̲type.shp 

Click  button > navigate to 3_inventry_survey folder > double click on the 

komu_forest_type.shp. 
 
(2) Change the layer order 
Drag one layer and move to up/down to change the layer order. Then modify the order like 
below. 

 
 
(3) Change the color of komu̲forest̲type.shp. 
Double click on komu_forest_type.shp > Symbology > Change single symbol to Categorized 
> Select LUtype for Value> Click Classify > Click OK * the color is randomly selected. 

 
Figure. The color settings of komu_forest_type.shp 



11 
 

6-2. Preparing the table 
(1) A table need to be prepared 
Volume/ha(and Merchandised) and Area(ha) are necessary. 

 
 
(2) Updating the forest type from komu̲forest̲type.shp 
Join the fores_type of komu_forest_type.shp to the attribute table of Komu_samplePlots.shp. 

  
Figure. The concept to join the attributes by the location. All points will be updated. 
 
Vector > Data Management Tools > Join Attributes by Location  

Forest type Avg_Tvol_ha Avg_Mvol_ha Area(ha)
Lowland Forest 299.3 97.7 223.7
Secondary forest 168.5 15.8 8.4
Settlement road
Swamp forest1 797.0 15.4 27.7
Swamp forest2 38.4
Swamp forest3 222.3 90.1 41.5
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Change the settings > Base Layer: komu_samplePlots > Join Layer: komu_forest_type > 

Check intersects > Click  at the right most of Fields to add(***) > Select LUtype > OK 

> RUN > You will see  the icon  shows 

temporal layer in the memory. 
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Figure. The settings of Join Attributes by Location function. 
 
Check the attribute table of komu_samplePlots to check the new attributes. 
Right-click on Joined Layer > Open Attribute Table 

 
Figure. The example of the attribute table of komu_samplePlots. LUtype field is added.  



14 
 

(3) Join inventory result in Joined layer 
Add inventry_survey.csv(which was exported 4.(6)). 

Click  button > navigate to 3_inventry_survey folder > double click on the 

inventry_survey.csv. This is not the map but the table. You can see the name with the table 

icon.  

Doble click Joined layer > Go to Join tab > Click + button > Select Inventory_survey for Join 
layer > Select SP_NO for Join field > select SP_ID for Target field > OK > Again OK. 

 

  



15 
 

Check the attribute table of Joined layer to check the new attributes. 
Right-click on Joined layer > Open Attribute Table > You can see the inventory result. 

 
 
(4) Copy the table to excel 

Click  to select all rows > Click  to copy selected rows > Click  to reset selection. 

> Open new excel > Click  under Paste > click to paste all rows from QGIS. 

You can see the pasted rows like below. 

   
 
(5) Calculate average m3/ha using pivot table function. 

Click  to select all cells >Go to insert menu > Pivot Table > OK > 

Then setting like below > When you calculate 
average, click the down-arrow > Value Field 
Settings > Select Average > OK 

 >>>>>>>>>> 

Back to QGIS, close the table window. 
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Figure. The settings of pivot table function. 

 
Figure. The result of the pivot table. You can see the average timber vol/ha of each forest 
type. 
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(6) Copy the area(ha) of komu̲forest̲type.shp and paste to excel. 
Right-click on komu_forest_type.shp > Open Attribute Table > Click  to select all rows 

> Click  to copy selected rows > Click  to reset selection. > Open the excel which we 

used (5) and create new sheet. Click  > Click  under Paste > click to paste all rows 

from QGIS. 
 
(7) Calculate the total area of each forest type. 

Click  to select all cells >Go to insert menu > Pivot Table > OK > 

Then setting like below. 

 >  
Figure. The pivot table setting and the result. 
 
(8) Merging the result of (5) and (7) 
Copy the result of (5) then paste to new sheet(please create) > Paste as value. 

 

Click  under Paste > click  to paste 
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 >  

Copy the result of (7) then paste to the sheet above > Paste as a value in D. Please make sure 
the Forest type. Both Forest types in A and D must be the same. 

 
 
(9) Calculating the total timber volume of this community. 
In F1, please type Total volume(m3), then In F2, type =B2*E2 > Enter > Double-click lower 
right conner of F2 to copy the formula to the end > modify the field name. 
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Figure. The almost-final result. Total volume(m3). 
 
Wait!! 
Settlement road does not have value but because of SP20 which overlapped both Lowland 
Forest and Settlement road categories. The value is mixed and not confident. So, please 
remove the value of the Settlement road. Don’t forget to calculate the grand total! 
And please calculate the total merchandised volume too. 
 

 
Figure. The final result. Total volume(m3). 
 

7. Discussion and conclusion 

Measuring the timber volume of all trees is impossible considering the cost and human 
resources. The statistical method can help you to reduce the cost of monitoring work by using 
the sample plots. Of course, a sampling survey is very hard work but maybe affordable. The 
accuracy of the estimation relies on the forest type map and number (also distribution) of the 
sampling points.  

Forest type Avg_Tvol_ha Avg_Mvol_ha Area(ha) Total volume(m3)
Lowland Forest 299.3 97.7 223.7 66950.2
Secondary forest 168.5 15.8 8.4 1418.6
Settlement road 148.2 25.5 8.6 1277.9
Swamp forest1 797.0 15.4 27.7 22058.8
Swamp forest2 38.4 0.0
Swamp forest3 222.3 90.1 41.5 9217.2

Total 100922.7

Forest type Avg_Tvol_ha Avg_Mvol_ha Area(ha) Total volume(m3) Total Mvol(m3)
Lowland Forest 299.3 97.7 223.7 66950.2 21846.7
Secondary forest 168.5 15.8 8.4 1418.6 132.7
Settlement road
Swamp forest1 797.0 15.4 27.7 22058.8 425.1
Swamp forest2 38.4
Swamp forest3 222.3 90.1 41.5 9217.2 3735.0

Total 99644.7 26139.5
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1. Objectives 

In this tutorial, we learn how to utilize the GIS data to create inventory 

2. Software and dataset 

2-1. Installation 
QGIS3.14.15 is used in this tutorial. QGIS3.10.x can be used. If you do not have it on your 
computer, please download the software from 
https://qgis.org/en/site/forusers/download.html. 
 
The current PCs are usually 64 bit. So, please download the standalone installer of 64 bit.  

  
After downloading, please double click on the .exe file to install. You can follow the guidance 
of the QGIS installer. 

 
 
2-2. Check your QGIS 
You have the QGIS folder on the desktop. e.g. QGIS 3.14. Please open the folder then start 
the QGIS with GRASS. e.g. QGIS Desktop 3.14.15 with GRASS 7.8.3.   

      
 
When you have opened the QGIS. Please add the Processing Toolbox. 
In the global menu in the QGIS window > Processing > Select Toolbox. 
So, you can see the Processing Toolbox on the right side of the QGIS window.  
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Adding the Processing Toolbox in the QGIS window 

 
2-3. Dataset 
Please copy the 3_inventory_survey folder on your PC. You had better use one folder to store 
online training material. e.g. C:/Online_training/3_inventory_survey.  
 

 

1. Series of Shape files of pilot sites 
2. Forest Manegement Unit (FMU) 
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3. Concept and procedure 

It is aiming to adding up or analizing the area information of GIS data (shape file), to make 
up the inventory. The inventory of each pilot site or activity site is necessary information for 
its monitoring. To compare and analize its change contribute next better planning of the 
activities and management. We always need to compare before and after when monitoring. 
This is simple approach to monitor the pilot site or other activitiy in MOFR with GIS data 
and forest information tools such as GPS, Tablet and UAV. 
 

3. Explore the land use maps 

1. Open the current land use map  
Just drag and drop SHP file to QGIS 
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After you open the map, right click to see the property 
 

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
And Select the QML file to Load the style, and click the “Load Style” 
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You can see the loaded style in property window. 
Please click “OK” 

 
 

 
2. Open the future land use map 
3. Open the future land use map 2nd (this include logging and AF plan) 



7 
 

   
Current Land Use Future Land Use Future Land use 2nd 

 
4. Compare the difference of these three maps 
 
 

4. Open the attribute table 

(1) Open the attribute table as it is described below 
Right Click and click ‘Open Attribute Table’. 
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(2) Confirm which information the table has 

 
(3) Open the attribute table with Excel 
We can open the same attribute table using excel, Let’s see ‘dbf’ file 
 

 

Drag one layer and move 
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(4) Open Excel without any files 

 
 
Drag and drop the dbf file ‘komu_current_landuse_2019’ 
Then, you will see attribute table on Excel 
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You see the exact same table with attribute 
 
 

 
 
 
 
 
 
 
 



11 
 

4. Add up with Pivot table. 

(1) Put on mouse on the data table 
(2)Click “Pivot table” 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
(3) After you confirm the data extent and place to make table, 
Click “OK” 
 
 
 
 
 
 
 
 
 
(4) See Pivot Table Fields 
(5) Set the column and “Rows” and “Values” 



12 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Change to “Sum” 

In order 
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(6) Then you see the table like image 
 
 
 
 
 
 
 
 
 
 
 
 
 
(7) After you make table, put the data to inventory sheet.  

 
 
 
 
 
 
(8) Continue with “komuniboli_future_landuse_1st_2019” 
(9) Continue with “komuniboli_future_landuse_2nd_2020” 
 
(10)Discuss its change of area components 
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1. Installation 
 

Before using ODK build, we need to download the software. We are going to use the standalone 

version, in which no installation is needed, you just download the data, unzip it and launch it. 

To start, go to this website: https://github.com/getodk/build/releases/tag/0.3.5 and download the 

file according to your computer operating system.  

Since I am using a Windows computer, I am downloading the odkbuild.win.x64.zip, which probably 

you have the same system. 

 

After download it, you need to unzip it. Right-click on the file and click on “Extract All…” 



 

 

After extracting, you can launch the ODK build application by clicking on the odkbuild.exe icon 

 

Good! Now you can use the ODK Build!  



2. The layout 
 

The layout of the application is very simple, let’s take a look at it 

 

 

 

The main tools we are going to use in this mini-tutorial are displayed on the upper figure. 

  

To create a new form: File > New Form 

Properties of your form 

Tools to create the form 



On “File” you can create your new forms, “properties” you can edit your survey name and which 

spreadsheet you want to use, and the tools on the bottom bar allow you to create your custom 

survey. 

 

For more information in how to proper setup the form, please look at the ODK server tutorial 

So, let’s start creating a new form. Click on File > New Form 

  

Step 1 – you can create a title for 

your form 

Step 2 – here you paste the link of 

the spreadsheet from Google Drive 



3. Creating a form 
 

Now you have your new form! You can add an element by dragging the elements from the bottom 

of the screen into the canvas 

 

 

The elements are divided into data types: 

- Text: you can input text data (e.g. Surveyor name, field name, etc.) 

- Numeric: you can input numeric data (e.g. DBH, height, etc.) 

- Date/Time: you can input the date and time (e.g. March 31st, 2021, 1:00 PM) 

- Time: you can input time data (e.g. 1:20 PM) 

- Location: you can input your GPS location data (e.g. lat, long) 

- Media: you can input media (e.g. Image, selfie, audio, video, draw, signature) 

- Barcode: you can input barcode information (e.g. barcode of products) 

- Choose one: you can give many options and the surveyor need to choose only one 

option 

- Select Multiple: is very similar to “Choose one” but instead of choosing only one, you 

can choose multiple options 

- Metadata: you can input the metadata of your device (e.g. serial number, user, phone 

number, etc.) 

- Group: you can create a group to create a loop (e.g. Many trees in a sample plot, and 

you need to insert all trees. You can create a group to ask what kind of tree is each until 

you finish input all of them) 

All these elements can be placed in any order you want. You can change the order by dragging.  To 

remove an element, you just need to click on the X icon. 



 

Good! Now you can create a form, so let’s take a look into the properties of some elements! 

 

 

 

 

 

 

 

 

 

  



4. Element properties 
 

There are many types of elements, text, number, time, date, multiple-choice, GPS location, and 

media. You can choose according to your necessity. 

 

 

Let’s go through some of the important fields: 

- Data name: This is the name that goes into the spreadsheet, you cannot use space 

between letters 

- Label: This is the name that will appear on the application 

- When creating a question with multiple options you can create different next questions 

for each type of answer, for example: 

 

Follow up question 



 

The orange boxes show the questions, while the blue boxes the answers available 

So, if you choose a forest, you can select what type of forest, and so on. Otherwise, if you choose 

agriculture, the next question would be what type of plantation. You can use this function by 

checking the “Follow up question” box, you select which answer leads to another question. 

 

Note that in the bottom part of the right panel, you have information explaining each field 

 

  



5. Example 
 

Now, let’s create a full form following the 5W1H (What, who, where, when, how, and why) 

questioning method (in this case we are going to use the ones that apply to the survey). 

So for this example we are creating the following questions: 

- Who? > Who is the surveyor? (Surveyor name) 

- When? > When the survey was made? (Date/Time) 

- What? > What is the land use type? (Land use type) 

- What? > What is the tree type? (Tree type) 

- What? > What is the DBH? (DBH Value) 

- What? > What is the tree height? (Tree height) 

- Where? > Where is it located? (Geolocation) 

- What? > What does it look like? (Photo) 

 

Surveyor’s name 

Click on “text” button on the bottom bar and fill the properties according to the image below: 

 

 

Step 4 - If the surveyor does not 

answer this question, this message 

will pop-up 

Step 1- click on the “text” button 

Step 2 – insert the data name (it will 

be displayed on the spreadsheet) 

Step 3 – Insert the question that will 

be displayed on the mobile device 

Step 3 – Add a hint to help the 

surveyor to answer 



Date 

Click on “Date/Time” button on the bottom bar and fill the properties according to the image below: 

 

Step 4 – Select what time of time 

you want the surveyor to take. In 

this case we are asking for full date 

(YY/MM/DD) and time 

Step 1- click on the 

“Date/Time”button 

Step 2 – insert the data name (it will 

be displayed on the spreadsheet) 

Step 3 – Insert the question that will 

be displayed on the mobile device 

Step 3 – Add a hint to help the 

surveyor to answer 



Landuse type 

Click on “Choose One” button on the bottom bar and fill the properties according to the image 

below: 

 

 

  

Step 4 - The “underlying value” is 

the value will be displayed on the 

table 

Step 2 – follows the same rule from 

other questions 

Step 1- click on the 

“Choose one” button 

Step 3 - These are the options that 

will appear on the mobile device 



Tree type 

Click on “Choose One” button on the bottom bar and fill the properties according to the image 

below: 

 

 

 

  

Step 4 - The “underlying value” is 

the value will be displayed on the 

table 

Step 2 – follows the same rule from 

other questions 

Step 1- click on the 

“Choose one” button 

Step 3 - These are the options that 

will appear on the mobile device 



DBH in cm 

Click on “Numeric” button on the bottom bar and fill the properties according to the image below:  

 

 

Step – 3 The style you can change as 

slider or pick up value, in this case 

we choose textbox where the 

surveyor can type the values 

Step 4 - Since we are working with 

centimeters, we do not need 

decimal values 

Step 2 – follows the same rule from 

other questions 

Step 1- click on the 

“Numeric” button 



Tree height 

Click on “Numeric” button on the bottom bar and fill the properties according to the image below: 

 

 

Step 3 - The style you can change as 

slider or pick up value, in this case 

we choose slider where the 

surveyor can slide the values 

Step 5 – here you can select the step 

between choices. Since we are 

working in meters, we are using 

0.1m between the choices 

Step 2 – follows the same rule from 

other questions 

Step 1- click on the 

“Numeric” button 

Step 4 – Here you can select the 

range of your slide (min and max) 



GPS location 

Click on “Location” button on the bottom bar and fill the properties according to the image below: 

 

 

Step 1- click on the 

“Location” button 

Step 2 – follows the same rule from 

other questions 

Step 3 – here you can select the 

type of feature you want to select, 

in this case we are taking only a 

point

Step 4 – You can select how to take 

the point, in this case we are using a 

map to show the device position 



Add photo 

Click on “Media” button on the bottom bar and fill the properties according to the image below: 

 

 

 

 

 

  

Step 1- click on the 

“Location” button 

Step 2 – follows the same rule from 

other questions 

Step 3 – what kind of media, in this 

case we chose image 



6. Groups 
 

With Groups you can create a loop of questions, but what does it mean? 

For example, if you have a plot with many trees, you can input each tree according to each species, 

and you can do it until you finish put all trees from the same plot 

 

Let’s see how to create that on ODK Build: 

- Click the group button 

 

- When you create a group, you can put any amount of elements 

- On the mobile of the application, at the end of the group, it is going to ask if you want to 

add a new tree or finish 



 

The group can be seen as a form inside a form. 

 

So, let’s create a group using to obtain these information: tree type, DBH, and tree height 

First, click on “Group” on the bottom bar 

 

 

 

 

 

 

 



You are going to see a green block, everything you put in this block it will be part of the group, you 

can rename it according to your needs. In this case we are calling it “Tree info” 

 

  

Step 1- click on the 

“Group” button 

Step 2 – follows the same rule from 

other questions 



Let’s add Tree type. Click on “Choose one” button on the bottom bar, drag it into the green block, 

and fill the properties according to the image below: 

 

 

  

Step 1- click on the 

“Numeric” button 

Step 3 – follows the same rule from 

other questions 

Step 2 – Drag the question inside 

the green block 



Next, let’s add the DBH values. Click on “Numeric” button on the bottom bar, drag it into the green 

block, and fill the properties according to the image below:  

 

Step 1- click on the 

“Numeric” button 

Step 3 – follows the same rule from 

other questions 

Step 2 – Drag the question inside 

the green block 



The last one is going to be the tree height. Click on “Numeric” button on the bottom bar, drag it into 

the green block, and fill the properties according to the image below: 

 

  

Step 1- click on the 

“Numeric” button 

Step 3 – follows the same rule from 

other questions 

Step 2 – Drag the question inside 

the green block 



So after you finishing filling up your group, click again on the green part and you have 2 choices 

 

Looped: it will loop the questions as we mentioned before 

Display On One Screen: all questions will be displayed in only one screen 

In this case, let’s display it in only one screen. Good now you are able to create groups! 

 

  



7. Save and Export 
 

To save the form to edit later, click on File > Save form. You will save with the .odbuild extension. 

You can open this file to edit your form. 

 

 

To export into your device, you need to go to File > Export XML. This will create a XML file that you 

can upload into Google Drive 

 

For more information in how to export, please look at the ODK server tutorial 



8. Conclusions 
 

This is a mini-tutorial on how to create a form using ODK build, we went through the installation 

process until creating a full form. 

To use this form on your mobile device, ask your technical staff how to set up it to the server and 

you can use it right away 

One point that should be highlighted, is to create relevant data for your inventory management. 

“With crap ingredients, you cannot have a good meal” 

For further information, you can access https://docs.getodk.org/build-intro/, where the whole 

tutorial is available 
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第1章 ジェンダー分析調査の概要 

1.1. 背景 

太平洋島嶼国のひとつであるソロモン諸島では、他の開発途上国と同様に、農村住民の

多くが森林資源に生計を依存した生活を送っている。同国では、2000 年からの 10 年間で

樹幹被覆率が 20％以上減少した森林面積が約 157,000ha にのぼるなど1、森林劣化の傾向に

ある。森林の劣化は住民の生活に影響を与えるが、その度合いは地域、性別、部族・氏

族、経済状況、また森林資源への依存度等の違いによって異なる。男女間で影響の度合い

が異なるのは、森林へのアクセスや権限（コントロール）、森林管理における役割や意思

決定権、森林資源への依存度等が異なるからである。そのため、政府や援助機関による地

域住民を巻き込んだ参加型の森林管理事業では、こうした対象地域における社会・ジェン

ダー事情、特に男女の役割や力関係を踏まえて、女性や脆弱層も事業に参加して便益が受

けられるように計画・実施する必要がある。 

国際協力機構（JICA）は、劣化傾向にあるソロモン諸島の森林資源の持続的な管理を目

的とする「ソロモン国における持続的森林資源管理能力強化プロジェクト（SI-SFRM 事

業）」（2017 年～2022 年）を実施してきた。同事業では、カウンターパート機関である森

林・研究省職員の対住民業務遂行能力の強化を目的に、対象 2 村落（ガダルカナル州コム

ニボリ村とマライタ州ファラケ村）において住民参加型の持続的な森林資源管理のパイロ

ット活動が実施されている。2 村落では、パイロット活動の実施前に社会・経済調査は実

施されたものの、ジェンダー分析調査は行われていない。 

本来、ジェンダー分析調査は事業計画段階に実施されるべきであるが、現段階でも、ジ

ェンダー分析調査を行う必要性と意義は大きい。ソロモン諸島では、母系制・父系制度社

会の別にかかわらず、一般的に森林資源（薪を含む非木材林産物（NTFPs））の収集は女性

の役割で、さらに農業や家畜管理でも女性は大きな役割を果たしている。しかし、男女の

役割にかかる社会規範が根強い伝統社会では、森林資源管理に限らず家庭内やコミュニテ

ィにおける意思決定権は女性にはなく、男性が最終決定者とされている2。森林資源の収集

や農業において大きな役割を果たしている女性の声やニーズが、パイロット活動の意思決

定に反映され、女性が主体的に森林資源管理や生計向上活動に参加し、必要な技術や資金

支援が受けられれば、SI-SFRM 事業の効果・インパクトはより大きなものとなる。コミュ

ニティ全体で持続可能な森林資源管理を目指すためには、女性や若者を含むすべての住民

が主体的に参加して、それぞれが役割を果たし、その役割と貢献が認識されることが重要

である。そのための効果的なアプローチや具体的な取組を検証するため、ジェンダー分析

調査を実施する意義は大きい。 

                                                        
1 ソロモン諸島の全国土は約 280 万 ha で、その 78.8％にあたる約 220 万 ha が森林とされる（2015 年

FAO）。 
2 ADB. 2015. Solomon Islands Country Gender Assessment. Manila: ADB. 
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1.2. 調査目的 

上述の背景を基に、森林資源管理事業において女性の意思決定段階への参画や経済的な

エンパワメントを促進するアプローチや取組を検証し、SI-SFRM 事業を含む JICA の技術

協力事業へ提言することを目的に、SI-SFRM 事業の中で、2020 年 12 月からジェンダー分

析調査が実施されることとなった。 

ジェンダー分析調査では、まずソロモン諸島の国全体のジェンダー格差の現状、および

政府の取組概要を把握することを目指した。次に、ソロモン諸島の森林セクターにおける

ジェンダー役割やジェンダー関係の把握を目的に、SI-SFRM 事業下で実施されるパイロッ

ト活動の対象 2 村落をケースとして、詳細なフィールド調査を実施することとした。この

フィールド調査では、農地や森林資源等への男女のアクセスやコントロールの違い、農業

や森林資源管理を含む生産活動、および家事やケアワークの再生産活動における性別役割

分担、コミュニティや家庭内での意思決定への男女の参画状況の違い等を特定することを

目的とした。フィールド調査の結果を基に、対象 2 村落で求められているジェンダー・ニ

ーズを特定するとともに、SI-SFRM 事業の中で実際に採用されている住民男女へのアプロ

ーチや取組、ファシリテーション方法等がそれらのジェンダー・ニーズを満たす上で適切

であるかどうかを分析することとした。この分析結果を基に、パイロット活動を通じて女

性の意思決定段階への参画、生計向上活動による女性の経済的エンパワメント、女性のリ

ーダーシップ醸成等を促進する効果的なアプローチや取組、ファシリテーション方法を分

析することとした。 

 

1.3. 調査手法 

 本ジェンダー分析調査は、以下の 3 つのステップを経て実施された。 

 

1) 既存データや文献のデスクレビュー 

2) フィールド調査の実施 

3) 分析 

 

まず、1）のデスクレビューでは、主要セクター（人口、貧困、教育、保健、農林水産業、

政治参加、女性に対する暴力等）におけるジェンダー格差の現状を把握するため、関連デー

タや調査報告書（国勢調査（2009 年、2019 年暫定版、世帯別収支調査（HIES2012/2013）、

人口保健調査（DHS2015）等）をレビューしたほか、政府の取組については、女性差別撤廃

条約（CEDAW）の報告書、国家開発戦略（2016-2035）、国家ジェンダー平等女性と開発政

策（2016-2020）、女性・少女の経済的エンパワメントのための国家戦略等をレビューした。 

次に、2）のパイロットサイトにおけるフィールド調査では、各村落のチーフや女性リー

ダーを対象としたキーインフォーマント・インタビュー、パイロット活動に参加している女

性と男性を対象としたフォーカスグループス・インタビュー、さらにこれらのインタビュー
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結果を基に、より詳細情報を得るために個人インタビューを実施した。これら複数の調査手

法を組み合わせることにより、各手法から収集した情報をクロスチェックし、情報の正確性

や信頼性を高めることを目指した。 

最後に、1）と 2）で得られた情報を基に、SI-SFRM 事業や将来計画・実施される類似の

事業において、既存のステレオタイプのジェンダー役割や不平等なジェンダー関係をより

平等なものに変えて、女性の意思決定段階への参画や経済的なエンパワメントを図るため

に効果的なアプローチや取組について分析を行うこととした。 

 本ジェンダー分析調査には、日本人専門家の野々口敦子（国際航業株式会社所属）とロー

カルコンサルタントの Ms. Gaylyn PUAIRANA が従事した。当初、日本人専門家が現地調査

を含め本ジェンダー分析調査のすべてを行う予定であったが、新型コロナウィルスの蔓延

により、渡航することが出来ず、ローカルコンサルタントを傭上することとなった。2020 年

12 月から、日本人専門家およびローカルコンサルタントがそれぞれの業務を開始した。日

本人専門家が作成した業務内容に基づき、ローカルコンサルタントが必要なデータ・文献を

収集し、主要セクターのジェンダー格差の現状や政府の体制・取組内容を分析した。さらに、

日本人専門家が作成したリサーチ・デザインおよび質問票を基に、ローカルコンサルタント

がフィールド調査を実施し、作成したインタビュー記録を基に、日本人専門家が対象２村落

における森林セクターのジェンダー事情を分析した。ローカルコンサルタントが収集した

データ・文献や作成した報告書等を参照しつつ、日本人専門家が、専門的見地から全体の分

析作業を行い、報告書にまとめることとした。 

 

表 1-1 ジェンダー分析調査のスケジュール 

年月 業務内容 

2020 年 12 月 ローカルコンサルタント傭上・契約 

12 月末～2021 年 1 月末 ソロモン諸島のジェンダー格差の現状と政府の取組状況
にかかる既存データ・文献の収集とレビュー 

2021 年 2 月 フィールド調査（各種インタビュー）の計画と実施 

2021 年 3 月 インタビュー記録の作成と内容確認 

2021 年 4 月 追加のインタビュー調査の計画と実施、インタビュー記録
の作成と内容確認 

2021 年 5 月～6 月 調査結果を基に分析、報告書の作成 

出典：調査団 
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第2章 ソロモン諸島におけるジェンダー格差の現状 

2.1. ソロモン諸島の社会・経済状況 

ソロモン諸島は、南太平洋のメラネシア（オーストラリアの北東、パプアニューギニアの

東）に位置し、主要 6 島と 1,000 近い小島から成る島嶼国家である。同国は、首都区域のホ

ニアラと9つの州3から構成されている。主要民族のメラネシア人が全人口の95.7％を占め、

以下ポリネシア人（2.4％）、ミクロネシア人（1.1％）が続く4。公用語は英語であるが、80

を超える固有の言語が話されているため、英語を土台としたピジン語が部族間の共通語と

なっている5。また、国民の 95％以上がキリスト教を信仰している6。 

同国は、1978 年にイギリス連邦（コモンウェルス）に加盟する立憲君主国として独立し

た。1998 年末から首都ホニアラのあるガダルカナル島において、元々ガダルカナル島に住

んでいた人々が、マライタ島から移住してきたマライタ島民に対して、土地の領有権や雇用

機会をめぐる不満からマライタ島民の排斥運動をおこし、武力抗争が激化した。2003 年 7

月、自国の警察だけで対応できなくなったソロモン諸島政府からの要請で、オーストラリア

やニュージーランドが主導し、太平洋諸島フォーラム（Pacific Islands Forum: PIF）の加盟国

の警察や軍隊から結成された地域支援ミッション（Regional Assistance Mission to Solomon 

Islands: RAMSI）を派遣して、治安の回復が図られた7。 

ソロモン諸島では、人口の 85％が農村部に暮らし、自給自足に近い生活を送る人々も多

い8。同国は、豊かな森林資源や水産資源に恵まれ、農林水産業が基幹産業となっている。

ソロモン諸島の 2019 年の国民総生産（Gross Development Product: GDP）は 15.9 億ドルであ

るが9、農林水産業がその 40％を占めている10。また、経済は、木材（丸太）、コプラ、アブ

ラヤシ、魚（カツオ含むマグロ）等の輸出に強く依存しているため、一次産品の国際価格下

落の影響を受けやすい11。そのため、政府は、水産加工品や製材品等、付加価値品の製造事

業を推進したいところであるが、部族対立の影響で日本の大洋漁業（現マルハ株式会社）が

撤退したり、森林の過剰伐採に対する抗議活動が強まり、新たな伐採ライセンスを止めてい

る状況にあり、新規の外国企業の参入や投資はあまり進んでいない12。また、金、ニッケル、

ボーキサイト等の豊富な鉱山資源の開発についても、土地問題等に制約されている13。 

                                                        
3 9 つの州：中央州、チョイス州、 ガダルカナル州、イサベル州、 マキラ・ウラワ州、 マライタ州、 

レンネル・ベローナ州、テモツ州、西部州。 
4 National Statistics Office, Ministry of Finance and Treasury. 2015. Solomon Islands 201213 Household 
Income and Expenditure Survey National Analytical Report. Honiara: NSO. 
5 https://pic.or.jp/country_information/4811/ （最終アクセス 2021 年 5 月 12 日） 
6 https://www.mofa.go.jp/mofaj/area/solomon/data.html （最終アクセス 2021 年 5 月 12 日） 
7 ibid. 
8 https://www.jstra.jp/html/PDF/research2017_07_02.pdf （最終アクセス 2021 年 5 月 12 日） 
9 https://data.worldbank.org/country/SB （最終アクセス 2021 年 5 月 12 日） 
10 FAO. 2019. Country Gender Assessment of Agriculture and the Rural Sector in Solomon Islands. Honiara: FAO & 

the Pacific Community. 
11 https://www.jstra.jp/html/PDF/research2017_07_02.pdf （最終アクセス 2021 年 5 月 12 日） 
12 ibid. 
13 ibid. 
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2.2. 主要セクターにおけるジェンダー格差の現状 

 特定の国のジェンダー格差やジェンダー差別の実態を把握するためには、キーとなるセ

クターにおける男女間の格差を定量的に示し、その値を同じ地域に属する周辺国や社会経

済レベルが類似する他の国と比較する方法が採られる。その際利用されるのが、国連開発計

画（United Nations Development Programme: UNDP）によるジェンダー不平等指数（Gender 

Inequality Index: GII）や世界経済フォーラムによるジェンダー・ギャップ指数（Gender Gap 

Index: GGI）である。GII は各国のリプロダクティブ・ヘルス、経済活動、政治参加の 3 分

野、また GGI は教育、保健、経済活動、政治参加の 4 分野の指標における男女間格差を基

に、各国の総合的な値を割り出し、それを相対評価して順位をつけている。 

しかし、ソロモン諸国は、GII や GGI で対象となっている指標の男女別のデータが欠如し

ているため、いずれにおいてもその値や順位は割り出されていない。周辺国も同様である。

一方、UNDP が GII のほか、毎年発表している人間開発指標（HDI）については、ソロモン

諸島の最新報告書（2020 年）の順位は 189 ヶ国中 151 番目となっている14。周辺国のバヌア

ツは 140 番目、パプアニューギニア（PNG）は 155 番目であった。 

 ここでは、ソロモン諸島の主要セクターごとにジェンダー格差の実態を見ていくことと

する。最初に同国の人口と貧困の現状についてレビューし、ジェンダーと関係性が高い、保

健（リプロダクティブ・ヘルス）、教育、雇用・経済活動、農林業、政治参加、ジェンダー

に基づく暴力・女性に対する暴力の各分野をジェンダー視点からレビューする。 

 

2.2.1. 人口 

 2019 年に実施された国勢調査の暫定結果によれば、ソロモン諸島の全人口は 721,455 人

で、この内男性が 369,252 人（51.2%）、女性が 352,204 人（48.8％）であった15。前回の国勢

調査時（2009 年）の人口は 551,525 人で、10 年間に約 17 万人も増加したことになる。この

間の年平均人口増加率は 2.7％で、1999 年から 2009 年の 3％と比べると減少しているが、

なお高い水準にある16。ソロモン諸島では、全人口の 82％（536,623 人）が農村部に集中し、

都市部の人口は 18％（184,832 人）に留まっている17。しかし、都市部への急速な人口の流

入は顕著で、1999 年から 2009 年の年平均人口増加率は 4.1％であったが、2009 年から 2019

年のそれは 5.3％にまで激増している（農村部はどちらも 1.9％）。また、人口は、マライタ

州（24％）、ガダルカナル州（21.4％）、首都ホニアラ（18％）に集中しているが、特にホニ

アラの人口は 2009 年の約 73,000 人から 2019 年には約 13 万人に増え（78％増、年平均人口

増加率は 5.8％）18、急速に都市化が進んでいる19。 

                                                        
14 UNDP. 2020. Human Development Report 2020. New York: UNDP. 
15 National Statistics Office. 2020. Provisional Count 2019 National Population and Housing Census. Honiara: 

NSO.  
16 ibid. 
17 ibid. 
18 ibid. 
19 ibid. 
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2.2.2. 貧困 

1) 貧困率 

 ソロモン諸島では、人口の 12.7%が貧困ライン以下で暮らしている20。貧困率を居住場所

別に見ると、都市部の 9.1％に対し農村部は 13.6％と高く、貧困人口もその 87％が農村部に

集中している21。また、州別に見ると、貧困率はマキラ州（31.5％）、ガダルカナル州（22.2％）、

首都ホニアラ（15％）の順に高く、貧困人口が占める割合はガダルカナル州が 38％、マキ

ラ州が 21.7％、マライタ州が 17.3％となっている22。一方、所得の五分位階級を居住場所別

に見ると、農村部における最貧困層の第 1 階級の割合が 24.4％であるのに対し、都市部は僅

か 0.8％であった23。反対に、富裕層が都市部に集中し、最富裕層の第 5 階級の割合が 72％

と高いが、農村部では 7.5％とその格差が大きい。 

 

2) 世帯主の性別・居住場所別による世帯年収格差と要因 

2012/2013 に実施された世帯別収支調査（Household Income and Expenditure Survey: HIES 

2012/13）によれば、ソロモン諸島の全世帯数は 108,041 で、その内男性世帯主世帯が 89.9％

で、女性世帯主世帯は 10.1％であった24。居住場所別に見ると、都市部の女性世帯主世帯の

割合は 13.2％、農村部は 9.4％と、都市部の方が多い25。各世帯の平均人数は、世帯主の性別

データはないが、都市部が 5.6 人であるのに対し農村部は 6 人と大きな差はなかった26。 

世帯別の平均年収は、都市部が SBD114,793（約 1,574 千円27）であるのに対し、農村部は

SBD45,116（約 619 千円）と半分以下であった。また、年間の世帯別平均支出額は、首都ホ

ニアラでは特に家賃が高く、都市部が SBD99,007（約 1,357 千円）であるのに対し、自給自

足や物々交換が少なくない農村部では SBD44,340（約 608 千円）と半分以下であった28。こ

れらの数字から、特に農村部では、収入と支出額がほぼ同等で、手元に残る収入はごく少額

といえる。 

一方、世帯主の性別で見てみると、男性世帯主世帯の平均世帯年収は SBD58,773（約 806

千円）であるのに対し、女性世帯主世帯のそれは SBD44,974（約 617 千円）と格差がある

（下表参照）。都市部でも農村部でも女性世帯主世帯の平均年収は男性世帯主世帯の平均年

収の約 7 割に留まっている（下表参照）。また、農村部の女性世帯主世帯の年収額自体も少

ないが、農村部の全世帯年収額に占める割合も 6.9％と非常に低い（下表参照）。 

                                                        
20 National Statistic Office and the World Bank Group. 2015. Solomon Islands Poverty Profile Based on the 2012/13 

Household Income and Expenditure Survey. Honiara: NSO and the WB Group. 
21 ibid. 
22 ibid. 
23 National Statistics Office, Ministry of Health and Medical Services, and the Pacific Community. 2017. Solomon 

Islands Demographic and Health Survey 2015. Honiara: NSO. 
24 National Statistic Office and Ministry of Finance and Treasury. 2015. Solomon Islands 2012/13 Household Income 

and Expenditure Survey National Analytical Report. Honiara: NSO. 
25 ibid. 
26 ibid. 
27 SBD はソロモン諸島の通貨であるソロモン諸島ドルを指す。１SBD＝13.7 日本円（2021 年 6 月時点） 
28 ibid. 
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表 2-1 世帯主の性別・居住場所別の平均世帯年収 

居住場所／世帯主の性別 世帯数 全年収額と割合 平均世帯年
収 SBD SBD: 1000 % 

都市部 男性世帯主世帯 16,497 1,970,534 90.3 119,450 

女性世帯主世帯 2,519 212,249 9.7 84,273 

合計 19,015 2,182,783 100.0 114,793 

農村部 男性世帯主世帯 80,630 3,737,884 93.1 46,358 

女性世帯主世帯 8,395 278,595 6.9 33,184 

合計 89,026 4,016,479 100 45,116 

全体 男性世帯主世帯 97,127 5,708,418 92.1 58,773 

女性世帯主世帯 10,914 490,844 7.9 44,974 

合計 108,041 6,199,262 100.0 57,379 

出典：2012/13 Solomon Island HIES 

 

世帯別の年間平均収入について、5 つの年収範囲グループに分けて、各グループに男性と

女性の世帯主世帯が占める割合を見る。平均世帯年収が SBD10,000 以下の女性世帯主世帯

の割合は 12.8％で、男性世帯主世帯（6.7％）の 2 倍近くとなっている（下表参照）。さらに、

平均世帯年収が SBD30,000 未満の世帯は、女性世帯主世帯が 53％のところ、男性世帯主世

帯は 44％と大きな格差がある（下表参照）。 

 

表 2-2 世帯主の性別による世帯年収範囲グループごとの割合 

平均世帯年収
（SBD） 

男性世帯主世帯 女性世帯主世帯 合計 

< 10,000 6.7% 12.8% 7.3% 

10,000 – 29,999 37.3% 40.2% 37.6% 

30,000 – 49,999 25.3% 22.2% 25.0% 

50,000 – 99,999 20.9% 17.5% 20.6% 

>100,000 9.9% 7.3% 9.6% 

合計 100.0% 100.0% 100.0% 

出典： 2012/13 Solomon Island HIES 

 

世帯主の性別による平均世帯年収の格差は、女性世帯主が現金収入を得られる機会が男

性世帯主に比べて少ないからである。特に、農村部の女性世帯主の半分以上（51％）が自給

自足であるのに対し、男性世帯主の自給自足の割合は 38％に留まっている29。また、農村部

で換金作物を栽培している女性世帯主は 8％、公・民セクターで働く女性世帯主は 17％であ

るのに対し、換金作物を栽培している男性世帯主は 18％、公・民セクターで働く男性世帯

主は 26％と、男性世帯主の方が現金収入を得ているケースが圧倒的に多い30。 

 

 

 

                                                        
29 ibid. 
30 ibid. 
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2.2.3. 保健（リプロダクティブ・ヘルス） 

1) 合計特殊出生率と家族計画 

妊娠・出産は、女性にとって身体的な負担だけではなく、子どもの数や出産間隔によって

は子育ての負担が経済活動への参加の大きな障壁となる。2015 年実施の人口保健調査

（Demographic and Health Survey: DHS）によれば、女性 1 人あたりの生涯出産数を示す合計

特殊出生率（Total Fertility Rate: TFR）は、4.4 であった31。1999 年実施の国勢調査の 4.8、

2006/07 年実施の DHS の 4.6、2009 年実施の国勢調査の 4.7 と比べて、大きな減少傾向には

ない。居住場所別に見ると、都市部では 3.4 に抑えられているが、農村部では 4.7 と高い32。

こうしたソロモン諸島、特に農村部における高い TFR は、貧困やジェンダー規範を背景に、

女性の教育レベルの低さや婚資を目的とする早期婚の慣習が大きく影響しているといえる。

そのため、女性（25～49 歳）が最初に出産した年齢の中央値は 22.1 歳であるが、都市部よ

り農村部の女性、富裕層より貧困層の女性、教育レベルが高い女性より低い女性の方が、最

初の出産年齢が若い33。結果、TFR も、都市部の女性は 3.4、最富裕層（五分位階級の第 5

位）の女性は 3.2、中等教育以上の教育を受けている女性は 3.1 となっている34。 

ソロモン諸島では、避妊や家族計画の普及があまり進んでおらず、若年層（10 代）の妊

娠や望まない妊娠も多い。2015 年実施の DHS によれば、15～49 歳の女性の 94％、同じ年

齢層の男性の 98％が少なくとも 1つ以上の避妊方法を知っていると回答している。しかし、

緊急避妊方法について知っていると回答した女性は 34％に留まっている35。また、避妊具の

使用率は、結婚している女性（15～49 歳）が 29％、未婚女性が 35％と非常に低い36。結果、

若年層（15～19 歳）の女性が妊娠・出産する割合は、同じ年齢層の女性 1,000 人当たり 12.3％

（都市部 9.7%、農村部 12.9％）と非常に高い37。州別に見ると、西部州が 16％と高く、首

都ホニアラは 9％に留まっている38。また、教育レベル別および五分位階級別に見ると、教

育を全く受けていない女性（15～19 歳）の妊娠・出産率は 32％（中等教育を受けた同じ年

齢層の女性は 7％）、第 1 階級と第 2 階級の女性（15～19 歳）の妊娠・出産率は 15％と 16％

（第 4 階級と第 5 階級の同じ年齢層の女性はどちらも 9％）であった39。 

また、2015 年の DHS 実施時に、過去 5 年間に妊娠した 15～49 歳の女性の内 20％がその

妊娠を「早すぎた」、12％が「望んでいなかった、計画していなかった」と回答している40。

家族計画が計画通りに満たされなかったと回答した女性の割合は、出産間隔についてが

                                                        
31 National Statistics Office, Ministry of Health and Medical Services, and the Pacific Community. 2017. Solomon 

Islands Demographic and Health Survey 2015. Honiara: NSO. 
32 ibid. 
33 ibid. 
34 ibid. 
35 ibid. 
36 ibid. 
37 ibid. 
38 ibid. 
39 ibid. 
40 ibid. 
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20％、出産数（子どもの数）についてが 14.7％、合計 34.7％となっている41。 

 

2) 母子保健 

ソロモン諸島における妊産婦死亡率は、2009 年の国勢調査では 10 万出生あたり 152 であ

ったが、2017 年の最新データでは 104 まで減少している42。しかし、太平洋地域の島嶼国の

平均は 70 なので43、なお改善する必要がある。2015 年の DHS によれば、医療機関でお産が

行われた割合は 85％（公立の医療機関が 76％、私立の医療機関が 8％）で、産婦人科医や

助産師等の専門家が介助したお産の割合も 9 割近い（医師 4％、助産師 72％、看護師 10％）。

しかし、伝統的産婆が介助したお産が 2％、誰も介助せず行われたお産が 1％となっている

44。また、妊娠・出産を経験した女性（15～49 歳）の約 94％が出産前の健診を医師や助産師

等から受診しているが、1％は伝統的産婆から受診し、5％は全く受けていない45。妊娠初期

（4 カ月まで）に初健診を受けた女性の割合がわずか 17％で、初健診を受ける妊娠月の中央

値は 5.6 ヶ月と非常に遅い46。そのため、出産前に 4 回以上の健診を受けた女性は 69％で、

出産前健診で破傷風の予防注射を 2 回摂取した女性の割合は僅か 22.8％であった47。一方、

出産後の健診を受けた女性の割合は 61％で、32％の女性はリスクの高い出産後 2 日以内の

健診を受けていない48。 

ソロモン諸島で、女性が出産前後の健診を十分に受けられていない要因として、医療機関

へのアクセスの問題、低い教育レベル、経済的な事情、ジェンダー役割やジェンダー関係等

が考えられる。特に農村部には、健診が受けられる医療施設がなかったり、あっても医療者

が常駐していなかったり、薬や機材が整備されていない等の事情から、遠く離れた都市部の

医療施設に行くしかない場合が多い。その場合、農村部の女性が日々担っている生産・再生

産活動を休めない、交通費や健診費が払えない、医療施設に行くために夫からの許可を得な

ければいけない（交通費や健診費を夫からもらう）等の制約があるという49。2006/07 に実

施された DHS で、女性が医療施設にアクセスする上で制約になる事項として回答した結果

は、下表のとおりである。 

 

 

 

 

 

                                                        
41 ibid. 
42 https://data.worldbank.org/indicator/SH.STA.MMRT?locations=SB （最終アクセス 2021 年 5 月 20 日） 
43 ibid. 
44 National Statistics Office, Ministry of Health and Medical Services, and the Pacific Community. 2017. Solomon 

Islands Demographic and Health Survey 2015. Honiara: NSO. 
45 ibid. 
46 ibid. 
47 ibid. 
48 ibid. 
49 ADB. 2015. Solomon Islands Country Gender Assessment. Manila: ADB. 
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表 2-3 女性が医療施設にアクセスする上で制約になる事項 

回答のあった制約事項 農村部の女性（％） 都市部の女性（％） 

薬がない 91 80 

医療者がいない 87 76 

女性の医療者がいない 60 51 

一人で行きたくない 44 39 

交通手段が必要 58 36 

医療施設までの距離 56 38 

交通費が必要 65 48 

医療機関に行く許可が必要 30 17 

出典：2006/07 Solomon Islands DHS 

 

2.2.4. 教育 

1） 識字率と教育レベル 

2009 年の国勢調査によれば、ソロモン諸島の成人女性（15 歳以上）の識字率は 69％、成

人男性は 83.7％と、男女間に大きな格差（14.7 ポイント）がある。ただし、2015 年実施の

DHS の調査対象者の 15～49 歳の年齢層に限れば、女性の識字率は 82.4％、男性は 90％と

男女間格差は大きく縮小されている。また、性別および居住場所別に見ると、都市部の女性

と男性の識字率（91.2％と 95.1%）の差は 4 ポイント弱であるが、農村部（79.8％と 88.3％）

では 8.5 ポイントと格差は依然大きいといえる。 

一方、ソロモン諸島の成人男女の教育レベルを見てみると、男女間に大きな格差があるほ

か、居住場所間でも大きな格差がある。下表が示すとおり、例えば、学校教育を全く受けて

いない男性の割合は 11.8％（都市部 4.4％、農村部 13.8％）であるが、女性の割合は 21.4％

（都市部 9.8％、農村部 24.4％）で、男女ともに農村部の方が多く、どちらの場所でも女性

の割合が男性の割合の倍近くとなっている。初等教育を終了している割合は、男女間でそれ

ほど差はないが、中等教育および高等教育を終了している割合は都市部の方が男女ともに

高く、どちらの場所でも男女間の格差が大きくなっている（下表参照）。 

 

表 2-4 ソロモン諸島の成人の教育レベル（男女別）（2009 年） 

レベル 合計（％） 都市部（％） 農村部（％） 

男子 女子 男子 女子 男子 女子 

無就学 11.8 21.4 4.4 9.8 13.8 24.4 

初等教育を少し履修 27.4 27.8 16.9 19.7 30.4 29.9 

初等教育を終了 31.6 30.2 27.5 29.5 32.7 30.3 

中等教育を履修または終了 22.0 16.8 36.2 31.4 18.0 13.1 

高等教育を履修または終了 6.0 3.1 13.5 8.9 3.8 1.6 

職業訓練修了証書を取得 1.3 0.6 1.6 0.7 1.3 0.6 

合計 100 100 100 100 100 100 

出典：National Statistics Office and Ministry of Finance and Treasury, the Government of Solomon 

Islands. 2014. 2009 National Population and Housing Census Report on Gender. Honiara: NSO. 
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2） 就学率50 

ソロモン諸島の教育制度は、就学前教育（Early Childhood Education: ECE）が 3 年（3～5

歳）、初等教育が 6 年（6～11 歳）、中等教育が 6 年（中学 3 年：12～14 歳、高校 3 年：15～

17 歳）、高等教育（大学）が 4 年（18～21 歳）となっている51。同国では、義務教育の制度

化がなされていない52。また、教育の無償化は政策として掲げられているものの53、実際は

学費（School Fee）や寮費の支払いが必要で、特に中等教育以上への就学の制約となってい

る。 

ソロモン諸島では、学齢期にありながら学校に行けていない子ども（Out-of-school 

Children: OOSC）の割合が、2018 年の初等教育レベルで 4.13％（4,351 人）となっている54。

男女別データがある 2007 年のデータによれば、初等教育レベルの男子の OOSC の割合は

18.22％（7,336 人）、女子は 20.65％（7,712 人）と女子の OOSC の割合の方が少し高かった

55。これが、識字率や各教育レベルにおける就学率の男女間格差にもつながっている。2008

～2012 年の就学前教育の総就学率（Gross Enrollment Rate: GER）では男子が 48.8％、女子が

50％であるが、初等教育の純就学率（Net Enrollment Rate: NER）は男子が 87.7％、女子が

87.3％、また中等教育の NER は、男子が 43.8％、女子が 41.5％と、教育レベルが上がるに

従い男女間の格差が生じている（下表参照）。 

 

表 2-5 等教育、中等教育の就学率（2008～2012 年）（男女別） 

 男子 女子 

就学前教育の GER 48.8% 50.0% 

初等教育の NER 87.7% 87.3% 

中等教育の NER 43.8% 41.5% 

出典：https://www.unicef.org/infobycountry/solomonislands_statistics.html （最終アクセス 2021

年 5 月 28 日） 

 

一方、高等教育については、ソロモン諸島にある主要な高等教育機関に就学する学生数

（2012 年）は 7,943 人であったが、内女子学生は 3,040 人で、全体の僅か 38.3％に留まって

いる56。特に技術系の専門学校である「Don Bosco」や「Rural Training Centers」に就学する

女子学生の割合は、それぞれ 21.1％、34.7％と低い57。 

 ソロモン諸島の各教育レベルの就学率における男女間格差を示す GPI（Gender Parity Index）

                                                        
50 ソロモン政府・教育人材開発省（MEHRD）の Performance Assessment Report に掲載されているデータ

（2016～2019 年）について、その信頼性に疑いがあるため、就学率については、UNICEF のデータ（2008

～2012 年）を使用する。就学率の男女間格差を示す GPI については正しいと思われることから、MEHRD

の最新データ（2019 年）を使用。 
51 ADB. 2015. Solomon Islands Country Gender Assessment. Manila: ADB. ＊ 就学年齢は目安 
52 JICA. 2010. 国別ジェンダー情報整備調査 ソロモン諸島 最終報告書.  
53 ソロモン政府は、2009 年に「The Fee-Free Education Policy」を施行。 
54 https://data.worldbank.org/indicator/SE.PRM.UNER.FE.ZS?locations=SB （最終アクセス 5 月 28 日） 
55 ADB. 2015. Solomon Islands Country Gender Assessment. Manila: ADB.  
56 ibid. 
57 https://data.worldbank.org/indicator/SE.PRM.UNER.FE.ZS?locations=SB （最終アクセス 5 月 28 日） 
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を見ると、格差はそれほど大きくない。2016 年から 2019 年の間、中等教育レベル（中学校

と高校）ではより同等（parity）に近づき改善されているが、就学前教育や初等教育では僅

かに格差が広がっている（下表参照）。 

 

表 2-6 教育レベル別就学率の男女間格差（GPI）（2016～2019 年） 

レベル 2016 年 2017 年 2018 年 2019 年 

就学前教育 0.96 0.97 0.98 0.94 

初等教育 0.93 0.93 0.93 0.91 

中等教育（中学） 0.96 1.00 0.98 1.00 

中等教育（高校） 0.88 0.92 0.93 0.94 

注：記載はないが、GER を基にした GPI と思われる。 

出典：Solomon Islands Education Management Information System (SIEMIS)58 

 

3) 教育における男女間格差の要因 

 ソロモン諸島において、教育における男女間格差が生じる背景には、ジェンダー役割や男

性を優位とする社会文化的な考え方があり、経済的に苦しい家庭においては、特に男子の教

育が優先されるためである59。また、農村部では、中学校や高校が離れており、通学の場合

の交通手段が限られ、特に女子は、通学路における安全確保ができないことが就学の制約と

なっている60。さらに、中等教育を寮で生活しながら受ける場合、女子寮は男子寮と比べて

少ないことも、寮費等の経済的な負担に加え、女子の就学の制約となっている61。そのほか、

経済的な理由から婚資を目的に早期婚が行われる慣習がなお続いており、教育を受けるこ

とよりも結婚が優先されたり、10 代の妊娠が多く、妊娠すると退学する必要があることも、

男女間の就学率格差に多少影響していると思われる。 

 

2.2.5. 雇用・経済活動 

1）労働参加率・雇用率 

 2009年実施の国勢調査によれば、ソロモン諸島の 12歳以上の労働参加率は、男性が 63.5％、

女性が 62.2％、雇用率も男性が 61.9％、女性が 61％と、男女間で格差はあまりない。これ

は、人口の 8 割以上が暮らす農村部において、多くの女性が自給自足の農業に携わっている

からである。そのため、労働参加率および雇用率は、それぞれ男女ともに農村部の方が都市

部より高い。さらに、農村部では、無報酬の労働に従事している女性の割合が 80.6％と、男

性の 58％、都市部の女性の 38％より圧倒的に高くなっている（下表参照）。一方、報酬のあ

る職業に就く人の割合が高い都市部では、失業率が農村部に比べてとても高い（下表参照）。 

                                                        
58 Ministry of Education and Human Resources Development. 2019. Performance Assessment Report 2019. Honiara: 

MEHRD. の中で引用。 
59 Female Education in the Solomon Islands – BORGEN: https://www.borgenmagazine.com/female-education-in-

the-solomon-islands/ （最終アクセス 2021 年 5 月 28 日） 
60 ibid. 
61 ibid. 
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表 2-7 男女別の労働・雇用状況（居住場所別）（2009 年） 

 合計（％） 都市部（％） 農村部（％） 

男性 女性 男性 女性 男性 女性 

労働参加率 63.5 62.2 56.6 48.5 65.5 65.8 

雇用率 61.9 61.0 52.5 45.0 64.6 65.2 

失業率 2.5 2.0 7.3 7.1 1.3 1.0 

有報酬の 

労働従事 

50.7 26.0 87.7 62.0 42.0 19.4 

無報酬の 

労働従事 

49.3 74.0 12.3 38.0 58.0 80.6 

出典：National Statistics Office and Ministry of Finance and Treasury, the Government of Solomon 

Islands. 2014. 2009 Population and Housing Census Report on Economic Activity and Labor Force. 

Honiara: NSO. 

 

 ソロモン諸島では、男女ともに自給自足目的で農作物の栽培に従事する人の割合が最も高

い（男性 43.4％、女性 61.3％）62。また、商業目的の農業・漁業に従事する人の割合も、男

性は 2 番目に高く（9.1％）、女性は 3 番目に高い（7.6％）63。そのほか関連する仕事を含め

ると、男性の約 6 割、女性の約 7 割が農業・漁業に従事していることになる64。しかし、農

業・漁業の仕事の多くは、自給自足目的、自営業、あるいは無報酬で行われており、フォー

マル・セクターの仕事のように社会保障があるわけではなく、従事する人々は脆弱な立場に

ある65。こうした脆弱な仕事に就く人は農村部に多く、男性よりも女性が多い（下表参照）。 

 

表 2-8 脆弱な雇用状態にある労働者の割合（性別、居住場所別）（2009 年） 

 合計 都市部 農村部 

男性 女性 男性 女性 男性 女性 

脆弱な雇用の割合 54.1 75.3 21.0 40.7 61.8 81.5 

脆弱な雇用の割合
（自給自足含む） 

67.4 86.3 24.8 50.9 77.4 92.7 

出典：National Statistics Office and Ministry of Finance and Treasury, the Government of Solomon 

Islands. 2014. 2009 Population and Housing Census Report on Gender. Honiara: NSO. 

 

2）女性の雇用・起業に対する制約条件 

 ソロモン諸島では、他の途上国と同様に、女性がフォーマル・セクターで雇用されたり、

自ら起業して生計向上活動を行うためには、多くの障壁を取り除く必要がある。まず、共通

する障壁として、女性が、ジェンダー役割を基に、自給自足に関わる農作業、家事労働、子

育て・ケアワーク等の再生産活動を主に担っていることから、時間的制約があることがあげ

                                                        
62 National Statistics Office and Ministry of Finance and Treasury, the Government of Solomon Islands. 2014. 2009 

Population and Housing Census Report on Economic Activity and Labor Force. Honiara: NSO. 
63 ibid. 
64 ibid. 
65 ADB. 2015. Solomon Islands Country Gender Assessment. Manila: ADB. 
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られる66。また、男性優位の価値観から男子の教育が優先され、女性は、男性より教育レベ

ルや識字率が低いことも障壁となっている67。その結果、男性は「物事をよく理解した上で、

人前で話をすることがうまいので、意思決定を行うのは男性の役割」とするジェンダー偏見

やジェンダー役割が固辞され68、雇用機会や職場内での女性に対する差別が存在している69。 

起業や生計向上活動については、まず、ビジネスを始めるための環境が整っていないこと

が大きい。農村部では、自宅（付近）で農作物や製品を作って販売する場合、水道や電気等

のインフラの不整備、道路の不整備による輸送の問題、市場が近隣に設置されていない等の

問題があげられる70。また、農村部では、公的サービスとして受けられるビジネス情報や技

術支援が限られているが、特に女性は男性と比べて情報や普及サービス・研修へのアクセス

が限られている71。 

女性の起業や生計向上活動の大きな制約となるのが、女性の意思決定権、およびビジネス

を始めるための資金やそのためにローンを借りる際の担保の欠如である72。女性が何かビジ

ネスを始めたいと考えても、資金やローンの担保となる生産財（土地等）への権限を持たな

い女性は、夫等から許可を得ずには何もできない。ソロモン諸島では、意思決定は男性の役

割とされており、妻の収入であっても妻自身がその使い道を決められず、夫だけで決めたり、

夫と妻の二人で決めるケースが多い（下表参照）。この傾向は農村部で顕著で、一般的に、

女性の教育レベルが男女間の意思決定力に影響するといわれるように、中等教育以上の教

育を受けている女性が自分の収入の使い道を決める割合は、初等教育、中等教育を受けた女

性より高くなっている（下表参照）。教育を受けていない女性が最も高くなっているのは、

栽培した野菜等を市場で販売し、得られた収入で、そのまま同じ市場で売られている食料品

や日用品を購入しているためと考えられる。 

 

 

 

 

 

                                                        
66 1) ibid. 

2) FAO and the Pacific Community. 2019. Country Gender Assessment of Agriculture and the Rural Sector in 

Solomon Islands. Honiara: FAO and the Pacific Community. 

3) International Finance Corporation. 2010. Solomon Islands Gender and Investment Climate Reform Assessment. 

Washington D.C.: IFC. 
67 ibid. 
68 1) Monson, Rebecca. 2017. “The Politics of Property: Gender, Land and Political Authority in Solomon Islands.” 

in Kastom, property and ideology: Land transformations in Melanesia. Australian National University Press: 

Canberra. 

2) Monson, Rebecca. 2010. “Women, State Law and Land in Peri-Urban Settlements on Guadalcanal, Solomon 

Islands. in Justice for the Poor Briefing Note, Vol. 4, Issue 3 (April 2010). Washington D.C.: the World Bank. 
69 ADB. 2015. Solomon Islands Country Gender Assessment. Manila: ADB. 
70 ibid. 
71 ibid. 
72 ibid. 
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表 2-9 妻の収入の使い道にかかる意思決定権 

特徴 妻の収入の使い道を誰が決めるか（％） 

主に妻 二人で 主に夫 その他 ﾃﾞｰﾀ欠損 合計 

居住場所 

都市部 35.0 51.8 10.5 0.0 2.7 100 

農村部 22.9 58.5 10.2 0.1 8.2 100 

教育レベル 

無就学 40.6 46.7 9.3 0.0 3.4 100 

初等教育 21.5 58.2 10.9 0.2 9.2 100 

中等教育 26.5 57.2 10.5 0.0 5.6 100 

中 等 教 育
以上 

34.3 53.8 9.1 0.0 2.9 100 

合計 26.9 56.3 10.3 0.1 6.4 100 

注：2015 年実施の DHS の調査対象者である 15～49 歳の女性の中で収入を得ている女性 989

人が対象。 

出典：National Statistics Office and Ministry of Health and Medical Services. 2017. Solomon Islands 

Demographic and Health Survey 2015 Final Report. Honiara: NSO. 

 

一方、夫の収入への妻の権限は、さらに低い（下表参照）。また、妻と夫の間で、夫の

収入の使い道を決める権限が誰にあるかに関する認識は異なり、夫の 61.1%が夫婦で相談

して決める、18.1％のみが夫自身で決めると回答しているが、妻の中で、夫婦で決めてい

ると回答したのは 55％のみで、3 割近くが夫のみで決めていると回答している（下表参

照）。妻が、自身や夫の収入に権限が持てない背景には、元々のジェンダー規範やジェン

ダーによる力関係があるほか、夫による妻への暴力を恐れて妻が何も言えないという事情

もあると考えられる73。 

 

表 2-10 夫の収入の使い道にかかる意思決定権 

 男性（％） 女性（％） 

妻 二人 夫 その
他 

ﾃﾞｰﾀ
欠損 

合計 妻 二人 夫 その
他 

ﾃﾞｰﾀ
欠損 

合計 

都市 16.4 61.7 18.9 0.0 3.0 100 11.6 57.7 28.5 0.1 2.0 100 

農村 12.4 60.8 17.7 0.6 8.4 100 14.9 54.5 29.3 0.1 1.3 100 

合計 13.7 61.1 18.1 0.4 6.6 100 14.2 55.2 29.1 0.1 1.4 100 

注：2015 年実施の DHS の調査対象者である 15～49 歳の男女が対象で、男性の回答者数は

891 人、女性の回答者数は 3,880 人。 

出典：National Statistics Office and Ministry of Health and Medical Services. 2017. Solomon Islands 

Demographic and Health Survey 2015 Final Report. Honiara: NSO. 

 

起業には、ビジネスに必要な資金を確保するため、銀行等の金融サービスへのアクセスが

キーとなるが、農村部の女性は特に限られている。ソロモン諸島では、農村部には銀行が少

                                                        
73 ibid. 
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ない上に、銀行開設の条件に、正規の職業に就き、定期的な収入（給料）があることがあげ

られている74。結果、ソロモン諸島の全人口の 8 割が銀行口座を持っていない（2010 年）75。

また、セイビングやマイクロクレジット等の活動を行う NGO はあるものの、一部の地域に

限られている76。そのため、農村部の人々、特に女性は元々教育レベルが低いこともあるが、

金融リテラシーを上げることが重要といわれている77。そのほか、女性のコミュニケーショ

ン力や自信の醸成も不可欠とされている78。 

 

2.2.6. 農林業 

1）農林業におけるジェンダー 

上述のとおり、ソロモン諸島の全人口の 8 割以上が農村部に暮らし、そのほとんどが生計

を農林水産業に依存している79。農村部では、自家消費の目的で農業を営む世帯が全世帯の

96％、漁業を営む世帯が 69％にのぼる80。そのため、男性同様、女性の労働参加率も 66％と

高く、全農業就業人口の 46％を女性が占めている81。しかし、同じように農業に従事してい

ても、男女の役割は異なり、扱う農作物も異なる。ソロモン諸島では、男性は主に開園のた

めの木の伐採等、力のいる仕事を担い、女性は主に苗の植え付け、除草、収穫等を担ってい

る82。そして、女性は、主に食用作物（イモ類、根菜類、その他の野菜等）の栽培を担当し、

家庭消費の目的で非木材林産物（Non-timber Forest Products: NTFPs）の野生の果物や野菜等

も採取する83。男性は、女性を手伝うが、主に換金作物（ココヤシ、カカオ、コーヒー等）

の栽培の責任を負っている84。この違いが、男女間で得られる現金収入の格差を生み、元々

の不平等な力関係（ジェンダー関係）をさらに強くし、継続させているといえる。 

 女性が、換金作物の栽培に従事できない要因は、上述の女性が起業できない要因と同様で

ある。まず、女性は、家庭消費のための農作物の栽培に加え、家事や育児等の再生産活動が

忙しい。家事の中でも時間のかかる日々の薪拾いや水汲みは女性の仕事で、男性は時々薪用

に枝切りを行う程度である85。また、換金作物の栽培には新しい農業技術を習得する必要が

あるが、農村部では普及員によるサービスが限られ（2018 年の女性普及員は 140 人中 38

人）、教育レベルの低い女性は研修機会から排除される傾向にある86。それは、居住村外で開

                                                        
74 ibid. 
75 ibid. 
76 ibid. 
77 ibid. 
78 ibid. 
79 FAO and the Pacific Community. 2019. Country Gender Assessment of Agriculture and the Rural Sector in 

Solomon Islands. Honiara: FAO and the Pacific Community. 
80 National Statistics Office and Ministry of Finance and Treasury, the Government of Solomon Islands. 2014. 2009 

Population and Housing Census, Economic Activity and Labour Force. Honiara: NSO. 
81 ADB. 2015. Solomon Islands Country Gender Assessment. Manila: ADB. 
82 FAO and the Pacific Community. 2019. Country Gender Assessment of Agriculture and the Rural Sector in 

Solomon Islands. Honiara: FAO and the Pacific Community. 
83 ibid. 
84 ibid. 
85 ibid. 
86 ibid. 
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催される研修の場合、女性にとって、さらに時間と移動の制約があることにも因っている87。

さらに、換金作物の栽培にも、まず土地が必要で、苗を購入するための資金も必要となるが、

それらの権限を持つのは男性である場合が多い。そのほか養豚や養鶏等の生計向上活動を

始めるにも資金は必要で、そのためには男性から許可を得なくてはいけないケースが多い。

このように、女性に土地や資金の権限および意思決定権がないことは、不平等なジェンダー

関係の要因であり結果にもなっている。 

 

2）土地制度とジェンダー 

土地の種類 

ソロモン諸島の国土の約 87％が「慣習地（custom land）」で、残りの非慣習地は「譲渡地

（alienated land）」ともよばれる88。譲渡地には、政府が所有する公有地（public/crown land）

（8％）や永久・定期不動産（perpetual/fixed-term estates）（5％）がある89。慣習地も譲渡地

も、憲法上、その所有権はソロモン諸島の国民に限定されているが、議会の承認が得られれ

ば、外国人や外国の法人でも、「土地および土地権に関する法律（Land and Titles Act 1978）」

の規定に基づいて、一定期間（75 年間）所有することができる90。 

ソロモン諸島では、伝統的に部族・氏族の親族集団によって土地が所有されていたが、19

世紀末以降のキリスト教布教や植民地化を目指すヨーロッパ人の入植により、一部の土地

（国土の約 4.5％）がヨーロッパ人に渡ってしまった経緯がある91。このように、入植者や

植民地政府に渡った土地が譲渡地であり、主にココヤシの農園や植民地政府の関連施設が

作られた92。ヨーロッパ人とソロモン諸島の人々の間の土地をめぐる抗争を経て、植民地政

府は、1914 年に新たな土地の接収を規制した93。そして、1978 年のソロモン諸島の独立に

より、譲渡地の大部分は公有地となり、首都ホニアラや各州の州都として整備されたほか、

ココヤシやアブラヤシ農園として企業に賃借されている94。 

 

母系・父系制社会における土地制度 

 上述のとおり、ソロモン諸島の国土の 9 割近くの土地は、伝統的に部族・氏族の親族集団

によって集団所有されてきた慣習地である。慣習地の各土地の権利は、その土地が休耕中で

あっても、最初に切り開いた集団に帰属し続ける95。慣習地の土地権については、大きく分

                                                        
87 ibid. 
88 https://www.sheltercluster.org/resources/documents/solomon-islands-hlp-mapping-ifrc-australian-red-cross （最

終アクセス 2021 年 5 月 31 日） 
89 ibid. 
90 http://www.u.tsukuba.ac.jp/~sekine.hisao.gm/solomon/land.html （最終アクセス 2021 年 5 月 31 日） 
91 ibid. 
92 関根久雄. 2015. 「地域的近代を生きるソロモン諸島」第 1 章持続可能な開発―土地意識の覚醒と開発. 

筑波大学出版会. 
93 http://www.u.tsukuba.ac.jp/~sekine.hisao.gm/solomon/land.html （最終アクセス 2021 年 5 月 31 日） 
94 ibid. 
95 ibid. 
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けて、1 次的権利（primary right）と 2 次的権利（secondary right）がある96。1 次的権利は、

土地権を次世代に相続させる権利で、2 次的権利は生業活動を行ったり、住居を建てて居住

するための権利である97。 

これらの権利が、それぞれ親族集団の中で誰に付与されるかは、その親族集団が母系制に

則った集団か、父系制に則った集団かによって異なる。母系制社会とは、母方の血筋によっ

て家族や親族集団を構成する社会で、父系制社会はその対義語である。母系制社会では、母

親の集団からその血筋を引く女性構成員に第 1 次的権利と第 2 次的権利が継承され、男性

構成員には 2 次的権利のみ与えられる98。一方、父系制社会では、父親の集団からその血筋

を引く男性成員に 1 次的権利と 2 次的権利が継承され、女性成員には 2 次的権利のみ与え

られる99。 

ソロモン諸島では、州ごとに母系制社会と父系制社会に分かれる。9 つある州の内、5 州

（ガダルカナル州、イサベル州、マキラ州、中央州、西部州）が母系制を踏襲し、4 つの州

が父系制を踏襲している（下図参照）。 

 

 

出典：調査団 

図 2-1 ソロモン諸島で母系制度が踏襲されている州 

 

 

 

                                                        
96 関根久雄. 2015. 「地域的近代を生きるソロモン諸島」第 1 章持続可能な開発―土地意識の覚醒と開発. 

筑波大学出版会. 
97 ibid. 
98 ibid. 
99 ibid. 

母系制を踏襲する州 

1: 中央州 

3: ガダルカナル州 

4: イサベル州 

5: マキラ州 

9: 西部州 
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慣習法に基づく土地制度におけるジェンダー差別と女性の権限 

 一般的に、母系制社会では、母から娘（長女や末娘）に土地が相続されることから、女性

には土地にかかる権限や意思決定権があり、女性の地位が高いと考えられることが多い。父

系制社会の女性に比べると、母系制社会の女性の地位は高いといえるが、女性の地位が男性

の地位より高いということではない。これは、母系制は母権制ではないからで、多くの国の

母系制社会において、女性に与えられているのは名目だけの相続権で、実際は集団で土地の

所有や管理がなされている。何より、土地にかかる意思決定は母方の男性親族に委ねられて

いるケースがほとんどである。 

ソロモン諸島も例外ではない。同国では元々、公的な場所での意思決定は男性の役割とさ

れているため、母系制社会にも、「女性は土地に関して話をすることができない・話をする

べきではない、土地に関して協議する公の場所では、男性の後ろに控えているべきである」

とする社会規範があり、土地にかかる意思決定は男性（チーフ（Chief）に任命された母方の

男兄弟や息子）の役割とされてきた100。こうしたジェンダー偏見・規範に基づくジェンダー

役割は、必ずしもソロモン諸島で固有に形成・踏襲されてきた規範やカスタム（kastom）101

ではなく、19 世紀後半以降のキリスト教布教や植民地化のために入植したヨーロッパ人の

家父長制に基づく男性優位の考え方に影響を受けた結果でもある102。 

 ソロモン諸島の母系制社会で、女性の土地にかかる権限が限定的な理由として、その居住

方式もあげられる。他国の母系制社会とは異なり、ソロモン諸島では、母系制社会であって

も、居住方式は母方居住方式ではなく、父方居住方式が採られている。つまり、母方出自の

女性であっても、結婚の際、1 次的権利や 2 次的権利を有する土地を離れ、夫のところに嫁

ぐのが一般的とされる103。これは、伝統的に新郎側から新婦側に婚資が送られるため、新婦

が新郎のところに移り住むのが慣習となっている104からである。結婚で実家を離れても、彼

女たちが土地の権利を失うわけではないが、嫁ぎ先が遠ければ、土地にかかる協議への参加

は物理的に困難となる。仮に協議に参加しても、元々土地にかかる意思決定は男性の役割と

されていることから、女性が主体的に意思決定にかかわれることはない。土地の相続権を持

つ女性の息子が成人し、母方の村でチーフに任命されれば、彼がその村の土地の意思決定を

担うことになる。つまり、母系社会における女性の相続権は名目だけで、実質的な権限は女

性の男兄弟から息子の間で継承されているのである105。 

                                                        
100 Monson, Rebecca. 2010. “Women, State Law and Land in Peri-Urban Settlements on Guadalcanal, Solomon 

Islands. in Justice for the Poor Briefing Note, Vol. 4, Issue 3 (April 2010). Washington D.C.: the World Bank. 
101 筑波大学の関根久雄氏によれば、「カスタム（kastom）」は、ピジン語で、ソロモン諸島の人々の祖先

がキリスト教に改宗する以前に実践していた生活様式、社会制度、生業活動、物質文化などの総称を意味

する。 
102 1) ibid. 

2) International Women’s Development Agency. 2016. Women and Leadership in Solomon Islands. Washington D.C.: 

IWDA. 

3) ADB. 2015. Solomon Islands Country Gender Assessment. Manila: ADB. 
103 International Finance Corporation. 2010. Solomon Islands Gender and Investment Climate Reform Assessment in 

Partnership with AusAID. Washington D.C.: IFC. 
104 ibid. 
105 ADB. 2015. Solomon Islands Country Gender Assessment. Manila: ADB. 
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制定法に基づく土地制度におけるジェンダー差別とジェンダー・インパクト 

 ソロモン諸島の土地制度は、慣習法でも制定法106でも、母系制でも父系制でも、女性は男

性と同等の権利や便益を享受できていない。それは、土地にかかる意思決定権を男性がほぼ

独占していることが大きい。慣習的に親族集団で土地を所有する形態から、大きな現金収入

を見越して、外国法人等に土地を譲渡、または貸し出しすることになれば、それまでの親族

集団内の男女間の力関係、つまりジェンダー・ダイナミクスが大きく変わり、特に女性には

さらに不利に働く。ソロモン諸島では、現在土地を譲渡・貸し出しするためには、まず土地

の所有権者（集団）や土地境界を明確にし、譲渡にかかる交渉役を担う受託者（Trustees: 5

人以下）を所有権者の中から任命して、土地の登録を行う必要がある107。植民地時代にさか

のぼると、男性には英語を読み書きし話す能力があるとされ、土地にかかる協議はヨーロッ

パ人と男性の間のみで行われた108。現在は、男性の方が女性より教育レベルが高いため、土

地譲渡・賃借にかかる法制度を理解する能力が高いとされ、受託者にはチーフ109等の男性リ

ーダーのみが選ばれ、女性はその意思決定から排除されている110。 

 土地の譲渡・賃借にかかる意思決定から排除された結果、所有権者である女性は、本来享

受できる便益を享受できていない111。まず、協議や交渉の過程で、その内容が女性たちに共

有されることは少なく、これは、「女性には話しても理解できない、意思決定は男性の役割

である」とするジェンダー偏見・ジェンダー規範が影響している112。さらに、受託者の男性

たちが便益を独占するために、土地の所有権者として自分たちの名前だけを記載して土地

の登録を行うケースが少なくない113。同様に、譲渡・賃借する土地が森林である場合、森林

の木材の所有権者についても登録する必要があるが、その際受託者が自分たちの名前だけ

を登録しているケースもある114。結果、土地の譲渡金、賃借金、木材のロイヤルティ等の便

益が一部の男性に独占され、本来権利を有する女性はまったく便益を受けられていない115。

したがって、制定法による土地制度も、男性が「公的な場所で意思決定を行う」とするジェ

ンダー役割に基づいて、男性により一層有利となる制度になっている。 

                                                        
106 ソロモン諸島において、土地にかかる法律として、憲法、Land and Title Act 1978、Customary Land 

Records Act 1970 が制定されている。 
107 1) International Finance Corporation. 2010. Solomon Islands Gender and Investment Climate Reform Assessment. 

Washington D.C.: IFC. 

2) Monson, Rebecca. 2010. “Women, State Law and Land in Peri-Urban Settlements on Guadalcanal, Solomon 

Islands. in Justice for the Poor Briefing Note, Vol. 4, Issue 3 (April 2010). Washington D.C.: the World Bank. 
108 1) Monson, Rebecca. 2017. “The Politics of Property: Gender, Land and Political Authority in Solomon Islands.” 

in Kastom, property and ideology: Land transformations in Melanesia. Australian National University Press: 

Canberra. 

2) Monson, Rebecca. 2010. “Women, State Law and Land in Peri-Urban Settlements on Guadalcanal, Solomon 

Islands. in Justice for the Poor Briefing Note, Vol. 4, Issue 3 (April 2010). Washington D.C.: the World Bank. 
109 Rebecca Monson によれば、チーフは土地を所有する親族集団を代表するスポークスマン（シニア）。 
110 Monson, Rebecca. 2017. “The Politics of Property: Gender, Land and Political Authority in Solomon Islands.” in 

Kastom, property and ideology: Land transformations in Melanesia. Australian National University Press: Canberra. 
111 Monson, Rebecca. 2010. “Women, State Law and Land in Peri-Urban Settlements on Guadalcanal, Solomon 

Islands. in Justice for the Poor Briefing Note, Vol. 4, Issue 3 (April 2010). Washington D.C.: the World Bank. 
112 ibid. 
113 ibid. 
114 ibid. 
115 ibid. 
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2.2.7. 政治参加 

1） 女性候補者の擁立と女性国会議員・州議会議員の推進 

 ソロモン諸島では、先述のとおり、「公的な場所での意思決定は男性の役割、リーダーは

男性」とするステレオタイプのジェンダー役割の考え方が根深く、女性の政治参加があまり

進んでおらず、政治に女性のリーダーシップは発揮されていない。1978 年の独立以降、こ

れまでに国会議員を務めた女性は 4 人のみである116。2019 年に行われた総選挙の結果、現

在は国会議員の全 50 議席の内僅か 2 議席を女性が占めている117。一方、地方議会について

は、2019 年の総選挙の結果、全 172 議席の内 4 議席のみに留まっている118。さらに、首都

ホニアラの市議会については、全 12 議席の内 1 議席のみ女性が占めている119。 

女性の国会議員が一人も選ばれなかった 2006 年の総選挙後に、オーストラリア国際開発

庁（AusAID）が女性候補者の敗因分析を行ったところ、カスタムやキリスト教に基づくジ

ェンダー役割の考えが根深いこと、女性候補者自身の選挙キャンペーンを戦略的に策定し、

効果的にメディアを活用して支持者を集めるなどの選挙戦略を展開するための能力が不足

していたこと、女性候補者が十分な資金を獲得することが難しかったことなどがその大き

な要因と分析された120。 

こうした分析結果も踏まえ、ソロモン政府は、各政党の女性候補者擁立を推進する施策を

盛り込んだ「政党誠実法（Political Parties Integrity Act 2014）」を制定したが、女性国会議員

数の増加にはまだ結びついていない121。また、同法の規定に則って、2019 年の総選挙で女

性候補者を最終候補者の 10％以上擁立した政党は、全 13 政党中 4 政党のみであった122。し

かし、女性候補者数については、全 333 人の候補者中 26 人123（7.8％）で、前回の総選挙

（2014 年）時の 5.8％（全 447 人中 26 人）を上回った124。さらに、元々の女性候補者の中

で最終候補者に選出された女性候補者の割合は、2010 年の 24％から、2019 年には 65％に

大きく増加している125。 

 

                                                        
116 https://www.jp.undp.org/content/tokyo/ja/home/blog/essay/essay_47_kubota.html （最終アクセス 2021 年 6

月 3 日） 
117 https://devpolicy.org/attitudes-towards-womens-political-participation-in-solomon-islands-20200921/ （最終ア

クセス 2021 年 6 月 3 日） 
118 Batalibasi, C. et al. 2019. Public Perceptions of Women as Political Leaders: Views on Women’s Leadership and 

Temporary Special Measures in Solomon Islands. Honiara: Women’s Rights Action Movement (WRAM) & 

International Women’s Development Agency (IWDA). 
119 ibid. 
120 JICA. 2010. 「国別ジェンダー情報整備調査 ソロモン諸島 最終報告書」 
121 Batalibasi, C. et al. 2019. Public Perceptions of Women as Political Leaders: Views on Women’s Leadership and 

Temporary Special Measures in Solomon Islands. Honiara: Women’s Rights Action Movement (WRAM) & 

International Women’s Development Agency (IWDA). 
122 ibid. 
123 2019 年の総選挙の最終女性候補者 26 人の内 18 人が政党所属、8 人が無所属であった。 
124 https://www.pacwip.org/country-profiles/solomon-islands/ （最終アクセス 2021 年 6 月 3 日） 
125 Batalibasi, C. et al. 2019. Public Perceptions of Women as Political Leaders: Views on Women’s Leadership and 

Temporary Special Measures in Solomon Islands. Honiara: Women’s Rights Action Movement (WRAM) & 

International Women’s Development Agency (IWDA). 
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2） 政府の意思決定に携わる女性職員の割合 

ソロモン諸島の政府内で、意思決定できる職位に就いている女性職員の割合は非常に低

い。2014 年時点で、全政府職員に女性が占める割合は約 40％と高いものの、そのほとんど

が下級の職位に就いており、中間レベルの職位に就いている女性職員も 22％である126。ま

た、2009 年のデータでは、政府省庁の全 25 の事務次官（Permanent Secretary）のポストの内

女性が 5 つのポストに就いていたが（20％）127、2014 年時点では 24 あるポストの内 2 ポス

ト（8.3％）のみであった128。さらに、次官補（Under Secretary）についても、全 20 ポスト

中 3 ポストのみに女性が就いていた129。一方、司法制度においては、高等裁判所の裁判官に

女性はおらず、どの司法機関にも女性の指導者はいない130。 

 

3） 女性の政治・意思決定への参加の障壁 

ソロモン諸島では、法整備をはじめ、女性の政治参加を推進する環境は整いつつある。し

かし、文化や宗教に基づくジェンダー規範はなおも女性の政治参加や意思決定のポストに

就く上での障壁となっている131。723 人の男女を対象とした女性の政治参加に関する意識調

査の結果、回答者の 88％が女性も国会議員や州議会議員になるべきであると回答した132。

一方で、女性候補者に投票したことがあると回答した人は回答者の 5 人に 1 人であった133。

また、女性候補者に投票するにしても、女性候補者がとても有能な候補者でなければならな

いとし134、女性候補者には男性候補者以上の資質を求めていることがうかがえる。つまりダ

ブルスタンダードである。この背景には、回答者の多くが「政治は男の仕事」とするジェン

ダー役割に囚われている現状がある135。 

 

2.2.8. ジェンダーに基づく暴力・女性に対する暴力 

1）女性に対する暴力の多発の実態 

 ソロモン諸島では、女性に対する暴力・ジェンダーに基づく暴力（Violence against Women/ 

Gender-based Violece: VAW/GBV）の発生率が非常に高い136。VAW/GBV は、女性に対する差

別や男女間の力の不平等によって引き起こされ、女性や少女の身体的・精神的ダメージが大

                                                        
126 ADB. 2015. Solomon Islands Country Gender Assessment. Manila: ADB. 
127 International Finance Corporation. 2010. Solomon Islands Gender and Investment Climate Reform Assessment in 

Partnership with Aus AID. Washington D.C.: IFC. 
128 ADB. 2015. Solomon Islands Country Gender Assessment. Manila: ADB. 
129 ibid. 
130 ibid. 
131 International Finance Corporation. 2010. Solomon Islands Gender and Investment Climate Reform Assessment in 

Partnership with Aus AID. Washington D.C.: IFC.. 
132 ibid. 
133 ibid. 
134 https://devpolicy.org/attitudes-towards-womens-political-participation-in-solomon-islands-20200921/ （最終ア

クセス 2021 年 6 月 3 日） 
135 ibid. 
136 International Finance Corporation. 2010. Solomon Islands Gender and Investment Climate Reform Assessment in 

Partnership with AusAID. Washington D.C.: IFC. 
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きく、女性の経済活動への参加や少女の学校への通学の障壁にもなっている137。2009 年に

太平洋共同体事務局（Secretariat of the Pacific Community: SPC）が親密なパートナーを持つ

女性（15～49 歳）2,618 人を対象に行った調査（Family Health and Safety Study: FHSS）によ

れば、64％の女性が身体的暴力、性暴力、あるいは両方を親密なパートナーから受けたこと

があると回答した（下表参照）。また、その内 42％が、調査前の直近 12 カ月の間にいずれ

か、あるいは両方の暴力を受けたと回答した（下表参照）。また、こうした親密なパートナ

ーからの暴力（Domestic Violence: DV）の中で身体的暴力は、殴ったり、蹴ったり、武器を

使っての攻撃など、激しい形態の暴力が多かった（75％）138。 

 

 

出典：SPC. 2009. Solomon Islands Family Health and Safety Study. Honiara: MWYCA and NSO. 

図 2-2 女性（15～49 歳）が親密なパートナーから暴力を受けた割合（暴力の形態別） 

 

 親密なパートナーからの精神的な暴力も深刻である。ソロモン諸島では結婚している女

性の多くが自分で意思決定をすることができないとされている139。FHSS によれば、調査対

象の女性（15～49 歳）2,618 人のうち 58％が親密なパートナーから行動をコントロールされ

ていると回答している。その内容としては、パートナーが女性の所在を知りたがる（42％）、

他の男性と話すと怒る（32％）、女性が医療施設に行くことをコントロールする（32％）、女

性の不貞を疑う（31％）、があげられている。さらに、調査対象の女性の 19％が、自分の貯

金または収入を親密なパートナーにコントロールされたことがあると回答している140。こ

うした親密なパートナーによる女性の行動や収入のコントロールは、そのカップル間の力

関係を如実に表しており、それが女性に対する肉体的暴力や性的暴力につながっていく141。 

 

                                                        
137 ADB. 2015. Solomon Islands Country Gender Assessment. Manira: ADB. 
138 Secretariat of the Pacific Community. 2009. Solomon Islands Family Health and Safety Study: A study on 

Violence against Women and Children. Honiara: Ministry of Women, Youth & Children’s Affairs (MWYCA) and 

NSO. 
139 UN Women. 2011. Ending Violence against Women and Girls: Evidence, Data and Knowledge in Pacific Island 

Countries. Suva, Fiji: UN Women. 
140 Secretariat of the Pacific Community. 2009. Solomon Islands Family Health and Safety Study: A study on 

Violence against Women and Children. Honiara: Ministry of Women, Youth & Children’s Affairs (MWYCA) and 

NSO. 
141 ibid. 
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2）女性に対する暴力を容認・正当化する背景 

男性が女性を精神的、経済的にコントロールし、女性に対して暴力をふるう背景には、不

平等なジェンダー関係とそれに基づいて社会に深く根付く「女性はどうあるべき」とするジ

ェンダー規範がある。FHSS によれば、男性が妻やパートナーに暴力をふるう直接の理由は、

「妻・パートナーが伝統的なジェンダー役割を果たさない」、「食事や家事を時間内に終わら

せない」、「セックスを拒絶する」、「男性に対して反抗的・従わない」、であった。ほぼすべ

ての男性回答者が、「しつけの一環として女性に暴力をふるう」とし、「妻は男性に従うこと

を学ぶべきである」としている142。一方、女性も、社会に根付くジェンダー規範を受け入れ、

男性による暴力を容認している。女性回答者の 71％が、「男性は妻に対して誰が主人なのか

見せるべき」とする考えに同意している143。また、66％は「良い妻は、自分の考えは違って

も、夫に従うべきである」とし、40％は「妻は、やりたくない時でも夫とのセックスをする

べきである」に同意している144。女性が、夫による暴力を正当化する理由として、順に、「妻

が不貞を働いた」（63％）、「妻が夫に従わなかった」（41％）、「夫が妻の不貞を疑っている」

（27％）であった145。 

夫の妻に対する暴力の背景にある、夫婦間の不平等な力関係を形成し、強化しているのが、

結婚の際、新郎側から新婦側に送られる婚資とされている。FHSS において、多くの女性が、

男性による女性への暴力や差別は「婚資」に因ると回答した146。ソロモン諸島では、「婚資

によって、夫は妻を所有する権利を得るので、妻に暴力をふるうことも含め、好きなように

扱うことができる」と考えられているという147。そのため、婚資を伴わずに結婚した女性に

比べ、婚資の伴った結婚をした女性の方が 2.5 倍夫からの暴力を経験している148。さらに、

夫に暴力をふるわれても別れられない理由として、婚資が支払われていることをあげた女

性が多くいた149。 

 

3）女性が被害を相談できない理由 

ソロモン諸島では、他の途上国と同様に、被害女性は VAW/GBV の被害を警察に届けた

り、誰かに相談することができない傾向にある。その主な理由には、加害者や加害者家族か

らの脅迫への恐怖もあるが、女性に対する暴力が社会タブーであることから、被害が明るみ

に出ると、社会的に恥辱を受けることを恐れる女性や家族が多い150。実際、ソロモン諸島で

                                                        
142 ibid. 
143 ibid. 
144 ibid. 
145 ibid. 
146 ibid. 
147 UN Women. 2011. Ending Violence against Women and Girls: Evidence, Data and Knowledge in Pacific Island 

Countries. Suva, Fiji: UN Women. 
148 Secretariat of the Pacific Community. 2009. Solomon Islands Family Health and Safety Study: A study on 

Violence against Women and Children. Honiara: Ministry of Women, Youth & Children’s Affairs (MWYCA) and 

NSO. 
149 ibid. 
150 UN Women. 2011. Ending Violence against Women and Girls: Evidence, Data and Knowledge in Pacific Island 

Countries. Suva, Fiji: UN Women. 
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は、1998 年から 2003 年まで続いた民族紛争下、レイプ事件が多数発生したが、被害を受け

た既婚女性の中には、夫の家族に恥辱をもたらしたとして、補償金の支払いを要求される等、

不当な扱いを受けた女性もいた151。さらに、FHSS によれば、暴力の被害を受けたことがあ

る女性の 70%は、被害について誰にも話していないと回答している152。誰かに話したと回

答した女性は、両親（14％）や友人（13％）のみに話し、警察、医師、ヘルスワーカー、NGO

等には話していなかった153。外部に助けを求めない理由として、「暴力は特別ではなく日常

の出来事だから」（51％）、「夫との関係が終わるかもしれないから」（28％）、「家族に不名誉

をもたらすから」（20％）、があげられた。また、ソロモン諸島では被害女性に対する公的サ

ービスが限られ、ホニアラにあるシェルター（宿泊、カウンセリングサービス等）に助けを

求めるには、アクセスの問題、加害者による仕返しへの恐怖、暴力の被害が世間に知られる

ことによる恥辱・不名誉等がある154。 

 

2.3. 政府の取組と課題 

2.3.1. 関連する国際条約へのコミット 

ソロモン諸島政府は、1995 年の第 4 回世界女性会議で採択された北京宣言および北京行

動綱領を基に、ジェンダー平等・女性のエンパワメントの推進にコミットし、これまでに関

連する主要な国際条約の批准や地域協定に合意してきた。主な条約や協定は以下のとおり

である。 

 

1）女性（女子）差別撤廃条約 

ソロモン諸島政府は、2002年に女性差別撤廃条約（Convention on the Elimination of All Forms 

of Discrimination against Women: CEDAW）に批准している。CEDAW は、1979 年 12 月に開

催された第 34 回国連総会で採択された条約で、女性に対するあらゆる差別を撤廃するため

の対策を取り、男女の完全な平等を達成することを目的としている。2021 年 2 月現在、

CEDAW の締約国は 189 ヶ国にのぼる155。メラネシアの周辺国である PNG、バヌアツ、フ

ィジーは 1995 年に批准している。オーストラリア政府は 1983 年に批准し、日本政府は 1985

年に批准している。 

                                                        
151 ibid. 
152 Secretariat of the Pacific Community. 2009. Solomon Islands Family Health and Safety Study: A study on 

Violence against Women and Children. Honiara: Ministry of Women, Youth & Children’s Affairs (MWYCA) and 

NSO. 
153 ibid. 
154 UN Women. 2011. Ending Violence against Women and Girls: Evidence, Data and Knowledge in Pacific Island 

Countries. Suva, Fiji: UN Women. 

ソロモン諸島では、2013 年に設立された「National SAFENET Referral Network」(SAFENET)があり、被害

者・サバイバーに対するサービス（身体・精神的なケア、法的サービス等）が提供されている。

SAFENET は、運営にかかる規定として Standard Operating Procedures (SOP)も作成している。関係機関への

リファラルのシステムを作り、ケースマネージメントも行われている（WDD の Beijing+25 National 

Review Report より引用）。 
155 https://www.gender.go.jp/international/int_kaigi/int_teppai/kjoyaku.html （最終アクセス 2021 年 6 月 8

日） 
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CEDAW に批准した国は、その実施体制を整え、実施状況をモニタリングし、進捗状況を

4 年毎に CEDAW 委員会に報告することが義務付けられている。ソロモン諸島政府において

は、ジェンダー平等を推進するナショナルマシナリである女性・若者・子ども・家族課題省

（Ministry of Women, Youth, Children and Family Affairs: MWYCFA）が実施とモニタリングの

責任を担い、その諮問機関として 「ソロモン諸島 CEDAW 諮問委員会（Solomon Islands 

National Advisory Committee on CEDAW: SINACC)」が 2013 年に設置されている。MWYCFA

および SINACC は、CEDAW を進めるため、法務省、教育・人材省、保健・医療サービス省

等とは連携が取れているものの、人口が集中する農村部の女性のエンパワメントの推進に

欠かせない関係省庁（農業・畜産省、森林・研究省、環境・気候変動・災害管理・気象省等）

とはまったく連携が取れていない156。MWYCFA の人的資源不足、能力不足、予算不足等に

より、こうした関係省庁の主要政策へのジェンダー主流化の働きかけができておらず157、

CEDAW 実施の遅れにつながっている。CEDAW の進捗報告書は、2013 年に漸く第 1 次分か

ら第 3 次分までをカバーする統合報告書が提出された158。 

 

2）国連安保理決議 1325 号「女性・平和・安全」にかかる国内行動計画 

国連安保理決議 1325 号は、2000 年 10 月に国連安全保障理事会で採択された、女性と平

和・安全保障の課題を明確に関連付けた初めての安保理決議である159。この決議は、紛争下

の女性や少女を GVB や人権侵害から保護するだけでなく、紛争の予防や解決、平和構築や

平和維持における女性の役割を重視し、女性の意思決定段階への参画を推進することに焦

点を当てている。国連安保理決議 1325 号の加盟国は、国内行動計画（National Action Plan: 

NAP）を策定することが求められている。 

ソロモン諸島政府は、2017 年に NAP（2017-2021）を策定している。2021 年 6 月現在、

NAP はオーストラリアや日本を含め 80 ヶ国で策定されているが、ソロモン諸島以外の太平

洋島嶼国では策定されていない160。ソロモン諸島の NAP は、MWYCFA が、国家統一・和

解・平和省、警察・矯正・安全保障省、ロイヤルソロモン警察、国連女性機関（UN Women）、

国連開発計画（UNDP）の協力を得て作成した161。ソロモン諸島が、他の周辺国に先駆けて

NAP を策定した背景には、1998 年から 2003 年まで続いた民族紛争下に少女や女性が GBV

の被害を受けたことのほか、その解決や平和構築の意思決定段階から女性が排除されたこ

                                                        
156 FAO and the Pacific Community. 2019. Country Gender Assessment of Agriculture and the Rural Sector in 

Solomon Islands. Honiara: FAO and the Pacific Community. 
157 International Finance Corporation. 2010. Solomon Islans Gender an Investment Climate Reform Assessment in 

Partnership with AusAID. Washington D.C.: IFC. 
158 ソロモン諸島政府の CEDAW 統合報告書（第 1 回～第 3 回）：

file:///C:/Users/Nonoguchi/Downloads/N1354258%20(1).pdf （最終アクセス 2021 年 6 月 8 日） 
159 関連する国連安保理決議は、ほかに 1820 号（2008 年）、1888 号（2009 年）、1889 号（2009 年）、1960

号（2010 年）、2106 号（2013 年）、2122 号（2013 年）、2242 号（2015 年）、2467 号（2019 年）、2493 号

（2019 年）がある。 
160 https://www.securitywomen.org/united-nations/unscr-1325-and-national-action-plans-nap （最終アクセス

2021 年 6 月 8 日） 
161 http://1325naps.peacewomen.org/index.php/solomon-islands/ （最終アクセス 2021 年 6 月 8 日） 
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とへの反省がある。また、ソロモン諸島の NAP は、日本の NAP と同様に、紛争だけでなく

緊急事態（気候変動・自然災害）下の行動計画も含まれている。紛争や気候変動リスクの女

性へのインパクトが示され、女性が意思決定段階に参画することの重要性が言及されてい

る一方、市民社会の参加や NAP の実施にかかる予算付けが明確に示されていないと指摘さ

れている162。 

 

3）女性の地位向上とジェンダー平等のための太平洋プラットフォーム行動計画 

ソロモン諸島を含む太平洋諸島諸国（Pacific Island Countries and Territories: PICTs）は、北

京行動綱領の基礎となった「女性の地位向上とジェンダー平等のための太平洋プラットフ

ォーム行動計画（Pacific Platform for Action on the Advancement of Women and Gender Equality 

(PPA)」を 1994 年に採択している。PPA は、北京行動綱領の 12 優先課題と同様の 13 分野が

あげられていたが、2004 年にレビューされ、4 分野に集約された。4 分野は、「女性の地位

を向上させるメカニズム」、「女性の法的権利と人権」、「女性の保健や教育サービスへのアク

セス」、「女性の経済的エンパワメント」、である。2013 年にもレビューが行われ、最新版の

「ジェンダー平等と女性の人権のための太平洋プラットフォーム行動計画（Pacific Platform 

for Action for Gender Equality and Women’s Human Rights（2018-2030））」は、CEDAW や北京

行動綱領はもとより、2012 年に採択された「太平洋地域のリーダーによるジェンダー平等

宣言（Pacific Leaders’ Gender Equality Declaration: PLGED）」や持続可能な開発目標（Sustainable 

Development Goals: SDGs）も踏まえた内容になっている163。 

 

2.3.2. ジェンダー平等を推進する体制と課題 

1）ナショナルマシナリ 

 上述のとおり、ソロモン諸島において、政府内でジェンダー平等を推進するナショナルマ

シナリの役割を果たすのは MWYCFA である。2007 年に MWYCFA が設置されたが、それ

以前は、現在同省の中に統合されている女性開発局（Women Development Division: WDD）

が単体で女性支援の役割を果たしていた164。元々は、1964 年に設置された「Women Interest 

Office（WIO）」が始まりで、女性が伝統的に家庭内で担っていた役割（家族の福祉の改善）

から、女性を対象に料理、家庭菜園、裁縫、機織り、保健等の研修支援が行われていた165。

その後 WIO は WDD に格上げされ、2007 年に MWYCFA が設置され、その中に WDD が統

合された。MWYCFA（WDD）は、ジェンダー平等を推進するための政策や法律を整備し、

関連セクター・省庁でそれらが適切に実施・施行されるようにジェンダー主流化を図り、政

                                                        
162 https://www.securitywomen.org/unscr-1325-and-national-action-plans-nap/solomon-islands （最終アクセス

2021 年 6 月 8 日） 
163 https://www.spc.int/sites/default/files/wordpresscontent/wp-content/uploads/2017/09/PPA-2018-Part-I-EN2.pdf 

（最終アクセス 2021 年 6 月 8 日） 
164 Whittington, S. et al. 2006. Women in Government in Solomon Islands A Diagnostic Study. (JICA. 2010. 「国別

ジェンダー情報整備調査 ソロモン諸島 最終報告書」で引用) 
165 ibid. 
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策の実施状況を監督・モニタリングする役割を担っている。 

 MWYCFA では、事務次官（Permanent Secretary）がトップを務め、次官補（Under Secretary）

がその補佐役を担い、その下に管理や経理部門と公共サービス部門がある。公共サービス部

門としては「女性と開発」を担当する WDD、「研究・政策立案・情報」、「若者と開発」、「子

どもと開発」を担当する局（Division）が設置されている（下図参照）。MWYCFA の職員数

は、2010 年時点で 36 名であった166。同省ホームページによれば、WDD には、局長（Director）

1 名、ジェンダー平等・女性の開発コーディネーター（Gender Equality and Women’s 

Development Coordinator）1 名、VAW 撤廃コーディネーター（Eliminating Violence against 

Women Coordinator）1 名、国家研修コーディネーター（National Training Coordinator）1 名、

州女性開発オフィサー（Provincial Women Development Officers）4 名の計 8 名が配置されて

いる167。 

 

注：2021 年 6 月現在、MWYCFA のホームページでは、この表にある WDD のコーディネータ

ー職の名称が一部変更されている模様（CEDAW/GEWD Coordinator から GEWD Coordinator

へ、Events/Programs Coordinator から National Training Coordinator へ変更） 

出典：MWYCFA’s Corporate Plan 2015-2018 

図 2-3 MWYCFA の組織図 

 

                                                        
166 JICA. 2010. 「国別ジェンダー情報整備調査 ソロモン諸島 最終報告書」 
167 MWYCFA のホームページ：http://www.mwycfa.gov.sb/about-us/women-s-development.html （最終アクセ

ス 2021 年 6 月 8 日） 
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2）省庁間および地方レベルとの連携体制 

 中央レベルにおいて、関係省庁に対してジェンダー主流化を図る役割は、MWYCFA/WDD

が公共サービス省の協力を得ながら担っている。本来、ジェンダー主流化はナショナルマシ

ナリが担うべき役割であるが、公共サービス省が公共セクターにおける「ジェンダー平等・

社会的包摂政策（ドラフト）」の実施を担う責任官庁であることから、協力している168。関

連省庁へのジェンダー主流化および省庁間のネットワーク強化の戦略として、全 24 省の各

省にジェンダー・フォーカルポイントが任命されている169。公共サービス省は、このジェン

ダー・フォーカルポイントに対してジェンダー研修も行っている170。MWYCFA は、公共サ

ービス省の協力もあって、教育・人材省や保健・医療サービス省とは CEDAW 実施の連携体

制ができ、ジェンダー視点が組み込まれた政策も策定されている171。しかし、農村部の女性

のエンパワメントの促進に不可欠な、農業・畜産省や森林・研究省については、任命された

ジェンダー・フォーカルポイントが機能せず、連携も取れていないので、関連政策へのジェ

ンダー主流化は図られていない172。 

 地方レベルにおいて、ジェンダー平等・女性のエンパワメントの推進を担っているのは、

上図でも示した通り、MWYCFA の WDD に配置されている州女性開発コーディネーター（4

名）である。この 4 名が、ソロモン諸島にある全 9 州の内 7 州173と首都ホニアラを担当して

いる。同コーディネーターは、各州に設置されている州女性開発事務所（Provincial Women 

Development Office）を拠点に、コミュニティの女性を対象にジェンダー平等・女性のエンパ

ワメントにかかる研修や啓発活動を行う役割を担っているが、州政府からの予算は限られ、

こうした活動は行えていない174。また、対象州はそれぞれ広範な上に、1 人が 2 州を担当す

ることから、カバーしきれていないのが現状である175。 

 

3）市民社会との連携体制 

 CEDAW に基づくジェンダー平等・女性のエンパワメントの推進には、市民社会との連携

が不可欠である。特に人的資源や予算が限られている MWYCFA にとって、中央レベルで

NGO の取り纏め役を担う国家女性連合（National Council of Women: NCW）、さらに全州に設

置されている州女性連合（Provincial Council of Women: PCW）との連携は効果的であると思

われる。PCW は、州の下の Ward レベルにフォーカルポイントを置いていることから、女性

                                                        
168 WDD, MWYCFA, Solomon Islands Government. 2020. Beijing+25 National Review Report: the 2014-2019 

National Review Report on Solomon Islands Implementation of the Beijing Declaration and Platform for Action. 

Honiara: MWYCFA. 
169 ibid. 
170 ibid. 
171 本調査のローカルコンサルタントが 2021 年 1 月に行った WDD の Supervising Director への聞き取り内

容による。 
172 ibid. 
173 西部州、チョルス州、イサベル州、中央州、ガダルカナル州、テモツ州、マキラ・ウラワ州の 7 州。 
174 MWYCFA. 2014. Report Solomon Islands National Review on the Implementation of the Beijing Declaration and 

the Platform for Action & the Outcomes of the Twenty-third Special Session of the General Assembly. Honiara: 

MWYCFA. 
175 ibid. 



30 

 

へのリーチアウトが容易でもある。しかし、PCW は、一部の教会関係者、政府関係者、住

民等から非難・中傷を受けた後、内部対立もあって、機能しなくなったとする調査報告書

（2006 年）があるが、それ以降の状況は不明である176。 

 

4） ナショナルマシナリの課題 

CEDAW 委員会は、ソロモン諸島政府が提出した進捗報告書へのコメントとして、ソロモ

ン諸島政府が、「国家ジェンダー平等・女性の開発政策」をはじめとして、女性の経済的エ

ンパワメント、教育や保健サービスへのアクセス改善、VAW 撤廃にかかる重要な法律や政

策・戦略を整備してきたことについて、大きな成果として評価している177。また、MWYCFA

（WDD）がナショナルマシナリとして設置され、全省庁および州レベルにもジェンダー・

フォーカルポイントが任命・配置されていることについても、体制整備の面では評価した。 

しかし、CEDAW 委員会は、その実施体制が実際に機能するかどうかについて懸念点・問

題点をあげている。まず、MWYCFA は、中央レベルも州レベルにおいても人材や予算が限

られており、ジェンダー主流化やジェンダー平等の促進が難しいのではないかとしている

178。さらに、州レベルには専門的な知識を持った職員がおらず、女性の地位向上や保護の取

り組みができないのではないかと指摘している。次に、ジェンダー平等を推進するために不

可欠な関係省庁や州レベルの関係機関および市民社会との連携が取れていなことも問題視

している。さらに、「国家ジェンダー平等・女性の開発政策」や「国家女性と少女に対する

暴力撤廃政策」等の重要政策の実施状況や成果をモニタリング・評価するためのシステムが

構築されていないことも、問題点としてあげている。 

FAO は、2019 年に行ったソロモン諸島の国別ジェンダー分析において、MWYCFA のジ

ェンダー主流化・ジェンダー平等を推進するためのコミットメント、組織内の風土、能力、

予算等の評価を行っている。まず、コミットメントについて、WDD の職員のそれは高いも

のの、知識や技術力が低いため、政策立案に必要な包括的なジェンダー分析ができていない

ことを制約としている179。具体的には、性別データを基にニーズを分析し、関係省庁にその

分析結果を基にジェンダー視点を組み込んだ政策を策定するように働きかける技術力が不

足していると評価している180。組織内の問題としては、省内に子どもや若者を対象とする部

                                                        
176 International Women’s Development Agency. 2016. Women and Leadership in Solomon Islands. Washington 

D.C.: IWDA.  
177 Committee on CEDAW. 2014. “Concluding observation on the combined initial to third periodic reports of 

Solomon Islands.” available at “UN Treaty Body Database.” 
178 MWYCFA の予算は、他省と比較しても少なく、そのほとんどが職員の給料等のための経常費用で、開

発費の予算は非常に限られている（JICA.2010.「国別ジェンダー情報整備調査 ソロモン諸島 最終報告

書」より引用。また、MWYCFA が 2014 年に行った「Report Solomon Islands National Review」によれば、

同省の 2013 年の経常予算は約 SBD12,000,000 で、内約 SBD2,600,000 が WDD に配分されたが、これは職

員の給料等の経費で、開発予算としては、「Family Protection Act」実施にかかる予算として SBD500,000、

CEDAW や子どもの権利憲章にかかる予算として SBD1,000,000、「国家ジェンダー平等・女性と開発政

策」実施にかかる予算として SBD250,000 が割り当てられた。 
179 FAO and Pacific Community. 2019. Country Gender Assessment of Agriculture and the Rural Sector in Solomon 

Islands. Honiara: FAO and Pacific Community. 
180 ibid. 



31 

 

局があるため、限られた予算を WDD に持ってくるために、本来業務以上に時間と労力を使

わざるを得ないことも課題としている181。組織力の観点からは、政府内でMWYCFA（WDD）

の力が非常に弱いため、他省に対してジェンダー主流化を図れない構造的な問題があげら

れている182。MWYCFA（WDD）の限られた人材や予算の中でジェンダー主流化を図ること

は大きな挑戦としている。 

 

2.3.3. 関連法・政策の整備状況と課題 

1） 憲法 

ソロモン諸島の憲法は、独立年の 1978 年に可決され、2009 年に改定されている。同憲法

の第 2 章第 3 項では、個人の権利と自由の保護、さらに人種、性別、信条、出身地、政治的

見解に基づく差別からの保護が規定されている183。しかし、性別に基づく差別からの保護に

ついて、ジェンダーに基づく差別の包括的な定義がなされておらず、CEDAW 委員会は、

CEDAW との整合性を持たせるためにも CEDAW の定義を適用することを提言している184。

さらに、ソロモン諸島の憲法は、女性に差別的な慣習法に対して、法的地位を与えており、

女性に対するあらゆる差別の撤廃を掲げる CEDAW に準拠していない185。従って、慣習法

上は抵触しないが、憲法上は性別に基づく差別である場合、憲法に規定された平等の保障が

優先されるとする規定はない186。つまり、憲法上でさえ、男女平等は必ずしも十分に保障さ

れていないのである。 

 

2） ジェンダー関連法 

家族保護法（2014 年） 

ソロモン諸島では、ジェンダー関連政策は策定されているものの、関連法は非常に限られ

ている。その中で大きな成果と言えるのが、2014 年に成立し、2016 年に施行された「家族

保護法（Family Protection Act 2014）」である。それ以前、同国には DV の防止や被害者保護

にかかる法令はなく、慣習法によって女性（被害者）が不利な形で解決が図られていたこと

から課題とされていた187。同法では、家族を DV から保護し、DV 被害者の安全、健康、福

祉を推進することが規定されている。同法の施行によって、DV 被害者（女性、子ども、障

害者）の保護や法的なサービスへのアクセスが改善され、DV が人権侵害の行為であり、犯

罪であるとの認識が人々の間で高まってきた188。しかし、人的資源や予算が限られ、同法の

                                                        
181 ibid. 
182 ibid. 
183 ibid. 
184 Committee on CEDAW. 2014. “Concluding observation on the combined initial to third periodic reports of 

Solomon Islands.” available at “UN Treaty Body Database.” 
185 International Finance Corporation. 2010. Solomon Islands Gender and Investment Climate Reform Assessment in 

Partnership with AusAID. Washington D.C.: IFC. 
186 ibid. 
187 JICA. 2010. 「ジェンダー情報整備調査 ソロモン諸島国 最終報告書」 
188 WDD, MWYCFA, Solomon Islands Government. 2020. Beijing+25 National Review Report: The 2014-2019 

National Review Report on Solomon Islands Implementation of the Beijing Declaration and Platform for Action. 
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施行状況をモニタリングするシステムもなく、DV を審判する家庭裁判所がそもそも機能し

ていない等、同法の実施には課題が山積しているのも事実である189。 

 

刑法の改正（2016 年） 

 ソロモン諸島では、法律改革委員会が刑法の見直し作業を行い、2016 年にそれまでの刑

法が改正された。同委員会が見直しで焦点を当てたポイントは、レイプや近親相姦、DV、

強制わいせつや児童虐待等の定義を明らかにし、こうした性犯罪の被害者に正義がもたら

されるように関連する条項を改正することであった190。結果、改正刑法では、児童の商業的

搾取を含む性犯罪に対してより強い措置が規定された191。 

 

政党誠実法（2014 年） 

 ソロモン諸島では、国会議員に占める女性の割合が非常に低く、女性の政治参加が喫緊の

課題である。そのため、2014 年に、各政党が女性候補者を擁立して当選させる努力をする

べく、「政党誠実法（Political Party Integrity Act 2014）」が可決された。この法律では、各政

党が候補者の 10％以上を女性にすることを義務付けている。さらに擁立した女性候補が当

選した場合は、SBD10,000 のインセンティブが政府から政党に贈与されることになってい

る。しかし、2019 年の総選挙で、この法律の効力は限定的であった。女性候補者を 10％以

上にするクォータを守ったのは全 13 政党中 4 政党のみであったことから192、いかに法令順

守を徹底するかが課題である。ただし、「意思決定は男性の役割」とする強いジェンダー規

範や男女間の教育レベルの格差等の制約がある中、2019 年の総選挙で元々の全候補者の中

から最終候補者に選ばれて選挙を戦った女性候補者は 65％に上り193、女性候補者の意欲、

能力等は確実に向上しているといえる。 

 

3） 国家開発戦略（2016-2035 年） 

ソロモン諸島政府は、長期的な開発戦略として、「国家開発戦略（National Development 

Strategy: NDS （2016-2035））」を策定し、具体的な活動と予算を「中期開発計画（Medium Term 

Development Plan (MTDP)」に纏めている。NDS は、持続可能な形で、農林水産業や観光業

への投資機会を作り、経済成長することを目指している194。具体的には、5 つの主要目的と

して、1）持続可能で包摂的な経済成長、2）貧困削減、3）質の良い教育と保健サービスへ

                                                        
Honiara: WDD. 
189 ibid. 
190 JICA. 2010. 「ジェンダー情報整備調査 ソロモン諸島国 最終報告書」 
191 International Finance Corporation. 2010. Solomon Islands Gender and Investment Climate Reform Assessment in 

Partnership with AusAID. Washington D.C.: IFC. 
192 Batalibasi, C. et al. 2019. Public Perceptions of Women as Political Leaders: Views on Women’s Leadership and 

Temporary Special Measures in Solomon Islands. Honiara: Women’s Rights Action Movement (WRAM) and 

International Women’s Development Agency (IWDA). 
193 ibid. 
194 Ministry of Development Planning and Aid Coordination, Solomon Islands Government. National Development 

Strategy 2016-2035. Honiara: MDPAC. 



33 

 

のアクセス改善、4）効果的な災害リスク管理による強靭で環境的に持続可能な開発、5）安

定的で効果的なガバナンスと公的秩序による国家統一、を掲げている195。これらの目的を達

成することで、SDGs も達成されるとしている196。 

MTDP は、上記の NSD の 5 つの主要目的に沿って、全部で 15 の戦略（Medium Term 

Strategies: MTSs）から構成されている。NDS の 5 目的はどれもジェンダーに強く関係し、

細分化された15のMTSsの中にも、女性の役割から女性の意思決定段階への参画が必要で、

またジェンダー差別や格差があることからその是正が必要な分野が多数あるが、そうした

ジェンダー視点はまったく組み込まれていない。代りに、NDS の目的 2（貧困削減）の下に

ジェンダーに特化した戦略として MTS7 が立てられている。MTS7 の目的は、「ジェンダー

平等の推進と脆弱層の支援」としているが、女性自らが主体的に意思決定に参画し、開発の

担い手になるべく、女性のエンパワメントを図るための戦略にはなっていない。コミュニテ

ィの男性、市民社会、および政府が、脆弱層の女性、子ども、障害者の支援を行い、女性は

受け身で支援を受けるだけの扱いになっている。MTSs には、女性のエンパワメント視点が

欠如している。 

 

4） ジェンダー政策 

国家ジェンダー平等・女性の開発政策（2016-2020 年） 

ソロモン諸島では、ジェンダー平等を推進するための政策として、国家ジェンダー平等・

女性の開発政策（National Gender Equality an Women’s Development Policy: NGEWDP）が策定

されている。第 2 次で最新版の NGEWDP は 2016 年から 2020 年までをカバーしている。

元々、ソロモン諸島では、1998 年に「女性のための国家政策（National Policy for Women）」

が策定されていたが、民族紛争も重なり実施されないまま、2010 年に内容が見直され、最

初の NGEWDP（2010-2015）に置き換わった経緯がある197。NGEWDP（2016-2020）の目標

および優先的に目指す成果（Prioritized Outcomes）は下表の示すとおりである。NDS（2016-

2035）とは違い、NGEWDP はジェンダーと関係性が強い重点分野が網羅されている一方、

女性人口の大半が従事する農林水産業に特化した優先的に目指す成果は設定されていない。 

 

 

 

 

 

 

 

                                                        
195 ibid. 
196 ibid. 
197 MWYCFA, Solomon Islands Government. 2016. National Gender Equality and Women’s Development Policy 

2015-2020. Honiara: MWYCFA. 
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表 2-11 NGEWDP（2016-2020）の目標および優先的に目指す成果 

NGEWDP（2016-2020） 

目標 あらゆる分野やレベルにおいてジェンダー平等を推進し、ソロモン諸
島の男女が自らのニーズを満たし、福祉を向上させるために、平等な機
会や開発による便益にアクセスできる人権を十分に享受できるように
なること 

優先的に目指す
成果 

1. ジェンダー視点を組み込んだ（gender-responsive）政府事業やサー
ビス 

2. 女性の経済状況の向上 

3. あらゆる段階の意思決定、ガバナンス、リーダーシップへの男女の
平等な参画 

4. 女性・少女に対する暴力の防止と対策 

5. 平和と安全保障における女性の役割にかかる意識と認識の向上 

6. 教育へのアクセスの向上と支援的な学校環境の提供 

7. 女性のリプロダクティブ・ヘルス・ライツの向上 

出典：MWYCFA, Solomon Islands Government. 2016. NGEWDP 2016-2020. Honiara: MWYCFA. 

 

 上記の 7 つの優先的に目指す成果について、各成果の戦略と行動計画も示されている（下

表参照）。「女性の経済状況の向上」において、農林水産業に関する記載はなく、起業・ビジ

ネスのみに焦点が当てられている。 

 

表 2-12 NGEWDP（2016-2020）の優先成果を達成するための戦略と活動計画 

優先成果 戦略・活動 

1. ジェンダー視
点が組み込ま
れた政府事業 

 CEDAW や国内の関連政策・関連法が適切に実施されるため
に、ジェンダー分析報告書やデータを駆使して、関係省庁の
職員の啓発・意識向上を図る。 

 関係省庁に対して、性別データ収集システムの構築や見直し
のための技術支援を行う。 

 関係省庁が連携して、NGEWDP の実施状況をモニタリング、
レポーティングするための諮問委員会を設置する。 

 ジェンダー・フォーカルポイントを含め、ジェンダー平等を
推進するメカニズムを強化する。 

 

2. 女性の経済状
況の向上 

 インフォーマル・セクターで働く女性のために、マイクロ・
バンキングにかかる法律の整備を提唱する。 

 女性の土地所有を保障する政策を策定する。 

 異なる産業分野での女性の雇用機会を増やすため、政府の関
連政策等をジェンダー視点から分析する。 

 女性の市場や資金へのアクセスを増やすため、関係機関との
ネットワークを築く。 

 女性によるセイビング活動の成功事例を考察する。 

 関係する政府機関とともに、女性のために起業やビジネスに
かかる研修を行う。 

 地方の市場の施設や管理方法を改善する。 

 労働にかかる全レベルの交渉の場において、女性の可視化、
女性の声を強化する。 

 女性に対する社会の否定的な態度を取り除く啓発活動を行
い、女性のビジネスを強化する。 
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3. あらゆる段階
の意思決定、ガ
バナンス、リー
ダーシップへ
の男女の平等
な参画 

 選挙管理委員会事務所とともに、選挙法を見直し、対策を考
える（対策例：各政党の女性候補者の割合を今の 10％から
30％に引き上げる、国会議員に占める女性の割合を最低 30％
とするクォータを設ける等）。 

 州レベルの市民社会等の関係者とともに、政治家、コミュニ
ティのリーダー、住民に対して、女性が平等に意思決定に参
加し、リーダーシップを発揮することの重要性について啓発
活動を行う。 

 中央や州レベルの意思決定者やコミュニティのリーダーに対
して、ジェンダー研修、リーダー研修等を実施する。 

 女性や若者が潜在的に持っている、意思決定者としての能力
を見せる場として、模擬の議会を開催する。 

 特別措置として、国会、州議会、政党、政府において、女性
を意思決定できる職位に昇進させる。 

 民間セクターと連携を取る。 

4. 女性・少女に対
する暴力の防
止と対策 

 すべての州において、被害女性への支援サービスの質を保障
し、すべての女性（障害者も）がアクセスできるように、
SAFENET システムを強化する。 

 女性組織や市民社会が女性被害者を支援するために必要な技
術的な能力を強化する。 

 家族保護法（2014）に基づき、あらゆる暴力は犯罪であると
いうことが理解されるように、特に女性に情報を普及する。 

 暴力の防止に取り組む組織や市民社会等にかかるマッピング
を作成する。 

 暴力の防止に取り組む組織・市民社会の連携を強化する。 

5. 平和と安全保
障における女
性の役割にか
かる意識と認
識の向上 

 国連安保理決議 1325 号の NAP を実施する。 

 国家の安全保障に携わる政府機関による、女性の権利侵害を
どのようにモニタリング、対応、報告するかにかかる政策、
手順、実践、能力について評価を行う。 

 紛争の防止や和解のアプローチについて文書化し、女性の知
識を向上させるための支援を行う。さらに、国家や州レベル
の関係者間でその内容を共有する。 

6. 教育へのアク
セスの向上と
支援的な学校
環境の提供 

 調査研究を実施し、女子が中等教育を受けられないジェンダ
ー規範等を特定する。 

 教員の意識向上や教授能力の向上を図る対策を講じる。 

 女子が就学中に妊娠した際退学しないで済むような政策を導
入する。 

 性教育やリプロダクティブ・ヘルスに関する教育を推進す
る。 

 改定された教育カリキュラムに沿った学習マテリアルに、ジ
ェンダー偏見やステレオタイプが含まれていないことを確認
する。 

 教師、親、関係者の間で、女子教育の重要性について意識・
認識を上げる。 

 教師に対して、ジェンダー偏見やステレオタイプ、セクハ
ラ、VAW 等について啓発や研修を行う。 

7. 女性のリプロ
ダクティブ・
ヘルス・ライ

 保健・医療サービス省と連携して、ジェンダー分析を行った
上で、ジェンダー・バジェッティング、戦略的プランニング
や事業化を行う。 
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ツの向上  母子保健の状況を改善するため、教育と保健セクターの連携
を強化し、女子への性教育、リプロダクティブ・ヘルスに関
する教育を向上させる。 

 保健セクターのデータ収集、モニタリング、ジェンダー分析
を強化し、同セクターの成果を正確に評価したり、女性の保
健サービスへのアクセスの制約を特定する。 

 関係者間の連携や意識向上を目的に、リプロダクティブ・ヘ
ルス・ライツ分野の啓発活動に携わる機関のマッピングを行
う。 

出典：MWYCFA, Solomon Islands Government. 2016. National Gender Equality and Women’s 

Development Policy 2016-2020. Honiara: MWYCFA. 

 

女性・少女の経済的エンパワメントのための国家戦略（2015 年） 

 ソロモン諸島では、NDP、特に NGEWDP の優先的に目指す成果 2 の「女性の経済的

エンパワメント」に焦点を当てた「女性・少女の経済的エンパワメントのための国家戦略

（National Strategy for the Economic Empowerment of Women and Girls: NSEEWG (2015)」が策

定されている。2012 年に MWYCFA がソロモン諸島の女性の経済状況をデスクレビューし

た結果に基づき、女性の経済的エンパワメントを実現するための政策枠組としてこの戦略

が策定された198。具体的に、キーとなる 6 つの戦略が示されている（下表参照）。なお、

キー戦略の 1 番目で、ジェンダー主流化を図る「資源セクター」として農業と漁業があげ

られている一方、森林施業や林業はあげられていない（下表参照）。しかし、森林セクタ

ーにおける女性の役割や森林資源を活用したビジネスの可能性から、森林セクターへのジ

ェンダー主流化は不可欠で、他の戦略（女性に対する金融サービス、金融リテラシーやビ

ジネスにかかる研修の支援）も、アグロフォレストリー等の生計向上活動にも共通して必

要で有効的な戦略である。 

 

表 2-13 女性・少女の経済的エンパワメントのための国家戦略の 6 つのキー戦略 

キー戦略の内容 

1 特に農村部の女性・少女が従事する農業や漁業と深く関係する資源セクターへの
ジェンダー主流化 

2 特にインフォーマル・セクターにおける金融リテラシー、セイビングのスキー
ム、金融サービスへのアクセスの改善を通じた金融包摂 

3 女性ビジネス協会（Solomon Islands Women’s Business Association: SIWBA、他国に
おける女性商工会議所にあたる）が女性に対して起業やビジネス研修を提供でき
るように支援 

4 マイクロ・バンキング、フォーマル・セクターの労働市場における平等な雇用機
会、女性の土地権・財産権の保障にかかる法整備 

5 調査研究・知識の共有 

6 MWYCFA の組織能力の強化 

出典：MWYCFA. 2015. A National Strategy for the Economic Empowerment of Women and Girls. 

Honiara: MWYCFA. 

                                                        
198 MWYCFA. 2015. A National Strategy for the Economic Empowerment of Women and Girls. Honiara: MWYCFA. 
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NSEEWG は、ソロモン諸島政府がそれ以前に策定した経済開発戦略・政策とは異なり、

ジェンダー視点が全体に組み込まれ、ジェンダー主流化が図られている199。同国家戦略

は、女性の経済的エンパワメントは、女性の権利にかかる認識を高めるため、また国家開

発目標である経済成長、貧困削減、教育や保健の社会サービスの充実を達成するために不

可欠としている200。つまり、女性が経済的エンパワメントを遂げる過程で、女性自身が女

性の権利を享受できるようになり、現金へのアクセスやコントロールが増すことで、世帯

レベルの貧困削減、国家レベルの経済成長や生産性の向上につながるとしている201。ま

た、女性が経済的エンパワメントを遂げるためには、能力（ability）、力（power）、主体性

（agency）が必要としている。つまり、前提条件としてスキルと資源が必要で、さらにそ

の資源や得られた利益を自分でコントロールでき、自分のスキルを駆使して、どうするか

を自分で決めて行動できるようになることが「エンパワメント」としている202。 

NSEEWG では、6 つのキー戦略に沿って行動計画も策定されている。行動計画の実施に

は、責任官庁の MWYCFA（WDD）のほか、関係省庁として開発計画・援助調整省、財務

省、農業・畜産省、漁業・海洋資源省、農村開発省、観光省、土地・住居調査省、さらに

市民社会、および UN Women や UNDP が参加している203。森林・研究省は、関係省庁とし

て参加していない。同計画の実施状況のモニタリング役は、MWYCFA の研究・政策立

案・情報局が担っている204。 

 

国家女性・少女に対する暴力撤廃政策（2016-2020 年） 

 ソロモン諸島では、上述の通り、家族保護法が 2014 年に成立し、2016 年に施行される

にあたり、「国家女性・少女に対する暴力撤廃政策（National Policy to Eliminate Violence 

against Women and Girls: NPEVAWG (2016-2020)」が策定された。NPEVAWG は、優先して

目指すべき成果として 5 つあげている（下表参照）。 

 

表 2-14 国家女性・少女に対する暴力撤廃政策（2016-2020）における優先して目指すべ

き成果 

優先して目指すべき成果の内容 

1 全体的な予防戦略の結果として女性や少女に対する暴力が減少する。 

2 法的枠組、法律の執行、司法制度が強化される。 

3 被害者・サバイバーの医療・法的・保護サービスへのアクセスが改善される。 

4 加害者の責任が適切に問われる。 

5 国家がコミットし、関係機関内の調整が改善される。 

出典：MWYCFA. 2016. National Policy to Eliminate Violence against Women and Girls (2016-

2020). Honiara: MWYCFA. 

                                                        
199 ibid. 
200 ibid. 
201 ibid. 
202 ibid. 
203 ibid. 
204 ibid. 
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 NPEVAWG は、課題のひとつとして、特に農村部の女性の多くが、VAW が犯罪で、政府

はその撤廃に向けてコミットし、法律、政策、サービスの実施が認識されていないことを

あげている。課題解決のためには、コミュニティ・レベルでの啓発活動による予防戦略の

ほか、上述のとおり、政府および市民社会によるリファラル制度の SAFENET に関する情

報普及も重要である。 

 

5） 森林、農業、気候変動対策にかかる政策 

国家森林政策（2020 年） 

 森林・研究省は、2020 年に「国家森林政策（National Forestry Policy）（2020）」を策定した。

同政策は、森林資源や生態系が持続可能な形で管理されることで、国民の便益や強靭化に寄

与することを目的としている205。同政策は、7 戦略・17 ゴールから構成されている206。その

中で、3 番目の「能力開発（Capacity Development）」戦略下に設定されたゴール 6 は、ジェ

ンダーに特化した「ジェンダー平等およびコミュニティのエンパワメントのための能力構

築」となっている。これがさらに細分化・具体化されたゴールとして、6.1、6.2、6.3 が設定

されている207（下表参照）。 

 

表 2-15 国家森林政策（2020）におけるジェンダーに特化した戦略とゴール 

 戦略 ゴール 

A 森林保護 Goal 1: 生物多様性や森林の生態系の保護 

Goal 2: 持続可能な生計のために生態系の重要性を認識 

B 持続可能な森林管理 Goal 3: 統合ランドスケープ計画作成のための空間分析 

Goal 4: 持続可能な森林管理実施のための一貫した森林法 

C 能力開発 Goal 5: 技術的なスキルと森林の専門知識の構築 

Goal 6: ジェンダー平等とコミュニティのエンパワメント
のための能力構築 

6.1 森林管理、森林再生、持続可能なアグロフォレストリ
ーに関する技術研修にジェンダー視点を組み込むよう推進 

6.2 森林管理や中小・零細企業開発に必要な金融やビジネ
ス研修にジェンダー視点を組み込むよう推進 

6.3 森林・環境関連法、土地利用権に関する研修にジェン
ダー視点を組み込むよう推進 

D 森林経済と市場 Goal 7: 国の林業と関係企業の強化 

Goal 8: 森林プランテーション 

Goal 9: 長期的に持続可能な税、歳入 

Goal 10: 関係経済や生計向上の多角化 

Goal 11: 収穫や輸出にかかる規定 

E コミュニティ・ガバナ
ンス 

Goal 12: コミュニティのガバナンスとエンパワメント 

Goal 13: コミュニティによる森林管理とプランテーション 

F モニタリングと法の
執行 

Goal 14: 情報共有や合法的なコントロールのためのモニタ
リング 

                                                        
205 インターネットで、国家森林政策（2020）のデータは入手できず、森林・研究省のホームページに掲

載されている「Corporate Plan 2020-2022」に抜粋された同政策の戦略とゴールの内容を引用。 
206 ibid. 
207 Goal 6 は、6.4 まで設定されているが、6.4 はコミュニティ住民の環境に関する知識を向上させるため

に地域の教育機関と連携を取るという内容で、直接ジェンダーには関係ない。 
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Goal 15: 法の執行 

G 透明性、労働条件、イ
ンセンティブ、誠実性 

Goal 16: 腐敗撲滅のための透明性 

Goal 17: 公正でバランスの取れた持続可能な雇用条件とサ
ービスのスキーム 

 出典：森林・研究省「Corporate Plan 2020-2022」 

 

本来、国家森林政策の全体にジェンダー視点が組み込まれるべきで、ジェンダーにかかる

目標がジェンダー視点を組み込んだ能力開発（gender inclusive technical capacity development）

のみに特化されているのは問題である。同政策がインターネット上で公開されておらず、そ

の中身を確認できないことから不明であるが、Goal 6 に、ジェンダー視点を組み込んだ能力

開発を設定した背景や理由は何か、またジェンダー分析が行われ、その結果がこの目標に反

映されているのか否か等について確認の必要がある。 

 森林・研究省は、国家森林政策に沿って、担当部署ごとの行動計画を作成し、「Corporate 

Plan 2020-2022」に取り纏められている。しかし、この計画において、Goal 6 の「ジェンダ

ー平等とコミュニティのエンパワメントの能力構築」にかかる活動内容を担当する部署は

不明で、また具体的な活動計画の記載もない。 

 

国家農業・畜産政策（2015-2019 年）およびソロモン諸島農業・農村開発戦略（2007 年） 

 ソロモン諸島の農業・畜産省は、「国家農業・畜産政策（National Agriculture and Livestock 

Policy: NALP）（2015-2019）」を策定している。NALP には 4 つの目標が示されている。それ

らは、1）食糧安全保障の達成、2）農村部の生計向上、3）輸入代替のための農業改善、4）

貿易促進、である。農業における女性の役割は大きいが、NALP には、ジェンダー分析に基

づくジェンダー視点が組み込まれていない208。NALP では、女性は脆弱層のカテゴリーに入

れられていることから209、農業を主体的に行っている女性の役割は無視され、上記 4 目標を

達成していく上で重要なステークホルダーとしては捉えられていないことが分かる。上述

の女性の経済的エンパワメントを目的とする NSEEWG にはジェンダー視点が組み込まれ、

農業・畜産省もその行動計画に参加しているにもかかわらず、NALP は NSEEWG と整合性

が取れていないことになる。 

 一方、開発計画・援助調整省が、世銀の支援を受けて、2007 年に策定した「ソロモン諸島

農業・農村開発戦略（Solomon Islands Agriculture and Rural Development Strategy: SIARD（2007）」

には、ジェンダー視点が組み込まれている210。SIARD では、女性が農業や農村コミュニテ

ィにおいて果たしている役割にもかかわらず、農業研修やニーズの聞き取りの機会から排

除されていること、さらに慣習的な土地権により周縁化（マージナライズ）されていること

を踏まえて、戦略が立てられている211。SIARD は 2007 年策定のため古いが、こうしたジェ

                                                        
208 FAO and Pacific Community. 2019. Country Gender Assessment of Agriculture and the Rural Sector in Solomon 

Islands. Honiara: FAO and PC. 
209 ibid. 
210 ibid. 
211 ibid. 
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ンダー分析結果（農業における女性のジェンダー役割に反して研修機会のジェンダー格差

等）は、NALP の策定時にも共通する課題であったことから、SIARD の内容を引用・活用し

て、ジェンダー視点を組み込んだ NALP が策定されるべきであった212。 

 

国家気候変動政策（2012-2017 年） 

 環境・気候変動・災害管理・気象省は、太平洋共同体や World Fish の支援を受けて、「国

家気候変動政策（National Climate Change Policy (2012-2017)」を策定している213。同政策で

は「政策指針の原則」として 9 項目あげられ、その中に「ジェンダー正義、若者・子ども・

障害者の参加（Gender equity, involvement of youth, children, and people with special needs）」が

含まれている214。そのため、MWYCFA は、同政策のワーキング・グループの下に設置され

たテーマ別ワーキング・グループの中で「脆弱性、災害リスク削減、適応」と「緩和、温室

効果ガスのインベントリー」に参加し、ジェンダー主流化に努めている215。まず、国家気候

変動政策の中で「8.3 脆弱性と適応、および災害リスク管理」の戦略のひとつとして、「ジェ

ンダー分析を行い、脆弱性を含む災害リスク評価、適応策にジェンダー視点を組み込む、脆

弱層の能力構築のために、女性や若者の参加をすべてのレベルにおいて積極的に働きかけ

る」が挿入されている216。同様に、「8.4 緩和」の戦略のひとつとして、「ジェンダー分析を

行い、ジェンダー視点を緩和策の計画に組み込む」が挿入されている217。 

  

                                                        
212 ibid. 
213 ADB. 2015. Solomon Islands Country Gender Assessment. Manila: ADB. 
214 MCCDMM. 2012. National Climate Change Policy. Honiara: MCCDMM. 
215 国家気候変動政策の Annex 6 National Climate Change Thematic Working Group: Membership, Scope and 

Role により。 
216 国家気候変動対策の pp.22。 
217 国家気候変動対策の pp.24。 
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第3章 調査サイトにおけるジェンダーと森林資源管理の現状 

3.1. フィールド調査の概要および調査結果 

3.1.1. 調査の概要 

1） 調査目的 

本調査のフィールド調査では、まず、SI-SFRM のパイロット活動の対象 2 村落（ガダル

カナル州コムニボリ村とマライタ州ファラケ村）におけるジェンダーによる男女間の違い

を明らかにすることに焦点を置いた。具体的には、生産活動・再生産活動における役割、森

林資源を含む自然資源へのアクセスとコントロール、収入や資源の使い道等にかかる意思

決定権の男女間の違いである。これは、こうした男女間の違いによって、パイロットサイト

の女性たちが SI-SFRM の森林管理、アグロフォレストリー、その他の生計向上活動の意思

決定段階から参加し、経済的エンパワメントやリーダーシップの醸成を目指す際、どのよう

な制約となり、反対に強みとなるのかについて分析するためである。最後に、分析された制

約を軽減するための対策を含め、パイロットサイトの女性たちの積極的な意思決定段階へ

の参画、経済的エンパワメント、リーダーシップを推進するために効果的なアプローチや取

組を考察することを目指した。 

 

2） 調査手法 

上述の調査目的を達成するため、フィールド調査では定性的な調査手法を採用した。得ら

れた情報の正確性や信頼性を高め、クロスチェックの機能が働くように、複数の定性的な調

査手法を組み合わせた。それらは、各パイロットサイトやその住民についてよく把握してい

るチーフや女性リーダーを対象としたキーインフォーマント・インタビュー（KII）、次に SI-

SFRM のパイロット活動に参加している女性グループ、男性グループを対象としたフォーカ

スグループス・インタビュー（FGI）、さらに KII と FGI で得られた情報を基に、焦点を絞り

込んだ項目の詳細情報を得るために FGI に参加した女性数名へのインデプス・インタビュ

ー（IDI）、の 3 種類の手法を駆使して、インタビュー調査を行った。 

インタビューは、それぞれ事前に質問票を作成したが、semi-structured の形式を採用した。

つまり、インタビューの冒頭は質問票に沿って質問を行うが、途中、参加者の応答の内容に

よっては質問を変え、また重要な情報になると思われる際は類似の質問を重ねて深めてい

く等の進め方である。また、各種インタビュー用に作成した質問票は、参加者にとって答え

やすいかどうかを見極めるため、事前にテストを行い、問題のある質問は修正した。全ての

インタビューは、参加者から許可を得て、録音し、テープを起こしてトランスクリプトを作

成した。同じパイロットサイトのトランスクリプトに共通して頻繁に出てくる言葉や表現

をキーワード、あるいはキーポイントとして、その意味するところの分析に努めた。 

KII および FGI を通じて、以下の調査項目がカバーされている。 
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(a) 各パイロットサイトの社会経済的な状況（人口、世帯数、氏族の種類、男女の

主な職業、世帯別収入、男女の教育レベル等） 

(b) 各パイロットサイトの意思決定システム 

(c) 土地制度 

(d) 森林資源（NTFPs）と森林管理のやり方 

(e) 農業（農業手法、農作物、販路） 

(f) 自然資源（水資源、森林資源、土壌等）の変化 

(g) ジェンダー役割とジェンダー関係 

 生産（農業、森林管理、畜産）活動と再生産活動（水汲み、薪拾い、

家事、ケアワーク）における男女の役割と 1 日の労働スケジュール 

 男女がそれぞれ担当する農作物や森林資源 

 男女の土地や森林資源へのアクセスとコントロールの違い 

 男女の意思決定権の違い 

 男女の研修・普及サービスや金融サービスへのアクセスの違い 

(h) 各パイロットサイトで組織化されている住民グループや市民組織 

(i) 政府や NGO による支援 

(j) SI-SFRM のパイロット活動への参加の有無と理由 

(k) 各パイロットサイトのニーズ 

 

 一方、IDI は、上記の項目に沿って得られた情報の中で、本調査の重要なポイントである

にもかかわらず不明点があったり、より深く追求する必要があると思われた項目のみに焦

点を当てて実施した。IDI で焦点を当てた項目は以下のとおりである。 

 

(a) 母系・父系制社会における土地の所有権と意思決定権（男女間、女性間の違い） 

(b) 農作物ごとの男女の年間作業スケジュール 

(c) 収入の使い道・買い物に対する男女の意思決定権の違い 

(d) パイロット活動の進め方（SI-SFRM スタッフ・チーフによる住民への情報の

普及の仕方、サイトの意思決定システム（各種委員会）を新たに設置し、メン

バーを選ぶ際のスタッフによるファシリテーションの仕方、スタッフによる

パイロット活動にかかる意思決定のファシリテーションの仕方、スタッフに

よる女性の参加推進の有無、参加推進がなされた場合のやり方、パイロット活

動内でのリーダーシップ研修の進め方等）、それらに対する住民男女の反応 

 

なお、詳細については、別添 1 の各種インタビューの質問票を参照されたい。 
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3） 調査サイト、調査日程、調査参加者 

フィールド調査は、上述のとおり、SI-SFRM のパイロット活動の対象地域である 2 村落

で行われた。2 村落は、ガダルカナル州コムニボリ村とマライタ州ファラケ村である。各村

落において、2 月に KII と FGI を行い、4 月に IDI を行った（下表参照）。 

 

表 3-1 フィールド調査の日程 

日程 対象村 調査の種類と参加者数 

2021 年 2 月 9 日～10 日 Komuniboli キーインフォーマント（4 人）とフォーカ
スグループス（女性グループ 3、男性グル
ープ 2） 

2021 年 2 月 22 日～24 日 Falake キーインフォーマント（4 人）とフォーカ
スグループス（男女各 3 グループ） 

2021 年 4 月 14 日 Komuniboli インデプス・インタビュー（2 人） 

2021 年 4 月 22 日～24 日 Falake インデプス・インタビュー（4 人） 

出典：調査団 

 

 各インタビューの参加者の人数やバックグラウンドは下表に示すとおりである。 

 

表 3-2 各種インタビュー参加者数とバックグラウンド 

対象村 ｲﾝﾀﾋﾞｭｰの種類 参加者 

コムニボリ ｷｰｲﾝﾌｫｰﾏﾝﾄ 

（4 人） 

男性 ：60 歳、チーフ、初等教育 

女性①：32 歳、女性リーダー、中等教育 

女性②：不明、女性リーダー、初等教育 

女性③：38 歳、女性リーダー、中等教育 

ﾌｫｰｶｽｸﾞﾙｰﾌﾟｽ 

（26 人） 

女性 G①：5 人（初等 4 人、中等 1 人）（農業 5 人） 

女性 G②：4 人（初等 2 人・中等 2 人）（農業 5 人） 

女性 G③：4 人（教育レベル、職業、年齢不明） 

男性 G①：6 人、30～52 歳、（農業 4 人、運転手 1 人） 

男性 G②：7 人（農業 7 人） 

ｲﾝﾃﾞﾌﾟｽ 

（2 人） 

女性①：女性 G①に参加した女性 

女性②：女性 G②に参加した女性 

ファラケ ｷｰｲﾝﾌｫｰﾏﾝﾄ 

（4 人） 

男性 ：男性リーダー、60 歳、大学 

女性①：女性リーダー、年齢不明、大学 

女性②：女性/若者リーダー、27 歳、大学 

女性③：女性/若者リーダー、24 歳、中等教育 

ﾌｫｰｶｽｸﾞﾙｰﾌﾟｽ 

（39 人） 

女性 G①：6 人、年齢不明（学生 3 人、農業 3 人） 

女性 G②：6 人、年齢不明（学生 1 人、農業 5 人） 

女性 G③：6 人、年齢不明（農業 6 人） 

男性 G①：7 人、年齢不明（政府職員 1 人、農業 6 人） 

男性 G②：8 人、年連不明（大工 2 人、農業 5 人、建設
業 1 人） 

男性 G③：6 人、年齢不明（農業 5 人、機械工 1 人） 

ｲﾝﾃﾞﾌﾟｽ 

（4 人） 

女性①②③：女性 G②に参加した女性 3 人 

女性④：女性 G③に参加した女性 

出典：調査団 
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3.1.2. 社会経済事情 

1) コムニボリ村 

地理 

 コムニボリ村は、ガダルカナル州の東北部に位置する小規模なコミュニティである。首都

ホニアラからは約 60 キロの距離で、車では 1 時間ほどでアクセスできる。 

 

人口・部族と氏族 

 KII の結果によれば、コムニボリ村の 2020 年時点の全人口は 124 人（男性 64 人、女性 60

人）であった。世帯数は 25 であるが、3 つの氏族に分かれており、まずコムニボリの土地

を所有する氏族である「Chaobata（Lunga）」が 10 世帯を占め、残る 15 世帯の内 10 世帯が

「Nekama」、5 世帯が「Thogo」となっている。また 25 世帯の内 3 世帯が女性世帯主世帯で、

すべて夫を亡くした女性が世帯主となっている。また、コムニボリでは核家族世帯が増えつ

つあるが、まだ大家族の世帯もあるとのことで、理由はさまざまである。キーインフォーマ

ントによれば、年老いた両親を看るために息子や娘の家族が一緒に暮らしていたり、自分た

ちの家を建てている間一時的に両親と一緒に暮らしているケースもあるという。 

 

生業と収入 

 コムニボリの主な生業は農業である。しかし、KII および FGI で、世帯ではなく、男女そ

れぞれの職業を聞いてみたところ、違いが明らかになった。インタビュー結果によれば、女

性が定期的に現金収入を得られる方法は、余剰農作物を首都ホニアラの市場で販売するこ

とに限られている。また、学校や教会でホームメイドのケーキを販売して少額の現金収入を

得る女性もいるとのことであった。これに対し、男性は、小川で釣った淡水雑魚（うなぎ）

の販売、養豚や養鶏、不定期ではあるが木材の販売のほか、インフォーマル・セクターでは

あるが、自営の小売業や運送業、日雇い労働から現金収入を得ている男性も少なくないこと

がわかった。 

 世帯収入については、どのインタビューでも、女性が市場で販売して得られるおおよその

収入については話が出たものの、男性が漁業、自営業、日雇い労働等から得ている収入につ

いての言及はほとんどなかった218。インタビュー参加者によれば、女性が市場で稼いでいる

収入についても、各世帯で栽培している農作物の種類や収穫量によって変わるとのことで

あった。プランテーション作物であるカカオ、ココヤシ、ビンロウの実（betel nuts）は一部

の世帯に限られ、多くの世帯が栽培・販売しているのは、サツマイモ、キャッサバ、パナ、

タロ、豆、野菜である。ココヤシは、ヤシの実のまま、あるいはコプラとして、またカカオ

はハーベストして販売するとのことである。そのほか、NTFPs の「mustard sticks」も換金作

物として収入源になっているという。 

                                                        
218 一部の参加者によれば、自営で小さなお店を経営している場合、1 日あたり SBD200 の売り上げがある

とのことである。 
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 チーフによれば、コムニボリの平均的な世帯収入は月収が SBD4,000 程度で、年収が

SBD48,000 程度とのことであった。そのほかのインタビュー参加者は、おおよその世帯収入

額として、女性が週に 1 度市場で農作物を販売して得られる額として SBD500 をあげた。そ

のほか、市場で販売する農作物の量が多かったり、コプラ、カカオ、mustard sticks の販売に

より、SBD1,000 程度稼ぐ女性もいるとのことであった219。ただ、女性参加者のみならず、

男性参加者のほとんどが、「農作物を販売して SBD500～1,000 を稼いでも、コムニボリから

ホニアラの市場までの交通費が往復 SBD200、市場の使用料 SBD50 を払い、自分たちの食

料（主食の米や調味料等）を購入すると、手元には SBD50～100 しか残らない」とし、家計

の厳しさを強調していた。 

 

教育・保健サービス 

 インタビュー結果から、コムニボリでは、男女ともに初等教育を終えているか、中等教育

を途中退学している者が多い。一方、高齢女性の多くは非識字者か初等教育を終えておらず、

高等教育に進んでいるのは少数の男子に限られるとのことだった。現在コムニボリの子ど

もたちの就学を阻む制約条件として、小学校ですらコムニボリから 2km 離れていて、さら

に川を越えなくてはいけないことがあげられた。コムニボリには就学前教育を行う施設が

なく、小学校に上がるまで学ぶ経験をしていないので、遠く離れた学校に川を越えてまで通

学することに、意欲を持続させられない子どももいるとのことであった。さらに、中等教育

以上の場合、経済的負担が大きな制約となっている。女性参加者たちによれば、中等教育の

学費・寮費は SBD2,500～5,000 で、大学は SBD7,000～10,000 かかるという。彼女たちは、

親が学費を払えなくなり多くの若者が中等教育の途中で退学していると話した。 

 コムニボリには、保健・医療施設はない。医療サービスが受けられる「Ruavatu Rural Clinic」

に行くためには、歩いて 1 時間ほどかかるとのことである。また、より深刻な病気やけがの

場合は、Tetere にある Good Samaritan Hospital か首都ホニアラにある National Referral Hospital

まで行く必要があるという。女性は、特に妊娠中の健診、出産、産後の健診とケアが必要で

あるが、病院までの距離、交通費、診察費等が大きな負担となっていることが、インタビュ

ー結果から分かった。 

 

2) ファラケ村 

地理 

ファラケ村は、マライタ州の West Kwara’ae に位置する。首都ホニアラからファラケまで

行くには、まず州都の Auki まで行く必要があるが、フェリーで行く場合は５～６時間かか

り、飛行機の場合は 30 分で行ける。Auki からファラケまでは車で行くことになるが、道路

の整備状況が悪く、1～2 時間程度かかる。 

                                                        
219 参加者の女性があげた例として、コプラ 500 個、キャベツ 20 個、マスタードスティック 10 袋を売る

と、SBD1,000 程度の収入が得られるとのこと。 
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人口・部族と氏族 

 KII の結果によれば、2020 年時点のファラケ村の人口は 157 人（男性 88 人、女性 69 人）

で、世帯数は 49（内 4 世帯が女性世帯主世帯）である。さらに、ファラケの主要部族であ

る「Funubua」が結婚により分家し、4 つの氏族に分かれていることが分かった。4 つの氏族

は、「Arurumae」、「Anita’a」、「Gae」、「Kwaiorea」である。キーインフォーマントによれば、

すべての氏族にファラケの慣習地の所有権があり、集団で所有・管理している。また、コム

ニボリとは違い、政府の仕事をはじめ、フォーマル・セクターで仕事を得ている人が、Fote

や Dala 等のファラケ周辺の都市に出て、離れて暮らしているケースも多いとのことである。 

 

生業と収入 

 各種インタビューの結果から、ファラケでも主な生業は農業であるが、コムニボリと比べ

ると、より安定した収入源がほかにあることが分かった。上述のとおり、正規の仕事を得て

都市部に暮らす男性家族からの仕送りを受けている世帯が少なくないからである。 

男女間で仕事や現金収入を得られる機会に違いや格差があることは、共通している。ファ

ラケの女性は、コムニボリの女性と同様に根菜類や野菜を市場で販売して収入を得ている。

また、コムニボリのインタビューではあまり出なかったが、ファラケの女性はビンロウの実

を販売することが、彼女たちの大きな収入源となっていることが分かった。一方、ファラケ

の男性は、女性の農業を手伝う傍ら、大工、溶接、交通・運搬（バス・トラック）、小売り

等の自営業、正規職、養豚等から現金収入を得ている。さらに、ある女性キーインフォーマ

ントによれば、男性は、より生産性が高く、商品価値の高いプランテーション作物の栽培・

販売に従事する傾向が強く、その例として「Kava」や木材をあげている。また、FGI に参加

した女性たちは、Kava を栽培するには技術や力が必要で、収穫まで 3 年を要するため、そ

れまで家族の食料を供給するためには女性は短期で収穫できる農作物を栽培・販売する必

要があると説明した。 

ファラケでは、女性間、男女間で栽培する作物が異なる上に、特に男性が栽培する作物の

市場価値がとても高いことから、男女間に大きな収入格差を生んでいることが分かった。ま

ず、女性たちが根菜類や野菜を売って得られる収入は、月当たり SBD1,000 程度であるが、

ビンロウの実も販売している女性は、より多くの収入が得られるとのことである。インタビ

ューに参加した女性たちによれば、ビンロウの実の需要は高いが供給量が少ないため、1 袋

SBD800 と高値で、週当たり 2～3 袋が売れる。一方、Kava を栽培する男性（世帯）はまだ

少数とのことである。インタビューに参加した男性たちによれば、Kava はキロ当たり

SBD250 で取引されていて、2016 年に Kava の苗を 300 本植えた男性の場合、2018 年以降

SBD2,000、SBD4,000、SBD8,000、SBD15,000 と年々売り上げを伸ばしているとのことであ

った。 

ファラケの場合、コムニボリと異なり、市場への交通費はかからず、使用料も無料のため、

市場で農作物を売って得られた収入はすべて女性たちの手元に残る。女性たちによれば、市
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場は村から 1km の距離の Dala にあり歩いて行け、またビンロウの実については仲買人が村

まで買い付けに来るという。多くのインタビュー参加者たちは、男女ともに「週当たり

SBD1,000 程度の収入があれば、コメ、砂糖、塩、石鹸等の生活必需品は買え、十分基本的

な生活が維持できる」とした。また、一部の女性参加者たちは、「食品や必需品を買って余

ったお金は、子どもの学費、息子が結婚する時の婚資のために貯めている」とも話した。 

 

教育 

 ファラケでも、コムニボリと同様に、男女ともに初等教育は終えているが、中等教育の途

中で退学している者が多い。また、高齢の女性たちは初等教育を終えておらず、男性の中に

は国立ソロモン大学を卒業している男性もいるとのことである。しかし、女子への教育は、

性に関するジェンダー規範により制約されているケースが少なくないことも分かった。キ

ーインフォーマントの女性によれば、「初等教育や中等教育を途中退学する女子の中には、

兄たちが、その妹と周囲の男子児童・生徒との関係を疑って、学校を退学させて、強制的に

結婚させるケースがある」とのことであった。一方、早期婚（幼児婚）は慣習的に行われて

いたため、高齢女性の多くは幼児婚により就学を断念している。インタビューに参加した高

齢女性たちは「昔だったので、慣習により幼児婚をさせられて、小学校を途中で止めざるを

えなかった」と経験を語った。さらに「今は、親の考えも変わり、男女ともに教育が大切だ

と認識されてきて、女子でも学校に行けるようになり、なかには職業訓練校や大学に行く女

子もいる」と話した。しかし、早期婚（幼児婚）・強制婚という女性・女子に対する暴力は

今も続き、女子の教育を受ける権利は一部で侵害されていることが分かった。 

  

3.1.3. コミュニティ・レベルの意思決定システム 

1）コムニボリ 

 KII の結果から、コムニボリでは、チーフが伝統的に土地の所有権を持つ「Chaobata（Lunga）」

氏族の長老たちとともに、土地の分配、森林管理、コミュニティ開発等にかかる意思決定を

自分たちだけで行ってきたことが分かった。また、そうした意思決定から排除されていた女

性や若者は、男性有力者の言うことや決定事項に従ってきたという。2020 年に、SI-SFRM

の働きかけで、より民主的な意思決定システムとして「Community Committee」と複数の「Sub-

Committees」を設置するまで、コミュニティにおける意思決定は、すべてこの一部の男性権

力者たちのみで行われていたという。女性キーインフォーマントによれば、「以前でも、森

林資源管理やその規則を話し合う会議に女性も参加できたが、会議で女性が自分の意見や

懸念について発言することはなかった」とのことである。また、その理由を「コミュニティ

の意思決定は男性の役割なので、女性は意見を言うべきではないとされていたから」と説明

した。新しく設置された意思決定システムにより、女性や若者も男性同様に、設置された委

員会のメンバーになったという。この大きな意思決定システムの転換について、すべてのキ

ーインフォーマントが「住民は新しいシステムには不慣れで適応するには時間がかかると
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思うが、このやり方でやっていきたい」と強い意志と肯定的な態度を示した。 

 コムニボリで新たに設置された意思決定システムは、Community Committee とその Sub-

Committees（宗教、社会サービス、文化・法執行、女性の開発、若者の開発、経済開発）か

ら構成される。各 Sub-Committees の委員には女性も選ばれているが、Community Committee

の委員には 1 人も選ばれず、また女性が議長に選ばれているのは「女性の開発」Sub-

Committee のみである（下表参照）。 

 

表 3-3 コムニボリで新たに設置された意思決定システムへの女性の参画状況 

 Community 

Committee 

宗教 社会サー
ビス 

文化・法
執行 

女性の開
発 

若者の
開発 

経済開
発 

議長の性別 男性 男性 男性 男性 女性 男性 男性 

女性委員数 0 3 1 1 4 2 2 

合計委員数 4 5 5 4 4 5 4 

出典：KII の結果を基に調査団作成 

 

2）ファラケ 

 ファラケの場合、コムニボリとは異なり、「Funubua」部族が 4 つの氏族に分かれている

ことから、意思決定システムは複雑である。キーインフォーマントによれば、4 つの氏族

が慣習的な土地の所有権を等しく有することから、土地や森林等にかかる意思決定は、各

4 氏族から代表の長老男性たちが集まって行うとのことである。また、この代表の中に

は、仕事の関係で周辺都市の Dala や Fote 等に暮らしている男性も含まれている。 

 ファラケでも、コムニボリと同様に、SI-SFRM の働きがけで、Community Committee と

5 つの Sub-Committees が設置されている。FGI の男性参加者たちによれば、「SI-SFRM が始

まるまでは、女性もコミュニティの会議に参加することはあったが、女性は座っているだ

けで、話し合いは男性のみで行われていた」、「SI-SFRM の支援が始まって、女性も森林管

理の委員会の委員として参加するようになった」とのことである。ファラケでは、

Community Committee に女性委員が含まれている一方、「文化・法執行」と「経済開発」に

は女性委員は一人も含まれておらず、「女性の開発」以外の議長はすべて男性が占めてい

る（下表参照）。 

 

表 3-4 ファラケで新たに設置された意思決定システムへの女性の参画状況 

 Community 

Committee 

宗教 社会サー
ビス 

文化・法
執行 

女性の開
発 

若者の
開発 

経済開
発 

議長の性別 男性 男性 男性 男性 女性 男性 男性 

女性委員数 2 1 3 0 6 1 0 

合計委員数 6 3 6 4 6 3 4 

出典：KII の結果を基に調査団作成 
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3.1.4. 土地制度と生産資源への男女のアクセスとコントロール 

1）コムニボリ 

 コムニボリは母系制社会であるため、慣習地は母親から長女に相続される。IDI の結果か

ら、具体的には「Chaobata（Lunga）」氏族の中で、相続していた母親が長女に、娘がいない

場合は、母親の姉妹の娘（姪）に相続されることが分かった。しかし、慣習地を相続しても、

女性は結婚によりコムニボリを離れ、男性のところに移り住むのが慣習となっている。これ

で、女性の慣習地の相続権（primary right）や使用権（secondary right）が消滅するわけでは

ないが、コムニボリから遠い場所に移り住んだ場合は、相続した土地や森林にかかる協議や

意思決定の場にはなかなか参加できず、ほとんど関われなくなってしまう。元々、土地や森

林の分配や利用にかかる意思決定権（コントロール）は、チーフ（母親の男兄弟か息子）に

あり、相続している女性には、相談はされても、最終的な決定を行う権限はない。つまり、

コムニボリの Chaobata（Lunga）出自の女性に与えられているのは名目だけの相続権で、土

地をどのように分配・利用・開発するか等の意思決定権は Chaobata（Lunga）出自の男性が

独占していることが分かった。 

  相続権を得ながら、土地の分配や利用・開発について関われない立場に置かれているこ

とについて、FGI に参加した女性たちは、婚資の慣習により自分たちの権限が侵されている

という認識を示した。1 つめの女性グループの参加者たちは、「本来は、女性たちが自分た

ちで土地に関して意思決定できるべきなのに、結婚でコムニボリを離れるので、残った男性

たちが意思決定を行っている」と話し、2 つめと 3 つめの女性グループの参加者たちは、「女

性が土地を所有しているのに、結婚でコムニボリを離れる、これは婚資のせいだ、男性はコ

ムニボリに残って土地の意思決定をし、利用もしている」と話した。ただ、こうした女性参

加者たちも、男性たちは、意思決定をする段階で必ず女性たちに相談をするとし、女性たち

に対して一定の敬意が払われていることは分かった。 

 IDI において、慣習地を相続する氏族「Chaobata（Lunga）」の女性、男性、その子女に与

えられる権利、結婚後の居住場所、土地・森林の意思決定にかかる役割を明確にした（下表

参照）。女性たちが結婚後コムニボリから離れて暮らしている場合、相続している土地・森

林の意思決定の場に参加するためには、夫の許可が必要とのことで、夫に行動・移動の自由

をコントロールされ、自ら意思決定できない立場にあることも分かった。 
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表 3-5 コムニボリで土地を集団所有する氏族の男女間の権利、居住場所、役割の違い 

カテゴリー 相続権 結婚後の居住場所 役割 

長女 〇 婚資により、伝統的に
夫のところに住むが、
生活様式の変化に伴
い、夫の考えや婚資の
有無によってはコムニ
ボリに住むこともある 

住んでいるところがコムニボリ
から近く、夫が許可すれば、土
地にかかる会議に参加できる
が、チーフと同様の意思決定権
はない、また土地の利用も続け
られる 

その他の娘 〇 同様に会議に参加したり土地を
利用できるが、長女に比べると
権限は少ない 

息子 × コムニボリ 特に、長男はチーフとして土
地、森林、森林資源等にかかる
意思決定やリーダーとしての役
割を担う 

孫（娘の子どもの
み） 

〇  
女性の

み 

父親が亡くなるまでは
父親のところで暮ら
し、以後コムニボリに
移り、男性の場合はチ
ーフを務める 

土地の利用権があり、土地や森
林にかかる会議にも参加し、男
性の場合は意思決定も担う 

出典：IDI の結果に基づき、調査団作成 

 

さらに、IDI では、コムニボリのいろいろな立場の女性たちには、血縁や姻戚関係によっ

て、土地にかかる権利にどのような違いがあるかについて聞き取った（下表参照）。 

 

表 3-6 コムニボリの女性の血縁・婚姻関係により異なる土地の権利 

カテゴリー 相続権 土地・森林の開
発・利用にかか

る意思決定 

短期的な作物栽
培のための土地

利用 

長期的な作物栽
培のための土地

利用 

Chaobata 出自の
女性・娘 

〇 〇 〇 〇 

Chaobata 出自の
男性の娘 

× 参加はできる
が、意思決定権
は限定的、土地
の売買等に関す
る権限はない 

〇 〇 

Chaobata 出自の
男性と結婚した
女性 

× 意思決定権は限
定的か、ほぼな
い 

〇 Chaobata の了承
が得られれば 

Chaobata と血
縁・婚姻の関係
がない移住女性 

× ×      
教育レベルが高
く助言ができる
女性であれば参
加可能、意思決
定権はない 

〇 Chaobata の了承
が得られれば 

出典：IDI の結果に基づき、調査団作成 
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2）ファラケ 

 ファラケは、コムニボリとは異なり、父系制社会である。上述のとおり、ファラケの

「Funubua」部族は 4 つの氏族に分かれるが、すべての氏族がファラケの慣習地の所有権

を有している。IDI に参加した女性によれば、各氏族間で、父親から長男のみに相続権が

譲渡されるのではなく、男性親族が集団で慣習地を相続し、所有するとのことである。ま

ずは、各氏族の親族間で話し合いを持ち、誰が土地を管理し、親族を代表して意思決定に

参加するかについて合意のプロセスを踏むという。もし、息子が複数いて、ファラケ村内

に居住している場合は、すべてが代表として土地にかかる会議に参加し、意思決定に携わ

るが、娘がいたら、娘も参加するとのことである。 

ファラケでも、女性たちは、結婚後、夫のところに移り住むのが慣習となっている。し

かし、IDI の結果によれば、夫の考えによっては、ファラケに夫が移り住んでくるケース

もあり、その場合は女性が持つ土地の利用権（secondary right）を基に、農業を営むことが

できるとのことである。一方、ファラケの男性と結婚し、ファラケに移り住んで来た女性

には、土地にかかる権利は付与されないが、夫を通じて利用することは可能である。その

ため、土地にかかる意思決定への権限はない。 

IDI において、ファラケの男性および女性には、血縁や姻戚関係によって、慣習地にか

かる権利にどのような違いがあるかについて聞き取りを行った（下表参照）。 

 

表 3-7 ファラケの男女の血縁・婚姻関係により異なる土地の権利 

カテゴリー 土地権 土地・森林の分
配・利用・開発

の意思決定 

短期的な作物を
栽培するための

利用権 

長期的な作物を
栽培するための

利用権 

父方の息子 相続権と利用権 〇 〇 〇 

母方の息子 利用権 教育レベルによ
る 

〇 〇 

父方の娘 利用権 呼ばれれば参加
可能、父や兄弟
を通じて意見を
言うことも可能 

〇 長老からの許可
があれば可能 

息子と結婚した
女性 

夫を通じて土地
にアクセス可能 

参加は可能、意
思決定の権限は
ない 

〇 夫を通じて可能 

出典：IDI の結果を基に、調査団作成 

 

3.1.5. 生産活動および再生産活動における性別役割分担と労働負荷 

1）コムニボリ 

農業における性別役割分担 

 各種インタビューの結果から、コムニボリの女性は生産活動および再生産活動で大きな

役割を果たしている。また、生産活動は性別による役割分担が明確で、再生産活動は主に女

性が担っていることも分かった。まず、生産活動について、農業（移動式の焼き畑農業）は
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女性が中心になって営んでいる。FGI の結果から、女性は農作業を中心的に行っているだけ

でなく、どんな作物を、いつ植え、いつ収穫するかといった営農にかかる意思決定も、夫と

は相談するものの、主体的に行っていることが分かった。農業において、男性は、草木を刈

り取って土地を整備したり、耕作や鍬入れをする等の力のいる準備作業を手伝うだけであ

る。それらの作業を含め、収穫、さらに余剰作物の販売まで、女性はほぼ全工程に携わる。

コムニボリの移動式焼畑農業における性別役割分担は、下表に示すとおりである。 

 

表 3-8 コムニボリでの移動式焼畑農業における性別役割分担 

 草 木 の
刈 り 取
り 

掃除 火入れ 鍬入れ・
土 地 準
備 

種まき・
苗植え 

除草 収穫 販売 

男性 ✓ ✓  ✓     

女性  ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

出典：FGI の結果を基に、調査団作成 

 

森林管理における性別役割分担 

 一方、森林管理については、男女で扱う草木の種類や利用目的が異なるが、それぞれがそ

の管理に役割を果たしている。まず、女性は、家庭消費用の薪や NTFPs（野生の食用野菜や

果物、ハーブ、マッシュルーム等）の収集を主に担っている。薪については、最初に、チェ

ーンソーを使って木から枝を切り落とし、いくつかに切っていくのが男性の役割で、それら

を薪割りするのは女性の役割である。ただ、普段、女性は自宅から近い場所で薪を入手でき

るため、男性が森林で木から枝を切り落とす作業を行うのは不定期である。一方、男性は、

市場価値の高い木材を含め森林資源の管理や伐採に責任を負っている。SI-SFRM による支

援が始まったこともあり、女性が森林管理の計画や意思決定に携われるようになったが、ま

だまだ限定的で、「忙しい」ことを理由に参加しない女性も多いとのことである。これは、

女性キーインフォーマントによれば、「森林や土地にかかる意思決定は男性の役割」とする

規範や「自信のなさ」に因るという。コムニボリの森林管理における性別役割分担は下表の

示すとおりである。 

 

表 3-9 コムニボリの森林管理における性別役割分担 

 森林管理
計画作り 

下刈り・
地揃え 

植林 育林 剪定・除
草 

火事・違
法伐採の

巡視 

男性 ✓ ✓   ✓ ✓ 

女性 （✓）  ✓ ✓ ✓  

注：（✓）は限定的 

出典：KII の結果を基に、調査団作成 
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再生産活動における性別役割分担 

 再生産活動について、コムニボリの女性は、薪や NTFPs の収集のほか、水汲み、料理、食

器洗い、子育て、家畜の世話等の作業を主に行っている。コムニボリの場合、多くの世帯が

自宅敷地内にタンクを設置しているので、水汲みにはあまり時間を要しないという。また、

世帯によっては、男性も薪拾いや、家畜の世話等を手伝う場合もあるとのことであるが、女

性により労働負荷がかかり、「時間の貧困」の状況に置かれていることが分かった。また、

こうした女性の再生産活動の労働負荷は、大家族の世帯ほど大きい。インタビューに参加し

た女性によれば、「家族が多いほど、食事の準備や食器を洗うのに時間と労力がかかる」と

のことである。 

 

男女の一日の活動スケジュール 

コムニボリの女性と男性の一日の活動スケジュールを下表に示す。一日の中で男女とも

に、自由な時間ができるのは午後 7時以降とのことである（下表参照）。 

 

表 3-10 コムニボリの女性と男性の一日の活動スケジュール 

女性 男性 

5:30 起床 

子どもを起こし、学校に行
かせる準備 

朝食準備、食事、片付け 

その他の家事 

6:00 

 

 

8:00 

起床 

（男性によっては）森林に移
動 

草木の刈り取りや掃除 

自宅に戻って、朝食 

9:00 

 

 

16:00 

畑に移動 

農作業 

 

自宅に移動 

9:00 

 

 

16:00 

（男性によっては）妻と畑に
移動して作業 

 

自宅に移動 

17:00 

19:00 

 

夕食の準備、食事、片付け 

自由時間 

就寝 

18:30 

19:00 

夕食 

自由時間 

就寝 

出典：FGI の結果を基に、調査団作成 

 

 上表は、女性が農作物を市場で販売しない日の活動スケジュールの例である。首都ホニア

ラの市場で農作物を販売する日は、女性は 4 時に起床して、首都ホニアラまで乗せてくれる

トラックが現れるのを道路沿いで待つとのことである。また、小さな子どものいる女性は、

畑に子どもも連れて行き、背負いながら作業を行う。さらに、女性は、男性とは違い、忙し

ければ日中の日差しのきつい時間帯も休まず作業を続けるという。年間を通じて、新しい農

地の準備をしたり、除草をする農繁期には、女性は 18 時くらいまで作業をする時もあるが、

収穫期は 2、3 時間ほどで作業が終えられるとのことである。また、土曜日は、日曜日の準

備（販売用のケーキを焼くため）に忙しいとのことである。一方、FGI に参加した女性たち

は、「比較的時間のある日は、午前 8～10 時くらいまで、洗濯場で洗濯をしながら、他の女

性たちと情報交換やおしゃべりをすることが楽しみ」と話した。 
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2）ファラケ 

農業における性別役割分担  

ファラケでも、生産活動および再生産活動において、コムニボリと同様の性別役割分担が

なされている。まず、農業においては、ファラケでも移動式の焼畑農業が営まれている。ま

た、コムニボリ同様に、農業は女性が主に担っている。ファラケでは、短期間に収穫できる

農作物について、いつ、何を、どこに植えるかといった営農に関する意思決定は、女性が行

う世帯もあれば、男性が行う世帯もあるとのことであった。KII の結果から、ファラケでは

男性の農業への関わり方がコムニボリの男性より多い（下表参照）。さらに、Kava 等のプラ

ンテーション作物に関しては、男性が中心になって収穫と販売を行っているとのことであ

る。 

 

表 3-11 ファラケの移動式焼畑農業における性別役割分担 

 草 木 の
刈 り 取
り 

掃除 火入れ 耕作・土
地準備 

種まき・
苗植え 

除草 収穫 販売 

男性 ✓ ✓ ✓ ✓ ✓    

女性  ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

出典：FGI の結果を基に、調査団作成 

 

森林管理における性別役割分担  

次に、森林管理については、コムニボリと同様の結果が出ている。ファラケでも、女性が、

主に、家庭消費用の薪や NTFPs（野生の食用野菜や果物、ハーブ、マッシュルーム等）の収

集を行っている。薪については、ファラケでも、最初にチェーンソーを使って木から枝を切

り落とし、いくつかに切っていくのが男性の役割で、それらを薪割りするのが女性の役割と

なっている。一方、男性は、市場価値の高い木材を含む森林資源の管理や伐採に責任を負っ

てきたとのことである。 

SI-SFRM による支援が始まって以降は、女性も森林管理の計画や意思決定に参画するよ

うになった。男性グループの参加者たちは、「以前は、会議で話をするのは男性で、女性は

座っているだけだった」と話し、さらに「女性は、土地や森林について話し合うのは男性の

役割なのに、どうして女性が参加するのかと言われるのが嫌で参加しなかった」と女性が参

加を躊躇してきた理由について説明した。また別の男性参加者は、「意思決定は男性の役割

とする文化的な考え方が、女性の参加の障壁になってきた」と指摘した。一方、女性グルー

プの参加者は、「SI-SFRM のスタッフの働きがけにより、特に元々ファラケ出身の女性は積

極的に会議で話をするようになり、結婚で移り住んできた女性であっても、Auki 等で実施

された女性のエンパワメントにかかるワークショップや研修に参加したことのある女性は、

自信を持って話をしている」と説明した。 

 ファラケにおける森林管理の性別役割分担は、下表に示すとおりである。なお、ファラケ

では、雨期に十分雨が降るため、水やりの必要はないとのことであった（下表参照）。 
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表 3-12 ファラケの森林管理における性別役割分担 

 森林管理
計画作り 

下刈り・
地揃え 

植林 育林 剪定・除
草 

火事・違
法伐採の

巡視 

男性 ✓ ✓ ✓  ✓ ✓ 

女性 （✓） ✓ ✓    

注：（✓）は限定的、「育林」について、ファラケでは雨期に十分雨が降るため水やりは不要。 

出典：KII の結果を基に、調査団作成 

 

再生産活動における性別役割分担 

 再生産活動について、ファラケの女性も、薪や NTFPs の収集のほか、水汲み、料理、食器

洗い、子育て、家畜の世話等の家事やケアワークを担っている。ファラケでも、世帯によっ

ては男性が家事（水汲み、料理、食器洗い）、子育て、家畜の世話を手伝っているというこ

とであるが、主に行っているのは女性で、農作業と再生産活動による労働負荷は大きい。 

 

男女の一日の活動スケジュール 

ファラケの女性と男性の一日の活動スケジュールは、コムニボリのものと同様である。フ

ァラケでは、男女ともに夕食後の 20 時以降に自由時間ができるとのことである。 

 

表 3-13 ファラケの女性と男性の一日の活動スケジュール 

女性 男性 

6:00 起床 

水汲み 

朝食準備、食事、片付け 

その他の家事 

7:00 

 

起床 

森林に移動 

草木の刈り取りや掃除 

自宅に戻って、朝食 

11:00 

 

 

16:00 

畑に移動／市場に移動 

畑で農作業／市場で販売 

 

自宅に移動 

11:00 

 

 

16:00 

男性によっては、妻と畑に移
動して作業、自営業に従事、
休憩 

自宅に移動 

18:00 

 

20:00 

 

夕食の準備、シャワー、教
会、食事、片付け 

自由時間 

就寝 

19:00 

 

20:00 

シャワー、教会、食事 

 

自由時間 

就寝 

出典：KII の結果を基に、調査団作成 

 

 上表は KII の結果によるが、FGI に参加した女性によれば、子どもが学校に通っている世

帯では、女性は 5 時に起きて準備を始めるという。それは、ファラケの場合も学校が 2、3km

離れたところにあるため、母親の中には子どもを学校に送る母親もいるからとのことであ

る。女性の自由時間は、畑から戻り夕食の準備、夕食、片付けを終えた 20 時以降とのこと

であるが、男性は、日中に自由時間のある男性もいるとのことである。女性と一緒に畑に行

き畑仕事を手伝っている男性の自由時間は、女性と同様の 20 時以降となる。 
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3.1.6. 性別により異なる担当農作物・農作業と年間の作業スケジュール 

1）コムニボリ 

性別により異なる担当農作物と農作業 

 コムニボリでは、上述のとおり、移動式焼畑農業が営まれている。この手法で栽培されて

いる農作物は、サツマイモ、キャッサバ、タロ、パナ、野菜、豆類である。また果物は、バ

ナナ、パイナップル、サトウキビである。一方、プランテーション（定住農業）で栽培され

ている換金作物は、カカオ、ココヤシ（ヤシの実、コプラ）、ビンロウの実である。FGI に

参加した女性たちによれば、2 年周期で、複数の作物を栽培・収穫した後、次の土地に移動

するとのことで、最初に 3～8 ヶ月間かけてパナを栽培・収穫し、その後 3～6 ヶ月かけてサ

ツマイモ、タロ、サトウキビ、バナナを栽培、サツマイモとタロを収穫した後も、サトウキ

ビとバナナは暫く収穫が続くが、その頃には次の土地に移動しているとのことである。上述

のとおり、農業では、準備段階は男性も女性を手伝うが、種まき・苗植え、除草、収穫、販

売は主に女性が担う。各農作物について、誰が、いつ、どんな作業を担っているのか、IDI

で聞き取ったところ、下表のような回答が得られた。 

 

表 3-14 コムニボリの農作物別、男女別の年間作業カレンダー（一例） 

種類 男女 1 2 3 4 5 6 7 8 9 10 11 12 

根菜

類 

女      1,2,3 4 4 4 4 5,6 5,6 

男      1,2       

野菜 女  1,2,3 4,5,6          

男             

果物

ﾊﾞﾅﾅ･

ﾊﾟｲﾝ 

女   1,2,3 4 4 4 4 5 6    

男   1,2,3          

ﾋﾞﾝﾛｳ

の実 

女 3,4 3,4           

男 3,4 3,4           

ｺｺﾔｼ/ 

ｶｶｵ 

女             

男             

注）作業のカテゴリー：1. 草木の刈り取り・火入れ、2. 耕作、3. 種まき・苗植え、4. 除

草、5. 収穫、6. 販売 

出典：IDI に参加した女性が夫とともに記録していたメモを基に、調査団作成 

 

 上表の記録を残していた女性は、SI-SFRM のアグロフォレストリーの活動の中で行われ

た収支の記録付けにかかる研修を受けて、夫とともに 2020 年の記録を付けたとのことであ

る。それまでは、全く記録を付けていなかったとう。通常、どの家庭でも、特に戦略的に時

期や作物を選ぶのではなく、前の作物の収穫が終わったタイミングで種や苗のある作物を

植えているという。上表が示すとおり、野菜（キャベツ等）によっては 6 週間で収穫できる

ものもあり、収穫後また別のものを栽培していくとのことである。一方、長期的な作物であ

るビンロウの実については、収穫まで 5、6 年かかる。コムニボリでは、ビンロウの実もコ
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コヤシも随分前に植えられているので、どの世帯も現在は収穫と販売のみ行っているとい

う。IDI に参加した女性は、夫とともに、新たにビンロウの実の苗を植えて除草も行ってい

るが、収穫は男性の仕事とのことである。これは、ビンロウの実の木が高く成長するので、

木に登って収穫する必要があるからとのことである。 

 

繁忙期 

 KII や FGI の結果から、コムニボリの住民男女にとって、年間を通じての繁忙期は 1 月、

6 月／7 月、12 月との回答を得た。1 月と 7 月は学校の新学期が始まる時期で、子どもの学

費を稼ぐために忙しく、6 月／7 月、12 月は農繁期（6 月と 7 月はサツマイモ等の種イモを

植える時期で、12 月は収穫の時期）で、さらに 12 月はクリスマスシーズンでその準備にも

忙しいとのことであった。 

 

2）ファラケ 

性別により異なる担当農作物と農作業  

ファラケでも、コムニボリと同様に、移動式の焼畑農業が行われている。この方法で栽培

されている根菜類は、サツマイモ、タロ、パナ、キャッサバで、野菜、豆類である。長期の

プランテーションによる換金作物は、カカオ、ココヤシ、Kava、ビンロウの実、ヤエヤマア

オキ（Morinda Citrifolia）である。女性グループの FGI の結果によれば、最初にキャッサバ

を栽培・収穫して、そのあとサツマイモを栽培・収穫して、次の土地に移動するが、2 年も

しないうちに元の土地に戻って来るとのことである220。ファラケでは、市場価値がより高い

Kava が栽培されているが、男性が主に担当している。IDI で、各農作物について、誰が、い

つ、どんな作業をしているのかについて聞き取ったが、記録は取られておらず、コムニボリ

ほど詳細な情報は得られなかった（下表参照）。 

 

表 3-15 ファラケの農作物別、性別の年間作業カレンダー（一例） 

種類 男女 1 2 3 4 5 6 7 8 9 10 11 12 

根菜類 女     1,2 3 4 4 4 4 4,5 5,6 

男     1,2 3       

ｺｺﾔｼ/ 

ｶｶｵ 

女             

男             

Kava 女             

男             

注）作業のカテゴリー：1. 草木の刈り取り・火入れ、2. 耕作、3. 種まき・苗植え、4. 除

草、5. 収穫、6. 販売 

出典：IDI の結果を基に、調査団作成 

                                                        
220 コムニボリ同様、ファラケでも、移動式焼畑農業の元の土地に戻って来るサイクルは 2 年毎と短くな

ってきており、この理由は、多くの農民が自宅から近い土地で行いたいという意志を反映してとのことで

ある。 
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 上表のとおり、IDI で、明確な性別役割分担と年間の作業スケジュールの回答が得られた

のは、根菜類についてのみであった。また、IDI に参加した女性によれば、ココヤシやカカ

オについては、収穫までに 5 年かかり、それまでは定期的に鍬入れをする等の作業をすると

のことである（家族の誰かが担当）。また、Kava に関しては、苗木が手に入れば植えるとの

ことで、作業としては最初に草木の刈り取り、耕作、苗の植え付け、除草、そして 3 年後に

収穫できるとのことである。FGI の結果から、草木の刈り取りや耕作、収穫までの管理、収

穫、販売は男性の役割で、女性も草木の刈り取り、苗木の植え付け、除草の作業を手伝う。 

 

繁忙期 

 KII や FGI の結果から、ファラケの住民男女にとっての繁忙期はコムニボリの結果と同様

であった。年間を通じての繁忙期は 1 月、6 月、12 月との回答を得た。1 月と 6 月は学校の

新学期が始まる時期で、子どもの学費を稼ぐために忙しく、6 月と 12 月は農繁期（6 月はサ

ツマイモ等の種イモを植える時期で、12 月は収穫の時期）で、さらに 12 月はクリスマスシ

ーズンでその準備にも忙しいとのことであった。また、イースターの４月をあげる参加者も

いた。 

 

3.1.7. 森林資源を含む自然資源の減少・劣化が与える男女への影響 

1）コムニボリ 

利用可能な森林資源と男女で異なる好みの樹種 

 コムニボリでは、SI-SFRM のパイロット活動の一環でアグロフォレストリーの活動が実

施されており、木材や果樹の樹種の苗木が植えられた。KII で、コムニボリで元々利用可能

な森林資源も含めて、参加者があげた樹種は下表の示すとおりである。また、男女それぞれ

の好みの樹種についても聞いてみたが、男女で大きな違いはないという回答であった。ただ

し、女性は薪として利用できる樹種によりニーズ・関心があるとも回答した。 

 

表 3-16 コムニボリの森林資源と男女で異なる好みの樹種 

 森林資源 男性が好きな樹種 女性が好きな樹種 

SI-SFRM 介入前 Akwa (Pometia) 

Vasa (Vitex) 

黒檀（Ebony） 

シダ（Fern） 

欄（花卉類） 

樹種の好みに男女間の違いはない。 

ただし、女性は、薪として Akwa や Vasa を
最も好む。 

SI-SFRM 介入後 マホガニー 

チーク 

Pencil Cedar 

果樹（柑橘類） 

出典：KII および FGI の結果を基に、調査団作成 
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森林資源を含む自然資源の変化と影響 

 各種インタビューの結果、コムニボリでは、人口規模が小さいこともあり、森林が比較的

良い状態で保全されていることが分かった。なかには、原生林も残っているとのことである。

FGI の参加者によれば、薪は自宅の近くで手に入り、NTFPs も減少していない。参加者の多

くが、過去 10 年ほどの変化としてあげたのは、異常気象で、雨期の豪雨で洪水が頻発した

り、乾期には全く雨が降らない等、降雨パターンが予測できなくなったとのことである。こ

のため、飲料水の水源は乾期に枯渇することもあるが、殆どの世帯は自宅にタンクを設置し

ているため、水汲みに困ることはない。一方、豪雨による斜面等の土壌流出に加え、移動式

焼畑農業のサイクルが短くなったことでも221土壌劣化が進んでおり、サツマイモ、タロ、ヤ

ム等の根菜類の生産性が落ちているとのことである。そのほか、コムニボリの農民を悩ませ

ているのが、「African Giant Snail」という巨大なカタツムリで、根菜類の生産に大きなダメ

ージを与えているとのことであった。 

 上述のとおり、コムニボリでは、女性が生産活動と再生産活動で大きな役割を担っている。

再生産活動の薪拾いや水汲みは、異常気象で森林資源や水資源にそれほど影響を与えず、そ

のため女性の役割にも影響は出ていない。しかし、降雨量の変化や土壌劣化は、農業を主に

担っている女性に直接影響を与えている。カタツムリの発生も同様である。コムニボリの女

性は、週に一度首都ホニアラの市場に農作物を持って販売に行くが、交通費や市場の使用料

のコストにお金がかかり、加えて農作物の生産量がさらに落ちると、生計に大きく影響を与

えることになる。 

 

2）ファラケ 

利用可能な森林資源と男女で異なる好みの樹種 

 ファラケでも、コムニボリと同様に、SI-SFRM のパイロット活動でアグロフォレストリ

ーの取組が実施され、果樹や Kava の苗木が植えられている。また、元々ファラケで利用可

能な森林資源として、チーク、Akwa（Pometia）、紫檀（Rosewood）等がある（下表参照）。

一方、ファラケでは、コムニボリとは異なり、男女で好みの樹種について明確な違いがあっ

た（下表参照）。 

 

 

 

 

 

 

 

                                                        
221 移動式焼畑農業のサイクルが短くなった理由は、人口増加等によるものではなく、上述のとおり、自

宅から遠く離れた土地での作業を嫌い、近場の農地のみで作業を行っているためである。 
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表 3-17 ファラケの森林資源と男女で異なる好みの樹種 

 森林資源 男性が好きな樹種 女性が好きな樹種 

SI-SFRM 介入前 チーク 

Akwa (Pometia) 

紫檀（Rosewood） 

Kerosene Wood 

マホガニー 

市場価値の高い木材
樹種、家の建築用と
しては強い木材樹種
を好む（例：Akwa、
Vasa、チーク、マホガ
ニー）。 

Akwa、Kerosene 

Wood、チークを薪
として好む。 

SI-SFRM 介入後 Kava 

果樹 

出典：KII および FGI の結果を基に、調査団作成 

 

森林資源を含む自然資源の変化と影響 

 ファラケでは、各種インタビュー結果から、過去に商業伐採や人口増加に伴い住宅建設の

ための木材の伐採を行ってきたことで、一部の森林が劣化していることが分かった。キーイ

ンフォーマントによれば、「伐採により原生林が壊れ、元々豊富にあった、ハンディクラフ

トの原料となる籐やナッツ（ナリナッツ）を含む NTFPs が激減した」とのことである。ま

た別のキーインフォーマントも、「伐採で森林は草地になってしまい、森林に元々天然自生

していた多様な樹種がなくなってしまった」と話した。一方、ファラケでも、異常気象の現

象は認識されており、雨期の豪雨で土が常に濡れた状態のため雑草が増え、除草作業が非常

に大変になっているとのことである。また、雨期の降雨量の増加や激しい風は、農作物の生

産に影響を与えている。反対に「乾期は雨が降らず、農作物を水なしで育てるのが大変」と

話す女性参加者もいた。さらに、コムニボリと同様に、移動式焼畑農業のサイクルが短くな

っているために土壌の劣化が進行しており、農作物の生産量は減少しているとのことであ

った。 

 ファラケにおける自然資源や気象の変化は、男女が担う役割や依存度により、その影響は

異なる。ファラケの森林は一部劣化しているものの、いい状態で保全されている森林も多く

残っている。女性は薪拾いと水汲みを主に担っているが、自宅周辺に自生する薪の量は変わ

っておらず、水も自宅にタンクを設置しているため、女性への影響はあまりない。一方、FGI

の男性参加者によれば、男性は森林でチェーンソーを使って枝を切り落とす役割を担って

いるが、「以前と比べると伐採が進み、そうした薪用の木がなかなか見つからず、以前より

も遠くに探しに行かなくてはならなくなった」と証言している。農業では、女性が主に農業

を担っていることから、より女性へ影響を及ぼしている。雨期の豪雨で土が常に濡れた状態

で雑草が増えると、除草作業は女性の仕事のため、女性の労働がまた増えることになる。あ

るキーインフォーマントは、「豪雨のあと、女性は除草作業に、以前よりももっと多くの時

間を費やしている」と証言した。さらに、土壌の劣化で農作物の生産量が減少していること

から、補うために女性の労働が増えているとのことである。 
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3.1.8. 世帯レベルの男女の意思決定権 

1）コムニボリ 

 IDI において、世帯レベルで誰（男性・女性）が現金収入に直接アクセスがあり、その使

い道について誰（男性・女性）が権限を持っているのかについて聞き取りを行った。具体的

には各農作物、淡水雑魚、家畜を誰が市場で（あるいは仲買人を通じて）販売し、家族の必

需品の購入から起業・ビジネスといった大きな決断を要する意思決定は誰が主に行ってい

るかについてインタビューした。 

まず、現金収入へのアクセスについて、農作物は女性が栽培していることから、主に女性

や少女が販売し、またパイナップルやバナナ等の果物やビンロウの実も女性や少女が販売

しているとのことである（下表参照）。一方、プランテーション作物のカカオやココヤシに

ついては、世帯により、どちらも販売に関わるという。豚は、夫婦の間であらかじめ販売価

格を相談しておき二人で、あるいは男性が仲買人との交渉に関わる（下表参照）。淡水雑魚

は釣った者が販売に関わるとのことで、コムニボリでは小川でうなぎを釣るのは男性と少

年なので彼らが販売するとのことである（下表参照）。 

 

表 3-18 コムニボリの男女の現金収入への直接的なアクセス 

カテゴリー 種類 Who 

農作物 短期間に収穫できる根菜類や野菜類 主に女性と少女（女性が無
理な場合のみ男性） 

果物（パイナップル、バナナ）やビンロウの
実 

主に女性と少女（女性が無
理な場合のみ男性） 

長期的なプランテーション作物（カカオ、
ココヤシ、Kava 等） 

世帯による 

家畜 豚 あらかじめ男女間で販売価
格を相談 

淡水雑魚 うなぎ うなぎを釣る男性・少年 

出典：IDI の結果を基に、調査団作成 

 

 次に、日々の必需品や大きな買い物等をする際、また新たにビジネスを起業する等の大き

な決断をする際、世帯内で誰（男性・女性）が意思決定を行っているかについては、下表の

示すとおりである。家族のための買い物には、高価なものであっても女性が権限を持ってい

るものの、自営業・ビジネスを始める意思決定は男性が行うとのことである（下表参照）。 

 

表 3-19 コムニボリの世帯内におけるお金の使い道にかかる意思決定 

カテゴリー 内容 Who 

日常的な買い物 食料や生活必需品等の買い物 女性 

学費 子どもの学費の支払い 男女 

医療費 家族の医療費の支払い 男女 

大きな買い物 家族のために高価なものを購入 女性 

ビジネス・起業 新しいビジネスを起業 男性 

出典：IDI の結果を基に、調査団作成 
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2）ファラケ 

 同様の質問を、ファラケの IDI でも聞いた。コムニボリに比べ、ファラケの方が、低価格

な農作物の販売は女性が担い、作物の市場価値が高くになるにつれて男性の販売への介入

が大きくなる傾向にあることが分かった（下表参照）。コムニボリではビンロウの実の販売

は女性が担うが、ファラケでは男性も販売するほか、カカオ、ココヤシ、Kava にいたって

は、男性が主に販売し、得られた収入も男性が管理するのことである（下表参照）。 

 

表 3-20 ファラケの男女の現金収入への直接的なアクセス 

カテゴリー 種類 Who 

農作物 短期間に収穫できる根菜類や野菜類 女性 

果物（パイナップル、バナナ）やビンロウの
実 

バナナは女性、ビンロウの
実は男女 

長期的なプランテーション作物（カカオ、
ココヤシ、Kava 等） 

世帯にもよるが、主に男性 

NTFPs 薪等 男女 

家畜 豚 世帯による 

出典：IDI の結果を基に、調査団作成 

 

 次に、世帯内の買い物や意思決定を誰が行うかについてであるが、買い物、学費や医療費

にかかる回答はコムニボリと同様であったが、ビジネスの起業は男性だけではなく、世帯に

より男女ともに意思決定できるとの回答であった（下表参照）。しかし、男性が、市場価値

の高い農作物の販売や得られた利益を管理・コントロールしている中、女性が高価な買い物

やビジネスの起業に対して意思決定できる環境にあるとは考えにくいところである。 

 

表 3-21 ファラケの世帯内におけるお金の使い道にかかる意思決定 

カテゴリー 内容 Who 

日常的な買い物 食料や生活必需品等の買い物 女性 

学費 子どもの学費の支払い 男女 

医療費 家族の医療費の支払い 男女 

大きな買い物 家族のために高価なものを購入 女性 

ビジネス・起業 新しいビジネスを起業 世帯により男女 

出典：IDI の結果を基に、調査団作成 

 

3.1.9. 男女の研修や金融サービスへのアクセスとネットワーク 

1）コムニボリ 

 コムニボリでは、1995～1998 年まで、「Solomon Island Development Trust」やニュージーラ

ンドの輸入木材企業等による「Eco Forest Programme」が実施されていた。この事業実施中

は、研修、意識向上のワークショップ、普及サービス等も提供されていた。しかし、終了後、

住民の研修機会はなくなり、現在は SI-SFRM のパイロット活動下で実施される研修のみと

のことである。 
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コムニボリの女性の多くは教会に所属しているが、「Seventh Day Adventist Church」を通じ

て女性組織（Women’s Docus Group）が女性を対象にケータリングや料理の研修を実施した

ことがあるとのことである。このことからも分かる通り、女性のネットワークは教会を中心

に築かれている。222 

コムニボリでアクセスできる金融サービスはなく、銀行は首都ホニアラまで行かないと

ないとのことである。キーインフォーマントによると、住民が緊急でお金が必要になった場

合、コムニボリで運送業を営んでいる男性から借りるケースが多いという。FGI に参加した

女性たちによれば、「以前、女性たちでセイビング・グループを始めようとしたが、その目

的等がうまく理解されず文句が出て、途中で立ち消えてしまった」とのことである。 

 

2）ファラケ 

 ファラケでも、SI-SFRM のパイロット活動が実施されるまでは、政府や NGO による支援

は限られていた。しかし、ファラケでは、「Ado Association」という日本の森林組合を模した

住民組織が組織化されている。IDI の参加者によれば、その会員になるためには、1,000 本

の樹木（カカオ含む）の苗木を植えることが条件となっている。また、男性が世帯を代表し

て、メンバーとして登録されているとのことである。メンバーへの研修等のサービスは実施

されていない。 

一方、ファラケの女性は、コムニボリの女性に比べ、「女性のエンパワメント」に焦点を

当てたワークショップやリーダー研修等の機会がある。これは、ファラケの女性が、教会の

ほかに、Malaita Provincial Council for Women（マライタ州女性委員会）とのネットワークを

持っていることが大きい。近隣の Kakara のマライタ州女性委員会が実施する研修やワーク

ショップに参加したファラケの女性は、SI-SFRM の会議等にも参加しているが、「その会議

の中で自信をもって発言している」と FGI の女性参加者たちが証言している。しかし、IDI

の参加者によれば、こうした研修には 2、3 人の女性しか参加しておらず、参加した女性た

ちも他の女性に研修で学んだことを共有することもないので、ファラケの女性全体へのイ

ンパクトはないとのことである。 

 金融サービスへのアクセスについては、ファラケにも銀行等の金融機関はない。しかし、

親族からの送金を定期的に受けている人々は銀行口座を持っているとのことである。また、

2020 年に、Ado Association が、その事業「UNITRUST」の中でセイビングのサービスを始め

たとのことであるが、貸付のサービスはなされていないとのことである。 

 

 

 

 

                                                        
222 SI-SFRM 事業の長期専門家への聞き取りによると、コムニボリ村、ファラケ村とも村に設立されてい

る教会は Roman Catholic Holy Cloth である。 
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3.1.10. JICA事業による女性の意思決定段階参画への影響 

 2021 年 2 月に、コムニボリおよびファラケにおいて、KII と FGI を実施した結果、上記で

も示した通り、どちらの村においても、また男性も女性も、SI-SFRM の介入により、女性が

意思決定段階に参画できるようになったことを肯定的に捉えていることが分かった。そこ

で、実際 SI-SFRM のパイロット活動において、スタッフが住民男女に対してどのようにフ

ァシリテーションを行い、それに対して住民男女はどう反応したのか、IDI で詳しく探るこ

ととした。結果を以下に示す。 

 

1）コムニボリ 

 IDI の結果を基に、SI-SFRM のナショナルスタッフが、ジェンダー視点に立って、女性の

参加の重要性を住民に常に話しかけ、女性の参加の推進を働きかけるとともに、社会・文化

的な制約も理解して、女性が意思決定の場で参加しやすい環境作りもしていることが分か

った。SI-SFRM の各段階において、スタッフがどのように住民男女に対してファシリテー

ションを行い、それに対して女性や男性がどのように反応したかを下表にまとめた。 

 

表 3-22 SI-SFRM における女性の意思決定段階への参画推進にかかる評価（コムニボ

リ） 

段階 スタッフのファシリテーシ
ョンのやり方 

女性・男性の反応・インパクト 

エントリー・
ポイント 

 チーフを通じて、最初の
会議に住民招集、特に女
性の参加を依頼した。 

 チーフから住民全員への召集があり、
女性（若い女性や結婚してコムニボリ
を出ていた女性）も参加した。 

 女性は、こうした機会を与えられたこ
とが嬉しかった。 

Community 

Mobilization 

 常に「平等」に言及し、
女性もコミュニティの
一員として活動に参加
して活動するようにフ
ァシリテーションを行
っていた。 

 スタッフの言葉・働きかけに、多くの
女性は動かされ、参加の意欲を高めた。 

 しかし、女性の中には、「ジェンダー役
割」や「自信のなさ」で、躊躇する女
性もいた。 

 男性も女性にとって良かったと考えて
いる。土地や森林資源は女性に属する
ため、女性がその管理法を学び、関わ
っていくことがよいと考えている。 

組織化  各委員会の委員を決め
る際、女性も選ぶよう強
く強調し、ファシリテー
ションを行った。 

 女性の中には「識字がなく、委員会の
管理の仕方が分からない、自信がない」
と躊躇する女性もいた。 

 委員の候補者に女性が選ばれた際、チ
ーフやスタッフが本人にやる気を確か
め、やる気のある女性は引き受けたが、
なかにはその会議に出席していない若
い女性が確認のないまま選ばれている
ケースもあった。 

 実際委員を引き受けた女性は、女性が
こうして委員の役割を務めることで
「女性にもできる」と証明でき、自信
が持てるようになった。女性が土地や
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森林にかかる活動に参加することは重
要であると考えている。 

意思決定の
進め方 

 意思決定への平等な参
加を常に言及し、女性も
意見が言えるように小
グループでの話し合い
の機会や、そのあと全体
の前で発表する機会を
設けている。 

 常に女性が話し合いに
参加できるように働き
かけている。 

 自信が持てない女性は、女性ばかりの
小グループの方が話しやすい。徐々に
慣れていくと、全体でも話せるように
なる。 

 男性は、女性を敬っていて、女性の意
見がコミュニティにとって良いことで
あれば、考慮に入れている。 

研修・会議の
開催時間帯 

 会議や研修を開催する
際、その時間帯について
事前に住民に相談をし
ている。 

 多くの場合日中開催だ
が、夜にかけての開催も
ある。 

 女性は、本来日中は農作業で忙しいが、
他に選択肢はない。夜は、昼間の農作
業で疲れてしまうので、日中の方が良
い。 

 農作業を休んでも、SI-SFRM の活動や
研修が将来的には自分たちの農業や森
林管理に役立つと思うので出席する。 

研修・ワーク
ショップ開
催にかかる
情報普及と
参加状況 

 スタッフはコミュニテ
ィ全員の参加を求めて
研修開催の案内を主要
メンバーに伝え、他の住
民への案内を依頼した。 

 アグロフォレストリーやその他の生計
向上にかかるワークショップや研修の
情報は広く普及され、多くの住民男女
が参加した。 

 リーダーシップ研修は、一部の住民に
しか案内されず、参加者選定の経緯等
は不明である。 

 コムニボリにはお茶やスナックを出す
お店がなく、参加者の女性数人が任意
で研修や会議を途中退席して、他の参
加者や講師たちのためにお茶やスナッ
ク作りをしている。 

研修の内容  森林・研究省の職員、農
業・畜産省の職員、SI-

SFRM のスタッフが研
修講師を担当した。 

 非識字や教育レベルの低い女性参加者
には、研修の内容が難しかった。こう
した参加者にもわかるように、「シンプ
ルな言葉」で説明してほしいとの要望
が強い。 

 さらに、事前にこうした参加者を対象
に基礎知識を学べる機会を設けてほし
いとの要望もあった。 

出典：IDI 結果を基に、調査団作成 

 

2）ファラケ 

 ファラケの IDI でも、同様に、SI-SFRM の各段階において、ナショナルスタッフがどのよ

うに住民男女に対してファシリテーションを行い、それに対して女性や男性がどのように

反応したかを聞き取った（下表参照）。コムニボリと同様に、ファラケでも、女性が意見を

出しやすい小グループでの話し合いは好評で、研修については女性が内容を分かりやすく
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する具体的な研修手法として「story-telling」や「女性リーダーの映像を見せる」等の対策案

も出た（下表参照）。 

 

表 3-23SI-SFRM における女性の意思決定段階への参画推進にかかる評価（ファラケ） 

段階 スタッフのファシリテーシ
ョンのやり方 

女性・男性の反応・インパクト 

エントリー・
ポイント 

 ファラケの代表に最初
の会議の案内をし、住
民、特に女性も参加する
ように招集を依頼した。 

 各氏族の代表から女性を含む住民すべ
てに最初の会議への参加が呼びかけら
れ、女性も参加した。 

 女性は会議に参加して、SI-SFRM に関
する内容について話が聞けて大変喜ん
でいた。 

Community 

Mobilization 

 スタッフからは、女性を
含む平等な参加につい
て強調された。 

 働きがけとしては十分だった。 

 しかし、女性の自信のなさにより、ま
た「忙しい」を理由に参加しない女性
もいた。 

組織化  スタッフからは、女性も
委員に選ぶよう強い勧
めがあった。 

 女性が立候補するのではなく、男性が
女性を推薦していた。 

 女性の中には自信が持てず、躊躇する
女性もいた。また、小さな子どもがい
る女性は、推薦されても断っていた。 

 やる意志のある女性のみが推薦を受け
て、委員になった。 

 女性の意識もゆっくり変わりつつある
時代なので、こうして委員に女性が選
ばれて、実際になったことは良かった。
その理由として、女性も農業や森林資
源の管理を行い、土地や森林に強く関
わっていることをあげた。 

意思決定の
進め方 

 スタッフは、女性や若者
が意見を言うようにフ
ァシリテートし、意見が
出やすくするために小
グループに分ける等の
工夫をしている。 

 女性は小グループに分かれると意見が
言いやすいので良かった。 

 男性も女性を敬い、女性の意見を聞く。
ファラケの男性は教育を受けているの
で、ジェンダー平等の考え方をある程
度理解している。 

研修・会議の
開催時間帯 

 スタッフが都合の良い
時間帯を予め女性に相
談したかどうかは不明
であるが、案内は関係者
を通じて普及は依頼さ
れた。 

 日中 9 時～16 時や夕方に開催されるこ
とが多かったが、事前に連絡があれば
みんな都合をつけて参加できる。前も
って案内が欲しい。 

 

研修・ワーク
ショップ開
催にかかる
情報普及と
参加状況 

 スタッフからファラケ
の代表者に、会議、ワー
クショップ、研修にかか
る案内を住民に普及す
るよう依頼している。 

 リーダーシップ研修についても、女性
にも案内された。 

 リーダー研修には希望する男女が参加
し、内容は「良いリーダー」「グッド・
ガバナンス」に関するものだった。 

研修の内容  森林・研究省の職員、農
業、畜産省の普及員、SI-

SFRM のスタッフが研

 研修内容が、女性にもわかる内容にす
る必要がある。研修に使うマテリアル
や手法も、女性（非識字者）が理解で
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修を行った。 きるように作成したほうがいい。例と
して、研修に「story-telling」や「女性リ
ーダーの映像を見せる」等を盛り込む。 

 女性には基礎的な知識を身につけるた
め、事前の研修の提供が必要である。 

出典：IDI の結果を基に、調査団作成 

 

3.2. 調査サイトにおけるジェンダー・ニーズ（実践的および戦略的ジェンダ

ー・ニーズ） 

3.2.1. フィールド調査で明らかになった不平等なジェンダー役割とジェンダー関係 

 フィールド調査の結果から、コムニボリおよびファラケの女性たちは、農業、畜産等の生

産活動、さらに薪を含めた NTFPs の収集、家事、ケアワーク等の再生産活動においても大

きな役割を果たしていることが分かった。しかし、「土地や森林にかかる意思決定は男性の

役割」とする伝統的なジェンダー役割により、女性はこれまで意思決定に十分に参画できず、

自分たちの声やニーズを土地分配や森林管理に反映させることができなかった。母系制・父

系制の違いに関わらず、両方の村の女性たちには、ジェンダーによって、土地を含めた生産

資源への権限が制限され、利用権のみに留まり、実質的な意思決定は男性が行ってきた。さ

らに、男女の力関係（ジェンダー関係）を基に、栽培・販売する農作物も男女の間で分かれ

ており、それによって男女それぞれが直接アクセスできる現金収入に格差が生じ、それが世

帯内の男女の力関係（ジェンダー関係）にも多少影響していることが分かった。 

 SI-SFRM や将来の類似案件を通じて、ジェンダー視点に立った「森林資源管理」や「生計

向上」の支援を行う際、ジェンダー分析結果を踏まえて、対象地域のコンテクストに沿った

2 種類のジェンダー・ニーズを満たしながら、ジェンダー平等・女性のエンパワメントを目

指していく必要がある。１つめのジェンダー・ニーズは実践的ジェンダー・ニーズで、もう

1 つが戦略的ジェンダー・ニーズである。実践的ジェンダー・ニーズは、あらゆる面で不利

な立場に置かれている女性が、日々の生活で直面している問題を解決し、よりよい生活・生

計を営むために必要なニーズを指す。それと同時に、女性が、男性と同様に意思決定に参画

し、主体的にコミュニティや社会の責任を果たしていく中で、不平等なジェンダー役割やジ

ェンダー関係をより平等なものに転換し、女性の地位を向上させるために必要なニーズが

戦略的ジェンダー・ニーズである。 

 

3.2.2. 実践的ジェンダー・ニーズ 

まず、実践的ジェンダー・ニーズについて、コムニボリとファラケの場合、森林資源を含

む自然資源の減少で女性たちが担う薪拾いや水汲みに今のところ影響が出ていないため、

薪炭樹種の植林や水道システムの整備等は該当しない。しかし、両方の村の女性の中には、

非識字や教育レベルの低い女性が多く含まれており、識字教室等の支援により、女性が読み

書きや計算を含む基本的な能力を上げることは、それに含まれる。さらに、コムニボリの女
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性たちは、特に、余剰農作物を販売しても経費を差し引くと手元に残る収入は限られている

ことから、市場価値の高い農作物の栽培・高付加価値製品の製造に必要なスキル研修、経費

を抑え利益を上げるためのビジネス研修、貯金を増やすための金融リテラシー研修を実施

することも、実践的ジェンダー・ニーズになる。また、両方の村の女性は、移動式焼畑農業

のサイクルが短くなったことによる土壌劣化、さらにコムニボリの女性は African Giant Snail

の出現により、農作物の生産性が落ちる問題に直面している。こうした問題を解決するため

の研修も重要な実践的ジェンダー・ニーズである。そのほか、起業や生計向上活動を始める

ための前提条件である、金融サービス支援、原材料・生産資材等の提供も該当する。 

 

3.2.3. 戦略的ジェンダー・ニーズ 

次に、戦略的ジェンダー・ニーズについて、まず事業実施側の体制を整える必要がある。

森林・研究省の国家森林政策は、ジェンダー視点を組み込んだ研修にのみ特化されているが、

女性の意思決定段階への参画や経済的エンパワメントを推進することにも焦点を当て、よ

り包括的な内容にし、その実施に必要な戦略と計画の立案、予算付け、さらに職員研修を行

うことが必要となる。一方、SI-SFRM や将来の類似案件においては、計画段階からジェンダ

ー分析を行い、その結果を計画案に反映させることが重要である。また、事業で行われた介

入（取組）がどの程度ジェンダー平等・女性のエンパワメントに寄与したかを定量的・定性

的に評価できるように、事業内で性別のデータを収集するシステムを構築しておくことが

必要となる。さらに、事業スタッフが、最初の段階で、対象地域の女性や若者が事業に参加

するための動機付けを行い、意思決定にも参画するようにファシリテーションするための

ガイドラインを策定し、そのための研修を行い、スタッフ間のファシリテーションのやり方

や能力を統一しておくことも重要である。 

対象地域においては、事業にかかる情報や研修機会へのアクセスを男女間で平等にする

ことはもちろんであるが、女性はジェンダー役割等を理由にそうした機会から排除されて

きたため、積極的に参加できない心理的事情がある。したがって、住民男女に対して、ステ

レオタイプや偏見を含むジェンダーにかかる意識や考え方を変えるためのジェンダー・セ

ンシタイゼーション・ワークショップの開催等の取組が必要となる。フィールド調査の結果、

女性が主に再生産活動を担い、またコムニボリの女性は特に農作物をホニアラの市場で販

売するために早朝に起床して出かける等、女性の「時間の貧困」は深刻である。センシタイ

ゼーションを通じて、男性が、女性が主に担っている再生産活動を手伝い、女性がより経済

活動を行えるように働きかけていく必要がある。また、フィールド調査において、どちらの

村の男性にも女性蔑視や女性に対する差別の態度は見受けられなかったが、女性自身、特に

識字がなく教育レベルの低い女性が、自分自身に自信が持てず、意思決定やリーダーは男性

の役割とする規範に固執している傾向が強かった。こうした女性に対しては、センシタイゼ

ーションのほか、コミュニケーション研修やリーダー研修を実施した上で、グループ内で女

性一人一人に役割を与え、研修で学んだことを実際の活動で取り組み、実地を通じて得られ
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た「自分にもできる」という小さな自信を積み上げていくことが重要となる。こうした女性

の意思決定システムへの参画促進、女性の主体性（エージェンシー）・リーダーシップの醸

成、女性のネットワーク構築が、戦略的ジェンダー・ニーズになる。  
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第4章 ソロモン諸島の森林資源管理事業で重視すべきジェンダー視

点を組み込んだアプローチ・取組への提言 

4.1. ジェンダー主流化に向けた提言 

 上述のフィールド調査で明らかになった、調査サイトの女性たちの実践的および戦略的

ジェンダー・ニーズを基に、SI-SFRM や将来の類似案件を通じてジェンダー平等・女性のエ

ンパワメントを推進するためには、森林・研究省や森林セクター、さらに SI-SFRM や将来

の類似案件へのジェンダー主流化を図る必要がある。これは、事業レベルでいくら女性のエ

ンパワメントに焦点を当てた取組を行っても、インパクトはその対象地域に限られ、一過性

の成果で終わるからである。つまり、事業レベルの取組のみならず、政策レベルにおいて、

法律・政策、組織体制、予算等の仕組みを整えることが、持続可能で面的な成果・インパク

トを実現するためには必要となる。政策レベルと事業レベルの各レベルにおいて、ジェンダ

ー主流化を図るために重視すべきアプローチや取組は、以下のとおりである。 

 

1）政策レベル 

 森林・研究省へのジェンダー主流化には、以下の項目の実現が重要である。 

 

 森林セクターにおけるジェンダー政策を策定する 

 森林セクターの関連法や政策にジェンダー視点を組み込む（女性が脆弱層ととしてだ

けではなく、主要なステークホルダーとして認識され、意思決定段階に参画し、男性と

同様の役割が果たせるための支援を行うとした内容） 

 省職員として女性の積極的採用や意思決定のできる職位への登用にコミットし、具体

的な目標を立てて取り組んでいる 

 職員に対してジェンダー研修を定期的に行っている 

 森林セクターの性別データ収集・蓄積システムが構築され、更新されている 

 森林セクターのジェンダー政策、あるいは森林政策に沿って、資源管理等に関わる女性

の意思決定段階への参画や経済的エンパワメントを推進するための具体的な計画が立

案され、そのために必要な予算が適切に割り当てられている 

 ジェンダー平等を推進するナショナルマシナリの MWYCFA と、ジェンダー主流化や女

性のエンパワメントのために技術的な支援を受ける等、連携を密に取っている 

 省内に配置されているジェンダー・フォーカルポイントは、省内の他の職員へのジェン

ダー意識向上、他の関係省庁との情報交換や連携のために機能している 

 

2）事業レベル 

 次に、事業へのジェンダー主流化を図るために、事業レベルで重視すべきポイントは以下

のとおりである。 
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 ジェンダー分析を行い、その結果が事業計画に反映されている 

 スタッフ（特にマネージャー職や専門職）には女性も採用されている 

 スタッフへのジェンダー研修が行われ、またファシリテーション研修も行われている 

 事業の運営ガイドラインには、以下のようなジェンダー視点が組み込まれ、実際にその

通りに実施されている 

 事業の開始段階で、女性や若者の事業参加への意識付けを目的とする

community mobilization を行う 

 女性の家事・ケアワークの労働負担を軽減するため、男性の協力を促し、女性

が男性と同様に意思決定段階に参画し、森林資源管理や生計向上活動等に積

極的に参加していくために、男女のジェンダー意識を変えることに焦点を当

てた、ジェンダー・センシタイゼーション・ワークショップ等を開催する 

 意思決定システム（委員会等）に女性議長や女性委員も選ぶ 

 女性の意思決定段階への積極的な参加やリーダーシップを促進するために、

コミュニケーション研修、リーダー研修等を行い、女性の自信やエージェンシ

ーを醸成する 

 ワークショップや会議では、女性が意見を言える環境作りを行い、女性の意見

やニーズに基づく活動案も採用されるようにする 

 ステレオタイプのジェンダー役割により、男女の活動や研修内容を制限しな

い（例：女性には料理やクラフト作りのみに限定） 

 研修は、女性も参加しやすい時間帯に設定した上で、その案内をすべての住民

に普及し、女性や脆弱層にはより参加の機会を提供する 

 事業内の取組や支援が、女性の意思決定段階への参画や経済的エンパワメントに貢献

した度合いを定量的・定性的にモニタリング・評価するために、男女別のデータ収集・

蓄積システムが構築され、スタッフは定期的にデータを収集している 

 女性の意思決定段階への参画や経済的エンパワメントを促進した効果的なアプローチ

や取組にかかる情報・知識がスタッフ間で共有される仕組み（文書化等）が構築されて

いる 

 

4.2. 具体的な取組とやり方 

 上述のジェンダー主流化のために政策レベルおよび事業レベルでとるべきアプローチ・

取組の中で、今後、SI-SFRM 下で実施可能なものについて、その取組方法も含めて以下に記

す。 

 

1）政策レベル 

 今後、SI-SFRM 下でのジェンダーの取組効果を上げるため、さらにはソロモン諸島政府

が将来的に緑の気候基金（Green Climate Fund: GCF）に事業資金の申請をする場合も踏まえ
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ると、森林・研究省による森林セクターのジェンダー政策の策定（あるいは関連政策へのジ

ェンダー視点の組み込み）や男女別のデータ収集システムの構築は不可欠となる。森林・研

究省のコミットメントやニーズに合わせて、政策面やモニタリング・評価システムに関して

技術的な支援を行う意義は大きい。その場合、重要となるのがナショナルマシナリである

MWYCFA との連携であるが、森林・研究省の考え方やコミットメントにもよる。そして何

より、実際に政策やデータ収集システムを作り、実施・運営するのは森林・研究省の職員で

あるため、職員が、基礎的なジェンダー知識を持ち、ジェンダー分析を行ったり、男女別の

データを収集し、それらに基づいて政策立案を行う、あるいはジェンダー視点を関連政策に

組み込むための能力を構築・強化する必要がまずある。この能力強化が、SI-SFRM 下で行う

取組として実現可能性が高い。これを、今後のジェンダー支援のエントリー・ポイントとし

て始めることが妥当である。 

 

2）事業レベル 

今後の SI-SFRM 下での取組 

 上述のとおり、本ジェンダー分析調査（特にフィールド調査）の結果を基に、パイロット

サイトの女性の実践的および戦略的ジェンダー・ニーズを特定した。女性が直面している問

題を解決し、生活・生計の改善を図るだけではなく、活動を通じて女性の意思決定段階への

参画、リーダーシップの醸成、さらにエンパワメントを見据えた、女性たちの能力強化を行

っていくことが重要である。そのためには、それに従事する森林・研究省の職員および SI-

SFRM のスタッフを対象に専門理論や方法論を含むジェンダー研修を行う必要がある。本ジ

ェンダー分析調査の手法や結果をケースとして、パイロットサイトにはどのようなジェン

ダー課題があるのか、何が問題なのか、その解決のためにどういった介入・取組をするべき

か、といった視点から講義を行い、ジェンダー分析やジェンダー視点を組み込んだ政策・計

画立案の演習も、研修内容に盛り込むこともできる。 

 フィールド調査の結果から、SI-SFRM のナショナルスタッフによる働きかけや工夫はな

されているが、パイロットサイトの女性自身の「自信のなさ」や女性の「時間の貧困」はな

おパイロット活動への参加の制約となっていることが分かった。そのため、パイロットサイ

トの男女に対して、ジェンダー意識を変えるためのジェンダー・センシタイゼーション・ワ

ークショップを行い、改めて女性の参加の重要性を説明し、女性が参加できるように男性が

再生産活動等を手伝うように働きかける必要がある。次に、NGO や市民社会の協力を得て、

公的な場所で発言したり、発表することに慣れていない女性や若者を対象とした「コミュニ

ケーション研修」や「女性の権利やエンパワメントに関する研修」を行い、女性の「自信」

や主体的に意思決定を行う「エージェンシー」を醸成する支援を行うことが重要である。ま

た、女性の起業や生計向上を促進するために、金融サービス（セイビングやマイクロクレジ

ット等）を提供する NGO と連携を取り、「金融リテラシー研修」や「ビジネス研修」を実施

することも女性の能力向上につながる。 
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 SI-SFRM のパイロット活動である「アグロフォレストリー」や「その他の生計向上」にか

かる技術研修がこれまでにいくつか実施され、女性も参加したが、女性には内容が難しかっ

たとの意見があげられた。女性、特に非識字者や教育レベルの低い女性も研修内容が理解で

きるように、講義だけでなく、小グループに分かれての演習、ロールプレイ、映像を活用す

る等、ジェンダー視点を組み込んだ研修実施のガイドラインを作成することも今後の取組

として考えられる。 

 

将来的な類似案件に向けた取組 

 将来の類似案件では、計画段階で、本調査と同様のジェンダー分析調査を行い、その結果

を事業計画に反映させる意義を関係者間で事前に共通の認識としておくことが重要である。

さらに、上述したとおり、ジェンダー視点を組み込んだ事業運営ガイドラインを作成し、そ

れに沿って事業を運営・実施していくことが重要となる。そのために、本ジェンダー分析調

査結果を踏まえて、運営ガイドライン案を策定し、将来の類似案件の対象地域におけるジェ

ンダー分析調査の結果を同案へ反映すれば使える状態にしておくことも想定できる。また、

男女別のデータ収集システムを作り、類似案件下のジェンダーにかかる介入・取組が、女性

の意思決定段階への参画、主体性（エージェンシー）・リーダーシップの醸成、経済的なエ

ンパワメント等において、どのような成果・インパクトをもたらしたか、定性的・定量的に

評価するためのモニタリング・評価システムの整備をしておくことの意義も大きい。 

 

4.3. 今後の取組に向けて更なる調査の必要性 

 本ジェンダー分析調査において、主要セクターにおけるジェンダー格差やジェンダー差

別・ジェンダー・ダイナミクスの実態をレビューし、SI-SFRM のパイロットサイトの男女間

の生産・再生産活動の役割、資源に対するアクセスとコントロール、意思決定権等の違い・

格差を明らかにした。これらの調査結果を基に、パイロットサイトの女性の実践的および戦

略的ニーズについてはある程度分析ができた。その実現のためにキーとなるのが、森林・研

究省や森林セクターへのジェンダー主流化の促進具合である。本ジェンダー分析調査では、

森林・研究省の関係者へのインタビュー調査はできず、関連政策のデータも手に入れられな

かったので、組織や政策の詳細な分析ができなかった。FAO が 2019 年に実施した国別ジェ

ンダー分析調査で、MWYCFA、農業・畜産省、漁業・海洋資源省の組織分析は行われてい

るが、森林・研究省については行われていない。また、ローカルコンサルタントが聞き取り

を行った MWYCFA の Supervising Director は、森林・研究省のジェンダーにかかる取組にか

かる監査（Audit）調査をエントリー・ポイントとして行うことを提言している。 

 以上から、今後 SI-SFRM や将来の類似案件でジェンダーの取組を効果的に行っていくた

めに、更なる調査として森林・研究省のジェンダーにかかる監査調査の実施を提言する。具

体的には、森林・研究省のジェンダー平等・女性のエンパワメントへのコミットメントとそ

の実施方法に関する考え方、関連政策や計画へのジェンダー主流化の促進具合、具体的な取
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組・活動内容、予算付け、組織体制等について、関係者から聞き取りを行い、データ・情報

を収集し、分析を行うことを目的とする。さらに、実施体制や職員のジェンダーにかかる能

力について、ジェンダー・フォーカルポイントの配置や機能の実態と制約、MWYCFA との

連携状況と制約、ジェンダー研修の実施の有無、実施されていればその研修の内容、制約・

ニーズ等についても把握する必要がある。森林セクターへのジェンダー主流化を促進して

いく上で不可欠な MWYCFA との連携や他ドナーによる支援状況についても確認し、他ド

ナーと連携を取る可能性も考察する。追加調査の概要は下表のとおりである。 

 

表 4-1 追加調査「森林・研究省のジェンダー取組にかかる監査調査」の概要 

調査項目 詳細 対象・調査手法 

省としてのコミット
メント 

ジェンダー平等・女性のエンパワメントに
対するコミットメントと具体的な進め方 

事務次官・次官補等
の意思決定者、実務
者へのインタビュー 関連政策へのジェン

ダー主流化 

森林政策に記載されているジェンダーに特
化した取組（能力強化）の真意、そのほかの
ニーズ（女性の意思決定段階への参画や経
済的エンパワメント）に対する考え方 

関連計画へのジェン
ダー主流化 

森林政策に記載されたジェンダーに特化し
た取組の Corporate Plan への反映、実施状
況、制約 

ジェンダー予算 ジェンダー平等・女性のエンパワメントの
ための取組・活動を実施するための予算の
割り当て状況・制約 

実施体制と連携 省内の部署と役割、職員数（女性職員数）、
ジェンダー取組を主に担う部署、州レベル
の体制、ジェンダー・フォーカルポイント
の配置状況・制約、MWYCFA 等の連携状況・
制約と方針 

職員のジェンダーへ
の意識と能力 

職員のジェンダーに対する意識・認識とジ
ェンダー研修実施状況 

性別データの収集シ
ステム 

性別データの収集システム、ジェンダー取
組による成果を評価するためのシステム構
築に対する考え方 

他ドナーとの連携の
可能性 

森林・研究省および森林セクターへのジェ
ンダー主流化の状況、制約、課題、JICA/SI-

SFRM に支援を期待する分野、連携の可能
性・制約 

UN Women、UNDP、
FAO、AusAID、SPC

等 

出典：調査団 
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Annex 1. キーインフォーマント・インタビューの質問票 

Semi-Structured Key Informant Interviews 

Profile of Key Informant  

Name  

Post  

Sex  

Age  

Ethnicity/Clan  

Occupation  

Education level  

 

1. General Socioeconomic Profile of the Village 

1) Population  

 Total number Disaggregated by sex 

Population  Male:                  Female: 

Households  Male-headed:            Female-headed: 

2) Clans 

Total number of clans in this village: 

Name of the clans: 1)                       2)                        3)  

The number of clan-wise households: 1)                2)                     3) 

3) Approximate average household/family size 

4) Main occupation/income sources 

Men: 

Women: 

(1) Agriculture; (2) Shifting cultivation/slash and burn agriculture; (3) Forestry, including 

selling NTFPs; (4) Fishery; (5) Animal raising; (6) Employment by the 

Government/private sector; (7) Labor work on a daily basis; (8) Self-employment/ 

business; (9) Other (specify         ) 

5) Approximate average income per month/year and household 

6) Average educational level  

Men: 

Women: 

(1) Illiterate/not go to school; (2) not finished primary school; (3) finished primary school, 

but dropped out of secondary school; (4) finished secondary school; and (5) college and 

more 

 

2. Decision-making Structure at the village level 

1) What are the main structures/bodies which govern and make a decision on village political and 

social matters? 
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Name of a 

Structure 

Purposes/Duties Members by 

sex/age 

How to select 

members 

Tenure/period 

     

     

     

 

2) How are decisions made in each of the structures raised above? What is the procedure for decision-

making processes like? 

3) How are the decisions made disseminated among other village people? 

 

3. Natural Resources and Livelihoods 

1) What is approximate percentage of forestland owned by the Government, village/community, 

clan, and individuals in this village?  

(1) The Government     %; (2) village/community    %; (3) clan      %; (4) 

individuals      %   

2) What is land tenure system or land allocating system like in this village? 

3) What kinds of tree/grass species (timber, firewood, fodder, other NTFPs, agro-forestry-

fruits/spices/coffee/other plantation products) are planted in the government- and 

community/clan-owned forests?  

a) Government owned 

- 

- 

- 

b) Village/community owned 

- 

- 

- 

c) Clan owned 

- 

- 

- 

 

4) How do village people manage the communal forests? Is there any rule/regulation for 

conserving the forests planting seedlings, selling timber/NTFPs, and sharing profits from the 

timber/NTFPs sold? Who makes such a rule/regulation in this village? 

5) How do you see a change in the availability of forest resources over time? If any change, what 

is the change like? What do you think is a main cause for the change? 

6) Are there any issues/concerns regarding forest and forest resources? Illegal logging, forest fires, 

decreased forest resources, etc.?  

7) In this village, what kind of agriculture is practiced? Shifting cultivation or settled agriculture? 

8) What kinds of crops are produced?  

Food crops: 

Cash crops: 

9) Is there any market nearby where village people can sell crops and NTFPs? If so, how far is it? 

How do they go there? 

10) How can people get market information, especially prices of main crops? 
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11) If shifting cultivation is practiced in this village, is there any change in the cycle of shifting 

cultivation over time? If so, what is a main reason for it? 

12) Is there any change in the amount of rainfall, availability of water resources, and soil condition 

of forestlands and farming land? If so, what is a main cause for the change? 

13) How do such changes in rainfall, the availability of water resource, or soil condition affect the 

availability of forest resources, the yield/production of crops, and overall livelihoods of people 

in this village? 

 

4. Gender 

1) What kinds of roles do women and men take up in forest management in this village? 

Men: 

Women: 

(1) Planning for forest management; (2) Preparation by cutting grass and cleaning 

forests; (3) Planting seedlings; (4) Watering/taking care of the seedlings; (5) Pruning 

and cutting grass; (6) Patrolling for illegal logging, forest fires; (7) Others 

(specify                          ) 

2) What kinds of roles do women and men mainly take up in agriculture in this village?  

Men: 

Women: 

(1) Preparing land/Plowing; (2) Application of manure/fertilizer; (3) Sowing seeds; (4) 

Weeding; (5) Application of pesticide; (6) Harvesting; (7) Post-harvest treatment 

(collection of seeds for next season); (8) Making process-foods; (9) Marketing; (1) 

Others (specify                        ) 

3) When is the busiest hour/time in a day and the busiest season/month in a year for women and 

men? Why? 

 Women Men 

Busiest Time/Hour   

Reasons   

Busiest Month/Season   

Reasons   

 

4) Who has access to/using right for forest lands and farming lands? 

5) Who has the ownership and decision-making power over forest lands and farming lands in 

terms of how to use the land, how to sell forest resources and agricultural crops, and 

when/whom to sell the land? 

6) Is there any problem or difficulty with women’s participating in forest management, agro-

forestry, income generation activities, or training outside the village? If so, what are main 

reasons or constraints? Are there any social norms or institutions which do not allow women to 
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participate in decision-making processes? If so, explain the details. 

 

5. Community-based Organizations 

1) Are there any community-based organizations in this village (e.g. Forest Management 

Committees, women’s groups, Self-Help Groups (SHGs), farmers groups, etc.)? If so, what are 

they? Who belong to each group/organization? What are main activities? 

6. Services by the Government and NGOs 

1) Is the Government’s forest extension and agricultural extension services available for women 

and men in this village? 

2) Are there any training opportunities available for women and men in this village which are 

provided by the Government or NGOs? If so, what kind of training and how often? 

3) Are there any formal and informal financial services available in this village or nearby? If so, 

what are they and main conditions for borrowing money?  

4) From whom do villagers generally borrow money when they need it? What are main 

reasons/objectives for their borrowing money?  

5) Do women and men in this village usually open a bank account? If so, what is a main 

objective? If not, what are main reasons not to open the account? 

 

7. Community problems/needs  

1) What is the major problem faced by this village and villagers? What kinds of resources and 

interventions do you think are necessary for solving such problems? Why do you think so? 
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Annex 2. フォーカスグループス・インタビューの質問票 

Semi-Structured Focus Groups Interviews 

Profile of Respondents/Participants 

 Name Sex Age Occupation 

1     

2     

3     

4     

5     

6     

 

Livelihoods 

1. What do women and men in this village do for a living? 

2. What is the average income per household like? Is it enough for maintaining the livelihood of 

the household? Why is that so? 

Land tenure/allocation system 

3. What is land tenure or land allocation system in this village like? Mostly who owns forests and 

agricultural land in this village? Is there any problem or complain about such a system? If so, 

why? 

Forest resource management 

4. Who usually collect firewood, fodder, or other NTFP (edible wild vegetable/fruits, mushroom, 

herb, etc.)? 

5. Do people sell such forest resources or use only for family consumption?  

6. How do women and men think about forests and forest resources? Is there any difference in 

preferred forest tree/grass species between women and men? If so, how different and why? 

7. Do both women and men participate in village meetings to make a rule on how to manage 

forests and forest resources? If no, who participate and who do not participate? Why? 

8. Is there any change in the availability/amount of forest resources, such as firewood, fodders, or 

other NTFPs over time (in terms of the distance and time spent for collecting firewood and 

fodders over time)?  

9. Is there any problem related to collecting/using and selling forest resources and NTFPs? If so, 

what kinds or problems and why? 

Agriculture 

10. Do you engage in settled agriculture or shifting cultivation for a living? If so, what kinds of food 

and cash crops do you cultivate?  

11. What are main responsibilities do women and men take in agriculture/shifting cultivation? 

12. Who makes a decision at the household level in terms of when to prepare land and plow seeds, 

what kinds of crops to cultivate, how much to be spend for seeds, fertilizer, pesticide, etc. and 
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when/where to sell cash crops? 

13. Is there any problem related to cultivation, harvesting, or selling of crops? If so, what kinds of 

problems and why? 

Water resources and Soil condition 

14. How far is a main source of water for life use and agricultural use? 

15. Primarily whose responsibility is to fetch water? 

16. Is there any change in the availability/amount of water or the time spent for fetching water over 

time? If so, what is a main reason for the change? 

17. Do you see any change in the soil conditions of forestlands and cultivation land over time? If so, 

what kind of a change and what is a main reason for the change? 

Gender role in reproductive work and daily-based/annual time-use 

18. What kinds of responsibilities do women and men take in household chores/reproductive work, 

such as collecting firewood/NTFPs, fetching water, cooking, washing, child-care, and taking 

care of animals/livestock? 

19. How many hours do women and men spend for household chores, child-care, and farming in a 

day? 

20. From what time to what time are women and men free or busy in a day? Why? 

21. When is the busiest season in a year for women and men? Why? 

Community-based organizations/groups and services by the Government and NGOs 

22. Do women and men belong to any community-based organization or group? If so, what kind of 

organization or group? 

23. Is the Government’s extension service or training programs available in this village? If so, who 

gets such services and training? Is there any difference in availability or access to the 

services/training opportunities between women and men? If so, why? 

24. Is there any financial services (micro-finance services) available in this village or nearby? If so, 

what are the conditions of the services for borrowing money? Is there any difference in 

accessibility and conditions for borrowing money between men and women? What kind of 

source do you prefer most if you borrow money?  

JICA activities 

25. Have you ever participated in any JICA activities? If yes, what kinds of activities have you 

participated? Why did you participate in such activities? If not, why didn’t you participate? 

26. How have you expected to benefit from the JICA activities? Why? 
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Annex 3. インデプス・インタビューの質問票（コムニボリ用） 

Questionnaire for Individual Interviews in Komuniboli 

 

1. Inheritance & Landownership 

1) In Komniboli, is agricultural and forest land inherited /handed over from a mother of any 

particular family (“Chabota/Lunga”) to her daughter (eldest daughter)? 

2) Even if any daughter inherits the land, is the land controlled and managed by a tribe of 

“Chabota/Lunga” as a whole or any particular group of men?  

3) What will happen to daughters and sons of the land-owning family when they get married? 

 

Category of Children Who is a heir 

(✓ if yes) 

After marriage, where 

does she/he live, 

Komniboli or her/his 

spouse’s place? 

Role/responsibility for the 

land/forest if she/he stays 

in Komniboli(Spell out) 

1) Eldest daughter    

2) Other younger 

daughter/s 

   

3) Sons    

4) Grandchildren  

(children of the 

daughters who 

moved out of 

Komuniboli at 

marriage) 

   

4) How can you categorize women in Komuniboli in terms of land ownership? Is the following 

categorization correct or wrong? If wrong, please correct it. 

(1) Category 1: Women who are the daughters of the “Chaobata” woman who has inherited the land 

ownership 

(2) Category 2: Women who are nieces (daughters of the brothers) of the “Chaobata” woman who 

has inherited the land ownership 

(3) Category 4: Women who are wives of the “Chaobata” men whose mother has inherited the land 

ownership 

(4) Category 5: Women who are not “Chaobata” and are not related at all to the “Chaobata” woman 

who has inherited the land ownership 

(5) Others (specify:                                             ) 

5) What kinds of rights does each of the women categorized have? 
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 Land rights: 

primary, 

secondary, or 

none 

Participation in 

decision-making/ 

consultation on land-

allotting/the 

concession/ selling 

the land 

Access/ Use 

rights for long-

term crops 

Access/ Use 

rights for short-

term crops 

Women (1)     

Women (2)     

Women (3)     

Women (4)     

Others     

Put a tick (✓), if yes 

 

2. Gender-based Activities’ Annual Calendar 

Not about JICA Project’s agro-forestry activity, but your household’s farming/plantation activity 

Type of 
Crops 

Who Jan Feb Mar Apr May June July Aug Sep Oct Nov Dec 

Root 
vegetable 

F             
M             

Other 
vegetable 

F              
M             

Fruits  F             
M             

Betel nuts F             
M             

Coconuts/ 
cocoa  

F             
M             

Indicate who does what activities and when, in the above table, by using the number of the following 

each activity and “→” (from the starting month to the ending month). Indicate at least around which 

month women/men start preparing land and around which month they finish harvesting and selling 

for each of short-term crops in particular. 

 

(1) Activities for farming short-term crops:  

1) preparation by cutting grasses/trees and burning; 2) plowing; 3) sowing seeds/planting seedlings; 

4) weeding; 5) harvesting; 6) marketing; and 7) others 

(specify:                                    ) 

(2) Activities for taking care of long-term plantation crops after plants have grown up: 

1) cutting grasses around; 2) pruning/cutting unnecessary brunches; 3) harvesting; 4) marketing; and 

5) others (specify:                                       ) 

3. Decision-making Power Over Income 

Who (women or men) goes to the market to sell crops and can keep with their hands the money 

earned by selling: 

1) short-term crops, including cassavas, potatoes/sweet potatoes, and other vegetables: 
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2) bananas, pineapples, betel nuts (mid-term?): 

3) long-term plantation crops, including coconuts, cocoa, and kava: 

4) NTFPs (specify any of firewood, mushroom, edible wild vegetables/fruits, or medicinal herbs) 

5) pigs: 

6) fish: 

Who (women or men) makes a decision on how to use the money for: 

1) buying food and living goods: 

2) children’s school fees: 

3) health care fee: 

4) starting any business: 

5) buying personal things: 

6) buying anything expensive for the household/family members: 

 

4. Processes/Procedures for JICA Project’s Pilot Activities 

1) Entry point: 

 How did you get information on JICA Project for the first time? Who told you about it? 

 Were women also invited to the first meeting of JICA Project? If so, what was the reaction of 

women to the invitation? Why was it so? 

2) JICA staff/experts’ Facilitation to Promote Women’s Participation 

 In the first meeting for JICA Project, did the facilitator of JICA Project talk about women’s 

participation in Project-related decision-making or pilot activities? If so, what did he/she say 

about it?  

 Were his/her words enough/or not enough to motivate women to participate in the decision-

making and pilot activities? Why do you think so? 

 How was the reaction of men to such an encouragement for women? Did men also agree to 

involve women in JICA Project’s decision-making and pilot activities? Why do you think that 

men agreed or did not agree? 

3) Process of Establishing the Community Committee and Sub-committees for JICA Project’s 

Pilot Activities 

 Did the facilitator of JICA Project say anything about involving women as members when 

he/she suggested villagers to establish the community committee and sub-committees for pilot 

activities? 

 If so, were his/her words enough/or not enough to convince women and men to involve women 

as members in the committees? Why do you think so? 

 How were female members selected for each committee? Were they selected by other villagers 

or candidacy of women themselves? 
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 There is a social norm that decision-making in a public place is men’s role in Solomon Islands. 

What do you think about your/women’s involvement in any committee as members in spite of 

such social norms? Why do you think so? 

 What do you think JICA Project should do to promote women’s active participation in decision-

making as members of the committees? Why do you think so? 

 In Komuniboli, the committee for women’s development was also established. What kinds of 

roles do you expect this committee to play and what kinds of activities do you expect the 

committee to conduct? Why do you think so? 

4) Decision-making of JICA Project’s Pilot Activities in Meetings and Workshops 

 How many of meetings/workshop did you attend in order to decide what kinds of income 

generation activities or what kinds of tree/crop species to be planted for agro-forestry activity?  

 What time of a day was such a meeting/workshop held? Did the staff of JICA Project ask 

women when/what time is more convenient for women to attend the meetings/workshops in 

advance? Was the timing for the meetings/workshops which were held good for women? 

 In the meetings/workshops, did the facilitator of JICA Project facilitate women to speak up their 

opinions? If so, how did he/she encourage women to speak up? Were his/her words enough/ or 

not enough for women to stop hesitating and speak up? Why do you think so? 

 In the meetings/workshops, were women’s opinions heard by men? Were women’s opinion 

taken as decisions or mostly ignored by men? If ignored, why? Did the facilitator of JICA 

Project say anything or try to facilitate men to take women’s opinions as decisions as well? 

 What do you think JICA Project should do for promoting women’s actively speaking up in the 

meetings/workshops and their opinions being heard and taken as decisions?  

5) Leadership Training Conducted under JICA Project 

 Do you know that JICA Project conducted a leadership training in Komuniboli around 

November or December 2020? 

 Did you get information on the leadership training by the staff of JICA Project or any 

community leaders? 

 Did you attend the training or do you know who attended it? 

 Do you know how participants in the leadership training were selected? 

 If you attended it, what did you learn about in the training?  

 Was the content of the training enough/ or not enough to encourage women to get confidence, 

speak up in a public place, and take leadership? Why do you think so? 

 Do you think the content of the leadership training needs to be improved? If so, in what way? 
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Annex 4. インデプス・インタビューの質問票（ファラケ用） 

Questionnaire for Individual Interviews in Falake 

 

1. Inheritance & Landownership 

1) In Falake, is agricultural and forest land inherited/handed over from a father of any a particular 

family to his eldest son?  

2) Even if any son inherits the land, is the land controlled and managed by the tribe of Funubun as 

a whole or any particular group of men? 

3) In Falake, do women get out of the village when they get married to men who live outside the 

village? Do women get married to men who are the same tribe, but different clans? 

4) Who has land rights and use rights, as well as decision-making power over the land, among 

clans and between women and men in Falake? 

 

Sex Land Rights 

First or second 

rights 

Participation in 

Decision-making 

on land 

development/land 

allocation/ land 

sale 

Access/Use 

Rights for Long-

term Crops 

Access/Use 

Rights for Short-

term Crops 

Sons of a 

landowning 

father 

    

Sons of a 

landowning 

tribal mother 

    

Daughters of 

a landowning 

father 

    

Other women     

Tick (✓)if Yes 

 

2. Gender-based Division of Crops and Division of Labor/Responsibilities 

Not about JICA Project’s agro-forestry activity, but your household’s farming/plantation activity 

Indicate who does what activities and when, in the above table, by using the number of the following 

each activity and “→” (from the starting month to the ending month). Indicate at least around which 

month women/men start preparing land and around which month they finish harvesting and selling 

for each of short-term crops in particular. 
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Type of 

Crops 

Who Jan Feb Mar Apr May June July Aug Sep Oct Nov Dec 

Root 

vegetable 

F             

M             

Other 

vegetable 

F              

M             

Fruits F             

M             

Betel nuts F             

M             

Coconuts/ 

cocoa/ 

Kava 

F             

M             

  

(1) Activities for farming short-term crops:  

1) preparation by cutting grasses/trees and burning; 2) plowing; 3) sowing seeds/planting seedlings; 

4) weeding; 5) harvesting; 6) selling/marketing; and 7) others 

(specify:                               ) 

(2) Activities for taking care of long-term plantation crops after plants have grown up: 

1) cutting grasses around; 2) pruning/cutting unnecessary brunches; 3) harvesting; 4) 

selling/marketing; and 5) others (specify:                                ) 

 

3. Decision-making Power Over Income 

Who (women or men) goes to the market to sell crops and can keep with their hands the money 

earned by selling: 

1) short-term crops, including cassavas, potatoes/sweet potatoes, and other vegetables: 

2) bananas, pineapples, betel nuts (mid-term?): 

3) long-term plantation crops, including coconuts, cocoa, and kava: 

4) NTFPs (specify any of firewood, mushroom, edible wild vegetables/fruits, or medicinal herbs) 

5) pigs: 

6) fish: 

Who (women or men) makes a decision on how to use the money for: 

1) buying food and living goods: 

2) children’s school fees: 

3) health care fee: 

4) starting any business: 

5) buying personal things: 

6) buying anything expensive for the household/family members: 

 



87 

 

4. Ado Association 

1) Who are the members of Ado Association? Are there any women members? If not, why? 

2) What is the eligibility to join Ado Association? Do members need to be from the landowning 

tribe and men? 

3) Is there any intervention/training program provided by its related external organization to 

promote women’s participation and leadership for Ado Association? If so, what was like? 

4) What is the regulation on how to share among members the profit earned from selling forest 

resources? If women are members, can they also get the share? Or is the profit shared among 

male members or only at the household level? 

5. Malaita Provincial Council of Women  

 What kinds of activities and training programs does Malaita Provincial Council of Women 

provide women in Falake? How often? Who attend the activities and training programs? 

 How do you get information on coming activities and training? How are participants selected 

for each activity and training? 

 Have you attended any activity or training? How was it? Do you think such an activity and 

training helpful for you to be self-confident, take an action, or take leadership? Why do you 

think so? 

6. Processes for JICA Project’s Pilot Activities 

1) Entry point: 

 How did you get information on JICA Project for the first time? Who told you about it? 

 Were women also invited to the first meeting of JICA Project? If so, what was the reaction of 

women to the invitation? Why was it so? 

2) JICA staff/experts’ Facilitation to Promote Women’s Participation 

 In the first meeting for JICA Project, did the facilitator of JICA Project talk about women’s 

participation in Project-related decision-making or pilot activities? If so, what did he/she say 

about it?  

 Were his/her words enough/or not enough to motivate women to participate in the decision-

making and pilot activities? Why do you think so? 

 How was the reaction of men to such an encouragement for women? Did men also agree to 

involve women in JICA Project’s decision-making and pilot activities? Why do you think that 

men agreed or did not agree? 

3) Process of Establishing the Community Committee and Sub-committees for JICA 

Project’s Pilot Activities 

 Did the facilitator of JICA Project say anything about involving women as members when 

he/she suggested villagers to establish the community committee and sub-committees for pilot 

activities? 
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 If so, were his/her words enough/or not enough to convince women and men to involve women 

as members in the committees? Why do you think so? 

 How were female members selected for each committee? Were they selected by other villagers 

or candidacy of women themselves? 

 There is a social norm that decision-making in a public place is men’s role in Solomon Islands. 

What do you think about your/women’s involvement in any committee as members in spite of 

such social norms? Why do you think so? 

 What do you think JICA Project should do to promote women’s active participation in decision-

making as members of the committees? Why do you think so? 

 In Falake, the committee for women’s development was also established. What kinds of roles 

do you expect this committee to play and what kinds of activities do you expect the committee 

to conduct? Why do you think so? 

4) Decision-making of JICA Project’s Pilot Activities in Meetings and Workshops 

 How many of meetings/workshop did you attend in order to decide what kinds of income 

generation activities or what kinds of tree/crop species to be planted for agro-forestry activity?  

 What time of a day was such a meeting/workshop held? Did the staff of JICA Project ask 

women when/what time is more convenient for women to attend the meetings/workshops in 

advance? Was the timing for the meetings/workshops which were held good for women? 

 In the meetings/workshops, did the facilitator of JICA Project facilitate women to speak up their 

opinions? If so, how did he/she encourage women to speak up? Were his/her words enough/ or 

not enough for women to stop hesitating and speak up? Why do you think so? 

 In the meetings/workshops, were women’s opinions heard by men? Were women’s opinion 

taken as decisions or mostly ignored by men? If ignored, why? Did the facilitator of JICA 

Project say anything or try to persuade men to take women’s opinions as decisions as well? 

 What do you think JICA Project should do for promoting women’s actively speaking up in the 

meetings/workshops and their opinions being heard and taken as decisions?  

5) Leadership Training Conducted under JICA Project 

 Was a leadership training conducted in Falake around November or December 2020? 

 If so, did you get information on the leadership training by the staff of JICA Project or any 

community leaders? 

 Did you attend the training or do you know who attended it? 

 Do you know how participants in the leadership training were selected? 

 If you attended it, what did you learn about in the training?  

 Was the content of the training enough/ or not enough to encourage women to get confidence, 

speak up in a public place, and take leadership? Why do you think so? 

 Do you think the content of the leadership training needs to be improved? If so, in what way? 
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1 

I  INTRODUCTION 

 

1 Background 

This report presents results of the community profiling and socio-economic analysis provided under the 

‘Activity 3.2: Conduct community profiling in collaboration with the community people and socio-

economic analysis in/around the Pilot Sites’ of the Project on Capacity Development for Sustainable 

Forest Resources Management (SFRM Project) (hereinafter referred to as ‘the Project’). 

Since the commencement of the Project in September 2017, various processes for selecting the Pilot 

Sites (Activity 3.1) had been conducted under the ‘Output 3: SFRM Pilot Activities, initiated by the 

communities and supported/ facilitated by MOFR1, are implemented’. As the results, two Pilot Sites 

were identified; i.e. i) Komuniboli Community of Guadalcanal Province, ii) Falake Community of 

Malaita Province. As for the next step for attaining the Output 3, the Activity 3.2 stated earlier was 

initiated. 

Apart from the community profiling and socio-economic analysis, ‘wealth ranking’ was supplementarily 

conducted to cope with a limitation encountered during the course of the field survey for the socio-

economic analysis. 

 

2 Methodology 

Methodologies applied for each process are described as below: 

 

2.1 Community profiling 

The major objective of the community profiling was to grasp general conditions of each target 

community. The items of data and information collected include i) General information, ii) Traditional 

governing system, iii) Population, iv) Community infrastructure, v) Economy, vi) Occupation/ employ-

ment, vii) Financial service, viii) Community-based organization, and ix) Record of activity/ project 

related with natural resources. 

Participatory rural appraisal (PRA), which is a qualitative and participatory research methodology, was 

adopted for the data and information collection. The particular methods and approaches of PRA applied 

were i) Seasonal calendar, ii) Resource map, and iii) Social map. Information on the dates and stake-

holders involved in the data and information collection is depicted in a table below, and the summary 

results of the community profiling are indicated in Appendix 1 and 2. 

 

                                                      
1 Ministry of Forestry and Research 



 

2 

Komuniboli Community 

 Date created 31 July 2018 

 Facilitators Ms. Stephanie Rikoi, MOFR HQ (Utilization Division) 

Ms. Ruvie Pitavaqa, MOFR HQ (National Herbarium and Botanical Garden Division) 

Falake Community 

 Date created 18 September 2018 

 Facilitators Task Force members 

 

2.2 Socio-economic analysis 

The socio-economic analysis was undertaken in order to further collect data and information regarding 

social and economic aspects of each target community. The items gathered for the social aspects include 

i) Leadership/decision making process, ii) Land ownership and use, iii) Gender2  situations, and iv) 

Community-based organisation, whilst for the economic aspects; i) Income and ii) Expenditure. 

As for the methodology of data and information collection, focus group interviews were applied with 

an intentionally unstructured style. Other information related to this process is shown in a table below: 

Komuniboli Community 

 Field survey period 11 September – 13 September 2019 

 Surveyors Mr. Eric Kwaria, MOFR HQ (Reforestation & Forest Development Division) 

Ms. Verity Halinge, MOFR HQ (Timber Utilisation Division) 

Ms. Shimako Narahara, JICA SFRM Project 

Falake Community 

 Field survey period 2 September – 4 September 2019 

 Surveyors Mr. Ronnie Aiwewe (2 Sep 2019), MOFR Auki Office 

Ms. Angela Gwao (2-4 Sep 2019), MOFR Auki Office 

Ms. Shimako Narahara (2-4 Sep 2019), JICA SFRM Project 

 

2.3 Wealth ranking 

As briefed previously in ‘1 Background’, this method or approach was applied to supplement the socio-

economic analysis. The difficulty learnt through field surveys for the socio-economic analysis was that 

sufficient quantitative data/information regarding the economic aspects, particularly household 

economy such as income and expenditure, were unable to be gathered from the interviewees mainly due 

to undevelopment of monetary economy. Thus there was a need to find another method that can gather 

                                                      
2 Regarding gender, a simple survey was conducted at the beginning of the project, and a full-scale survey was conducted in the latter half of 

the project with reference to the contents of this report, and summarized in the report. Please refer to the report for details. 
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sufficient economic data/information which can also be utilized as the baseline data/information of the 

Project. 

Wealth ranking is a tool that can identify different socio-economic groups in the community according 

to how they themselves perceive their different levels of well-being. At workshops organised for detailed 

planning of livelihood related activities, the key criteria and indicators were set by the local participants 

themselves to categorise the households into different socio-economic categories. Detailed information 

on the workshops is summarised as follows: 

Komuniboli Community 

 Date 3 March 2020 

 Facilitators Mr. Eric Kwaria, MOFR HQ (Reforestation & Forest Development Division) 

Mr. Hillary Wemani, JICA SFRM Project 

Mr. Makoto Fukuyama, JICA SFRM Project 

Falake Community 

 Date 10 March 2020 

 Facilitators Mr. Hillary Wemani, JICA SFRM Project 

Mr. Makoto Fukuyama, JICA SFRM Project 

 

Later, only the Community Committee members reportedly conducted the actual categorisation of all 

the households according to the selected criteria and indicators since this was rather a sensitive issue of 

the communities. 

The results of the wealth ranking as the baseline data shall be utilised for comparing with the endline 

data that will be collected at the end of the Project life so that the effects and impacts of the Project can 

be assessed. 
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II  RESULTS 

 

This chapter illustrates the results including the findings, lessons learnt and remarks of the three 

processes; i.e. the community profiling, socio-economic analysis and wealth ranking. 

 

1 Komuniboli Community 

1) Social aspects 

Points of Information & Analysis 

 The decision-making authority is not possessed by the Community Chief. Rather, the decision making 

is done through Chief-elders discussion and consultation. 

 There is no formal/registered community organisation exists in the Community. However, the recently 

re-shuffled Komuniboli Community Committee could be a decision-making and management body of 

the Project-related activities. The Community Committee is composed of not only the Chief and 

established elders but also active Community members who possess leadership and initiative. 

 Komuniboli being a matrilineal society, the bloodline of the leaders and inheritance system hold females 

in esteem. However, the practical leadership is dominantly assumed by males. Practically saying, 

females are isolated not only from leadership/initiatives but also from information. 

Leadership/Decision making process 

Komuniboli 

Community Chief 

 Komuniboli belongs to a sub-tribe called Lunga, under Ghaobata (one of the 

tribes3 or big tribes in Guadalcanal). 

 Komuniboli has a Chief who represents the whole Community. 

 Current Komuniboli Chief is Mr. Joseph Manegelea. He inherited the chieftain-

ship from late Mr. Charles Maneka (Joseph’s elder brother from the same 

mother), in 2018 when Chief Charles was diseased. 

 The chieftainship is assumed by a male, although it is inherited through the 

female bloodline of the Chiefs’ family.4 The chieftainship belongs to one 

person until he passes away. 

 In Joseph’s case, he became the Chief only in 2018. However, because the ex-

Chief Charles had been long sick and unable to manage the Community, Joseph 

had acted as the de-facto Chief for some time. This de-facto Chief is called “the 

Elder of the Community”. 

Komuniboli 

Community in the 

Tribe 

 For the sake of the Project activities, it is proposed not to call Komuniboli a 

“clan”, “sub-tribe” or “tribe” but “Community” from now on, so that any 

confusion is avoided. 

 Lunga sub-tribe communities are located in east-central area of Guadalcanal. 

                                                      
3 Community people sometimes call Komuniboli as the “tribe”, without defining what a tribe is. Ghaobata is often called the “big tribe”. They 

usually do not call Lunga as “sub-tribe” (just “Lunga”, or “Lunga tribe”), but in the sense that “Ghaobata” is the tribe (as a common sense 

in Guadalcanal), in this report, Lunga is called a sub-tribe, under which Komuniboli Community is situated. In the survey and other Project 

activities so far, the surveyors have not heard the term “clan” is used in Komuniboli 
4 The detailed information on chieftainship was collected but the contents are not indicated in this report due to a strong request by the 

community. 
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 Within Lunga sub-tribe, there are 4 communities: 

- Komuniboli 

- Lathi 

- Luluga 

- Mataniko (located in Honiara) 

 No chief exists to govern Lunga sub-tribe. However, the 4 Lunga Communities 

cooperate and consult with each other. 

 Marriage within Komuniboli, and within Lunga sub-tribe is prohibited. 

Therefore, inter-marriage with a person of Ghaobata (outside Lunga) is not a 

problem. 

 When one of Lunga Communities enters into a logging concession, the benefit 

is shared to other 3 Lunga Communities as well. 

 Komuniboli was recently given: 

- A one-box vehicle (bus)5 by Mataniko, and 

- A 3-ton truck6 by Luluga. 

as examples of intra-Lunga cooperation. 

 Ghaobata has a Chief, who is a male and is selected through a selection process 

in which the area’s paramount chief is involved. 

Decision making 

through consultation 

 The Community Chief is the representative of the Community, but he does not 

make any important decision on his own. 

 Important decisions are made through discussion between the Chief and the 

community elders.7 

Intra-Community 

family groups 

 The current Chief’s siblings (3 brothers and 4 sisters) and their descendants 

form loose family-groups in the Community. 

 Out of 7 siblings, 2 brothers passed away, some sisters live outside Komuniboli. 

 The Community does not see these family-groups as any formal groupings such 

as clans. Borrowing one respondent’s words, the Community is “one big 

family”. 

Decision making 

body for Project-

related issues 

 Komuniboli Community had formed a commu-

nity governing system. Lately the system 

members were reshuffled. 

 It was proposed, during the survey period, that 

the re-organised system, called Komuniboli 

Community Committee, shall serve as the 

 The names of the Commit-

tee members are listed in 

Table 1 attached at the 

end of this section. Just for 

reference, a list of the 

Community Sub-

committee members is 

                                                      
5 The vehicle is currently managed by Abraham Maneghana. 
6 The truck is currently managed by a person living outside the community. There has so far been no profit made by a business using the truck 

yet. However, the rules of profit sharing have yet to be determined among the stakeholders. 
7 There are some levels of the Elders, and which level of Elders involve in an issue depends of the importance of the issue. As the community 

is a matrilineal society, there are some Elder women; e.g. sisters of the Chief, etc. and they are sometimes consulted but it seems the major 

decisions are made among the Elder men. 

It is also rather complicated to define the Elders. Elders living outside the community, who are close to the Chief family, seem to be included 

in the Elders. Compared with the Falake Community, those Elders are less influential but they still keep a certain degree of influence on the 

community. 
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decision-making and management body of the 

Project-related issues and activities. 

 The Committee is composed of: 

- Executive team (Chairman, Vice-chairman, 

Treasurer, Vice-treasurer, Secretary and Vice-

secretary) 

- Non-executive Committee members (7 

persons) 

- Sub-committees (Works, Accommodation, 

Stock, Village Management) 

 The Chairman of the Committee is the 

Community Chief. 

 More or less all family groups inside the 

Community are represented in the current 

Committee in a balanced manner. 

indicated in Table 2 but it 

does not necessarily mean 

that the Sub-committees 

shall only deal with the 

Project related issues. 

Land ownership and use 

Land ownership  The Community land (including the forest) is 

tribally owned8, not individually owned, 

regardless of gender. 

 

Forest land 

allocation and use  

 When Komuniboli Community members wish to 

use the forest, they need to consult with the 

Community Chief and the elders, before starting 

any activity. 

 This is especially for long-term and/or larger-

scale use such as plantation. 

 The Chief and the elders discuss and when 

agreed as good for the community and the 

future, the use is approved. 

 As of the time of the survey, 2 households have 

established coconuts plantations, and some have 

cultivated small patches as vegetable gardens 

inside the forest. 

 

Gender situations9 

Marriage  Some women were born here in Komuniboli and 

their husbands married in. Others were born in 

other communities and married into Komuniboli 

-born husbands. 

 The exact rates of 

married-in women and 

Komuniboli-born women 

are not clear. However, it 

                                                      
8 In this sentence, the term “tribe” does not mean Ghaobata. It is owned by the community’s collective ownership. 
9 Regarding gender, a simple survey was conducted at the beginning of the project, and a full-scale survey was conducted in the latter half of 

the project with reference to the contents of this report, and summarized in the report. Please refer to the report for details. 
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 There is no apparent contraposition or disagree-

ment between 2 women’s groups (married-in 

women and Komuniboli-born women). 

However, although not clearly expressed, 

married-in women seem to feel that their group 

is more pressurised, always having to work hard. 

seems neither pattern is 

dominant. 

Project-related 

information, 

decision-making 

and activities 

 The access to information by the women is 

greatly problematic; it was discovered that some 

women had not even known that the Project is 

forestry-related, until participating the survey. 

 Women in general feel that the Project-related 

decisions have been made without their suffi-

cient participation. Not that they disagree with 

what has been decided, but rather, they wanted 

to question and clarify before the final decision 

is made. 

 (Asked the reasons why they do not raise 

questions or express opinions in meetings) 

Women gave the following as answers: 

- The respondents do not know the language 

used (English, Pidgin). 

- Although having ideas, the respondents are 

not accustomed to speaking up in formal 

meetings. 

- The respondents have no courage to say 

things in front of others. 

- “Men-only decision making” is what always 

happens in the Community. No say for 

women. 

- For married-in women, who are not seen as 

land-owners, the interest toward forest may 

be less than the Komuniboli-born women. 

 

 

 

 

 Although the Community 

is matrilineal, in practice, 

women hardly have 

chances and influences in 

meetings and in decision-

making process.  

 Holding women-only 

meetings would improve 

the situation. The 

respondents preferred 

smaller-size meetings as 

they would feel more in 

ease to say anything. 

Women’s groups  Women have formed Komuniboli Women’s 

Group. 

- Basically a savings group but not very active 

yet. 

- The leaders are: Mary Tagithia, Elizabeth 

Mane, and Belinda Aba10. 

 

                                                      
10 They are also the Community Committee Members. 
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 The women started to gather for group cooking 

and would like to start catering business, target-

ing possibly nearby schools. 

 The respondents would like to have “women-

only” training. The contents may include: 

- Cooking 

- Business management and financial 

management (for catering and other business) 

- Discussion skills (for them to be capable of 

speaking up in meetings/ with outsiders) 
 

Lessons Learned & Suggested Project Approaches 

 It is very important to understand the decision-making process, as it varies greatly from a community to 

another. In Komuniboli’s case, depending on how important an issue is, more “elders” including those 

who reside outside the Community may need to be consulted, which inevitably requires more time. This 

would make it difficult to keep planned intervention schedule. When MOFR/the Project plan any 

intervention, this point needs to be taken into consideration. 

 The Community members seem to use the community-related terms including “chief” and “elder”, and 

“tribe”, “sub-tribe” and “community” without clear definitions and differentiations. It would be 

advisable for MOFR and the Project to be careful when hearing and/or using these terms, so that no 

misunderstanding occurs. 

 As such, in community-based activities in general, it is essential to double-check with the concerned 

community people what they exactly mean by the terms “tribe”, “clan”, “chief”, “elder” and other 

commonly used societal words. Without clear understanding of these basic terms, MOFR’s goodwill 

intervention may confuse the communities. 

 The survey found out that the participation to and understanding of the so-far Project activities (including 

meetings) by the women is greatly insufficient, despite the Community being matrilineal. Likewise, the 

women’s participation in decision-making process within the Community in general is low. MOFR and 

the Project should consider means to efficiently and effectively involve women more, and to encourage 

their initiatives and actions. 

 The survey found out that some women were not even aware of the Project having to do with the 

forest/forestry. The information does not automatically trickle down inside the Community. In order not 

to widen the information divide inside the Community, the very basic information about the Project 

(including its focus on forestry/forest management, and it’s not being a funding project) should be 

periodically reminded to the Community members, especially to those who are often marginalised 

(including women and youth). When doing so, using Langus (their tribal language), not English and not 

Pidgin, is highly advised, because the marginalised people are not well accustomed to even Pidgin. This 

means Langus-speaking MOFR officers’ involvement/initiative in Project-related activities is even more 

important than it was previously understood. It may be worth thinking to have separate “basic-

information sharing” meetings with these marginalised Community members, as it now seems there is 

a gap inside the Community between people who know and people who do not know what is going on. 
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 Capacity building of the newly-formed Community Committee shall be required. The Community 

people also requested to provide training (especially about organisational management, financial 

management, shared-property management and leadership) to the Committee members, hoping the other 

Community members will be able to learn from the Committee members later. 

 Capacity building of the women’s group is desirable. Similar kinds of training to the Committee would 

be effective. 

 It is important to clarify who is/are the contact person(s) of the community. At the same time, it must be 

noted that this contact person may or may not be the leader of the Community (be it formal decision 

maker or opinion leader). This means what the person says or understands may or may not be what the 

Community thinks or decides. 

 

Table 1  List of Community Committee members (Komuniboli) 

Post Name 

Chairperson Joseph Manengelea 

Vice Chairperson Abraham Maneghana 

Treasurer Mary Tagithia 

Vice Treasurer Elizabeth Mane 

Secretary Philimon Pete 

Vice Secretary Belinda Aba 

Member Augustine Geve 

Ditto Moses Pegoa 

Ditto Desmon Tagithia 

Ditto James Tapalia 

Ditto Julia Sam 

Ditto Batistina Saburua 

Ditto Mark Sukulu 

 

Table 2  List of Community Sub-committee members (Komuniboli) 

Sub-committee Responsible person 

Works Desmon Tagithia, Augustine Geve 

Accommodation Mark Sukulu, Sosimo Kuki (Jr) 

Stock Abraham Maneghana, James Tapalia 

Village Management Moses Pegoa, Joseph Votakema 
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2) Economic aspects 

Points of Information & Analysis 

 Majority of the respondents described their major livelihood (income-generating) activity is farming. 

However, the kinds of crops, the frequency, amount, marketing locations of the selling are very diverse 

and basically very much up to each person/household. 

 Seemingly, some own larger scale plantations (such as coconuts and/or cacao) while others do not have 

any plantations and struggle to earn cash income. 

 As such, there is hardly any “typical” or “average” type/scale of agricultural and other activities in the 

community, as the following examples show. 

Income 

Agricultural 

crops 

1) Coconuts 

 Owns 2ha plantation (outside the forest). 

 Dry coconuts: SBD11 1-2/fruit. 

 Copra: SBD 2-2.4/kg. Go to Honiara for selling. 

 Selling frequency is twice a month at maximum 

(both dry coconuts and copra). When price is not 

good or harvest is not enough, selling frequency 

becomes less. 

2) Cacao 

 Trees planted outside the forest. 

 Dry: in 2018, sold twice. SBD 11/kg. 

 Wet: in 2019 (9 months), Sold twice. SBD 2/kg. 

Sells it when needs fast-money. 

 For cacao selling, there are a few buyers. When 

selling, shop-around and sell to the best available 

buyer. 

3) Fruit leaf 

4) Vegetable 

 Go to Central Market in Honiara for selling. 

 

 The respondent seems to be one 

of the most established farmers 

in the Community, given his 

diversified crops which give 

him choices when and how 

much to sell. 

 

 

 

 

 

 

 

 

 

 Fruit leaf is the long bean-like 

fruit which is consumed with 

betel nuts. 

Coconuts and cacao 

 Have some trees of both kinds. 

 Complains the income from them is not good, 

partly because the soil is not suitable for the 

species. 

 

 2 respondents gave the same 

answers, without giving actual 

figures (selling prices, 

frequency, or amount) 

Fruit leaf 

 Selling price fractures. Maximum SBD 30-40/ 

parcel, minimum SBD 5/parcel. 

 

 In this interview, 4 male 

respondents mentioned growing 

and selling fruit leaf as a 

livelihood means. 

                                                      
11 Solomon Islands dollar. As of 1 May 2020, SB 1 = JPY 12.63. 



 

11 

 Latest selling was a few days ago before the 

Interview. At that time, the respondent sold it by 

SBD 10/parcel. 

 The selling frequency depends on how much the 

harvest is. 

 

 One of the 4 respondents said it 

is the only cash-income he has. 

 4 respondents said they were 

starting piggery and chicken 

rearing, as they do not see 

coconuts and copra having 

good potential. They have not 

experienced any actual selling 

of either pig or chicken. 

Cane and Sago palm leaves 

 When order comes, collects from the forest and 

sells. 

 Both is usually sold in SBD 80-100/bundle. 

 Selling is not frequent as it is basically demand-

based. 

 Cane and Sago palm leaves are accessible to and 

can be harvested by, all Community members 

without anybody’s approval. 

 

Timber  Timber harvesting and marketing had been tried 

before, but proved to be non-profitable and 

currently not practiced. 

 Depending on the respondents, 

the period/timing of timber 

marketing trial, as well as how 

the Community members try to 

organise the practice, vary 

greatly. In this survey, it did not 

become clear what actually 

happened when, involving 

whom. 

Expenditure Expected 

Regular 

goods 

 Rice, Taiyo (tuna cans), salt, sugar—these things 

are usually bought from Honiara and/or nearby 

shops. 

 Now majority of households have solar cells and 

kerosene buying is not required. 

 Some kinds of fish and eels are 

harvested from ponds in the 

Community forest. When there 

are surplus, the fish are sold 

locally. 

School fee  Primary school 

- Including registration fee, approx. SBD 50-200 

required. 

- In addition to that, uniforms and books cost. 

 Secondary school 

- Approx. SBD 2,000/year 

- In addition to that, uniforms, books and board-

ing expense cost—in total SBD 3,000 or more 
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Bride price  Currently approximately SBD 20,000 (cash plus 

shell money) required as bride price. 

 The Community members contribute a part of the 

bride price. The contribution will be repaid by the 

groom (not the father), in similar situations; i.e. 

when a contributor’s son gets married, the now-

groom will give his contribution. 

 Bride price in Komuniboli (and 

most places in Solomon 

Islands) is paid from the 

groom’s family to the bride’s 

family. 

Community 

contribution 

 Church contribution, approx. 3 times/year 

 School contribution, approx. 3 times/year 

 Roughly SBD 50-200 required 

 

Expenditure Unexpected 

Hospital fee  Elderly couple’s regular hospital cost: 

- Both husband and wife needs regular hospital 

care. 

- Unable to pay on their own (actual expenditure 

not clear). 

- Currently paid by the husband’s son, although 

the couple and the son are different households 

 

Funeral  Expenditure depends, but considerable burden in 

terms of household-economy. 

 However, Community members contribute to help. 

 

Expenditure (Others) 

House 

building 

 When building houses and other small buildings, 

basic materials such as timber is harvested in the 

Community forest. 

- Before harvesting timber from forest trees, it is 

needed to get verbal approval from either 

Community Chief or next Chief. 

- The timber is harvested from the patches 

allocated as “sustainable harvesting area” in 

the forest. 

 Komuniboli Community owns 2 timber mills, 

which are supervised by one Community member. 

- In order to use the mill to produce timber, mill 

usage fee is required. 

 Community member: SBD 1,000/day 

 Non-Community member: SBD 1,500/day 

 The supervisor is to use the earned money to 

maintain the mill properly. He is also allowed to 

use some part of the earning for his own purpose. 

 

 

 

 

 If trees in the sustainable 

harvesting area is insufficient/ 

not big enough, the person 

needs to buy timber from 

outside. 

 

 Other respondents’ explanation 

contradicts what is written in 

the left column: According to 

the other group of people, this 

“supervisor” does not let other 

Community members use the 

mill. 
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Lessons Learned & Suggested Project Approaches 

 It should be noted that due to the limited time available for the research, it is quite possible that many of 

the people who work outside the community are missed out from the Focus Group Interviews, hence the 

community people’s livelihoods outside the community (e.g. transportation-related business) is not 

understood well enough. This means there is even more diversity, than that seen above, exists in the 

community. 

 Even with the present information, it is virtually impossible and moreover impractical to try to have an 

“average” picture of the community members’ livelihood means including income, expenditure, and 

income-generating skills/knowledge. 

 MOFR and the Project should accept the diversity of their livelihoods means, and try to think of a 

practical intervention(s) which would contribute to different types of livelihoods means and to varied 

levels of income-generating and fund-management skills of the community members. 

 It is very likely that other communities (with which MOFR will work in the future) would have quite 

similar diversity of livelihood means of the community members. The support/intervention of MOFR 

should be planned based on this understanding. 

 

3) Wealth ranking 

Criteria 
Indicators 

Rich / Wealthy Fair Below average (Poor) 

1) Machinery/ Equipment Have  None 

2) Cash/ Saving Meet necessary needs in 

time 

Borrow money but repay 

later 

Have debt, always 

postpone repayment 

3) Housing - Permanent 

- Large 

- with water tank 

- Semi-permanent - Bush materials 

- Small 

4) Transport business Have  None 

5) Plantation > 1 plot 1 plot None 

6) Poultry Broiler and local variety Local variety None 

7) Pigs > 10 locals < 10 locals None 

8) Education Literate  Illiterate 

9) Schooling of children Tertiary school Secondary school Primary / None 

10) Furniture Mattress   

 

RESULTS (# OF HHS) 1 11 12 
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2 Falake Community 

1) Social aspects 

Points of Information & Analysis 

 It is found out that there are 4 clans in the community, not 3 clans as previously understood. Arurumae 

Clan, Anita’a Clan, Gae Clan and Kwaiorea Clan (in order of population/number of households). The 

last Kwaiorea Clan, which was previously unknown to MOFR and the Project, is the people who live in 

the inland part of the community land12. 

 Falake people does not use the word “chief” as the leader of the tribe/clan. Rather for leadership 

positions, they use the word “elder”. It should be noted that the word “chief” is used for persons 

appointed to solve troubles. 

 An elder of a clan is a male, and the eldest son of the ex-elder of the clan. The elder’s bloodline is 

descended from the original 3 brothers of the tribe. 

 The elders of the Clans are the leaders of the Community. According to the information gathered, there 

is no one particular person who represents Falake. The Clan leaders discuss and make a decision. 

 However, even the agreed decision of the leaders of 4 Clans will not be the final decision. All decisions 

are to be made through consultation and mutual agreement, not only with other Clans of Falake but also 

with other tribal members who live in other communities including Dala13 and Honiara. 

 The inter-relationships of the clans are complicated, with no clan/person has any solid authority over the 

other clans. 

 Moreover, advice and consent from other tribal elders who live outside Falake has a considerable 

influence over Falake Community’s decision making. 

 There is an influential organisation called ‘ADO Rural Farmers’ Association’ existing in the community. 

Leadership/Decision making process 

Elder as Clan leader  The leader of a Clan is called the elder. The clan 

elder is the eldest son of the ex-elder of the clan. 

 The elder’s bloodline is descended from the 

original 3 brothers of the tribe. 

 If, for any reason, the 

elder’s eldest son cannot 

become the next elder, 

then a clan meeting shall 

be held and decide who 

will become the next elder. 

“Chief” as trouble-

shooter 

 Chief in Falake’s context is a Clan’s trouble-

shooter. 

 The position is taken by Mr. Hendry Kwateana, 

a younger-middle-age (approx. in 30s), appoint-

ed by Clan elders. 

 The troubles which the chief deals with are 

basically inside-Falake ones, such as stealing, 

fighting and other problems. 

 

                                                      
12 A map showing residential areas by clan (except Kwaiorea) is given in Figure 1. 
13 Dala is located a few kilometres far away from the Falake Community. 
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 When the trouble is more than the chief can take 

care of, he will consult the Clan elder. 

 If the Clan cannot deal with it, then other Clans’ 

chiefs and/or Clan elders will be involved. 

 In case of bigger troubles (i.e. not-inside-Falake 

problems), Clan elders (rather than chiefs) take 

the lead. 

Decision making 

through discussion 

and consultation 

 No decision is made by one elder. 

 If the issue concerns only-Falake, the elders of 

all Falake Clans discuss and decide. Then they 

let the Community members know. 

 If the issue concerns not Falake-only, Falake 

Clan elders cannot make decision on their own. 

They need to consult other Clans of the tribe 

beforehand, and gets their opinions and advices. 

 

Decision making 

body for Project-

related issues 

 Some respondents expressed their worry about 

insufficient transparency (from their point of 

view) of the decision-making process in relation 

to Project-related issues. 

 It was suggested to form a Falake Community 

Committee which will have a decision-making 

authority for Project-related issues. 

 The proposed members of the Community 

Committee include: 

- Clan representatives (male and female from 

all 4 Clans) 

- Executives of ADO Rural Farmers’ Associa-

tion 

- Clan chiefs 

- Church representative(s) 

- Women’s representative(s) 

- Other representatives incl. Youth and 

Education representatives 

 

 

 

 

 On the last day of the 

survey, the proposed 

forming of Community 

Committee was discussed 

and agreed by the 

Community. 

 Towards the end of 

September, Falake 

Community Committee 

members were selected by 

the Community people. All 

proposed members (see the 

left column) were included 

in the Committee structure. 

 The names of the Commit-

tee members are listed in 

Table 3 attached at the end 

of this section. Just for 

reference, member lists of 

the Community Sub-

committees are also 

indicated in Table 4. 
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Land ownership and use 

Forest land 

allocation system 

 There are no clear rules, system or authority for 

allocation of forest land. 

 Anybody (Falake Community members as well 

as outside-Falake tribal members) can take a 

piece of land of the Falake forest for his use. 

 No formal approval from elder(s) and/or 

chief(s) needed. However, the person who wants 

to use a patch of land must inform the elders 

and others. In reality, it seems if the person 

cannot get the consent from the concerned elder 

and others, he cannot use the forest land. 

 Due to this non-existence 

of allocation system, most 

of the forest land is already 

taken and in small patches. 

 The Community people are 

aware that this non-system 

is unsustainable, but so far 

no actual means of change 

is thought out or practiced. 

Ownership of 

plantation 

 When the person gets the consent for using the 

forest land, he will have the ownership of the 

planted/harvested trees and other crops in the 

land. However, the ownership of the land of the 

patch remains with the tribe, not the person. 

 Women do not have land ownership. But for 

plantation, both sons and daughters inherit the 

plantation ownership from their parents. 

 

Gender situations14 

Marriage  Majority of married women seem to have been 

married in (i.e. born in other tribes/ commu-

nities), with some exceptions. 

 All women were supposed 

to move out of Falake 

before, when they got 

married with non-Falake 

males. But, lately, the 

tradition has become 

loosen and some women 

live with married-in 

husbands in Falake. 

Project-related 

activity 

 Have heard about the Project since 2018. 

 Some participated in meetings but just sat there, 

because decision making is men’s job. 

 Boundary survey not participated because it is 

men’s job, and also there are tambo sites. 

 When husbands are in the Project activity, it is 

difficult for females to also participate because 

they have to take care of children at home. 

 

 

 

 Women are not allowed to 

enter tambo (taboo) sites 

in the forest. 

 Outside tambo sites, the 

forest is open to women. 

They usually do not go 

                                                      
14 Regarding gender, a simple survey was conducted at the beginning of the project, and a full-scale survey was conducted in the latter half 

of the project with reference to the contents of this report, and summarized in the report. Please refer to the report for details. 
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 If invited to the Project’s forestry-related 

activity; respondents said they would like to go 

but it could be difficult because their time is 

already packed. In order to participate in more 

activity, they have to find time to do so. 

 

into the deep forest, but 

for non-timber forest 

products (NTFPs) collec-

tion and helping the 

husband’s forestry work, 

for ex-ample, the women 

do go into the forest. 

Decision-making in 

Project-related 

matters 

 (When asked if they want to have more say in 

the Project-related decision making) Yes, the 

women want to participate more in the Project 

and Project-related decision making process. 

 However, it is not their culture and if there is 

just one female in the meeting, it is difficult to 

say anything. Therefore, it is good if two or 

more women are invited to and attend in the 

meeting, to back up each other. The more in 

number, the easier for the women to express 

their opinions. 

 

Control of money  Different from couple to couple. 

 Considerable number of women go out of 

Community to sell crops. For example: 

- Going to Honiara to sell cabbage, leafy 

vegetable and betel nuts, not regularly but 

often. 

- Selling betel nuts and root crops at Fosim 

Market15. 

 Some respondents (women) seem to have at 

least some level of money-control. For example: 

- The couple discusses after gaining cash 

income and keeps part of it for future (mainly 

for children’s education). 

- However, the majority seems to have little 

control of money in the households. 

 

 The women’s having not 

much control of cash is a 

presumption based on the 

way of their reactions in 

the Focus Group Discus-

sion. Apparently most of 

the women did not want to 

give any clear answer to 

the surveyors. 

Gender-based 

violence (GBV)16 

 GBV surely exists, especially by husbands to 

wives. 

 The elders and neighbours step in to stop it, 

only when physical violence is seen. 

 GBV exists, but just like 

other societies, it is not 

supposed to be a topic to 

openly talk about. 

Therefore, the identities of 

                                                      
15 The nearest local regular market from the Falake Community. 
16 Regarding gender, a simple survey was conducted at the beginning of the project, and a full-scale survey was conducted in the latter half 

of the project with reference to the contents of this report, and summarized in the report. Please refer to the report for details. 
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 As such, when GBV is not physical (such as 

arguing/verbal), wives have no help from 

outside of the household. 

the informants shall not be 

revealed. 

Falake Women’s 

Craft group 

 Started to gather in July 2019, based on some of 

ADO leaders’ idea. 

 Weekly meetings on Wednesdays. 

 Have so far made some handicrafts. 

 Wish to sell the products, but no action yet. 

 It was found that women of 

2 Clans (out of 4 Clans) are 

not participating. This 

seems to be something to 

do with inter-Clan rivalry. 

 The surveyors strongly 

recommend for MOFR and 

the Project not to use this 

Women’s group as a “base” 

of gender-related Project 

activity, as it is likely to 

lead more complicated 

inter-Clan relationship. 

Community-based organisation 

ADO Rural Farmers’ 

Association 

 Executive Committee structure 

- Chairman: Pius Itea (Gae Clan) 

- Vice-Chairman: Charles Kofasia (Anita’a 

Clan, Community’s catechista) 

- Secretary: Martin Kalafiu (Gae Clan) 

- Treasurer: Nicholas (Arurumae Clan) 

- Committee member: Andrew Itea (Arurumae 

Clan) 

 Executive Committee meeting 

- The Executive Committee members meet 

once a month. 

- No particular meeting set for other members. 

 Membership 

- Now supposedly 45 members. However, the 

number of members should be double-

checked, as record-keeping is not well done. 

- Any person who planted 100 or more trees of 

any kind (with membership payment) is 

accepted as a member. 

 Activities 

- Voluntary tree planting 

- Nursery: Members and non-members can 

purchase from the nursery. Seeds provided by 

MOFR (free of charge, as ADO is a register-

 In 2013, MOFR Auki 

Office (Rony) supported 

the organisation by a work-

shop and then formally 

registered. 

 Since the start of ADO, no 

change except for Andrew’s 

participation in the Execu-

tive Committee’s members 

in 2018. 

 

 

 

 

 

 

 

 

 

 

 

 People buy seedlings such 

as Mahogany and Kava 

seedlings (see below). 
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ed association). ADO sells the seedlings for 

SBD 2/seedling. 

- Furniture making: Since 2014. So far it is not 

very profitable. Has made chairs, dining 

tables, food shelf and so on for Dola Commu-

nity High School staff’s housing. Currently 

not trying to sell furniture to outside; as ADO 

is trying to build its office, the furniture is 

also to be made for ADO’s own use. For 

materials, currently ADO uses trees which 

had been illegally logged in the periphery of 

the community land. 
 

 

 

 So far 2 single beds (SBD 

700/bed), 1 double-bed 

(SBD 1,500), 6 dining 

chair (SBD 300/chair) were 

made and sold. 

 The profit goes to ADO, 

not to individual. 

 

Lessons Learned & Suggested Project Approaches 

 It is very important to understand the decision-making process, as it varies greatly from a community to 

another. In the Falake’s case, depending on how important an issue is, inside-Falake decision may or 

may not become a final decision. When MOFR/the Project plan any intervention, this point needs to be 

taken into consideration. 

 Clan elders are respected, but in practice, they may not be the persons to make decisions (or to lead the 

decision making process), as they are those of the older generation. From the survey, in reality, 

Community decision makers (or at least opinion leaders) seem to be those of the next generation (in late 

30s to early 50s). And all are males. 

 As such, how to reflect female opinions to Community decisions and activities needs to be considered 

by MOFR and the Project. When doing so, whether the planned intervention will not have any potential 

negative impact (such as inducing males’ backlash, and/or putting unnecessary pressure to women who 

do not want to draw attention) also needs to be carefully considered. 

 The new Falake Community Committee is to function as the primal decision making body for the issues 

related to the Project activities, but the existing decision making process and its influential players should 

be always taken into consideration, and their opinions and advices should be properly heard, not only 

by the Committee and the Community but as well as by MOFR and the Project. 

 Capacity building of the to-be-formed Community Committee and of ADO shall be required.  

 It is important to clarify who is/are the contact person(s) of the community. At the same time, it must be 

noted that this contact person may or may not be the leader of the Community (be it formal decision 

maker or opinion leader). This means what the person says or understands may or may not be what the 

Community thinks or decides. 
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Figure 1  Location map of clan-wise households (excluding Kwaiorea Clan) 
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Table 3  List of Community Committee members (Falake) 

Post Name 

Chairperson Constantine Etemani 

Vice Chairperson Maria Annie 

Secretary Joachim Lamusi 

Vice Secretary Jerry Loft Itea 

Treasurer Nelly Urufaka 

Vice Treasurer Hendry Kwateana 

 

Table 4  List of Community Sub-committee members (Falake) 

Sub-committee Post Name 

Planted Forest Chairperson 

Vice Chairperson 

Secretary 

Treasurer 

Vice Treasurer 

Gabriel Kalafiu 

Casper Suru 

Alda Kofasia 

Lovelyn Itea 

Godrick Malagela 

Natural Forest Chairperson 

Vice Chairperson 

Secretary 

Treasurer 

Member 

Member 

Raymond Kalafiu 

Ambrose Ometa 

Helina Lodo 

Freda Lodo 

Patrick Agote’emae, 

Nicholas Maeoa 

Agroforestry Chairperson 

Vice Chairperson 

Secretary 

Treasurer 

Vice Treasurer 

Charles. Koofasia 

Ben Arurumae 

John Bosco Kwasu 

Cathy. Kalafiu 

Ferdinal Kwaifii 

Livelihood Chairperson 

Secretary 

Treasurer 

Member 

Member 

Member 

Stanley Kwafii 

Pius Itea 

Elsie Kofasia 

Stanley Gae 

Jacinto Ramo 

Blaise Kofasia 
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2) Economic aspects 

Points of Information & Analysis 

 Majority of the respondents described their major livelihood (income-generating) activity is farming. 

However, the kinds of crops, the frequency, amount, marketing locations of the selling are very diverse 

and basically very much up to each person/household. 

 Some respondents have skills with which they can earn cash outside the Community. 

 As such, there is hardly any “typical” or “average” type/scale of agricultural and other activities in the 

community, as the following examples show. 

 

Income 

Agricultural 

crops 

Cacao 

 Sell wet to a middleman who comes to Falake. 

 Has more than 300 trees. Replanted old trees to 

new ones. 

 In 2018, no middleman came. Cacao wasted. 

 In April 2019, no middleman came. Cacao wasted. 

 In September 2019, middleman came but bought 

only SBD 2.5/kg. 

 

 The respondent also grows 

and sells betel nuts. His 

betel nuts sold once a 

week, SBD 100-150/10kg 

at Fosim Market. 

 Other respondents also 

mentioned about making 

income from cacao, also 

saying the current selling 

price is SBD 2.5/kg. The 

mentioned no negotiation 

done with the middlemen. 

Betel Nuts (1) 

 Can sell betel nuts at Fosim Market all year round. 

 Selling price varies considerably. When good, 

SBD 400/20kg. When bad, 200/20kg.  

 In the latest selling (a few days ago of the Inter-

view), gained SBD 300/20kg. 

 Go to sell when needs be. 

 

 On this day, the respondent 

sold 2 bags (40 kg). As 

such, he gained SBD 600. 

 Lately, the respondent has 

been selling his betel nuts 

more regularly than before. 

This is because he is 

building his house, hence 

needs considerable cash-

income more often than 

usual. 

Betel nuts (2) 

 Sells betel nuts in Honiara (not at Fosim Market) 

 The selling is done by the couple: 

- The respondent (husband) harvest and pack 5-7 

bags (each 20kg) of betel nuts, approx. 4 times 

per month. 

 

 The respondent also sells 

vegetable for cash-income. 

The selling place is Auki, 

not Fosim Market. 
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- The wife brings the bags to Honiara. At the 

wharf, the buyers of betel nuts are waiting for 

the boat to arrive, where the wife sells the bags. 

Kava 

 Planted kava in 2009. First kava farmer in Falake. 

 As kava needs 3 years to become big enough to 

harvest, started harvesting in 2012. 

 First harvest in 2012 became SBD 4,100/ 18 

bottoms (16.9kg). Sold to Varivao Holdings. 

 Latest harvest was April 2019. Income being SBD 

8,600. 

 

 So far, this respondent is 

the only person who has 

already gained income 

from kava. 

 Hearing his success, many 

people are now growing 

kava, but their kava is yet 

to be big enough for 

harvest yet. 

Skilled/semi-

skilled works 

Lucas mill operator 

 SBD 150-200/day. Contract-base (when demand/ 

order is, called up for work). 

 Good to have the demand 

approx. 5 days/month. 

 This person grows egg-

plants for additional 

income. 

 Had cacao but did not 

replant new cacao trees 

after the fall of the price. 

Welder 

 Income depending on how much welding work 

needed. In case of 2-3 parts welding, receives 

SBD 200-300. 

 Welding trained at Solon 

Islands National Univ-

ersity (SINU). 

 This person has no cash 

crop. 

Carpentry 

 Capable to make both houses and furniture 

 Contract-base (when demand/order is, called up 

for work) 

 Income depending on the job/contract. For 

example, the Dola Community School building 

was contracted for SBD 30,000 but this is only for 

the labour fee. 

 

 Almost Anita’a men are 

good at carpentry but it’s 

difficult for them to subsist 

on it. 

 In Dola Community School 

project, the materials were 

provided. In case, material 

procurement is included, 

the same contract would 

have become approx. SBD 

100,000. 

Shop-owning 

 Running a small shop in the Community 

 Income/expenditure not clear 
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Expenditure Expected 

Regular goods  Rice, Taiyo (tuna cans), salt, sugar—these things 

are usually bought from Auki and/or nearby shops. 

 Fish, chicken, sausage, minced meat—these things 

are bought in Auki. 

 Now almost all households have solar cells and 

kerosene buying is not required. 

 

 

 

 

 One small solar battery 

(12V) can be purchased @ 

SBD 160. Used for mobile-

charging and lighting. 

School fee  Primary school 

- School fee: SBD 100/year 

- Uniforms: Boys SBD 140, Girls SBD 160 

 Secondary school 

- School fee: SBD 500/year 

- Whether uniforms required for secondary 

schools not clear. 

 

 School fee payment can be 

done either yearly or half-

yearly. Usually people pay 

twice a year: End of 

January and July. 

 Other than listed, station-

ary, school contribution 

(for school picnics and so 

on), and other small 

expenditure required. 

Higher education 

fee 

 University (SINU) 

- Tuition fee: SBD 15,000/year 

- Living expenses in Honiara: SBD 1,000/month 

at least 

 Living expenses provided 

here do not include 

housing expenses. The 

student (the respondent’s 

daughter) lives in a 

relative’s house. 

Bride price In 2018, one marriage’s bride price is approx. SBD 

20,000 (cash) plus SBD 10,000 (shell money). 

 Took the respondent (father of the groom) one full 

year to prepare half of the required money. 

 The remaining half was contributed by the 

Community members. The contribution will be 

repaid by the groom (not the father), in similar 

situations; i.e. when a contributor’s son gets 

married, the now-groom will give his contribution. 

 Bride price in Falake (and 

most places in Solomon 

Islands) is paid from the 

groom’s family to the 

bride’s family. 

Expenditure Unexpected 

Hospital fee Caesarean operation: SBD1,000+ 

- Borrowed from relatives. 

- Unplanned selling of vegetable & betel nuts at 

Fosim and Auki Markets. 
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Expenditure (Mixed) 

House building  Basic materials (timber): harvested from the 

Community forest 

 Labour: provided by the house owner and 

Community people (basically same Clan people) 

 Chainsaw: requires payment of SBD 300/day for 

renting the chain-saw and operator hiring 

 

 For timber harvesting from 

the Community forest, the 

house owner first informs 

his Clan elder. The Clan 

elder then informs other 

Clans elders and other to-

be-informed people. 

 Not only Falake people but 

also tribal members who 

reside outside Falake have 

the right to harvest timber 

from the forest. 

Lessons Learned & Suggested Project Approaches 

 It should be noted that due to the limited time available for the survey, it is quite possible that many of 

the people who work outside the community are missed out from Focus Group Interviews, hence the 

community people’s livelihoods outside the community (e.g. transportation-related business) is not 

understood well enough. This means there is even more diversity, than that seen above, exists in the 

community. 

 Even with the present information, it is virtually impossible and moreover impractical to try to have an 

“average” picture of the community members’ livelihood means including income, expenditure, and 

income-generating skills/knowledge. 

 MOFR and the Project should accept the diversity of their livelihoods means, and try to think of a 

practical intervention(s) which would contribute to different types of livelihoods means and to varied 

levels of income-generating and fund-management skills of the community members. 

 It is very likely that other communities (with which MOFR will work in the future) would have quite 

similar diversity of livelihood means of the community members. The support/intervention of MOFR 

should be planned based on this understanding. 
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3) Wealth ranking 

Criteria 
Indicators 

Rich / Wealthy Fair Below average (Poor) 

1) Housing (size) Large Medium Small / simple 

2) Kinds of crops cultivated Long-/medium-/short-

term 

Medium-/short-term Short-term 

3) Skills/ knowledge/ 

formal education 

Sufficient  Insufficient 

4) Loan Never Sometimes and repay right 

time 

Never repay or postpone 

repay 

5) Livestock Cattle, pig, goat Chicken, duck None 

6) Sanitation (toilet) Proper (flushing) Toilet stool only Poor (just pits) 

7) Cash income > SBD 1,000/month SBD 500 – 1,000/month < SBD 500 

8) Schooling of children Tertiary school Secondary school Primary / None 

9) Purchasing power High Medium Low/ none 

10) Communication device Have  None 

 

RESULTS (# OF HHS) 3 18 17 

Note: The total number of the HHs (38) does not match the current number of HHs (48) (see Appendix 2  

Community profile of Falake) due to a recent increase in immigrants derived from the COVID 19. 
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Appendix 1  Community Profile of Komuniboli 

Date Created 31 July 2018 Date Updated 23 June 2020 

Created by Stephanie / Ruvie (Taskforce Team) Updated by Fukuyama (JICA Project) 

Date Checked 8 August 2018 Date Checked 25 June 2020 

Checked by Hillary / Kato (JICA Project) Checked by Hillary Wemani 

 

1. General Information 

Community Name Komuniboli 

Location 
Ward #: 16 / Ward Name: Aola 

Constituency: North East Guadalcanal / Province: Guadalcanal 

Tribe Name <Tribe> Ghaobata / <Clan> Lunga 

Language(s) Doku 

Community Chief 
Name: Charles Manaka / Mobile#: NIL17 

Name: Joseph Manegelea / Mobile#: 8609576 

Constituency 

Development Officer 
Name: Atkin / Mobile#: unknown 

Church Leader Name: Joseph Manengelea / Mobile#: 8609576 

Women Leader Name: Belinda Aba / Mobile#: 8443370 

Youth Group Leader Name: Augustine Ambrose Geve / Mobile#: 8563647 

 

2. Traditional Governing System 

Paramount Chief Name: Robert Manegelea / Mobile#:  8510303 

Tribal Chief 

(Ghaobata) 
Name: Mr. Eric Tapalia / Mobile#: unknown 

Members of 

House of Chief 
Tribe Name: Thibo / Name: Mr. Leon Sasa / Mobile#: unknown 

Members of 

Council of Chief 
Tribe Name: Nekama / Name: Mr. Charles Vavanga / Mobile#: unknown 

Members of 

Council of Chief 
Tribe Name: Thogo / Name: Mr. Malakia Veni / Mobile#: unknown 

Members of 

Council of Chief 
Tribe Name: Lathi / Name: Mr. Benson Sonithivua / Mobile#: unknown 

 

3. Population18 

Number of Households 20 24 

Population Male: 62 64 Female: 63 60 Total: 125 124 

                                                      
17 The data/information indicated by strike-through denote those that had been replaced by the updated ones. 
18 Updated according to the results of the Household Population Census of February 2020. 
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4. Community Infrastructure (Assets, Basic Service Supply, etc.) 

☑  Community Hall ☑  Church □ Health Centre/ Aid Post 

☑  Prep & Primary School □ Secondary School □ Rural Training Centre 

□ Community Crop/ Food 

Storage 

□ Male’s House □ Women’s House 

□ Community Boat/ OBM □ Community Truck/Bus □ Community Market 

□ Community Water Tank ☑  Community Well □ Communal Fishing 

Equipment 

☑  Communal Portable Mill ☑  Communal Chainsaw □ Communal Solar Panel 

□ Other (                ) □ Other (                ) □ Other (                  ) 

□ Gas Supply □ Power Supply □ Petrol/Kerosene Supply 

□ Public Water/ Sewage 

Supply 

☑  Mobile Coverage (B-

mobile) 

□ Internet Coverage 

 

5. Economy 

Economic 

Development Driver 

of the Community 

□ Wage Work (incl. Oil Palm Plantation, Copra Plantation, Logging, 

Mining) 

☑  Agriculture / Horticulture Development (Incl. Cacao, Coffee, Copra) 

□ Fishery Development (incl. Fish Farming, Sea Cucumber Farming, 

Inland Fishery, Shellfish Cultivation) 

□ Forestry Development (incl. Commercial Tree Plantation, Timber Milling) 

□ Livestock Development (incl. Livestock Farming) 

□ Others 

Major Cash Crop 1) Copra/Coconut 2) Cacao 3) Tomato 4) Eggplant 

5) Chinese Cabbage 6) Staple Food 

(Potato, 

Cassava, Taro, 

Banana) 

7) Fruits 

(Pawpaw, 

Pineapple, 

Melon, 

Cucumber) 

8) 

Major Livestock 1) Pig (both domestic 

and wild) 

2) Poultry (local 

breed) 

3) 4) 

Major Valuable 

Timbers Species 

and Non-timber 

Forest Products 

1) Akwa (Pometia pinnata) 2) Vasa (Vitex sp.) 3) Rosewood 

(Pterocarpus indicus) 

4) Sago Palm 

(Leaves for house roof) 

5) Loya cane 6) Wild betel nut 

Logging Record □ Currently Operational ☑  Operated in the past 

 (1980-81) 

□ Never 

Mining Record □ Currently Operational □ Operated in the past ☑  Never 
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Distance to Market Capital City: 60 km 

(Honiara) 

Nearby town: 25 km 

(GPPOL) 

Nearby local market: 

5 km (Ruavatu) 

Eco-

Tourism 

potential 

☑  Accommodation 

□ Transport 

☑  Tourist Guide 

☑  Porter 

☑  Bird Watching 

☑  Butterfly 

Watching 

□ Trekking/Hiking 

□ Climbing 

□ Turtle Watching 

□ Dolphin/Dugong 

Watching 

□ Snorkelling/Scuba  

□ Website 

□ Email/Internet 

□ SNS 

(Facebook) 

 

6. Occupation / Employment 

Employment Opportunity in Community How many? 

Public Servant (including casual worker) NIL 

School Teachers 5 

Doctor/Nurse/Health Workers NIL 

Oil Palm Plantation Worker (Wage based) NIL 

Copra Plantation Worker (Wage based) NIL 

Mining Operation Worker (Wage based) NIL 

Commercial Logging Operation Worker (Wage based) NIL 

Commercial Fishery Worker (Wage based) NIL 

Timber Milling Worker (Wage based) NIL 

Micro/Small Enterprise (Canteen/Store, OBM Mechanic, Petrol Supply etc.) 1 

 

7. Financial Service 

Location of nearest Bank 

branch 

Location: Honiara Distance: 60 km 

Location of nearest ATM Location: Tetere Police Station (GPPOL) Distance: 25 km 

# of Households (HHs) has Bank Account: 5 # of Households (HHs) has Bank Loan: 0 

Existence of Saving 

Club 

☑ Exist /□ Not exist Established: 2016 # of Members: 35 

Other Group Market Vendors Group Established: 2017 # of Members: 50 

 

8. Community-based Organization 

Name of CBO Main Activity Establishment Members Registration 

1) Tutuvaolu 

Association 

1) Training on farming skills 

2) Cultural/custom dancing, music 

3) Training in religious activities 

4) Information on anti-social 

activities 

Year: 2006 22 (both 

male and 

female) 

□ Done 

☑  Not yet 
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2) Catholic 

Women 

Association 

1) Church activities (singing, 

dancing, worshipping, prayer 

group) 

Year: 2000 10 ☑  Done 

□ Not yet 

 

9. Record of Activity/Project related with Natural Resources (# = Select number from bottom 
of table) 

# Category Type of Activity Year (Period) Implementing Agency Achievement/Outcome 

1 #: 4 #: ⑤ 2017 # 2 / Name: Rural 

Development Program 

Flush flood recovery and 

installation of water 

tanks 

2 #: 1 #: ①＋③ 2013 # 1 / Name: MOFR 

Utilization Division 

Sustainable forest 

management and timber 

utilization through milling 

3 #: 1+2 #: ③＋⑤+⑧ 1983-1999 # 2 / Name: Solomon 

Islands Development 

Trust (SIDT/ Greenpeace) 

Milling skills and Eco-

timber production, 

Community Hall construc-

tion, Farming eels 

L 

E 

G 

E 

N 

D 

Category #: 

1) Forestry 

2) Fishery 

3) Agriculture 

4) Community 

Development 

Type # of Activity: 

①Reforestation / 

Plantation 

②Forest Conservation/ 

Protection 

③Timber Processing 

④Biodiversity 

Conservation 

⑤Livelihood Improvement 

⑥Fishery Management 

⑦Marine Resource 

Conservation 

⑧Inland Fishery 

⑨Agriculture/ 

Horticulture 

⑩Livestock Farming 

⑪Agroforestry 

⑫Microfinance/ Saving 

Group 

⑬Other 

Type # of Agency 

1) Ministry 

2) Donor 

3) NGO 

4) CBO 

5) Research Institute 

 

 

Attachments: 

1) Seasonal climate and event calendar 

2) Resource map 

3) Social map 

4) Community governing system (Tentative) 

5) Case of land dispute 

6) Photo album 
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Attachment 1  Seasonal climate and event calendar of Komuniboli Community 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Attachment 2  Resource map of Komuniboli Community 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  



 

33 

Attachment 3  Social map of Komuniboli Community 
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Attachment 4  Community governing system (tentative) 

 

  

# Name (Position) Mobile 

0 Charles Maneka (Community Chief) NIL 

Executives 

1 Joseph Manegelea (Chairman) 8609576 

2 Vincent Suklu (Secretary) 8413927 

3 Robert Manegelea (Advisor) 8510303 

4 Abraham Manegaua (Treasurer) 8916325 

5 Berinda Amba (Vice Treasurer) 8443370 

Committee 

1 Charles Vavaga NIL 

2 Samson Taganepari NIL 

3 James Tapalia NIL 

4 Desmon Kuki NIL 

5 Salome Tapalia NIL 

6 Elizabeth Gena 8592558 

7 Julian Des NIL 

8 Julian Sam NIL 

9 Teresa Lesapa NIL 

10 Augustine Geve 8563647 

Note: The above community representatives were reshuffled as specified in Table 1 of the Chapter II of 

this document. 

  

Chief

Executives

Committee
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Attachment 5  Case of land dispute 

Agenda Description 

When was the dispute happened? The year of 1999, before the tension happened 

With which tribe/clan? Thibo Tribe 

Where is the dispute land located? South-west side, Small portion, Mainly swampy area 

(Please see the below map photos) 

How is this dispute expected to be 

resolved? 

This case was already registered in Supreme Court, back 

in early 2000s, but still on trial. Last consultation was 2006-

07 and both side (especially tribal leaders) endeavour to 

explain ancestor’s stories regarding land boundaries and 

land inheritances. 

How is the progress? Both parties agreed to resolve this case peacefully though 

legal procedure. 

How serious is this case? Mild. Both parties never got violent or aggressive due to 

this dispute and commit themselves to settle this 

peacefully. 

 

Above: Community Boundary Map 

Left: Land boundary under dispute with Thibo Tribe 
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Attachment 6  Photo album 

 

Community boundary map 

  

  

Conserved secondary forest and reforestation site 
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Appendix 2  Community Profile of Falake 

Date Created 18 September 2018 Date Updated 28 July 2020 

Created by Task Force members Updated by Fukuyama (JICA Project) 

Date Checked 1 October 2018 Date Checked 28 July 2020 

Checked by Hillary Wemani (JICA Project) Checked by Hillary Wemani 

 

1. General Information 

Community Name Falake 

Location 
Ward #: 4 / Ward Name: Fouabu 

Constituency: West Kwara’ae / Province: Malaita 

Tribe Name Funibua O’oro 

Community 

Language(s) 
Kwara’ae 

Community Chief 
Name: Emmanuel Kwateana / Mobile#: 8879620 

Name: Hendry Kwateana19 

Family Group (1) 
Name of Family Group: Funibua 

Name of Group Leader: Martin Kalafiu / Mobile#: NIL 

Family Group (2) 
Name of Family Group: Funibua O’oro 

Name of Family Group Leader: Clement Malagela / Mobile#: NIL 

Family Group (3) 
Name of Family group: Funibua Looro 

Name of Family Group Leader: Joseph_Koubusu / Mobile#: 8713781 

Constituency 

Development Officer 
Name: Unknown / Mobile#: Unknown 

Church Leader Name: Charles Kofasia / Mobile#: 8534600 

Women Leader Name: Salome Kofasia / Mobile#: 8534600 

Youth Group Leader Name: Benjamin Arurumae / Mobile#: 8534600 

 

2. Traditional Governing System 

Paramount Chief Name: None existence / Mobile#: NIL 

Tribal Chief Name: None existence / Mobile#: NIL 

Members of  

Council of Chief 
Name: None existence / Mobile#: NIL 

Other 

(title: Chairman of 

ADO Rural Farmers 

Association) 

Name: Pius Itea / Mobile#: 8616370 

                                                      
19 He replaced the former Chief and also his father, Mr. Emmanuel Kwateana, and was agreed and approved by the community 

on 10 June 2020. 
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Other  

(title:            ) 
Name: NIL / Mobile#: NIL 

 

3. Population 

Number of Households 36  4820 

Population21 Male: 87 88 Female: 93 69 Total: 180 157 

 

4. Community Infrastructure (Assets, Basic Service Supply, etc.) 

☑  Community Hall ☑  Church □ Health Centre/ Aid Post 

☑  Prep & Primary School □ Secondary School □ Rural Training Centre 

□ Community Crop/ Food 

Storage 

☑  Male’s House □ Women’s House 

□ Community Boat/ OBM □ Community Truck/Bus □ Community Market 

□ Community Water Tank ☑  Community Well □ Communal Fishing 

Equipment 

☑  Communal Portable Mill □ Communal Chainsaw □ Communal Solar Panel 

□ Other (                 ) □ Other (               ) □ Other (                  ) 

□ Gas Supply ☑  Power Supply (Generator) □ Petrol/ Kerosene Supply 

☑  Public Water/ Sewage 

Supply 

☑  Mobile Coverage ☑  Internet Coverage 

 

5. Economy 

Economic 

Development Driver 

of the Community 

□ Wage Work (incl. Oil Palm Plantation, Copra Plantation, Logging, 

Mining) 

□ Agriculture / Horticulture Development (Incl. Cacao, Coffee, Copra) 

□ Fishery Development (incl. Fish Farming, Sea Cucumber Farming, 

Inland Fishery, Shellfish Cultivation) 

☑  Forestry Development (incl. Commercial Tree Plantation, Timber Milling) 

□ Livestock Development (incl. Livestock Farming) 

□ Others 

Major Cash Crop 1) Betel nut 2) Vegetable 3) Cacao 4) Korokua 

5) Kava 6) Kumara 7) Cassava 8) Nut 

Major Livestock 1) Pig 2) Chicken 3) Duck 4) Goat 

Major Valuable 

Timbers Species 

1) Vitex sp. 2) Rosewood 3) Pometia sp. 

4) Callophylum sp. 5) Mudu 6) Pencil cedar 

                                                      
20 Updated according to a recent interview with the community representatives. 
21 Updated according to the results of the Household Population Census of February 2020. 
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and Non-timber 

Forest Products 

Non-timber Forest 

Products 

1) Loya cane 2) Kava 3) Sago palm 

4) Bush rope 5) Wild betel nut 6) Orchid 

Logging Record ☑  Currently Operational 

(since 2016) 

□  Operated in the past □ Never 

Mining Record □ Currently Operational □ Operated in the past □  Never 

Distance to Market Capital City:  Nearby town: 26 km 

(Auki) 

Nearby local market: 

2 km (Fosim) 

Eco-

Tourism 

potential 

☑  Accommodation 

☑  Transport 

□  Tourist Guide 

□  Porter 

☑  Bird Watching 

☑  Butterfly 

Watching 

☑  Trekking/Hiking 

☑  Climbing 

□ Turtle Watching 

□ Dolphin/Dugong 

Watching 

□ Snorkelling/Scuba  

□ Website 

□ Email/Internet 

□ SNS 

(Facebook) 

 

6. Occupation / Employment 

Employment Opportunity in Community How many? 

Public Servant (including casual worker) Nil 

School Teachers 2 

Doctor/Nurse/Health Workers 2 

Oil Palm Plantation Worker (Wage based) Nil 

Copra Plantation Worker (Wage based) Nil 

Mining Operation Worker (Wage based) Nil 

Commercial Logging Operation Worker (Wage based) Nil 

Commercial Fishery Worker (Wage based) Nil 

Timber Milling Worker (Wage based) 1 

Micro/Small Enterprise (Canteen/Store, OBM Mechanic, Petrol Supply etc.) 4 

Other (                                               ) Nil 

 

7. Financial Service 

Location of nearest Bank branch Location: Auki Town Distance: 26 km 

Location of nearest ATM Location: Dala South Distance: 4 km 

# of Households (HHs) has Bank Account: 21 # of Households (HHs) has Bank Loan: Nil 

Existence of Saving 

Club 

□ Exist /☑ Not exist Established: 

                 

# of Members: _______ 
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8. Community-based Organization 

Name of CBO Main Activity Establishment Members Registration 

1) ADO Rural Farmers 

Association 

Encourage farmers to plant 

trees promoting Sustainable 

forest Management. 

Year: 2013 

 

☑  Done 

□ Not yet 

2)       Year:   □ Done 

□ Not yet 

 

9. Record of Activity/Project related with Natural Resources (# = Select number from bottom 

of table) 

# Category Type of Activity Year (Period) Implementing Agency Achievement/Outcome 

1 #: 4 #: ⑤ 2002～ #: 2&1 / Name:_NZ & 

Ministry Health 

Water supply system 

around community. 

2 #: 1 #: ① 2015～ #: 1 / Name:_ Ministry of 

Forestry and Research 

- Assistance in form of tools 

- Awareness talk by 

Utilisation division. 

- Provision of seeds. 

- Working close with Auki 

forestry officer. 

L 

E 

G 

E 

N 

D 

Category #: 

1) Forestry 

2) Fishery 

3) Agriculture 

4) Community 

Development 

Type # of Activity: 

①Reforestation / 

Plantation 

②Forest Conservation/ 

Protection 

③Timber Processing 

④Biodiversity 

Conservation 

⑤Livelihood Improvement 

⑥Fishery Management 

⑦Marine Resource 

Conservation 

⑧Inland Fishery 

⑨Agriculture/ 

Horticulture 

⑩Livestock Farming 

⑪Agroforestry 

⑫Microfinance/Saving 

Group 

⑬Other 

Type # of Agency 

1) Ministry 

2) Donor 

3) NGO 

4) CBO 

5) Research Institute 

 

Attachments: 

1) Seasonal and event calendar 

2) Resource map 

3) Social map 
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Attachment 1  Seasonal and event calendar of Falake Community 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Attachment 2  Resource map of Falake Community 
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Attachment 3  Social map of Falake Community 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 


	表紙
	添付資料1
	添付資料2
	添付資料3
	添付資料4
	添付資料5



